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The following sections have changed or information has been added to 
the Power IQ User Guide based on enhancements and changes to the 
software and/or user documentation.  

 Configuring PDU Display Settings - View PDUs by IP or Name 
(on page 40) 

 Customizing Your View of PDUs, Devices, and Events (on page 
41) 

 Adding Raritan PDUs in Port Forwarding Configuration (on page 
30) 

 View Events (on page 70) 

 Geist RCX Supported Events (on page 50) 

 Raritan PX/PX2/PX3 Supported Events (on page 55) 

 Power IQ Role Definitions (on page 83) 

 Sharing a Dashboard (on page 92) 

 Enabling the Web API User Account (on page 125) 

 Active Power Trends for Devices (on page 177) 

 Search for PDUs (see "Search for PDUs and Devices" on page 
181) 

 Sensor Assignment Guideline (on page 210) 

 Sharing Reports on the Analytics Page (on page 228) 

 Create a Rack Failover Report (on page 245) 

 Downloading Daily Sensor Readings (on page 267) 

 Trap Support in Dynamic Plugins - Structured or Custom (on 
page 288) 

 Managing Removed or Out of Service Objects (on page 343) 

 Enable or Disable the Root Accounts for Support (on page 354) 

 Configuring ODBC User Credentials (on page 358) 

Please see the Release Notes for a more detailed explanation of the 
changes applied to this version of the Power IQ. 
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For simplicity in the GUI, Power IQ uses the term PDU to encompass 
any device that Power IQ polls to gather power or sensor data.  

When you see the term PDU in the product interface, remember that it 
includes every polled object: rack PDUs, CRACs, floor PDUs, floor UPSs, 
power panels, standalone meters, and environmental sensor 
aggregators. 

In this guide, the following terms are also used: 

 Rack PDU 

 Facilities Objects: CRAC, floor PDU, floor UPS, power panel, and 
standalone meter. 

 

The Term "PDU" in Power IQ 
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If you obtained Power IQ as a VMware application, you must install it on 
a VMware ESX/ESXi Server. 

In This Chapter 

Virtual Machine Requirements .................................................................. 1 
Preparing to Install Power IQ..................................................................... 1 
Creating the Power IQ Virtual Machine ..................................................... 2 
Loading Power IQ onto the Virtual Machine .............................................. 2 
 
 

Virtual Machine Requirements 

Minimum 
Configuration 
(Number of 
PDUs)* 

RAM 

(GB) 

CPU 

(Cores) 

Datastore 

(GB) 

OS VMware 

Up to 50 4 4 160 or more CentOS  64-Bit ESX/ESXi 

51-100 8 4 160 or more CentOS  64-Bit ESX/ESXi 

101-500 8 6 160 or more CentOS  64-Bit ESX/ESXi 

501-1000 8 8 160 or more CentOS  64-Bit ESX/ESXi 

1001-1500 16 8 160 or more CentOS  64-Bit ESX/ESXi 

More than 1500 24 8 160 or more CentOS  64-Bit ESX/ESXi 

*Based on 30 outlets per PDU 
 

Preparing to Install Power IQ 

 Verify that you have the DVD containing the Power IQ .ISO file. 

 Verify the datastore has at least 160GB free for a new virtual 
machine. 

 If you plan to install the virtual machine from the datastore, verify that 
there is sufficient extra space free for the installation ISO file, and 
copy the file from the DVD to the datastore. 

 If you plan to install from a remote server, copy the ISO file from the 
DVD to the server. 

Note: The instructions in this guide refer to the vSphere client, which is 
compatible with ESX/ESXi 4.0 and higher. 
 

Chapter 1 Installing the Power IQ Application 
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Creating the Power IQ Virtual Machine 

1. Connect to the VMware server using vSphere client. Log in as a user 
that has permission to create, start, and stop virtual machines. 

2. In the Summary tab, click New Virtual Machine in the Command box. 

3. Choose Custom. Click Next. 

4. Enter a name for the virtual machine. Click Next. 

5. Choose a Datastore with at least 160GB of free space available. 
Click Next. 

6. You may need to select the Virtual Machine Version, depending on 
your host. Select the version. Click Next. 

7. Select Linux for the Guest Operating System, then select CentOS 
64-bit, if available, from the Version drop-down. If CentOS 64-bit is 
not available, select Other Linux (64-bit). Click Next. 

8. Set the number of virtual processor cores to 4, 6 or 8, depending on 
the size of your configuration. See Virtual Machine Requirements 
(on page 1). Click Next. 

9. Adjust the amount of memory allocated for the virtual machine, 
depending on the size of your configuration. See Virtual Machine 
Requirements (on page 1). Click Next. 

10. Set the number of NICs to one or two. If there are two NICs, one can 
be used for external access to the web interface and the other can 
be used as a private LAN for communication with the PDUs and 
other data center devices.  

In either case, make sure Connect at Power On is checked, and 
leave all other settings at default. Click Next. 

11. Select LSI Logic for the SCSI Controller. Click Next. 

12. Select "Create a new virtual disk." Click Next. 

13. Set the Disk Capacity to 160GB minimum. Select a disk provisioning 
option. Select "Store with the virtual machine". Click Next. 

14. Leave all advanced options at default. Click Next. 

15. Select the "Edit virtual machine settings before completion" 
checkbox, then click Continue. Select New CD/DVD, then select a 
Device Type option to map the CD/DVD drive on the virtual machine. 
Click Finish to save the drive and return to the main dialog.   

16. Click Finish to create the virtual machine. 
 

Loading Power IQ onto the Virtual Machine 

1. From the tree in the left pane, select the Power IQ Virtual Machine. 
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2. Select the Console tab. Click  to power up the virtual machine. 
After a few moments, the Power IQ kickstart page opens. 

 

3. Type 2 for a VMware installation and press Enter to begin installation. 
Installation takes 20 minutes. When it completes, press Enter to 
reboot the Power IQ virtual machine. 

4. The virtual machine reboots and displays a console prompt.  
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After installing Power IQ®, you must configure the system for access over 
the network. 

Note: Hardware versions only: Connect a keyboard, mouse, and monitor 
to the Power IQ device. 

 

In This Chapter 

Configuring Power IQ for Access over Network ....................................... 4 
Open Port Requirements .......................................................................... 5 

 
 

Configuring Power IQ for Access over Network 

 To configure Power IQ for access over network: 

1. Power on Power IQ. 

2. When prompted to log in, use the username config and the password 
raritan. The Power IQ configuration page opens. 

 

3. Select Networking Setup, then select Setup LAN 1 to configure the 
primary Ethernet port. 

4. Press the Space bar to select Enable this LAN Port. 

5. To manually assign the network settings to Power IQ, leave Use 
DHCP deselected. Type the IP address, network masks, and 
gateway into the appropriate fields. 

6. Select Accept to reset the network interface with the new values. 

7. If you are using a second network interface, select Setup LAN 2 from 
the Network Configuration menu and configure the secondary 
Ethernet port in the same manner as the first. Optional. 

Chapter 2 Initial Configuration of Power IQ 
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8. Select Ping Network Test to ensure that Power IQ can communicate 
over the network. Optional. 

9. To disable SSH remote access to Power IQ, select System Services. 
Then deselect Enable SSH. By default, the config account has 
access to Power IQ. SSH is re-enabled if a support connection is 
created. Optional. 

10. Select Exit from the main menu. You can now access Power IQ from 
any client on the network. 

 

Open Port Requirements 

You must ensure that certain ports are open for Power IQ to work. 

See Support Connections (on page 353) for details about open port 
requirements for support connections to Raritan Technical Support. 
 

Ports Open Between Power IQ and PDUs 

 Port 161 (UDP): Required for all PDUs 

 Port 162 (UDP): Required for Raritan PX PDU traps to be sent to 
Power IQ 

 Port 443 (TCP): Required for Raritan PX PDU firmware upgrades 
performed through Power IQ 

 Port 623 (UDP): Required for Raritan PX PDUs. Standard IPMI 
communication port. 

 

Ports Open Between Clients and Power IQ 

 Port 443 (TCP): allows the web interface 

 Port 5432 (TCP): allows ODBC access. Optional. 

 Port 22 (SSH): allows Raritan technical support to log into the shell 

 80 (HTTP): insecure connection to the web UI that immediately 
forwards to 443 (HTTPS) 

 111 (rpcbind):  

 



 

 
6
 

 

1. Connect to Power IQ using a web browser on any machine on the 
network.  

2. In the browser's address bar, enter the IP address or hostname 
assigned to Power IQ. For example: https://192.168.1.10 

3. Answer yes to any security alerts and accept all certificates. If this is 
your first time connecting to Power IQ, you must upload your license 
and accept the End User Licensing Agreement before logging in. If 
this is not your first time connecting to Power IQ, skip to step 4. 

Licenses are .LIC files. Repeat this step to add incremental licenses 
if needed. 

Note: Your license file can be retrieved from the Raritan web site 
after you have activated your registration. To activate your 
registration, click the link in the "Thank you for registering" email 
from Raritan and create your user account. Once you create your 
account, look for a "Your Raritan software license key is available" 
email containing a link to your license file download page. 

4. Log in with the default username admin and password raritan. 

The Power IQ dashboard opens.  

 

Chapter 3 Connecting to Power IQ 
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Configuring Logging through Syslog 

External Syslog servers can be used to record events occurring on 
Power IQ. Using a Syslog provides a separate external log of events.  

All servers listed under Current Syslog Destinations record events on 
Power IQ. Recorded events include new users, configuration changes, 
and failed login attempts.  

 To configure logging through Syslog: 

1. In the Settings tab, click Server Settings in the Appliance 
Administration section.  

2. In the Syslog Destinations box, click Add, then type the IP address of 
a Syslog server in the "Syslog server address" field. This must be in 
the form of a numeric address. 

3. Click OK. The server appears on the list of current Syslog 
Destinations. 

 To stop a syslog server from recording events: 

 Select the checkbox next to the server you want to remove then click 
Remove. 

 

Chapter 4 Additional Configuration Tasks 
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Configuring Polling Intervals 

At each polling interval Power IQ collects data from PDUs under its 
management.  

 To configure the polling interval: 

1. In the Settings tab, click Power IQ Settings in the Appliance 
Administration section. 

2. In the Polling Settings box, select a time period from the "Polling 
interval" drop-down list. The time period indicates how much time 
passes before Power IQ starts a new polling cycle 

3. Click Save Poller Settings. 

Note: When managing a large number of PDUs you may need to 
configure a longer time period for the polling interval. Setting a longer 
time period helps ensure that all PDUs are polled within a given cycle. A 
warning message appears if Power IQ is unable to poll all PDUs within 
the configured time period. See Recommended Polling Intervals  (on 

page 9)for details on settings that help Power IQ poll faster. 
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Recommended Polling Intervals 

The optimal polling interval depends on your business needs, the 
number of PDUs you have deployed, their types and the platform you are 
running Power IQ on. Outlet metered PDUs are a larger system load 
than unit-level metered PDUs. Raritan PDUs have a unique feature to 
store readings. Storing readings gives you the added flexibility to set a 
poll rate and a sample rate. See Buffered Data Retrieval (on page 12) 
for more detail.  

Start with a longer polling and sample interval to ensure system 
operation. Gradually shorten the polling and sample interval as business 
needs require.  

Your actual results may vary based upon local conditions. PDUs that 
provide less data than the Raritan PDU have a lower system load. You 
can therefore likely poll those PDUs at the stated sample rate for a given 
configuration. 

To allow faster polling, disable the storage of raw sensor readings in 
CSV files to the Power IQ disk. Disabling this setting allows Power IQ to 
poll more devices at a faster polling interval, but you won't have access 
to raw readings in CSV format. See Configure Raw Sensor Readings 
Storage (on page 10) for details. 

See Configuring Polling Intervals (on page 8) for details on changing 
these settings. 

 Polling Intervals with buffered data retrieval: 
 

Number of PDUs Sample Rate Polling Interval Memory  

 1,000 outlet metered PDUs  5 minutes   30 minutes  8 GB RAM 

 1,500 outlet metered PDUs  5 minutes   30 minutes  16 GB RAM 

 2,000 outlet metered PDUs  5 minutes  30 minutes  24 GB RAM 

 3,200 unit metered PDUs  10 minutes  30 minutes  8 GB RAM 

 Polling Intervals without buffered data retrieval:  
 

Number of PDUs Polling Interval Memory  

 2,100 outlet metered PDUs  10 minutes  8 GB RAM 
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Configure Raw Sensor Readings Storage 

In Power IQ releases before 4.0.0, raw sensor readings collected by 
Power IQ are automatically stored in daily CSV files which are 
compressed into ZIP files at the end of each day. Power IQ retains a 
maximum of eight full days of compressed CSV files depending on 
available disk space.   

Power IQ 4.0.0 is capable of polling at faster rates than older Power IQ 
releases. The more sensor readings that Power IQ collects, the more 
likely it becomes that the disk partition where these CSV files are stored 
will run out of space. This could prevent the Power IQ poller from 
functioning properly.   

In Power IQ 4.0.0, if you require access to the raw sensor readings in 
CSV format, you must enable this feature. Depending on your Power IQ 
polling configuration, such as number of managed PDUs, polling interval, 
sample rate, Power IQ may not be able to store eight full days of 
readings. In some configurations, it may not be possible to write sensor 
readings to CSV because the number of raw sensor readings in a day 
will consume too much disk space.   

If you do not require access to raw sensor readings in CSV format, the 
feature should remain disabled. Disabling this feature will improve the 
performance of the Power IQ poller and will free system resources for 
other tasks. 

When the feature is disabled, you can still access two hours of raw 
sensor data stored in the database before values are rolled up, and the 
raw data deleted from the database. This raw sensor data can be 
retrieved using ODBC access and reporting tools. See ODBC Access 
(on page 357).  

See Data Storage Configuration Calculator (on page 10) for details on 
a tool you can use to determine if your system configuration is 
compatible with writing raw sensor readings to CSV. 

See Enable or Disable Storing Raw Readings in CSV Files on Disk 
(on page 11) for instructions on changing the setting. 
 

Data Storage Configuration Calculator 

The Data Storage Configuration Calculator is a tool that can help you 
determine if storing raw readings in CSV files is supported for your 
configuration.  

You can download the Power IQ 4.0.0 version from the Raritan website. 

http://www.raritan.com/support/power-iq/v4.0.0/data-storage-configurator
/ 
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Enable or Disable Storing Raw Readings in CSV Files on Disk 

Depending on your configuration, storage of raw sensor readings in CSV 
files may not be supported, and could lead to performance issues with 
the Power IQ poller. 

Use the Power IQ data storage configuration calculator tool to determine 
if storage of raw sensor readings is supported with your configuration.  

Power IQ Data Storage Configuration Calculator: 
http://www.raritan.com/support/power-iq/v4.0.0/data-storage-configurator
/ 

 To enable or disable storing raw readings in CSV files on disk: 

1. In the Settings tab, click Power IQ Settings in the Appliance 
Administration section. 

 To enable storage of daily sensor readings, select the "Store raw 
readings in CSV files on disk" checkbox. This option enables raw 
readings to be stored in CSV files on disk.  

 To disable storage of daily sensor readings, deselect the "Store 
raw readings in CSV files on disk" checkbox. This option will not 
store raw readings on disk, and frees up resources for faster 
polling. 

2. Click Save Poller Settings.  
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Buffered Data Retrieval 

Raritan PX PDUs version 1.2.5 and higher have the ability to temporarily 
buffer power measurements. This allows Power IQ to receive more data 
with less frequent polling. Enabling buffered data retrieval instructs 
Power IQ to retrieve these buffered measurements instead of collecting a 
single point of data at the time of polling. This results in increased 
efficiency when gathering data from Raritan PX PDUs.  

See Enabling Buffered Data Retrieval from Raritan PX 1.2.5 or 
Higher (on page 13) for instruction on enabling the feature. 

You must set a Sample Interval when using buffered data retrieval. The 
polling interval controls how often Power IQ requests buffered data from 
Raritan PX PDUs, the sample interval controls how granular the buffered 
data is. 

For example: With a polling interval of 1 hour, and a sample interval of 1 
minute, Raritan PX PDUs under Power IQ management collect 
measurements each minute and store the data in the Raritan PX's data 
buffer. Every hour, Power IQ then retrieves the data buffer with the last 
hour's measurements from each Raritan PX. 

Shorter sample intervals cause Raritan PX PDUs to fill their buffers more 
quickly. As a result, Power IQ may limit the polling interval to prevent 
data loss due to filled buffers. 

When buffered data retrieval is in use, Power IQ polls other PDUs that 
do not support this feature at the Sample Interval. This helps maintain a 
consistent granularity of measurements across all readings. 

The Buffered Data Retrieval feature may consume the space available 
for data storage rapidly since it allows Power IQ to retrieve a great deal 
of data at once.  

Note: To configure Raritan PX sampling rates, Power IQ must have 
SNMP write access to those PDUs. First make sure the Raritan PX 
SNMP agents are enabled. Then ensure that they have been added to 
Power IQ management using an SNMP community string that has write 

access. 
 

Set Polling Intervals and Sample Rates at Even Multiples 

Set your sample rate at even multiple of your polling interval, when data 
buffering is enabled. This enables Power IQ to collect an even number of 
data points. 
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Enabling Buffered Data Retrieval from Raritan PX 1.2.5 or Higher 

Note: All Power IQ's using buffered data retrieval that are polling the 
same PDU must use the same Sample Interval setting to prevent each 
instance of Power IQ from attempting to change the sample interval to its 

own setting. 

See Buffered Data Retrieval (on page 12) for more details. 

 To retrieve buffered data from Raritan PX 1.2.5 or higher: 

Make sure that Raritan PX PDUs have been added to Power IQ with a 
Write Community String, or buffered data retrieval will not work. See 
Editing PDUs under Power IQ Management (on page 22) for details on 
editing PDU credentials.  

1. In the Settings tab, click Power IQ Settings. 

2. In the Polling Settings section, select the "Enable buffered data 
retrieval on Raritan PDUs" checkbox. 

3. Select a sample period from the Sample Interval drop-down list. This 
configures the sample interval that Raritan PX PDUs use to buffer 
power measurements. 

For example: If 1 minute is selected, every minute, Raritan PX PDUs 
takes a power measurement and stores it in its internal buffer for 
retrieval. 

Note: The polling interval and sample interval should not be set to 
the same time period. Set the polling interval to a longer time period 
than the sample interval. For example: 30 minute polling interval with 
a 10 minute sample interval. See Configuring Polling Intervals (on 

page 8). 

4. Click Save Poller Settings. 
 

External Sensor Data from Raritan PX 

Raritan PX model PDUs version 1.6 and higher support buffered data for 
external sensors. 

For Raritan PX model PDU versions earlier than 1.6, external sensor 
data is not recorded at the sample interval when Buffered Data Retrieval 
is enabled. The external sensor data is recorded at the polling interval. 

See Buffered Data Retrieval (on page 12). 
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Use NTP Servers with Buffered Data Retrieval 

If you enable Buffered Data Retrieval, Raritan strongly suggests enabling 
NTP and configuring Power IQ and your Raritan PX PDUs to use the 
same NTP servers. This ensures that all recorded data is in sync, 
whether generated by Power IQ or Raritan PX. 

Difference in time between Power IQ and PDUs can cause incorrect 
values on the capacity gauges on the dashboard. 
 

Advanced Polling Settings 

WARNING: Advanced Polling Settings, including Advanced SNMP 
Settings and Advanced Thread Pooling Settings, should only be used 
with Raritan Technical Support guidance, or by expert users. Changes 
to these values can negatively affect Power IQ performance, or result 
in loss of data. 

If you have PDUs in the Lost Comm state, changing the default SNMP 
settings may help. Do not proceed without Raritan Technical Support 
guidance. See Troubleshooting Lost Communication Status in PDUs 
(on page 16) for details on possible causes. See Advanced SNMP 
Settings (on page 15) for details on the settings. 
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Advanced SNMP Settings 

Changing the SNMP settings may help if you have too many PDUs in 
Lost Communication (LostComm) state.   

See Troubleshooting Lost Communication Status in PDUs (on page 
16) for details on possible causes and other solutions.  

Warning: You should only change these settings if you are an expert 
SNMP user, or with Raritan Technical Support's help. Changes to 
these values can negatively affect Power IQ performance, or result in 
loss of data. 

 Recommended changes: 

Increase how many times Power IQ will attempt an individual SNMP 
request and how long Power IQ will wait for an individual SNMP request. 
A poll of a PDU can potentially involve hundreds of individual SNMP 
requests. It is recommended to gradually increase the "Read timeout" 
and Retries settings and allow several poll intervals to pass to gauge the 
impact of the change before making additional changes.  

If you see a large number of unexplained outages for Raritan PX1 or 
PX2 PDUs, it may also be necessary to decrease the "Maximum rows 
per request (PX)" setting. In a small number of cases the default value of 
10 may result in SNMP response packets that are too large for customer 
networks to handle correctly due to packet fragmentation. This is related 
to PDUs being managed remotely over a WAN. Decreasing this value 
results in some loss of efficiency because Power IQ has to send more 
SNMP requests to the target PDU, given that a smaller set of data is sent 
back in each SNMP response. 

By default, Power IQ uses the following default SNMP settings: 

 Read timeout: 5000 milliseconds 

 Write timeout: 5000 milliseconds 

 SNMPv3 timeout: 20000 milliseconds 

 Retries: 2  

 Total number of attempts= retries + 1. The default number of 
attempts is 3. 

 Maximum rows per request (default): 1  

 This value is used for non-Raritan PDUs 

 Maximum columns per request (default): 5= 

 This value is used for non-Raritan PDUs 

 Maximum rows per request (PX): 10 

 This value is used for Raritan PDUs 
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 Maximum columns per request (PX): 15  

 This value is used for Raritan PDUs 
 

Troubleshooting Lost Communication Status in PDUs 

A PDU in "LostComm" state usually has one of these problems. 

1. The user has configured Power IQ with the wrong community string 
for the PDU. 

2. There is a network connectivity issue between Power IQ and the 
PDU.  

3. The PDU is powered off or not connected to the network. 

If you have checked and corrected these problems, and the status does 
not change, there may be an SNMP setting that is causing the problem. 
These problems are much less common. These problems may be solved 
by changing the SNMP settings, but you should only change these 
settings if you are an expert SNMP user, or with Raritan Technical 
Support's help. See Advanced SNMP Settings (on page 15) 

1. The configured SNMP timeout and retry value are insufficient for 
your use case. For example, you need to manage remote PDUs over 
a WAN. Network latency or bandwidth do not work well with the 
default SNMP settings, resulting in a large number of SNMP 
timeouts that show up as LostComm state PDUs.  

2. The SNMP agent on the PDU is not responding to requests. The 
PDU's processor may be busy handling other tasks and is 
temporarily unable to respond to SNMP requests. 
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Advanced Thread Pooling Settings 

Warning! The configured thread pool settings determine how many 
Power IQ resources are allocated to polling PDUs. The default 
settings are designed to work for most use cases and should not need 
to be changed. If you are experiencing performance issues related to 
polling, Raritan Technical support can work with you to determine if 
changing the thread pool settings will be beneficial.  

Warning! Do not change these settings without the guidance of 
Raritan Technical Support. 

 Enable dynamic thread pool sizing: Determines if dynamic thread 
pool sizing is enabled (default: true)  

 Threads per core: If dynamic sizing is disabled, this value will be 
used to calculate thread pool size. (default value: 10) This parameter 
affects poller operation when dynamic thread pool sizing is enabled 
or disabled.  

 Dynamic thread pool size: Dynamically calculated ideal thread pool 
size (default: 0)  

 Maximum CPU utilization: Target CPU utilization for polling PDUs. 
(default: .80)  

 Maximum size of dynamic thread pool: Defines the maximum 
possible size of the dynamic poller thread pool. (default: 225 threads) 

 Maximum number of active database connections: Defines the 
maximum size of the database connection pool that is shared by the 
entire Poller JVM. 

 Dynamic restart threshold: Defines how large the delta between the 
configured max pool size and the calculated ideal pool size must be 
before a Poller JVM restart is justified. (default: 5)  

 Minimum time between restarts (in minutes): Defines minimum time 
between Poller restarts due to thread pool resizing (default: 1440, 
that is, only allow Poller to restart once every 24 hours to adjust 
thread pool size)  

 Interval between thread pool evaluations (in minutes): Defines how 
frequently the Poller service will evaluate the thread pool size to 
determine if resizing is needed. (default: 60) 

 Low water mark: Thread pool scheduler low water mark. Low water 
mark controls how aggressively threads are removed from the thread 
pool. This water mark represents the ratio of threads to items in the 
queue. The higher the value the more likely a thread will be removed 
from the pool. (default: .01) 
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 High water mark: Thread pool scheduler high water mark. High water 
mark controls how aggressively threads are added to the thread pool. 
This water mark represents the ratio of threads to items in the queue. 
The smaller the value the more likely a thread will be added to the 
pool. (default: .10)  

 

Setting the Default SNMP Version for PDUs 

 To set the default SNMP version for PDUs: 

1. In the Settings tab, click Power IQ Settings in the Appliance 
Administration section. 

2. In the Polling Settings box, select 1/2c or 3 as the default SNMP 
version for new PDUs added to Power IQ.  

3. Click Save Poller Settings.  

You can change the default value when you add the PDU. 
 

SNMPv3 May Require Longer Polling Interval 

Enabling SNMPv3 represents about twice the load on Power IQ as 
SNMPv1/2. 

You may need to increase the polling interval to enable Power IQ to poll 
all pdus when SNMPv3 is enabled. 

See Setting the Default SNMP Version for PDUs (on page 18). 

See Configuring Polling Intervals (on page 8). 
 

Setting Default Estimated Voltages 

Power IQ can estimate active power for PDUs that do not directly provide 
Active Power measurements.  

If a PDU does not provide one of the following values, the default 
estimated voltage will be applied. 

 Inlet Voltage 

 Outlet Voltage 

 Active Power 

This default value can be changed per PDU, in the Edit PDU page. 
These voltage values are only editable when they are NOT coming from 
the PDU. See Configure Estimated Voltages (on page 24). 

 To set the default estimated voltages: 

1. In the Settings tab, click Power IQ Settings. 
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2. In the Polling Settings box, enter a default estimated voltage for 
single phase PDUs and a default estimated inlet and outlet voltage 
for three phase PDUs. Optional. 

3. Click Save Poller Settings. 
 

Note on Geist and Rittal PDUs 

Geist and Rittal PDUs are marked as single or three phase at the second 
polling interval after discovery.  

If a PDU is not marked after two polls, mark the phase manually. 
 

Support for IPv6 

You can assign Power IQ an IPv6 address. 

Power IQ supports IPv6 communication for the following functions. 

 Add PDUs with IPv6 addresses 

 Add PDUs with IPv6 addresses using CSV import 

 Add IT devices with IPv6 addresses 

 Enable access controls using IPv6 address 

 Use SNMP diagnostics over IPv6 network.  

 Allow IPv6 hosts to connect to the ODBC database 

 Configuring NTP servers with IPv6 addresses 

 Do network diagnostics using ping, traceroute over IPv6 network. 
Serial console only. 

 Enable static routes using IPv6 addresses. Serial console only. 
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Valid IPv6 Address Formats 

Power IQ accepts IPv6 addresses written in any of the valid formats. 

IPv6 addresses need to be enclosed in square brackets when used in 
the browser. 

These examples show several valid versions of the same IPv6 address, 
and one invalid example. 

 Valid IPv6 address formats: 

FE00:0000:0000:0001:0000:0000:0000:0056 

FE00::1:0:0:0:56 

FE00:0:0:1::56 

In a browser: https://[FE07:2fa:6cff:2113::101]/login 

 Invalid IPv6 address formats: 

Note: The :: abbreviation, meaning one or more quartets of all 0s, cannot 
be used twice.  

The abbreviation FE00::1::56 is not valid. 
 

Adding PDUs to Power IQ Management 

Once Power IQ is configured, add Raritan PX or other PDUs to its 
management. Power IQ can then gather data from these PDUs. If you're 
adding a PDU that uses a custom dynamic plugin, see Adding PDUs 
with Custom Dynamic Plugins (on page 29). 

You can also add PDUs to Power IQ by uploading a CSV file containing 
the information. See Adding PDUs in Bulk with CSV Files (on page 25) 
in the Power IQ User Guide. 

 To add PDUs to Power IQ management: 

1. In the PDUs tab, click Add. 

2. Enter the IP address of the PDU. 

3. If the PDU is in a daisy-chained configuration or console server 
configuration, enter the PDU's position number in the chain or serial 
port number in the Proxy Index field. For example, this field is 
mandatory for a slave Raritan PDU in the port forwarding 
configuration. See Adding Raritan PDUs in the Port Forwarding 
Configuration (see "Adding Raritan PDUs in Port Forwarding 
Configuration" on page 30). 
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You can also specify branch circuit monitors using the Proxy Index 
field. See Adding Veris Branch Circuit Monitors with Acquisuite 
(on page 28). 

Note: If the PDU is not in this type of configuration, leave the Proxy 
Index field blank. 

4. Enter an asset tag number or other asset management code in the 
External Key field. Optional.  

5. Enter data in Custom Field 1 and Custom Field 2. Optional. The 
labels may have been changed in Power IQ to identify these fields.  

6. If the PDU is a Raritan PX, enter a valid Username and Password for 
the PDU in the PDU Administrative Credentials section. Re-enter the 
password in the Password Confirm field. 

7. Select the SNMP Version. 

 For SNMP version 1/2c PDUs, enter an SNMP Community String 
that has at least READ permissions to this PDU. This enables 
polling the PDU for data. Enter an SNMP community string that 
has both READ and WRITE permissions to the PDU to enable 
power control, outlet naming, sensor naming, and buffered data 
retrieval. 

 For SNMP version 3 PDUs, enter the Username and select an 
Authorization Level. The authorization levels are: 

 noAuthNoPriv - No Authentication Passkey, No Encoding 
Passkey 

 authNoPriv - Authentication Passkey, No Encoding Passkey 

 authPriv - Authentication Passkey, Encoding Passkey 

a. Depending on the Authorization Level selected, you must enter 
additional credentials for Authorization and Privacy. 

b. Authorization Protocol: Select MD5 or SHA. 

c. Enter the PDU's Authorization Passkey, then re-enter the 
passkey in the Authorization Passkey Confirm field. 

d. Privacy Protocol: Select DES or AES. 

e. Enter the PDU's Privacy Passkey, then re-enter the passkey in 
the Privacy Passkey Confirm field. 

Note: You must enable the SNMP agent on all PDUs added to 
Power IQ. 

8. Select "Validate and wait for discovery to complete before 
proceeding" to check credentials and view the discovery process 
status as you add this PDU. Optional. See Validating PDU 
Credentials (on page 22) in the Power IQ User Guide. 

9. Click Add. 
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Note: PDU discovery is complete once the PDU model type is 
determined. SNMP fields such as contact or location values are not 

determined until this device is polled for the first time. 

Once added, the PDU appears in the PDU list. Power IQ begins 
polling the PDU for sensor data. You can configure how often Power 
IQ polls PDU. See Configuring Polling Intervals (on page 8) in the 
Power IQ User Guide. 

 

Discovery Progress Status 

Viewing the discovery process displays a status result for each PDU. 
See PDU Status (see "PDU Connectivity Health Statuses" on page 
173). 
 

Validating PDU Credentials 

When adding PDUs to Power IQ individually, you can specify whether 
the admin credentials are validated.  

Check the "Validate and wait for discovery to complete before 
proceeding" checkbox on the Add a New PDU page. See Adding PDUs 
to Power IQ Management (on page 20) for details on adding PDUs. 

When you specify validation, the PDU will not be added if the credentials 
are incorrect. If you opt not to validate, all PDUs will be added, and those 
added with incorrect credentials will trigger an event called 
PDUCredentialsInvalid.  

When adding PDUs to Power IQ with a CSV file, the admin credentials 
are not validated before the PDU is added. When credentials are found 
to be incorrect, an event is logged. 

Power IQ can poll PDUs without the correct credentials. You cannot 
upgrade PDUs or use bulk configuration without the correct credentials. 
 

Editing PDUs under Power IQ Management 

Editing a PDU allows you to reconfigure the SNMP community string for 
a PDU, or change the username and password used to access that 
PDU. 

If you need to maintain the PDU or physically remove it without deleting 
its data from Power IQ, you have to edit the PDU to change its 
connectivity state. See Managing Removed or Out of Service Objects 
(on page 343).   

 To edit PDUs under Power IQ management: 

1. In the PDUs tab, click a PDU link to open the PDU Details.  

2. Choose Actions > Edit. 
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3. Enter an asset tag number or other asset management code in the 
External Key field. Optional.  

4. To set the PDU to the maintenance mode, select the Maintenance 
Mode checkbox. To decommission the PDU, select the 
Decommissioned checkbox. If both checkboxes are selected, the 
PDU is considered decommissioned. 

5. Enter data in Custom Field 1 and Custom Field 2. Optional. The 
labels may have been changed in Power IQ to identify these fields.  

6. Select the SNMP Version. Then, use the fields that display to enter 
the credentials. To delete previous credentials for either SNMP 
version, select the "Delete SNMP v2 community credentials" 
checkbox. 

 For SNMP version 1/2c PDUs, enter an SNMP Community String 
that has at least READ permissions to this PDU. Use an SNMP 
community string that has both READ and WRITE permissions 
to the PDU to enable power control, outlet renaming, and 
buffered data retrieval. Re-enter the string in the Community 
String Confirm field. 

 For SNMP version 3 PDUs, enter the Username and select an 
Authorization Level. The authorization levels are: 

 noAuthNoPriv - No Authentication Passkey, No Encoding 
Passkey 

 authNoPriv - Authentication Passkey, No Encoding Passkey 

 authPriv - Authentication Passkey, Encoding Passkey 

a. Depending on the Authorization Level selected, you must enter 
additional credentials for Authorization and Privacy. 

b. Authorization Protocol: Select MD5 or SHA. 

c. Enter the PDU's Authorization Passkey, then re-enter the 
passkey in the Authorization Passkey Confirm field. 

d. Privacy Protocol: Select DES or AES. 

e. Enter the PDU's Privacy Passkey, then re-enter the passkey in 
the Privacy Passkey Confirm field. 

7. PDU Phase: 

 When Power IQ can detect the phase, the Automatic option is 
selected, and the phase displays. For example, "Automatic 
(determined to be single phase)." 

 When a PDU does not report phase, the Ignored option is 
selected. You can keep this setting to ignore phase, or set the 
phase manually. 

 To set the phase manually, either if it cannot be determined 
automatically, or is incorrect, select the "Manually set to single 
phase" or "Manually set to three phase" option. 
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8. If the PDU is a Raritan PX/PX2/PX3/EMX, enter a valid Username 
and Password for the PDU in the PDU Administrative Credentials 
section. Re-enter the password in the Password Confirm field. Leave 
the fields blank to keep using the password already configured. If 
you want to use a blank password, select the "Delete PX credentials" 
checkbox. 

9. Click Save. 
 

Configure Estimated Voltages 

Power IQ can estimate Active Power for PDUs that do not directly 
provide Active Power measurements. 

If a PDU does not provide one of the following values, the default 
estimated voltage will be applied. See Setting Default Estimated 
Voltages (on page 18). 

 Inlet Voltage 

 Outlet Voltage 

 Active Power 

These voltage values are only editable when they are NOT coming from 
the PDU.  

 To configure estimated voltages: 

1. In the PDUs tab, select a PDU then click the Edit this PDU icon  
in the Actions column. 

2. For three-phase PDUs, enter the voltages in the Manually 
Configured Inlet Voltage and Manually Configured Outlet Voltage 
fields.  

3. For single-phase PDUs, enter the inlet voltage in the Manually 
Configured Voltage field.  

If no value is entered, the default value is used.  

4. Click Save. 
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Adding PDUs in Bulk with CSV Files 

You can add PDUs in bulk by uploading a CSV file.  

Power IQ does not check the credentials of the PDU while adding it 
during a CSV import. If the credentials are incorrect, an event called 
PDUCredentialsInvalid is logged. 

Importing more than 100 PDUs at a time causes polling to suspend while 
the import is in progress.  

You can download a step-by-step CSV template file in the Support 
section of Raritan's website, under Firmware and Documentation. See 
http://www.raritan.com/support/power-iq/. 

See Structure of the Add PDUs CSV File (on page 25) for file 
requirements. 

 To add PDUs in bulk with CSV files: 

1. In the PDUs tab, choose Activities > Import PDUs from CSV file. The 
Import PDUs page opens. 

2. Click Browse and select the CSV file. 

3. Select "View progress of the import as each PDU is discovered" to 
view the discovery progress and the resulting status. Optional. 

4. Click Begin Import. 
 

Structure of the Add PDUs CSV File 

The structure of the CSV file is as follows: 

 One line per PDU to import. 

 No header row. 

 Each line has only the following value columns, in the following 
order: 

1. IP address 

2. Proxy index: If the PDU is in a daisy-chained configuration or 
console server configuration, enter the PDU's position number in 
the chain or serial port number. See Proxy Index Details (on 
page 27). 

Leave blank if the PDU is not in this type of configuration.  

3. Raritan PX username 

4. Raritan PX password 

Leave the Raritan PX username and Raritan PX password fields 

blank for other PDUs. 
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5. SNMP Community String 

Leave the SNMP Community String blank if it does not apply for a 
PDU. 

6. SNMPv3 enabled: true or false. 

Leave columns 7-12 blank if SNMPv3 is set to false. 

7. SNMPv3 username 

8. SNMPv3 authorization level: noAuthNoPriv, authNoPriv or 
authPriv. 

9. Authorization protocol: MD5 or SHA. 

10. Authorization passkey: no commas allowed 

11. Privacy protocol: DES or AES 

12. Privacy passkey: no commas allowed 

13. External key 

14. Custom field 1 

15. Custom field 2 

 For example:  

192.168.43.184,,admin,raritan,private 

192.168.44.101,,,,PDUread 

The first line in this example represents a Raritan PX PDU. The second 
line represents a PDU from another vendor. Uploading this CSV file 
would instruct Power IQ to add two PDUs to management. The first PDU 
is located at 192.168.43.184, and uses the login/password combination 
admin/raritan for authentication. Its SNMP Community String is set to 
private. The second PDU is located at 192.168.44.101 and does not use 
a user name and password for authentication. Its SNMP Community 
String is set to PDUread. 
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Proxy Index Details 

For stand-alone PDUs, the proxy index field should be left blank.  

For PDUs acting in a daisy-chain, or for PDUs that are being proxied 
through another PDU, the proxy index field should contain the number of 
the PDU's position. 

For daisy chained systems, the proxy index field should be set to the 
PDU's position within the chain. The head-end or master system should 
have a proxy index value of 1. The second system in the chain would 
have a proxy address of 2 and so on. 

For element managed systems, such as PDUs behind a serial proxy, the 
proxy index field should contain the serial port number to which the PDU 
is attached on the management console. 
 

Adding MRV PDUs 

For MRV PDUs, make sure you have configured the get and set clients 
with the same community string, and use that community string when 
adding the PDU to Power IQ. 
 

Adding Raritan EMX 

You can add a Raritan EMX to Power IQ the same way you add a PDU. 
All information in this help that refers to PDUs can be applied to EMX, 
with a few exceptions. 

Power IQ collects and displays sensor and asset strip data from a EMX 
in the same way as other PDUs with attached sensors or asset strips. 
EMX does not have any outlets. 

You cannot upgrade or use bulk configuration for EMX through Power 
IQ. 

See Adding PDUs to Power IQ Management (on page 20) 
 

Adding Rack Transfer Switches 

You can add a supported Rack Transfer Switch to Power IQ the same 
way you add a PDU.  

You can upgrade or use bulk configuration for Raritan PX3TS transfer 
switches through Power IQ. 

See Adding PDUs to Power IQ Management (on page 20). 

See Transfer Switch (see "Rack Transfer Switches" on page 169). 
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Adding Veris Branch Circuit Monitors with Acquisuite 

Use the Add a PDU function to add a Veris branch circuit monitor (BCM) 
connected to a Veris or Obvius Acquisuite modbus to Power IQ. 

See Adding PDUs to Power IQ Management (on page 20). 

Specify the following information when adding the Veris BCM to ensure 
Power IQ connects to the correct panel. 

Field name in Add a PDU page Modbus/BCM information 

IP Address IP address of the Acquisuite modbus.  

Proxy Index 

REQUIRED 

 

Device number of the BCM panel.  

Example: The device number of the panel as 
configured in the Acquisuite. This information can 
be found in the Acquisuite web client. 

Each panel displays as a PDU with up to 42 outlets. Each branch 
displays as an outlet. 

Each single-phase branch is monitored independently as a single-phase 
circuit. 

Groupings into multi-phase circuits is not supported. 
 

Adding PDUs Managed by Dominion SX 

You can add PDUs that are managed by a Dominion SX serial console 
to Power IQ. 

Specify the following information when adding the PDU to ensure Power 
IQ connects to the correct SX-managed PDU. 

See Adding PDUs to Power IQ Management (on page 20). 

Field name in Add a PDU page Modbus/BCM information 

IP Address IP address of the Dominion SX 

Proxy Index Dominion SX port number that the PDU is 
connected to 

PDU Administrative Credentials 

Username, Password, Password 
Confirm 

Dominion SX username and password 

SNMP fields Leave blank. 
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Adding PDUs with Custom Dynamic Plugins 

When adding a PDU that uses a custom dynamic plugin, use the same 
Add a PDU feature as any other addition. See Adding PDUs to Power 
IQ Management (on page 20). 

When Power IQ detects that there is at least one custom dynamic plugin 
configured, a Plugin drop-down field displays. 

 

 Automatic: Use Automatic to allow Power IQ to determine the correct 
plugin for the PDU you are adding. Automatic attempts to find an 
exact match between the PDU and the plugin for SysObjectID, PDU 
Model name, and Proxy ID. 

 If there is no exact match, but several dynamic plugins are 
eligible to manage the PDU, based on sysObjectID, then Power 
IQ selects from among the eligible plugins. If automatic mode 
does not select the desired dynamic plugin, delete the PDU and 
add it again, selecting the specific custom dynamic plugin from 
the list. 

 Or, select the specific custom dynamic plugin from the list. 
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Adding Raritan PDUs in Port Forwarding Configuration 

Raritan PDUs can be cascaded via USB cables to share an Ethernet 
connection. The first PDU in the chain is the master device, and all PDUs 
connected to it are slave devices. Power IQ only supports 
USB-cascading chains with a total of two PDUs: one master and one 
slave. 

Note: Only Raritan "PX2" and "PX3" PDU models support the 
USB-cascading feature. For details, see the USB-Cascading Solution 
Guide on the PX2 web page 

(http://www.raritan.com/support/product/px2/) of the Raritan website. 

Power IQ only supports Port Forwarding mode for USB-cascading chains.  
In Port Forwarding mode, all PDUs share one IP address. 

Add master and slave PDUs in Port Forwarding mode the same way you 
add a standalone Raritan PDU. See Adding PDUs to Power IQ 
Management (on page 20). 

Specify the following information when adding master and slave PDUs in 
Port Forwarding mode. 

 

Field name in Add a 
PDU page 

Master PDU Slave PDU  

IP Address IP address of the master PDU Same IP address as the master 
PDU 

Proxy Index 

REQUIRED 

1 2 

External Key Any unique entry different from the 
IP address 

Any unique entry different from 
the IP address 

PDU Administrative 
Credentials 

Username, Password, 
Password Confirm 

The master PDU's credentials The slave PDU's credentials 

SNMP fields The master PDU's SNMP strings The slave PDU's SNMP strings 

 
 

Bulk Configuration of Raritan PX PDUs 

By leveraging Raritan PX's ability to create a backup of its configuration, 
Power IQ can configure additional PX PDUs of the same model type. 
This is helpful for large scale deployments. 

This applies to Raritan PX version 1.2 and later, only. 
 

http://www.raritan.com/support/product/px2/
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Requirements for Bulk Configuration 

Prerequisites for bulk configuration: 

 Each PX must be of the same model type. 

NOTE: For Raritan PX2's running firmware 2.5.30 or higher, the 
same bulk configuration file can be used on PDUs where the only 
differences are the length of the line cord (option A or L), the color of 

line cord (option B), or the PDU Color (option K). 

 Each PX must have the same firmware version (1.2 or later). 

 Each PX must be configured with an IP address and be under Power 
IQ management. 

 A configuration backup file from a configured PX. 
 

Plan a New Rollout 

 To plan a new rollout: 

1. In the PDUs tab, choose Activities > Bulk Configuration. 

2. Click "Plan a new rollout." The bulk pdu configuration rollout planning 
wizard starts. 

3. Enter a name for the plan and click Continue. 

A summary of plan options appears at the top of the page. Continue 
adding details of your plan at the bottom of the page, or click the links 
in the summary list to add details. 

4. In the Choose a PDU Configuration File section, you can add a new 
PX backup file or select a previously uploaded file. Configuration 
backup files are .XML files for PX2 configurations, and do not show a 
file extension for PX1 configurations.  

 To add a new file, click the Upload a New File tab, then click 
Browse to select the file. Enter comments. Click Upload. The file 
is automatically selected for the plan. 

 To select a previously uploaded file, click the Available Files tab, 
then select a file from the list, and click Continue. 

5. All PX PDUs available for the rollout appear in a list. Select the 
checkboxes for the PDUs you want to configure, then click Selected 
PDUs to add them to the "PDUs selected for this plan" list at the 
bottom of the page. Or, click All PDUs to add all available PX PDUs 
to the list. 

 To remove PDUs from the plan, click Selected PDUs or All PDUs 
in the bottom list. Only PDUs in the bottom list will be configured. 

6. Click Continue. Click the Plan Options link in the summary at top. 

7. On the Plan Options page, edit the plan name, if needed, and set 
other preferences. 
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a. Select the "Abort on failure" checkbox if you want Power IQ to 
cancel all remaining configurations in the plan if a configuration 
failure occurs. This could help prevent a configuration problem 
from affecting other Raritan PX PDUs in the plan. 

b. Select the "Allow simultaneous rollouts" checkbox if you want 
Power IQ to configure multiple Raritan PX PDUs at once. This 
makes batch configurations faster by allowing up to 25 
configurations to run at the same time. 

8. Click Continue. Review the summary of the plan. Click Add 
Comment if you want add notes to the plan. Click Add or Remove 
PDUs if you want to edit the list of PDUs to configure. 

9. Click Save. The completed plan summary page opens. 

10. Click Start Rollout to execute the plan immediately. The rollout starts, 
and the status page displays. You can also execute the saved plan 
later. See Execute Saved Configuration Plans (see "Execute a 
Saved Rollout Plan" on page 33). 

 See View Status of Rollout Plans in Progress (on page 33) for 
details on checking rollouts in progress. 

 See View Completed Rollout Plans (on page 34) for details on 
checking completed rollouts. 

 

View Saved Rollout Plans 

View saved rollout plans to verify and edit their details before executing a 
plan. 

 To view saved rollout plans: 

1. In the PDUs tab, choose Activities > Bulk Configuration. 

2. Click "View saved plans." All plans display in a list. 

3. Click the Plan name link to view the details and edit if needed. 
 

Edit a Saved Rollout Plan 

Saved rollout plans can be edited to change details, add or remove 
PDUs, or change the configuration file. 

You can only edit rollout plans that you created.  

 To edit a saved rollout plan: 

1. In the PDUs tab, choose Activities > View Status of Current Rollouts. 

2. All plans display in a list. Click the Plan name's link to view the 
details. 

3. Click the blue links in the plan summary to edit the plan. Or, scroll 
down to click Edit and use the wizard to edit.  
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See Plan a New Rollout (on page 31) for details of plan settings. 
 

Execute a Saved Rollout Plan 

 To execute a saved configuration plan: 

1. In the PDUs tab, choose Activities > Bulk Configuration.   

2. Click "View saved plans." All plans display in a list. 

3. Click the Plan name link for the plan you want to execute. 

4. Click Start Roll Out to execute the plan. 

 See View Status of Rollout Plans in Progress (on page 33) for 
details on checking rollouts in progress. 

 See View Completed Rollout Plans (on page 34) for details on 
checking completed rollouts. 

 

Rollout Timing 

Each PX PDU configuration takes approximately 30 seconds. 

If you select "Allow simultaneous rollouts" in the plan options, 25 
configurations will begin simultaneously, and each batch of 25 will take 
approximately 30 seconds. 
 

View Status of Rollout Plans in Progress 

Rollout plans in progress have 3 possible statuses. 

 Init: Initializing to prepare the PDU for configuration 

 Login: Logging in to the PDU 

 Verify: Verifying the PDU is responsive after configuration is 
complete 

 To view status of upgrade plans in progress: 

The status page for plans in progress displays when you execute the 
plan. You can return to the status page at any time, even after the plan 
has finished. 

1. In the PDUs tab, choose Activities > Bulk Configuration. 

2. Click "View saved plans." All saved plans display in a list.  

3. Click the Status link for the plan you executed to view the status 
page.  
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View Completed Rollout Plans 

When a plan has been executed, you can view details of the plan status 
and results of each PDU included in the plan. 

 To view completed rollouts: 

1. In the PDUs tab, choose Activities > Bulk Configuration. 

2. Click "View previously completed rollouts." All completed plans 
display in a list. 

3. Click the Plan name link to view the details. 

 If the plan completed successfully, a success message displays 
at the top of the plan details.  

 The list of PDUs included in the plan includes a Success or 
Failure message. 

 Click the "View detailed upgrade status messages" link for more 
information about each PDU. 

 

Manage Configuration Files 

You can upload different configuration files for use in rollout plans, and 
view previously uploaded configurations. 

Configuration files are .DAT files. Configuration files are created by 
backing up a Raritan PX.  

 To view uploaded configuration files: 

1. In the PDUs tab, choose Activities > Bulk Configuration.   

2. Click Manage Configuration Files. The link is not available if you do 
not have any uploaded configuration files. The PDU Configuration 
Files page opens. 

3. All configuration files previously uploaded appear in a list.  

 To delete a configuration file: 

 Select the checkbox for the configuration file you want to delete, then 
click Delete. 

 To upload a new configuration file: 

1. Scroll down to the Upload New Configuration File section.  

2. Enter the model name that the file is for in the Model Name field. 

3. Click Browse to select the .DAT file.  
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4. Click Upload. The file is added to the list and will be available to 
select when creating a new rollout plan. See Plan a New Rollout (on 
page 31). 

 

PDU Outlet Naming and Setting System Attributes 

Power IQ enables you to export all the current PDU Outlet and System 
Attribute names to a CSV file that you can edit, and then re-import new 
names. See Naming Outlets in Bulk with CSV Files (on page 36). 
Change individual names manually by clicking a field and editing. See 
Naming Individual Outlets (on page 35). 

Raritan PDU outlet names can be up to 32 characters in length, with no 
character restrictions. See the manufacturer's specification for naming 
requirements for other brands of PDUs. 

Note: PDUs must be configured in Power IQ with an SNMP community 
string that has write-level access to allow outlet naming.  

The following PDUs have manufacturer limitations that affect renaming 
via SNMP: Outlet and system attribute naming is not available via SNMP 
for Avocent or Geist PDUs. Outlet naming via SNMP is not available for 
Tripp Lite PDUs or the Eaton Pulluzi model PDU. The standard Eaton 
model does support outlet naming. System attribute naming via SNMP is 
not available for Baytech PDUs. Names for Servertech PDUs cannot 

contain spaces. 
 

Naming Individual Outlets 

 To name individual outlets: 

1. In the PDUs tab, click the link for a PDU to open the smart view. 

2. Scroll down to the Outlets list. 

3. Double-click the outlet name, then enter the new name in the field. 
Use only UTF-8 characters. 

4. Press Enter to save the name. 

The names are written back to the PDU. If you connect to the PDU 
directly, the outlets appear there with their new names. 
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Naming Outlets in Bulk with CSV Files 

When you import an outlet name CSV file, Power IQ names the outlets 
according to the values in the file. The names are written back to the 
PDU. If you connect to the PDU directly, the outlets appear there with 
their new names. 

For details on creating the outlet name CSV file, see Structure of the 
Outlet Name CSV File (on page 37). 

 To name outlets in bulk with CSV files: 

1. In the PDUs tab, choose Activities > Outlet Naming. 

2. Click Browse, then select the CSV file. 

3. Click Import. 
 

Setting SNMP System Attributes for PDUs 

In addition to naming the outlets of PDUs, this CSV file can be used to 
set three SNMP system attributes. These attributes are SYS_CONTACT, 
SYS_NAME and SYS_LOCATION. These settings are optional values in 
the CSV file. 

 SYS_CONTACT: is used to identify a person to contact regarding 
the PDU. For example, the IT administrator. 

 SYS_NAME: is used to set the name of the PDU. 

 SYS_LOCATION: is used to describe where the PDU is located. For 
example, "Sales Rack - Server Closet 2." 

Note: Setting SNMP system attributes is not available for Raritan PX 
versions lower than 1.3, Baytech, Eaton, Geist, Liebert, or Avocent PDUs. 

Leave these fields blank for those PDUs. 
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Structure of the Outlet Name CSV File 

The CSV file used for outlet naming and setting SNMP system attributes 
uses the following structure. There is one PDU per line/row. 

Use only UTF-8 characters. 

Note: The following PDUs have manufacturer limitations that affect 
renaming via SNMP: Outlet and system attribute naming is not available 
via SNMP for Avocent or Geist PDUs. Outlet naming via SNMP is not 
available for Tripp Lite PDUs or the Eaton Pulluzi model PDU. The 
standard Eaton model does support outlet naming. System attribute 
naming via SNMP is not available for Baytech PDUs. Names for 
Servertech PDUs cannot contain spaces. Setting SNMP system 
attributes is not available for Raritan PX versions lower than 1.3, Baytech, 
Eaton, Geist, Liebert, or Avocent PDUs. Leave these fields blank for 

those PDUs. 

 The first column is an IP address identifying a PDU. 

 The second column is the Proxy Index value. Leave this value blank 
if the PDU does not support or is not using this configuration. You 
cannot change the Proxy Index value via CSV import. See Proxy 
Index Details (on page 27). 

 The third column is the SNMP SYS_CONTACT value. Optional. 

 The fourth column is for the SNMP SYS_NAME value. Optional. 

 The fifth column is for the SNMP SYS_LOCATION value. Optional. 

 Each value/column following the SYS_LOCATION represents an 
outlet on that PDU. Outlets start at 1 and increase sequentially with 
each column. 

These values indicate only what is changed by the naming operation: 

 If an IP address does not appear in the file, no naming operations 
occur on that PDU. 

 If an outlet value is blank, its name does not change. 

For example: 
 

192.168.77.102,,Michael,Test PX2,RACK1,KVMSwitch1,KVMSwitch2,,Sales FTP Server 

A PDU at 192.168.77.102 would receive the system name "Test PX2". 
Its first outlet would be renamed to "KVMSwitch1" and its second outlet 
renamed to "KVMSwitch2." The third outlet would not be renamed. The 
fourth outlet would be renamed to "Sales FTP Server." 
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Exporting Outlet Names to a CSV File 

You can export the outlet names in Power IQ to a CSV file.  

You can edit the file to change outlet names, then import it. See Naming 
Outlets in Bulk with CSV Files (on page 36).  

Note: The following PDUs have manufacturer limitations that affect 
renaming via SNMP: Outlet and system attribute naming is not available 
via SNMP for Avocent or Geist PDUs. Outlet naming via SNMP is not 
available for Tripp Lite PDUs or the Eaton Pulluzi model PDU. The 
standard Eaton model does support outlet naming. System attribute 
naming via SNMP is not available for Baytech PDUs. Names for 
Servertech PDUs cannot contain spaces. Setting SNMP system 
attributes is not available for Raritan PX versions lower than 1.3, Baytech, 
Eaton, Geist, Liebert, or Avocent PDUs. Leave these fields blank for 

those PDUs. 

 To export outlet names to a CSV file: 

1. In the PDUs tab, choose Activities > Outlet Naming. 

2. Click the export link. 
 

Bulk Change PDU IP Addresses 

You can update the IP addresses of multiple PDUs, including facilities 
objects such as Floor PDUs, Floor UPS, Power Panels, and so on, using 
a CSV import. This is useful if you need to repartition a network and 
move PDUs from one subnet to another. 

Power IQ will report lost connectivity events until the systems are aligned 
after the bulk IP address change is complete. 

Polling will be interrupted by the bulk IP address change. 

The CSV file is validated at import: 

 IP addresses must be properly formatted. 

 Existing IP addresses cannot be reused as new IP addresses. 

 If the existing IP address in your CSV file is not found in Power IQ, 
that change is rejected. 

 New IP addresses that already exist in Power IQ are rejected. 

 To bulk change PDU IP addresses: 

1. Create the CSV import file. See Bulk Change PDU IP Address File 
Requirements (on page 39). 

2. In the PDUs tab, choose Activities > Import IP Address Changes. 

3. Click Browse, then select the CSV file. 
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4. Click Begin Import. A progress bar displays. 

 If all changes are successful, Power IQ redirects to the PDUs list. 

 If any changes fail, the errors are listed in the Import page, and 
nothing is imported. Correct the errors in the file, and try the 
import again. 

 
 

Bulk Change PDU IP Address File Requirements 

The CSV import file for changing PDU IP address should follow this 
format. 

Column 1 Column 2 

Old IP address New IP address 

To help you create the CSV file, you can export your PDU IP addresses 
from Power IQ, then edit the file to prepare it for import. 

 To export IP addresses: 

1. In the PDUs tab, make sure the IP column is visible.  

 To display the IP column, click any column header, then click 
Columns, and select the IP checkbox. The column displays. 

2. In the PDUs tab, click the Export/Save icon  in the upper right 
corner of the grid. 

Save or open the file using the dialog that appears. 

3. Edit the exported file to contain only the old IP addresses in column 
1, and the new IP addresses in column 2.  

4. Save the file as .CSV. 
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Configuring Proxy Connections to Power IQ 

If network restrictions prevent some users from connecting directly to 
Power IQ®, they may need access through a proxy server that is 
authorized to make the connection. Check your firewall and security 
settings to ensure that communication between the proxy server and 
Power IQ is allowed. 

 To configure proxy connections to Power IQ: 

1. In the Settings tab, click Server Settings in the Application 
Administration section.  

2. In the Proxy Configuration section, select the web protocol the proxy 
server communicates over, HTTP or HTTPS. 

3. Enter the IP address of the proxy server in the Proxy Host field. 
Power IQ only accepts proxy communication from this address.  

4. Enter the communications port the proxy server uses in the Proxy 
Port field. 

5. If the proxy server is required to authenticate with Power IQ, select 
Yes in the Authentication Required field, and enter a Username and 
Password. These fields must use a valid Power IQ username and 
password combination. 

6. Click Save Proxy Settings. 
 

Configuring PDU Display Settings - View PDUs by IP or Name 

Select whether you want all PDUs in the system to be identified by PDU 
name or IP address in the Settings tab. This setting affects all pages 
where PDUs are listed, and is used in email notifications when identifying 
PDUs. This setting applies to all users in the system. 

PDU names are retrieved from the PDU, via SNMP, NOT from the 
network. PDU name is not guaranteed to be unique. If a PDU name is 
not available, the PDU label is set to "Unnamed" and the IP address is 
included. 

The PDU display setting affects the Quick Search feature. If IP address 
is selected in the display settings, you can search PDUs by either name 
or IP address. If PDU name is selected, only searching by PDU name is 
permitted. Devices can always be searched by either name or IP 
address regardless of the PDU display preference. See Search for 
PDUs (see "Search for PDUs and Devices" on page 181). 

 To configure PDU display settings: 

1. In the Settings tab, click Application Settings in the Appliance 
Administration section. 
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2. In the Display Settings box, select Show PDU IP Address or Show 
PDU Name, then click Save Display Settings. 

 

Customizing Your View of PDUs, Devices, and Events 

Each user can save their own customized views of PDU, Device and 
Events lists in Power IQ. Once you save a customized view, it is retained 
even if you leave the tab and return, or use a different browser or client. 

Note: If you open the PDU list by clicking on a health chart, your view will 
be filtered by the chart. For example, click the red bar of a health chart to 

view only the PDUs with red health status. 

 To customize your view of PDUs, Devices and Events: 

1. In the PDUs, Devices, or Events tab, drag and drop columns to 
customize your view. Hover the mouse on a column heading then 
click the arrow to view a drop-down list of other options. You can 
hide or show each column, set the ascending or descending order of 
data, or enter a search term to filter the column to include only items 
that match the search term.  

 See Filter the Events List (on page 70). 

 See Filter the PDUs List (on page 178). 

2. Click the Panel Options button in the upper right corner of the list 
view, then select Save Current Grid Configuration to save your view. 

 

 To return to the default view: 

 In the PDUs, Devices or Events tab, click the Panel Options button in 
the upper right corner of the list view, then select Use Default Grid 
Configuration. 
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Power IQ can receive SNMP traps from supported PDUs and display 
them as events. You can also set power thresholds for racks based on 
capacity, and Power IQ will generate events when the thresholds are 
exceeded. See Rack Thresholds (on page 67). 

You can also enable notifications, so that Power IQ sends an email 
message for specific events. 

In This Chapter 

User Permissions for Event Management ............................................... 42 
Prepare PDUs for Power IQ Event Management .................................... 42 
PDU Connectivity Lost and Restored Events .......................................... 66 
Rack Thresholds ...................................................................................... 67 
View Events ............................................................................................. 70 
Filter the Events List ................................................................................ 70 
Export the Events List to CSV ................................................................. 71 
Clear Events ............................................................................................ 71 
Automatic Delete of Cleared Events ....................................................... 72 
Enable or Disable Event Notifications ..................................................... 72 
Event Fuse Handling ............................................................................... 75 
Events That Clear Quickly ....................................................................... 75 
 
 

User Permissions for Event Management 

You must have the Event Manager role to view the Events tab. See 
Assign Roles to a User (on page 86). 
 

Prepare PDUs for Power IQ Event Management 

Power IQ receives and displays supported events in the Events tab, and 
sends notifications if enabled.  

You must configure PDUs to send the supported SNMP traps to Power 
IQ. SNMP v1 and SNMP v2 trap types are supported. See Supported 
Events (on page 43). 

PDU trap names differ by vendor, so Power IQ maps the trap names to 
common event names to highlight the common traps across PDUs. 
 

Chapter 5 Configuring Event Management 
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Supported Events 

Power IQ supports SNMP traps from the following vendors, and converts 
the traps into Power IQ events. See the vendor name for supported 
events.  

 APC (see "APC Supported Events" on page 43) 

 APC Netbotz (see "APC Netbotz Supported Events" on page 44) 

 Aphel (see "Aphel Supported Events" on page 45) 

 Avocent (see "Avocent Supported Events" on page 45) 

 Baytech (see "Baytech Supported Events" on page 46) 

 Cyberswitching (see "Cyberswitching Supported Events" on 
page 47) 

 Geist (see "Geist Supported Events" on page 47) 

 Geist EM (see "Geist EM Supported Events" on page 48) 

 Geist V3 (see "Geist V3 Supported Events" on page 49) 

 Hewlett Packard (see "Hewlett Packard Supported Events" on 
page 51) 

 Knurr (see "Knurr Supported Events" on page 52) 

 Liebert (see "Liebert Supported Events" on page 54)  

 MRV (see "MRV Supported Events" on page 54) 

 Raritan PX/PX2/PX3 (see "Raritan PX/PX2/PX3 Supported 
Events" on page 55) 

 Rittal (see "Rittal Supported Events" on page 63) 

 Servertech (see "Servertech Supported Events" on page 65) 
 

APC Supported Events 
 

APC Supported Events 

Event description Trap name Common event name 

Underload Threshold  rPDULowLoad inletCurrentLowerWarning 

Underload Condition Cleared rPDULowLoadCleared inletCurrentLowerWarningClear 

Low Overload Threshold  rPDUNearOverload inletCurrentUpperWarning 

Low Overload Threshold 
cleared  

rPDUNearOverloadCleared  inletCurrentUpperWarningClear 

Overload Threshold rPDUOverload inletCurrentUpperCritical 

Overload Threshold cleared rPDUOverloadCleared inletCurrentUpperCriticalClear 

Outlet Turned on rPDUOutletOn outletPowerOn 

Outlet Turned off  rPDUOutletOff outletPowerOff 
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APC Supported Events 

Event description Trap name Common event name 

High temperature threshold 
violated on the probe 

envHighTempThresholdViolation envTemperatureUpperCritical 

High temperature threshold 
violation cleared on the probe 

envHighTempThresholdViolationClea
red 

envTemperatureUpperCriticalClear 

Low temperature threshold 
violated on the probe 

envLowTempThresholdViolation envTemperatureLowerCritical 

Low temperature threshold 
violation cleared on the probe 

envLowTempThresholdViolationClea
red 

envTemperatureLowerCriticalClear 

High humidity threshold 
violated on the probe 

envHighHumidityThresholdViolation envHumidityUpperCritical 

High humidity threshold 
violation cleared on the probe 

envHigHumidityThresholdViolationCl
eared 

envHumidityUpperCriticalClear 

Low humidity threshold 
violated on the probe 

envLowHumidityThresholdViolation envHumidityLowerCritical 

Low humidity threshold 
violation cleared on the probe 

envLowHumidityThresholdViolationCl
eared 

envHumidityLowerCriticalClear 

 
 

APC Netbotz Supported Events 
 

APC Netbotz Supported Events 

Event description Trap name Common event name 

Temp Env Sensor High 
Threshold 

netBotzTempTooHigh envTemperatureUpperCritical 

Temp Env Sensor High 
Threshold Cleared  

netBotzTempTooHighRTN envTemperatureUpperCriticalClear 

Temp Env Sensor Low 
Threshold  

netBotzTempTooLow  envTemperatureLowerCritical 

Temp Env Sensor Low 
Threshold Cleared  

netBotzTempTooLowRTN  envTemperatureLowerCriticalClear 

Humidity Env Sensor High 
Threshold  

netBotzHumidityTooHigh  envHumidityUpperCritical 

Humidity Env Sensor High 
Threshold Cleared  

netBotzHumidityTooHighRTN envHumidityUpperCriticalClear 
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APC Netbotz Supported Events 

Event description Trap name Common event name 

Humidity Env Sensor Low 
Threshold  

netBotzHumidityTooLow  envHumidityLowerCritical 

Humidity Env Sensor Low 
Threshold Cleared  

netBotzHumidityTooLowRTN envHumidityLowerCriticalClear 

 
 

APC Transfer Switch Supported Events 
 

APC Transfer Switch Supported Events 

Event description Trap name Common event name 

Transfer Switch Active Inlet 
Changed 

atsSourceSwitched transferSwitchActiveInletChangedCriti
cal 

transferSwitchActiveInletChangedWar
ning 

Transfer Switch Operating 
State Change 

atsLostRedundancy 

atsLostRedundancy 

atsRedundancyRestored 

transferSwitchOperatingStateNonRed
undant 

transferSwitchOperatingStateStandby 

transferSwitchOperatingStateNormal 

 
 

Aphel Supported Events 
 

Aphel Supported Events 

Event description Trap name Common event name 

Inlet Current Upper Critical 
Threshold 

ampsCT1TRAP  

ampsCT8TRAP  

inletCurrentUpperCritical  

 
 

Avocent Supported Events 
 

Avocent Supported Events 

Event description Trap name Common event name 

Outlet Turned on avctPmOutletStatusOnTrap 

avctPmOutletCmdOnTrap  

outletPowerOn 
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Avocent Supported Events 

Event description Trap name Common event name 

Outlet Turned off  avctPmOutletStatusOffTrap 

avctPmOutletCmdOffTrap  

outletPowerOff 

Inlet Current Upper Critical 
Threshold  

avctPmPduMaxLoadHighTrap  inletCurrentUpperCritical 

Inlet Current Upper Critical 
Threshold Cleared  

avctPmPduMaxLoadBackTrap  inletCurrentUpperCriticalClear 

Inlet Current Low Critical 
Threshold  

avctPmPduMinLoadLowTrap  inletCurrentLowerCritical 

Inlet Current Low Critical 
Threshold Cleared 

avctPmPduMaxLoadBackTrap  inletCurrentLowerCriticalClear 

Inlet Current Upper Warning 
Threshold 

avctPmPduWarnLoadTrap  inletCurrentUpperWarning 

Inlet Current Upper Warning 
Threshold Cleared  

avctPmPduMaxLoadBackTrap  inletCurrentUpperWarningClear  

 
 

Baytech Supported Events 
 

Baytech Supported Events 

Event description Trap name Common event name 

Outlet Turned on  outletOn  outletPowerOn 

Outlet Turned off  outletOff  outletPowerOff 

Inlet Current Upper Critical 
Threshold  

currentThresholdViolation  inletCurrentUpperCritical 

Inlet Current Upper Critical 
Threshold Cleared  

currentThresholdViolationCleared inletCurrentUpperCriticalClear 

Inlet Current Low Critical 
Threshold 

currentUnderThresholdViolation  inletCurrentLowerCritical 

Inlet Current Low Critical 
Threshold Cleared  

currentUnderThresholdViolationClear
ed  

inletCurrentLowerCriticalClear 

Inlet Voltage Upper Critical 
Threshold  

voltageOverThresholdViolation  inletVoltageUpperCritical 

Inlet Voltage Upper Critical 
Threshold Cleared 

voltageOverThresholdViolationCleare
d 

inletVoltageUpperCriticalClear 
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Baytech Supported Events 

Event description Trap name Common event name 

Inlet Voltage Lower Critical 
Threshold  

voltageUnderThresholdViolation  inletVoltageLowerCritical 

Inlet Voltage Lower Critical 
Threshold Cleared  

voltageUnderThresholdViolationClear
ed  

inletVoltageLowerCriticalClear 

Circuit Breaker Tripped  circuitBreakerAlarm  cbTripped 

Circuit Breaker Recovered  circuitBreakerAlarmClearTrap cbRecovered 

Temp Env Sensor High 
Threshold 

sensorTempThreshHiAlarmTrap  envTemperatureUpperCritical 

Temp Env Sensor High 
Threshold Cleared 

sensorTempThreshHiAlarmClearedT
rap  

envTemperatureUpperCriticalClear 

Temp Env Sensor Low 
Threshold  

sensorTempThreshLoAlarmTrap envTemperatureLowerCritical 

Temp Env Sensor Low 
Threshold Cleared  

sensorTempThreshLoAlarmClearedT
rap 

envTemperatureLowerCriticalClear  

 
 

Cyberswitching Supported Events 
 

Cyberswitching Supported Events 

Event description Trap name Common event name 

Inlet Current Upper Critical 
Threshold  

tricomG2UnitCurrentCritical  inletCurrentUpperCritical 

Inlet Current Upper Warning 
Threshold 

tricomG2UnitCurrentWarning  inletCurrentUpperWarning 

Outlet Current Upper Warning 
Threshold  

tricomG2OutletHighCurrentWarning  outletCurrentUpperWarning 

Outlet Current Lower Warning 
Threshold  

tricomG2OutletLowCurrentWarning  outletCurrentLowerWarning 

Circuit Breaker Tripped tricomG2OutletTripped  cbTripped  

 
 

Geist Supported Events 
 



Chapter 5: Configuring Event Management 
 

48
  

 

Geist Supported Events 

Event description Trap name Common event name 

Inlet Current Upper Critical 
Threshold 

totalDeciAmpsPhaseATRAP 

totalDeciAmpsPhaseBTRAP 

totalDeciAmpsPhaseCTRAP 

inletCurrentUpperCritical  

Inlet Current Upper Critical 
Threshold Cleared 

 inletCurrentUpperCriticalClear  

Circuit Breaker Current Upper 
Critical Threshold 

outlet1ADeciAmpsTRAP 

outlet12CDeciAmpsTRAP 

CBCurrentUpperCritical  

Circuit Breaker Current Upper 
Critical Threshold Cleared 

 CBCurrentUpperCriticalClear  

Outlet Current Upper Critical 
Threshold  

outlet1ADeciAmpsTRAP  

outlet12CDeciAmpsTRAP  

OutletCurrentUpperCritical  

Outlet Current Upper Critical 
Threshold Cleared  

 OutletCurrentUpperCriticalClear  

 
 

Geist EM Supported Events 
 

Geist EM Supported Events 

Event description Trap name Common event name 

Circuit Breaker Current 
Threshold Warning Event 

mainChannelDeciAmps01WARN 

mainChannelDeciAmps07WARN 

 

Circuit Breaker Current 
Threshold Critical Event 

mainChannelDeciAmps01ALARM 

mainChannelDeciAmps07ALARM 

 

Outlet Current Threshold 
Warning Event 

auxChannelDeciAmps01WARN 

auxChannelDeciAmps32WARN 

outlet1AB-1DeciAmpsWarningTRAP 

outlet24CA-8DeciAmpsWarningTRA
P 

OutletCurrentUpperCritical 

Outlet Current Threshold 
Warning Event Cleared 
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Geist EM Supported Events 

Event description Trap name Common event name 

Outlet Current Threshold 
Critical Event 

auxChannelDeciAmps01ALARM 

auxChannelDeciAmps32ALARM 

outlet1AB-1DeciAmpsTRAP 

outlet24CA-8DeciAmpsTRAP 

OutletCurrentUpperCritical 

Outlet Current Threshold 
Critical Event Cleared 

 OutletCurrentUpperCriticalClear 

Phase Current Threshold 
Warning Event 

totalDeciAmpsPhaseAWarningTRAP 

totalDeciAmpsPhaseCWarningTRAP 

inletCurrentUpperWarning 

Phase Current Threshold 
Warning Event Cleared 

 inletCurrentUpperWarningClear 

Phase Current Threshold 
Critical Event 

totalDeciAmpsPhaseATRAP 

totalDeciAmpsPhaseCTRAP 

inletCurrentUpperCritical 

Phase Current Threshold 
Critical Event Cleared 

 inletCurrentUpperCriticalClear 

 
 

Geist V3 Supported Events 
 

Geist V3 Supported Events 

Event description Trap name Common event name 

Temperature Threshold High 
Violation 

gstTempSensorTempCNOTIFY 

gstTempSensorTempFNOTIFY 

gstClimateTempCNOTIFY 

gstClimateTempFNOTIFY  

(alarmTripType = 2) 

 

Temperature Threshold Low 
Violation 

gstTempSensorTempCNOTIFY 

gstTempSensorTempFNOTIFY 

gstClimateTempCNOTIFY 

gstClimateTempFNOTIFY 

(alarmTripType = 1) 
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Geist V3 Supported Events 

Event description Trap name Common event name 

Temperature Threshold Clear  gstTempSensorTempCNOTIFY 

gstTempSensorTempFNOTIFY 

gstClimateTempCNOTIFY 

gstClimateTempFNOTIFY 

(alarmTripType = 0) 

 

Humidity Threshold High 
Violation 

gstClimateHumidityNOTIFY 

(alarmTripType = 2) 

 

Humidity Threshold Low 
Violation 

gstClimateHumidityNOTIFY  

(alarmTripType = )1 

 

Humidity Threshold Clear gstClimateHumidityNOTIFY 

(alarmTripType = 0) 

 

Outlet Current Threshold High 
Violation  

gstCtrlOutletDeciAmpsNOTIFY 

(alarmTripType = 2) 

 

Outlet Current Threshold Low 
Violation - 

gstCtrlOutletDeciAmpsNOTIFY 

(alarmTripType = 1) 

 

Outlet Current Threshold 
Violation Clear 

gstCtrlOutletDeciAmpsNOTIFY 

(alarmTripType = 0) 

 

 
 

Geist RCX Supported Events 
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Geist RCX Supported Events 

Event description Trap name Common event name 

Ctrl3ChDELTADeciAmpsA = 
Three Phase Inlet Phase A 
Current 

gstCtrl3ChDELTADeciAmpsANOTIF
Y (10606) 

 

Ctrl3ChDELTADeciAmpsB = 
Three Phase Inlet Phase B 
Current 

gstCtrl3ChDELTADeciAmpsBNOTIF
Y (10607) 

 

Ctrl3ChDELTADeciAmpsC = 
Three Phase Inlet Phase C 
Current 

gstCtrl3ChDELTADeciAmpsCNOTIF
Y (10608) 

 

Pow3ChDeciAmpsA = Three 
Phase Inlet Phase A Current 

gstPow3ChDeciAmpsANOTIFY 
(11110) 

 

Pow3ChDeciAmpsB = Three 
Phase Inlet Phase B Current 

gstPow3ChDeciAmpsBNOTIFY 
(11119) 

 

Pow3ChDeciAmpsC = Three 
Phase Inlet Phase C Current 

gstPow3ChDeciAmpsCNOTIFY 
(11128) 

 

Ctrl3ChIECDeciAmpsA =Three 
Phase Inlet Phase A Current 

gstCtrl3ChIECDeciAmpsANOTIFY 
(12508) 

 

Ctrl3ChIECDeciAmpsB =Three 
Phase Inlet Phase B Current 

gstCtrl3ChIECDeciAmpsBNOTIFY 
(12516) 

 

Ctrl3ChIECDeciAmpsC 
=Three Phase Inlet Phase C 
Current 

gstCtrl3ChIECDeciAmpsCNOTIFY 
(12524) 

 

 
 

Hewlett Packard Supported Events 
 

Hewlett Packard Supported Events 

Event description Trap name Common event name 

Voltage High Critical trapCritical  inletOverVoltageCritical  

Voltage High Critical Clear 
  

trapCleared  inletOverVoltageCriticalClear  

Voltage Low Critical   trapCritical  inletUnderVoltageCritical  

Voltage Low Critical Clear trapCleared inletUnderVoltageCriticalClear 

Current Critical  trapCritical  inletOverCurrentCritical  
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Hewlett Packard Supported Events 

Event description Trap name Common event name 

Current Critical Clear  trapCleared  inletOverCurrentCriticalClear  

Voltage High Warning   trapWarning  inletOverVoltageWarning  

Voltage High Warning Clear trapCleared  inletOverVoltageWarningClear  

Voltage Low Warning  trapWarning  inletUnderVoltageWarning  

Voltage Low Warning Clear  trapCleared  inletUnderVoltageWarningClear  

Current Warning  trapWarning  inletOverCurrentWarning  

Current Warning Clear  trapCleared  inletOverCurrentWarningClear  

 
 

Knurr Supported Events 
 

Knurr Supported Events 

Event description Trap name Common event name 

Inlet Pole Current Upper 
Warning Threshold 

pdu-M1TrapPreWarnPh1 

pdu-M1TrapPreWarnPh2 

pdu-M1TrapPreWarnPh3 

pdu-M2TrapPreWarnPh1 

pdu-M2TrapPreWarnPh2 

pdu-M2TrapPreWarnPh3 

pdu-M3TrapPreWarnPh1 

pdu-M3TrapPreWarnPh2 

pdu-M3TrapPreWarnPh3 

pdu-M4TrapPreWarnPh1 

pdu-M4TrapPreWarnPh2 

pdu-M4TrapPreWarnPh3 

inletOverCurrentWarning 

Inlet Pole Current Upper 
Critical Threshold 

pdu-M1TrapAlarmPh1 

pdu-M1TrapAlarmPh2 

pdu-M1TrapAlarmPh3 

pdu-M2TrapAlarmPh1 

pdu-M2TrapAlarmPh2 

pdu-M2TrapAlarmPh3 

inletOverCurrentCritical  
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Knurr Supported Events 

Event description Trap name Common event name 

pdu-M3TrapAlarmPh1 

pdu-M3TrapAlarmPh2 

pdu-M3TrapAlarmPh3 

pdu-M4TrapAlarmPh1 

pdu-M4TrapAlarmPh2 

pdu-M4TrapAlarmPh3 

Inlet Pole Current Lower 
Warning Threshold 

pdu-M1TrapInfoPh1 

pdu-M1TrapInfoPh2 

pdu-M1TrapInfoPh3 

pdu-M2TrapInfoPh1 

pdu-M2TrapInfoPh2 

pdu-M2TrapInfoPh3 

pdu-M3TrapInfoPh1 

pdu-M3TrapInfoPh2 

pdu-M3TrapInfoPh3 

pdu-M4TrapInfoPh1 

pdu-M4TrapInfoPh2 

pdu-M4TrapInfoPh3 

inletUnderCurrentWarning 

Inlet Pole Current Threshold 
Clear - All 

pdu-M1TrapRetToNormPh1 

pdu-M1TrapRetToNormPh2 

pdu-M1TrapRetToNormPh3 

pdu-M2TrapRetToNormPh1 

pdu-M2TrapRetToNormPh2 

pdu-M2TrapRetToNormPh3 

pdu-M3TrapRetToNormPh1 

pdu-M3TrapRetToNormPh2 

pdu-M3TrapRetToNormPh3 

pdu-M4TrapRetToNormPh1 

pdu-M4TrapRetToNormPh2 

pdu-M4TrapRetToNormPh3 

inletOverCurrentWarningClear 

inletOverCurrentCriticalClear 

inletUnderCurrentWarningClear 
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Knurr Supported Events 

Event description Trap name Common event name 

Inlet Unbalanced Current 
Upper Warning Threshold 

pdu-M1TrapOutOfBal 

pdu-M2TrapOutOfBal 

pdu-M3TrapOutOfBal 

pdu-M4TrapOutOfBal 

inletOverUnbalancedCurrentWarni
ng 

Note: Power IQ only supports SNMPv2 traps of Knurr PDUs as of 

release 4.3.0. 
 

Liebert Supported Events 
 

Liebert Supported Events 

Event description Trap name Common event name 

Outlet turned on  lgpEventRcpPowerStateChangeOn  outletPowerOn 

Outlet turned off lgpEventRcpPowerStateChangeOff  outletPowerOff  

 
 

MRV Supported Events 
 

MRV Supported Events 

Event description Trap name Common event name 

Temp Env Sensor High 
Threshold  

irTempHighTholdAlarmRaised  envTemperatureUpperCritical 

Temp Env Sensor High 
Threshold Cleared   

irTempHighTholdAlarmCleared  envTemperatureUpperCriticalClear 

Temp Env Sensor Low 
Threshold  

irTempLowTholdAlarmRaised   envTemperatureLowerCritical 

Temp Env Sensor Low 
Threshold Cleared   

irTempLowTholdAlarmCleared  envTemperatureLowerCriticalClear 

Humidity Env Sensor High 
Threshold  

irHumidityHighTholdAlarmRaised  envHumidityUpperCritical 

Humidity Env Sensor High 
Threshold Cleared  

irHumidityHighTholdAlarmCleared envHumidityUpperCriticalClear 

Humidity Env Sensor Low 
Threshold  

irHumidityLowTholdAlarmRaised  envHumidityLowerCritical 
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MRV Supported Events 

Event description Trap name Common event name 

Humidity Env Sensor Low 
Threshold Cleared  

irHumidityLowTholdAlarmCleared  envHumidityUpperCriticalClear 

 
 

Raritan PX/PX2/PX3 Supported Events 

Some Raritan PX models support Event Rules, so that you can specify 
which events will be sent to Power IQ 

Set up rules to reduce the number of traps sent to Power IQ. Optional. 

Once rules are created, associate the rule with the SNMP Trap Action, 
with Power IQ as the trap destination. 

See Event Rules or Actions in the Raritan PX User Guide.  

Note: Model numbers that begin with "PX2" support Event Rules. 
 

 

Raritan PX Supported Events 

Event description Trap name Common event name 

Peak Current inletSensorStateChange inletOverPeakCurrentCriticalClear 

inletOverPeakCurrentCritical 

inletOverPeakCurrentWarningClear 

inletOverPeakCurrentWarning 

inletUnderPeakCurrentCriticalClear 

inletUnderPeakCurrentCritical 

inletUnderPeakCurrentWarningClear 

inletUnderPeakCurrentWarning 

inletPeakCurrentSensorUnavailable 

InletPeakCurrentSensorUnavailableClear 

Unbalanced Current inletSensorStateChange inletOverUnbalancedCurrentCriticalClear  

 InletOverUnbalancedCurrentCritical  

 inletOverUnbalancedCurrentWarningClear  

 inletOverUnbalancedCurrentWarning  

 inletUnderUnbalancedCurrentCriticalClear 

 inletUnderUnbalancedCurrentCritical 
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Raritan PX Supported Events 

Event description Trap name Common event name 

 
inletUnderUnbalancedCurrentWarningClear 

 inletUnderUnbalancedCurrentWarning  

 inletUnbalancedCurrentSensorUnavailable  

Active Power inletSensorStateChange inletOverActivePowerCriticalClear  

 inletOverActivePowerCritical  

 inletOverActivePowerWarningClear  

 inletOverActivePowerWarning  

 inletUnderActivePowerCriticalClear 

 inletUnderActivePowerCritical  

 inletUnderActivePowerWarningClear  

 inletUnderActivePowerWarning  

 inletActivePowerSensorUnavailable  

 InletActivePowerSensorUnavailableClear  

Apparent Power inletSensorStateChange inletOverApparentPowerCriticalClear  

 inletOverApparentPowerCritical  

 inletOverApparentPowerWarningClear  

 inletOverApparentPowerWarning  

 inletUnderApparentPowerCriticalClear  

 inletUnderApparentPowerCritical  

 inletUnderApparentPowerWarningClear  

 inletUnderApparentPowerWarning  

 InletApparentPowerSensorUnavailable  
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Raritan PX Supported Events 

Event description Trap name Common event name 

Power Factor inletSensorStateChange inletOverPowerFactorCriticalClear  

 inletOverPowerFactorCritical  

 inletOverPowerFactorWarningClear  

 inletOverPowerFactorWarning  

 inletUnderPowerFactorCriticalClear  

 inletUnderPowerFactorCritical  

 inletUnderPowerFactorWarningClear  

 inletUnderPowerFactorWarning  

 inletPowerFactorSensorUnavailable  

 InletPowerFactorSensorUnavailableClear  

Frequency inletSensorStateChange inletOverFrequencyCriticalClear  

 inletOverFrequencyCritical  

 inletOverFrequencyWarningClear  

 inletOverFrequencyWarning  

 inletUnderFrequencyCriticalClear  

 inletUnderFrequencyCritical  

 inletUnderFrequencyWarningClear  

 inletUnderFrequencyWarning  

 inletFrequencySensorUnavailable  

 InletFrequencySensorUnavailableClear  

Phase Angle inletSensorStateChange inletOverPhaseAngleCriticalClear  

 inletOverPhaseAngleCritical  

 inletOverPhaseAngleWarningClear  

 inletOverPhaseAngleWarning  

 inletUnderPhaseAngleCriticalClear  

 inletUnderPhaseAngleCritical  

 inletUnderPhaseAngleWarningClear  

 inletUnderPhaseAngleWarning  

 inletPhaseAngleSensorUnavailable  

 InletPhaseAngleSensorUnavailableClear  
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Raritan PX Supported Events 

Event description Trap name Common event name 

Residual Current inletSensorStateChange inletOverResidualCurrentCriticalClear  

 inletOverResidualCurrentCritical  

 inletOverResidualCurrentWarningClear  

 inletOverResidualCurrentWarning  

 inletUnderResidualCurrentCriticalClear  

 inletUnderResidualCurrentCritical  

 inletUnderResidualCurrentWarningClear  

 InletUnderResidualCurrentWarning  

Power Quality inletSensorStateChange powerQualityUnavailable  

 powerQualityUnavailableClear  

 powerQualityWarning  

 powerQualityWarningClear  

 powerQualityCritical  

 PowerQualityCriticalClear  

Voltage Line to Neutral InletPoleSensorStateChange inletOverVoltageLnCriticalClear  

 inletOverVoltageLnCritical  

 inletOverVoltageLnWarningClear  

 inletOverVoltageLnWarning  

 inletUnderVoltageLnCriticalClear  

 inletUnderVoltageLnCritical  

 inletUnderVoltageLnWarningClear  

 inletUnderVoltageLnWarning  

 inletVoltageLnSensorUnavailable  

 InletVoltageLnSensorUnavailableClear  

Peak Current outletSensorStateChange outletOverPeakCurrentCriticalClear  

 outletOverPeakCurrentCritical  

 outletOverPeakCurrentWarningClear  

 outletOverPeakCurrentWarning  

 outletUnderPeakCurrentCriticalClear  

 outletUnderPeakCurrentCritical  
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Raritan PX Supported Events 

Event description Trap name Common event name 

 outletUnderPeakCurrentWarningClear  

 outletUnderPeakCurrentWarning 

 outletPeakCurrentSensorUnavailable  

 
OutletPeakCurrentSensorUnavailableClear  

Unbalanced Current outletSensorStateChange outletOverUnbalancedCurrentCriticalClear  

 outletOverUnbalancedCurrentCritical  

 
outletOverUnbalancedCurrentWarningClear  

 outletOverUnbalancedCurrentWarning  

 
outletUnderUnbalancedCurrentCriticalClear  

 outletUnderUnbalancedCurrentCritical  

 
outletUnderUnbalancedCurrentWarningCle
ar  

 outletUnderUnbalancedCurrentWarning 

 
outletUnbalancedCurrentSensorUnavailabl
e  

OutletUnbalancedCurrentSensorUnavailabl
eClear  

Active Power outletSensorStateChange outletOverActivePowerCriticalClear  

 outletOverActivePowerCritical  

 outletOverActivePowerWarningClear  

 outletOverActivePowerWarning  

 outletUnderActivePowerCriticalClear  

 outletUnderActivePowerCritical  

 outletUnderActivePowerWarningClear  

 outletUnderActivePowerWarning  

 outletActivePowerSensorUnavailable  

 
OutletActivePowerSensorUnavailableClear  

Apparent Power outletSensorStateChange outletOverApparentPowerCriticalClear  



Chapter 5: Configuring Event Management 
 

60
  

 

Raritan PX Supported Events 

Event description Trap name Common event name 

 outletOverApparentPowerCritical  

 outletOverApparentPowerWarningClear  

 outletOverApparentPowerWarning  

 outletUnderApparentPowerCriticalClear  

 outletUnderApparentPowerCritical  

 outletUnderApparentPowerWarningClear  

 outletUnderApparentPowerWarning  

 outletApparentPowerSensorUnavailable  

 
OutletApparentPowerSensorUnavailableCle
ar 

Power Factor outletSensorStateChange inletOverPowerFactorCriticalClear  

 inletOverPowerFactorCritical  

 inletOverPowerFactorWarningClear  

 inletOverPowerFactorWarning  

 inletUnderPowerFactorCriticalClear  

 inletUnderPowerFactorCritical  

 inletUnderPowerFactorWarningClear  

 inletUnderPowerFactorWarning  

 inletPowerFactorSensorUnavailable  

 InletPowerFactorSensorUnavailableClear  

Frequency outletSensorStateChange outletOverPowerFactorCriticalClear  

 outletOverPowerFactorCritical  

 outletOverPowerFactorWarningClear  

 outletOverPowerFactorWarning  

 outletUnderPowerFactorCriticalClear  

 outletUnderPowerFactorCritical  

 outletUnderPowerFactorWarningClear  

 outletUnderPowerFactorWarning  

 outletPowerFactorSensorUnavailable  
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Raritan PX Supported Events 

Event description Trap name Common event name 

OutletPowerFactorSensorUnavailableClear  

Phase Angle outletSensorStateChange outletOverPhaseAngleCriticalClear  

 outletOverPhaseAngleCritical  

 outletOverPhaseAngleWarningClear  

 outletOverPhaseAngleWarning  

 outletUnderPhaseAngleCriticalClear  

 outletUnderPhaseAngleCritical  

 outletUnderPhaseAngleWarningClear  

 outletUnderPhaseAngleWarning  

 outletPhaseAngleSensorUnavailable  

 OutletPhaseAngleSensorUnavailableClear  

Voltage Line to Neutral outletPoleSensorStateChange outletOverVoltageLnCriticalClear  

 outletOverVoltageLnCritical  

 outletOverVoltageLnWarningClear  

 outletOverVoltageLnWarning  

 outletUnderVoltageLnCriticalClear  

 outletUnderVoltageLnCritical  

 outletUnderVoltageLnWarningClear  

 outletUnderVoltageLnWarning  

 outletVoltageLnSensorUnavailable  

 OutletVoltageLnSensorUnavailableClear  

Outlet Power State On/Off outletSensorStateChange outletPowerStateUnavailable  

 outletPowerStateUnavailableClear  

 outletPowerStateOff  

 outletPowerStateOffClear  

 outletPowerStateOn  

 OutletPowerStateOnClear  
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Raritan PX Supported Events 

Event description Trap name Common event name 

Circuit Breaker Peak Current overCurrentProtectorSensorStateCh
ange 

cbOverPeakCurrentCriticalClear  

 cbOverPeakCurrentCritical  

 cbOverPeakCurrentWarningClear  

 cbOverPeakCurrentWarning  

 cbUnderPeakCurrentCriticalClear  

 cbUnderPeakCurrentCritical  

 cbUnderPeakCurrentWarningClear  

 cbUnderPeakCurrentWarning  

 cbPeakCurrentSensorUnavailable  

 CbPeakCurrentSensorUnavailableClear  

 
 

Raritan EMX Supported Events 
 

Raritan EMX Supported Events 

Event description Trap name Common event name 

Numeric sensor threshold 
crossing events 

External sensor 
'[EXTSENSORNAME]' in slot 
'[EXTSENSORSLOT]' asserted 
'above upper critical'. 

External sensor 
'[EXTSENSORNAME]' in slot 
'[EXTSENSORSLOT]' asserted 
'above upper warning'. 

External sensor 
'[EXTSENSORNAME]' in slot 
'[EXTSENSORSLOT]' asserted 
'below lower warning'. 

External sensor 
'[EXTSENSORNAME]' in slot 
'[EXTSENSORSLOT]' asserted 
'below lower critical'. 

envTemperatureUpperCritical 

envTemperatureUpperCriticalClear 

envTemperatureLowerCritical 

envTemperatureLowerCriticalClear 

envHumidityUpperCritical 

envHumidityUpperCriticalClear 

envHumidityLowerCritical 

envHumidityLowerCriticalClear 

External Sensor Slot State 
Change 

External sensor 
'[EXTSENSORNAME]' in slot 
'[EXTSENSORSLOT]' is closed. 

SensorContactOpen 

SensorContactClosed 
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Raritan PX3TS Transfer Switch Supported Events 
 

Raritan PX3TS Supported Events 

See Raritan PX Supported Events (see "Raritan PX/PX2/PX3 Supported Events" on page 55) for events related 
to functions other than the transfer switch. 

Event description Trap name Common event name 

Transfer Switch Active Inlet 
Changed 

transferSwitchStateChange transferSwitchActiveInletChangedCritical  

transferSwitchActiveInletChangedCriticalCl
ear 

transferSwitchActiveInletChangedWarning 

Transfer Switch Operating 
State Change 

transferSwitchStateChange transferSwitchOperatingStateNormal 

transferSwitchOperatingStateStandby 

 
 

Rittal Supported Events 
 

Rittal Supported Events 

Event description Trap name Common event name 

Inlet Current Upper Critical 
Threshold  

alarmUnit1 

alarmUnit2 

alarmUnit3 

alarmUnit4  

inletCurrentUpperCritical  

Inlet Current Upper Critical 
Threshold Cleared  

alarmUnit1 

alarmUnit2 

alarmUnit3 

alarmUnit4  

inletCurrentUpperCriticalClear  

Inlet Current Lower Critical 
Threshold  

 

alarmUnit1 

alarmUnit2 

alarmUnit3 

alarmUnit4  

inletCurrentLowerCritical  

Inlet Current Lower Critical 
Threshold Cleared  

 

alarmUnit1 

alarmUnit2 

alarmUnit3 

inletCurrentLowerCriticalClear 
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Rittal Supported Events 

Event description Trap name Common event name 

alarmUnit4  

Inlet Voltage Upper Critical 
Threshold  

alarmUnit1 

alarmUnit2 

alarmUnit3 

alarmUnit4  

inletVoltageUpperCritical  

Inlet Voltage Upper Critical 
Threshold Cleared 

alarmUnit1 

alarmUnit2 

alarmUnit3 

alarmUnit4  

inletVoltageUpperCriticalClear  

 

Inlet Voltage Lower Critical 
Threshold 

alarmUnit1 

alarmUnit2 

alarmUnit3 

alarmUnit4  

inletVoltageLowerCritical  

Inlet Voltage Lower Critical 
Threshold Cleared  

alarmUnit1 

alarmUnit2 

alarmUnit3 

alarmUnit4  

inletVoltageLowerCriticalClear  

Temp Env Sensor Upper 
Critical  

alarmUnit1 

alarmUnit2 

alarmUnit3 

alarmUnit4  

envTemperatureUpperCritical  

Temp Env Sensor Upper 
Critical Cleared 

alarmUnit1 

alarmUnit2 

alarmUnit3 

alarmUnit4  

envTemperatureUpperCriticalClear  

Temp Env Sensor Low Critical alarmUnit1 

alarmUnit2 

alarmUnit3 

alarmUnit4  

envTemperatureLowerCritical  
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Rittal Supported Events 

Event description Trap name Common event name 

Temp Env Sensor Low Critical 
Cleared  

alarmUnit1 

alarmUnit2 

alarmUnit3 

alarmUnit4  

envTemperatureLowerCriticalClear  

Humidity Env Sensor Upper 
Critical 

alarmUnit1 

alarmUnit2 

alarmUnit3 

alarmUnit4  

envHumidityUpperCritical  

Humidity Env Sensor Upper 
Critical Cleared  

alarmUnit1 

alarmUnit2 

alarmUnit3 

alarmUnit4 

envHumidityUpperCriticalClear  

Humidity Env Sensor Lower 
Critical 

alarmUnit1 

alarmUnit2 

alarmUnit3 

alarmUnit4 

envHumidityLowerCritical 

Humidity Env Sensor Lower 
Critical Cleared  

alarmUnit1 

alarmUnit2 

alarmUnit3 

alarmUnit4 

envHumidityLowerCriticalClear  

 
 

 

Servertech Supported Events 
 

Servertech Supported Events 

Event description Trap name Common event name 

Infeed Current High Threshold infeedLoadEvent inletCurrentUpperCritical 

inletCurrentUpperCriticalClear 

Infeed Current Low Threshold  infeedLoadEvent inletCurrentLowerCritical 

inletCurrentLowerCriticalClear 

Outlet Current High outletLoadEvent  outletCurrentUpperCritical 
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Servertech Supported Events 

Event description Trap name Common event name 

Thresholds  outletCurrentUpperCriticalClear 

Outlet Current Low Thresholds outletLoadEvent outletCurrentLowerCritical 

outletCurrentLowerCriticalClear 

Outlet Current Status Change outletChangeEvent outletPowerOn 

outletPowerOff 

Temp Env Sensor High 
Threshold 

tempHumidSensorTempEvent envTemperatureUpperCritical 

envTemperatureUpperCriticalClear 

Temp Env Sensor Low 
Threshold 

tempHumidSensorTempEvent envTemperatureLowerCritical 

envTemperatureLowerCriticalClear 

Humidity Env Sensor High 
Thresholds  

tempHumidSensorHumidEvent envHumidityUpperCritical 

envHumidityUpperCriticalClear 

Humidity Env Sensor Low 
Thresholds  

tempHumidSensorHumidEvent envHumidityLowerCritical 

envHumidityLowerCriticalClear  

 
 

PDU Connectivity Lost and Restored Events 

Power IQ generates PDU connectivity events when connectivity is lost or 
restored with a PDU. The PDU's health status will change to red when 
connectivity is lost. Loss of connectivity is a critical severity event. 

Power IQ checks PDUs that it has lost communication with every 15 
minutes. If a PDU remains inaccessible for 1 hour, the Connectivity Lost 
event is generated. Once communication with the PDU is restored, the 
Connectivity Restored event is generated, and the health status will 
update. 

To configure email notifications for this event, see Configure 
Notification Filters (on page 73). Event notifications must be enabled. 
See Enable or Disable Event Notifications (on page 72). 

The event details are in the table.  

Event description Trap name 

Loss of connectivity detected. 
A timestamp is associated with 
the event. 

Connectivity Lost 

Connectivity with the PDU is Connectivity Restored 
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Event description Trap name 

restored. 

 
 

Rack Thresholds 

Rack thresholding creates events and event notifications when a rack 
reaches a set percentage of the rack’s capacity, measured using active 
power (kW).  

Calculations use the maximum active power reading found for each inlet, 
during each polling period. The maximum values are summed to 
determine the rack active power. If the summed value exceeds a set 
threshold, an event is triggered. 

The threshold calculation interval is based on the configured polling 
interval. For example, with a polling interval of 15 minutes, Power IQ will 
also run a rack threshold calculation every 15 minutes. 

Note: Calculations are estimates. Raritan PDUs with buffered data 
retrieval ("data logging") enabled will give more accurate maximum 
readings. Other PDU types may have less accurate maximum readings, 

which can cause false negatives or false positives.  

Warning or critical rack threshold events are not cleared unless all inlets 
on all PDUs in a rack are responding. A new warning or critical event will 
still be issued even when a rack has PDUs that are not responding, if the 
collected readings from the PDUs that are responding are enough to 
exceed the configured capacity threshold. 

 To configure rack thresholds: 

1. Configure Global Threshold Settings (see "Configure Default 
Threshold Settings" on page 68) 

2. Set Rack Capacity and Override Threshold Percentages (on 
page 69) 

3. To receive event notifications, configure notification filters to include 
Rack events. See Configure Notification Filters (on page 73). 
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Configure Default Threshold Settings 

When you enable calculating of rack thresholds, Power IQ calculates 
each rack's active power at the polling interval. The calculation uses the 
inlet active power of each PDU. For PDUs with buffered data retrieval, 
the maximum active power reading is used. 

Power IQ uses the threshold percentages to determine when a rack is 
nearing capacity.  

 Default upper warning threshold: 80% 

 Default upper critical threshold: 90% 

These percentages apply to all racks, unless you set an override at the 
rack level. See Set Rack Capacity and Override Threshold 
Percentages (on page 69). 

Events are triggered when the calculated capacity of the rack equals or 
exceeds the threshold.  

Each rack must have a configured capacity for rack thresholds to be 
calculated. See Set Rack Capacity and Override Threshold 
Percentages (on page 69). 

 To configure default threshold settings: 

1. In the Settings tab, click Power IQ Settings. 

2. In the Threshold Settings section, select the "Enable calculating of 
rack thresholds" checkbox. 

3. Change the default percentages for upper warning and upper critical 
if desired. Optional.  

4. Click Save Threshold Settings. 
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Set Rack Capacity and Override Threshold Percentages 

Power IQ uses the rack capacity to calculate when a threshold has been 
exceeded, and generate an event. Power IQ uses the default threshold 
unless you set a different percentage at the rack level, to override the 
default setting. 

To set capacity and override threshold percentages for multiple racks 
simultaneously, use the EDM import function. See Import EDM Object 
Mappings (on page 140). 

 

 To set rack capacity and override threshold percentages: 

1. In the Data Centers tab, select the rack. The Rack smart view opens. 

2. Click Actions, then choose Edit Details. 

3. Enter the capacity for the rack in kW.  

4. Enter a percentage in the Critical or Warning level fields to override 
the default global thresholds. When these fields are blank, the 
defaults are used. See Configure Default Threshold Settings (on 
page 68). 
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View Events 

The Events tab displays all events that Power IQ receives from 
configured PDUs. 

For PX, PX2 and EMX, Power IQ also displays the actual measured 
reading values for the event whenever that information is available in 
notifications. 

 To view events: 

 Click the Events tab. The Events browser page opens.  

 To view event details: 

1. Click the Events tab. The Events browser page opens. 

2. Click the links in the Events column to open the Event details page.  
 

Filter the Events List 

You can customize your view of the Events list by using filters and 
sorting. 

See Customizing Your View of PDUs, Devices, and Events (on page 
41). 

 To filter the events list: 

In the Events tab, all events in the system display in a list. 

Most columns of data contain a filter criteria selection. Click the arrow in 
the column header to open the options. Filter is the last option. 

 Filter by date: In the Occurred on column filter, select the checkbox 
for Before, After or On, then select a date in the calendar to view 
events that occurred before, after or on the date you select. 

 Filter by event severity: In the Severity column filter, select the 
checkbox for the severity of events you want to view. Select multiple 
options as needed. 

 Filter by event name: In the Event column filter, enter an event name 
to view. 

 Filter by PDU associated with the event: In the Associated PDU 
column filter, enter a PDU name or IP address to view events 
associated with a PDU. 

 Filter by event status: In the Status column filter, select the checkbox 
for the status of events you want to view, either active, or cleared. 
Select multiple options as needed. 
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Export the Events List to CSV 

Export the Events list to create a CSV file that contains all the 
information in the grid on the Events tab. 

The exported file contains the same columns as the page in Power IQ. If 
you have applied filters, the same filters will apply to the exported 
information. Export includes all records matching the filter criteria. The 
export is not limited by the number of events shown in the list grid. 

 To export the Events list to CSV: 

1. In the Events tab, click the Export/Save icon  in the upper right 
corner of the grid. 

2. Save or open the file using the dialog that appears. 
 

Clear Events 

Events can be automatically cleared by other events, or you can clear 
them manually. 

 To clear events in the Events browser view: 

1. In the Events tab, select the checkbox for an event in the list. Select 
multiple checkboxes to choose multiple events to clear. 

2. Click Clear Selected Events. 

 To clear an event from the Events details page: 

1. In the Events tab, click the link for an event to open the Event details 
page. The link to open Event details is in the Events column. 

2. In the Event details page, click "Clear this event". 
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Automatic Delete of Cleared Events 

Power IQ automatically deletes cleared events from the system hourly.  

Cleared events will only be deleted when there are more than 100,000 
events in the database.  

The oldest events in the system are eligible to be deleted first. If there 
are 100,000 or fewer events in the database at the hourly check, then no 
events will be deleted.  

Only cleared events are eligible to delete. Power IQ will not delete active 
events. 

You can access events and event configurations via ODBC views. If you 
need to keep a log of all generated events, run a script periodically that 
retrieves event data via ODBC before Power IQ deletes cleared events 
automatically.  
 

Enable or Disable Event Notifications 

If you would like to receive email notification for events that Power IQ 
receives, you must enable event notifications. When event notification is 
enabled, Power IQ sends an email message for every event. Set up 
notification filters if you do not want to receive emails for every event. 
See Configure Notification Filters (on page 73). 

 To enable or disable event notifications: 

1. In the Settings tab, click Power IQ Settings in the Application 
Administration section. 

2. In the Event Notification Settings box, select the "Enable e-mail 
delivery of event notifications" checkbox to enable event 
notifications. 

or 

Deselect the "Enable e-mail delivery of event notifications" checkbox 
to disable event notifications. 

3. Click Save. 

 After enabling event notifications, the "Configure event 
notifications for your account" link appears. Click this link to use 
filters to manage your notifications. 

 After enabling, configure the SMTP settings for your system. See 
SMTP Server Settings (on page 74). 
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Configure Notification Filters 

When event notification is enabled, Power IQ sends an email message 
for every event. Set up notification filters if you do not want to receive 
emails for every event. 

 To add notification filters: 

1. Click your username link, next to the Logoff link in the upper right 
corner of Power IQ.  

2. Click Manage Event Notifications. 

3. Click "Add a filter." 

4. Select the Enable this Filter checkbox. 

5. Select the Severity levels of the events for which you want Power IQ 
to send email notifications: Critical, Warning, and Informational. 

6. Select the Sources of the events for which you want Power IQ to 
send email notifications: Outlet, Inlet, Circuit Breaker, Environmental 
Sensors, PDU Connectivity, Rack, and Internal Power IQ Services. 

 Power IQ generates PDU connectivity events when connectivity 
is lost or restored with a PDU. 

 Rack sources is for rack capacity threshold events.  

 Power IQ Internal services is for Enterprise Power IQ extraction 
failure events. 

7. Select "Send notifications for all PDUs" to receive email notifications 
for all PDUs that meet the Severity level and Source criteria 
selected. 

or 

Select "Send notifications only for the following PDUs" and then enter 
IP addresses for PDUs or values for Custom Fields associated with 
PDUs. 

 Enter a value in either or both custom fields to receive email 
notifications only for PDUs that have those custom field values 
assigned. Custom Field 1 and Custom Field 2 may be renamed 
in your system. See Configuring Custom Fields (on page 153). 

 Click Add to enter the IP addresses of the PDUs for which email 
notifications should be sent. Enter a partial IP address to specify 
a group of PDUs in sequence. For example, enter 192.168.45 to 
specify all IP addresses beginning with that sequence. Click See 
Matching PDUs to verify the list of PDUs for which Power IQ will 
send email notifications.  

Note: IP address filters do not apply to rack events or internal Power 
IQ service events. 

8. Click Save.  
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Manage Event Notifications for Users 

Users with the Site Administrator role can manage other user's event 
notification settings. 

 To manage event notifications for users: 

1. In the Settings tab, click User Accounts in the Authorization and 
Authentication section. 

2. Click the username link for the user whose event notification settings 
you want to view. 

3. Click "Manage event notifications." 

4. Change the settings as needed and click Save. See Configure 
Notification Filters (on page 73) for details. 

 

SMTP Server Settings 

Configure the SMTP server settings to determine how email notifications 
are sent when Power IQ receives events. 

You must reboot Power IQ after changing the encryption method in the 
SMTP server settings. See Shutting Down and Restarting Power IQ 
(on page 268). 

 To configure SMTP server settings: 

1. In the Settings tab, click Server Settings in the Appliance 
Administration section. 

2. In the SMTP Server Settings section, enter the basic settings for the 
SMTP server. 

a. Server name/IP address: Enter the email server's domain name 
or IP address. 

b. Port: The default port is 25. Change this number if you use a 
different port. 

c. "Sender email address": Enter the Power IQ's IP address. 

3. In the Authentication and Encryption Settings section, select the 
method for your SMTP server. 

a. Authentication type: Select None or Password. If you select 
Password, enter the Username, Password, and Confirm 
password. 

b. Select an Encryption method. 

4. Click Send a Test Email to enter your email address and try sending 
an email message using the settings you configured. If you see a 
success message, click Save SMTP Settings. 
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If you see a failure message, edit your settings and try again. A 
password must be entered in the page to test the settings. Once 
saved, passwords do not display in the page for security. 

 

Event Fuse Handling 

The event fuse will not be de-activated until the trap rate drops 30% 
below the 15 traps/sec threshold and the trap rate is re-calculated each 
time a trap is received. Therefore the fuse will not be de-activated until 
Power IQ receives a trap and determines that the trap rate is 30% below 
15 traps/sec. 

If the event fuse is tripped and then no more traps are received, the 
event fuse will remain tripped until the next event is received. 
 

Events That Clear Quickly 

If two events occur, active and cleared, within 30 seconds, only one 
event notification is sent, for the cleared event. For example, if a PDU 
experiences a temperature spike, but the temperature returns to normal 
within one second, only the event notification for the cleared event is 
sent. 

The event notification contains information indicating when the original 
event occurred and when that event was cleared. 
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You can add both LDAP and locally authenticated users. All user 
permissions are authorized locally. 

In This Chapter 

Change the Administrator Password ....................................................... 76 
Adding, Editing, and Deleting Users ........................................................ 76 
Editing and Deleting Users - Local and LDAP......................................... 77 
Configuring LDAP Authentication ............................................................ 78 
Finding and Adding LDAP Users ............................................................. 80 
Adding, Editing, and Deleting User Groups ............................................. 82 
Limiting View Permissions ....................................................................... 83 
Assigning Roles for User Permissions .................................................... 83 
 
 

Change the Administrator Password 

It is important to change the default admin account password as soon as 
possible. This helps prevent unauthorized administrator access to Power 
IQ. 

The password must follow the requirements selected in Settings > 
Password Requirements. See Configuring Password Requirements 
(on page 123). 

 To change the administrator password: 

1. Click the Settings tab. 

2. Click User Accounts. The User Configuration page opens, displaying 
a list of all the user accounts created for the system. 

3. Click Edit for the admin user. 

4. Type a new password for the admin account in the Password field, 
then type it again in the Confirm Password field. 

5. Click Save. 
 

Adding, Editing, and Deleting Users 

Add a User 

 To add a user: 

1. In the Settings tab, click User Accounts. The User Configuration 
page opens displaying a list of all the user accounts created for the 
system. 

Chapter 6 User Configuration 
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2. Choose Add > Add User. A blank user information page opens. 

3. Enter the Common User Information. 

a. Enter a username with at least 3 characters, but not more than 
40 characters. Required 

b. Enter the user's first name, last name, and email address. 

c. Password and Confirm Password: Enter a password for this user. 
Default password strength requires at least 8 characters, 
including one numerical character, one uppercase character, 
one lowercase character, and one of the following special 
characters: ~!@#$%^&*()_+{}|:"<>?/.,';][=-`"). See Configuring 
Password Requirements (on page 123).  Required 

d. In the Description field, enter comments about the user. 
 

Editing and Deleting Users - Local and LDAP 

Edit Users 

You can view and edit all users, including local and LDAP, in the User 
Accounts page. 

Edited information is saved only to Power IQ, not to your LDAP server. 

For information on editing user permissions, see Assigning Roles for 
User Permissions (on page 83). 

 To edit a user: 

1. In the Settings tab, click User Accounts. 

2. Click the blue Login for the user you want to edit.  

3. Click Edit and edit the information as needed.  

 Login: 3 characters minimum. 40 characters maximum. 

 First Name: 1 character minimum. 

 Last Name: 1 character minimum. 

 Email: Must contain a correctly formatted email address. 

 Description: Optional. 
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Delete Users 

You can delete users that no longer need access to Power IQ. Both local 
and LDAP users can be deleted. When a user is deleted, all data, roles, 
and public shared reports that may be used by other users, are deleted. 
Only one user can be deleted at a time. 

 To delete users: 

1. In the Settings tab, click User Accounts. 

2. Select the checkbox for the user you want to delete. 

3. Click Remove. A confirmation message appears. Click Delete User 
to confirm. 

 

Configuring LDAP Authentication 

Repair an LDAP Configuration After Upgrade - Release 4.0 and 
Earlier ONLY 

When you upgrade Power IQ from release 4.0 or earlier only, your 
previously configured LDAP settings require a repair process to be run. 
The Repair finds the DN of each user and stores that information in the 
database. Power IQ needs the DN of each user to be able to 
authenticate in Power IQ 4.1 and later. 

You must run the repair function once after upgrade. LDAP users will not 
be able to login to Power IQ until you run the repair. Only the "admin" 
user account will be able to login before the repair is run. 

Your LDAP server configuration, Bind DN and Base DN are retained. 
Your Bind Password is not retained, and you must enter it to run the 
repair. Search settings are not retained, but they are not needed to run 
the repair. You must enter them after repair if you need to find and add 
new LDAP users. 

 

 To repair an LDAP configuration after upgrade: 

1. In the Settings tab, click User Accounts. 

2. Click Add > Find LDAP Users. 
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3. Enter your Bind Password and click Repair. 

4. When the repair process completes, a message appears showing 
how many users were repaired. 

5. To view any users that were not repaired, go to the User Accounts 
list, and check the LDAP DN column.  

a. In the Settings tab, click User Accounts. 

b. Click the LDAP DN column header to sort the list by LDAP DN 
value. Sort again if needed to find users with a blank LDAP DN 
value. 

 

Configuring the LDAP Server Settings 

The LDAP server settings enable Power IQ to connect to your LDAP 
server. To configure the LDAP search settings, go to Settings > User 
Accounts. See Find LDAP Users (on page 80) 

 

 To configure the LDAP server settings: 

1. In the Settings tab, click LDAP Server Settings. 

2. Complete the fields with your LDAP information. 

 LDAP Server: Enter the IP address or hostname. 

 LDAP Port: Enter the port number.  

 Port 389 is the standard, unencrypted and TLS-encrypted 
LDAP communication port.  

 Port 636 is the standard, SSL-encrypted LDAP 
communication port. 

 Transport Security: Select Unencrypted, SSL Encryption, or TLS 
Encryption. 

3. Click Save.  

 Next steps: See Find LDAP Users (on page 80). 
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Finding and Adding LDAP Users 

Find LDAP Users 

Enter search and filter criteria to find LDAP users you want to add. 

 To find LDAP users: 

1. Make sure your LDAP server settings are configured. See 
Configuring the LDAP Server Settings (on page 79). 

2. In the Settings tab, click User Accounts. 

3. Click Add > Find LDAP Users. 

4. Enter the Bind DN and Bind Password for an LDAP user that has 
permissions to perform search queries in the LDAP server. 

5. Specify a Base DN (directory level/entry) under which the 
authentication search query will be executed. Power IQ can do a 
recursive search downward from this Base DN. 

Example Description 

dc=raritan,dc=com The search query for 
the user entry will be 
made over the whole 
directory structure. 

cn=Administrators,cn=Users,dc=raritan,dc
=com 

The search query for 
the user entry will be 
performed only in the 
Administrators 
sub-directory (entry). 

6. Type a user's attributes in the Filter field so the search query will be 
restricted to only those entries that meet this criterion. For example, 
(objectClass=user) or (objectClass=person) depending on how 
LDAP is configured. 

7. Select the Scope. Select Subtree to allow a recursive search starting 
at the Base DN. 

8. Select the Follow Referrals checkbox to allow LDAP to follow 
referrals to complete a search if referral objects are encountered 
while Power IQ is searching the LDAP server. 

9. Click Find to search the LDAP server. A list of users displays in the 
Results section. Search results include a limited number of records. 
See LDAP Search Results Limits (on page 81). 

10. You can edit the user account details, and add the LDAP users 
shown in the Results list. See Add and Edit LDAP Users (on page 
81). 
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LDAP Search Results Limits 

Power IQ's Find LDAP Users search result size is limited to the LDAP 
server's search limit. The number of records returned depends on the 
type of LDAP server being queried, and whether the server is configured 
with the default limit or some other value. 

If your search results don't return the needed users due to the limit, 
refine your search configuration using more specific Base DN, Filter, and 
Scope. See Find LDAP Users (on page 80). 
 

Add and Edit LDAP Users 

Using an LDAP server search results list, you can edit user account 
details, and add the users to Power IQ. 

 LDAP users results list details: 

 

 To add and edit LDAP users: 

1. Complete a search for LDAP users. See Find LDAP Users (on page 
80). 

2. Select the checkboxes for the users you want to add. Users without 
a checkbox have already been added. 

3. Edit the user information as needed. User information can also be 
edited after users are added. To edit, click in the field to activate it. 
The Login, Mail, Given Name, and Surname columns are editable. 
Edits are saved to Power IQ only, not to the LDAP server. Edited 
fields display a triangle indicator. 

 Login is required and must contain the username. 3 characters 
minimum. 40 characters maximum. 

 Mail is required and must contain a correctly formatted email 
address. 

4. Click Add. Successfully added users no longer have a checkbox. 
Check the Messages column to see errors for users who could not 
be added. Correct the information and click Add. 
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Adding, Editing, and Deleting User Groups 

Default User Groups 

There are two default user groups, All Users and Site Administrators. 

The All Users group contains every user you add to Power IQ, and has 
the View role assigned to it. 

The Site Administrators group contains the Admin user, and has the Site 
Administrator role assigned to it. The Site Administrator role allows users 
to do all tasks in Power IQ. 

You can change the roles assigned to both groups.  
 

Add a User Group 

 To add a user group: 

1. Click Settings. 

2. Click User Groups. 

3. Click Add, then enter a name. Click Next. The Group Information 
page opens. 

4. In the Group Members section, select users in the drop-down list, 
then click Add. Users in the group appear in the list by login, name, 
and email. 

5. In the Group Roles section, select roles in the drop-down list, then 
click Add to assign the permission to the group. Roles assigned to 
the group appear in the list. See Role Definitions (see "Power IQ 
Role Definitions" on page 83). 

 

Edit a User Group Name 

 To edit a user group name: 

1. Click Settings. 

2. Click User Groups. 

3. Select a group then click Edit. 

4. Click Edit to change the group name. 

5. Click Save. 
 

Delete a User Group 

 To delete a user group: 

1. In the Settings tab, click User Groups. 
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2. Select a group and click Remove. 
 

Limiting View Permissions 

By default in Power IQ, all users are assigned to a group called All Users. 
You cannot remove users from this group. 

The All Users group includes the View role by default. If you wanted to 
limit the viewing permissions of your users, you must remove the View 
role from the All Users group. 

Your users will need to be assigned view permissions in some other way. 
There are several ways to do this. 

 Make sure each user is in a group with the View role assigned at the 
appropriate EDM node.  

 Make sure each user is in a group with another role assigned that 
includes View permissions, such as Operator. 

 Assign the View role, or another role that includes View permissions, 
such as Operator, directly to the user. 

 

Assigning Roles for User Permissions 

Power IQ Role Definitions 

Assign these roles to users or user groups to allow the permissions for 
operations within Power IQ. 

You can assign any role to apply globally, meaning access to perform 
the tasks will be granted for every object in Power IQ. For example, a 
user assigned a global Power Control role can perform power control on 
any PDU or IT device, no matter where it is in the enterprise data model.  

See Assign Roles to a User Group (on page 87) and Assign Roles to 
a User (on page 86).  

Or, you can assign the Administrator, Operator, View, and Power Control 
roles to apply only to a certain object in your enterprise data model, such 
as a rack. See Assign Roles within a Data Center (on page 88). When 
these roles are assigned to the user or user group directly at the 
EDM-node-level via the Data Centers tab, the permission allowed will be 
limited to the selected enterprise data object, and all levels beneath it.  
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Role Tasks Applies To 

Site Administrator 

 The Site 
Administrators 
group is assigned 
this role by default, 
and contains the 
Admin user. 

 "Super user"  

Every task in Power IQ. 

 Full permissions to Settings tab. 

 Full permissions to Dashboards 
tab. 

 Full permissions to create Tags in 
the Reports tab, and to tag nodes 
in the EDM. 

 Full permissions of View, Power 
Control, Create Reports and 
Dashboards, and Event Manager. 

 Power IQ 

 Global only. 

 

Role Tasks Applies To 

Administrator  Administrator role includes the 
permissions of View, Power 
Control, Create Reports and 
Dashboards, and Event Manager.  

 Full permissions to Dashboards 
tab. 

 Permission to tag nodes in the 
EDM. 

 Excludes the Settings tab, other 
than personal user profile 
settings. 

 Global, when applied in Settings > User 
Accounts page.  

 Selected EDM node and down, when 
applied in Data Centers tab. NOTE: 
Applying Administrator in the Data Centers 
tab also excludes permission to view the 
Analytics tab and the Events tab. 

 

Role Tasks Applies To 

Operator  Operator role includes the 
permissions of View. 

 View permissions to Dashboards 
tab reports; upload drawing 
permission for Floor Maps in 
Dashboards tab. Excludes 
creating reports in Dashboards 
tab.  

 Permission to tag nodes in the 
EDM. 

 Excludes the Settings tab other 
than personal user profile 
settings, Power Control, Create 
Reports and Dashboards, Event 
Manager 

 Global, when applied in Settings > User 
Accounts page.  

 Selected EDM node and down, when 
applied in Data Centers tab 
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Role Tasks Applies To 

View View role has permission to: 

 View EDM in the Data Centers tab 

 View EDM nodes in Floor Maps 

 View data from EDM nodes in 
Reports tab 

 View all other tabs in Power IQ 

 View personal user profile settings 
in the Settings tab. 

 Global, when applied in Settings > User 
Accounts page.  

 Selected EDM node and down, when 
applied in Data Centers tab 

 

Role Tasks Applies To 

Power Control Power Control role has permission to: 

 Power control 

 Create device groups 

 View devices, device groups, 
PDUs, Data Centers tab, and 
Dashboards tab.  

 Global, when applied in Settings > User 
Accounts page.  

 Selected EDM node and down, when 
applied in Data Centers tab 

 See Permissions for Power Control on a 
Device Group (on page 89) for details on 
this task. 

 

Role Tasks Applies To 

Create Reports and 
Dashboards 

Create Reports and Dashboards role 
has permission to: 

 Create reports and charts in the 
Analytics tab 

 Create dashboards in the 
Dashboards tab 

 Global only, applied in Settings > User 
Accounts page. 

 The information a user can include or view 
in a report, chart, or dashboard is based on 
View permissions. 

 A user with this role also needs the View 
role, or another role that includes View 
permission. 

 

Role Tasks Applies To 

Event Manager Event Manager role has permission 
to: 

 View the Events tab 

 Create event notification filters 

 View and clear events 

 View events in the Smart views 

 View Floor Maps in the 
Dashboard 

 Global only, applied in Settings > User 
Accounts page. 
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Assign Roles to a User 

Roles assigned to groups or users in the Settings tab give permissions 
that apply to all Data Centers, PDUs and Devices in Power IQ. These 
are sometimes referred to as "global" roles. See Power IQ Role 
Definitions (on page 83). 

You can also assign the Administrator, Operator, Power Control, and 
View roles to a user or user group, but limit the role to only a specific 
level of a data center. To limit the permission, assign the role in the Data 
Centers tab, in the Permissions section of the data center level the role 
should cover. See Assign Roles within a Data Center (on page 88). 

You must be assigned the Site Administrator role to assign roles. 

 To assign roles to a user: 

1. In the Settings tab, click User Accounts. Select a user then click Edit. 

2. In the User Roles section, select roles in the drop-down list, then 
click Add to assign the permission to the user. Roles assigned to the 
user appear in the list. 

Users can perform the tasks allowed by the roles assigned. 
 

Remove Roles from a User 

 To remove roles from a user: 

1. Click Settings.  

2. Click User Accounts. 

3. Select a user and click Edit. 

4. In the User Roles list, select a role, then click Remove. The user can 
no longer perform the tasks allowed by the role. 
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Assign Roles to a User Group 

Roles assigned to users or user groups in the Settings tab give 
permissions that apply to all Data Centers, PDUs and Devices in Power 
IQ. See Role Definitions (see "Power IQ Role Definitions" on page 
83). 

You can also assign the Administrator, Operator, Power Control, and 
View roles to a user or user group, but limit the role to only a specific 
level of a data center. To limit the permission, assign the role in the Data 
Centers tab, in the Permissions section of the data center level the role 
should cover. See Assign Roles within a Data Center (on page 88). 

You must be assigned the Site Administrator role to assign roles. 

 To assign roles to a user group: 

1. In the Settings tab, click User Groups. 

2. Select a user group, then click Edit. 

3. In the Group Roles section, select roles in the drop-down list, then 
click Add to assign the permission to the group. Roles assigned to 
the group appear in the list. 

Users can perform the tasks allowed by the roles assigned to the 
group. 

 

Remove Roles from a User Group 

 To remove roles from a user group: 

1. In the Settings tab, click User Groups. 

2. Select a user group then click Edit. 

3. Select a role, then click Remove. Users in the group can no longer 
perform the tasks allowed by the role. 

 To remove all roles from a user group: 

1. In the Settings tab, click User Groups. 

2. Select a user group then click Edit. 

3. In the Group Roles section, click Empty. 
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Assign Roles within a Data Center 

You can control what individual users or user groups can see and do in 
Power IQ at each level in each data center. Permissions extend to levels 
nested below the selected level. 

You can also assign global permissions for users and user groups for all 
levels of all data centers in Power IQ, and to PDUs not mapped into a 
data center. See Assign Roles to a User (on page 86) and Assign 
Roles to a User Group (on page 87). 

Permissions are included in different roles that you assign. See Role 
Definitions (see "Power IQ Role Definitions" on page 83). 

You must be assigned the Site Administrator role to assign roles. 

 To assign roles within a data center: 

1. In the Data Centers tab, select a data center level, such as a rack. 
The details page opens. At the Rack and PDU levels, the Smart 
Rack or Smart PDU view opens. See Smart Rack View and Smart 
PDU View 

2. Permissions are accessed differently for Racks and PDUs than all 
other enterprise data model levels.   

 For Data Centers, Rooms, Aisles, and Rows, use the 
Permissions section in the Data Centers tab to view or assign 
roles. 

 For Racks, click Configure Rack Details in the Smart Rack view 
to open a dialog that contains permissions settings. 

 For PDUs, click Configure PDU Details in the Smart PDU view to 
open a dialog that contains permissions settings. 

3. Click Add Role to > Add User Role or Add Role to > Add Group Role. 
Adding a Group Role will give permissions selected to all users in the 
group. Then, select the user or group who needs permission to this 
object. level of the data center.  

4. Select the role to allow in the Roles list. Click OK. 
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Permissions for Power Control on a Device Group 

To perform power control operations on a device group, your 
permissions must satisfy one of the following. 

 You have the global power control role.  

OR 

 You are the creator of the device group AND you have the power 
control role assigned within the Data Centers tab for every device in 
the device group. 
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The Power IQ dashboard allows each user to customize collections of 
charts and widgets in a single view. You can create multiple versions of 
your dashboard and select which one to view, or start a slideshow for all 
or selected dashboards. 

The default dashboard configuration includes 2 rows. The top row 
includes a health chart that shows overall PDU health. The second row is 
a device chart that shows average active power over the past 24 hours. 

You must have the Create Reports and Dashboards role to edit the 
dashboard. 

In This Chapter 

Viewing the Dashboard ........................................................................... 90 
Sharing a Dashboard ............................................................................... 92 
Adding or Deleting a Dashboard ............................................................. 93 
Setting the Dashboard Layout ................................................................. 94 
Configuring Widgets ................................................................................ 95 
View Dashboards as a Slideshow ......................................................... 117 
Renaming a Dashboard ......................................................................... 118 
View Dashboard in Full Screen Mode ................................................... 119 
How Does Power IQ Calculate the Sum of a Data Center Node? ........ 119 
 
 

Viewing the Dashboard 

You can configure multiple versions of the dashboard as needed. 

Other users can share their dashboards with you, as a shared report. 
You can also share your dashboards with other users.  

If you have more than 1 dashboard, follow either procedure below to 
view a dashboard. 

 Use the dashboard links under the Dashboards tab: 

1. Click the Dashboards tab.  

Chapter 7 Dashboard 
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2. If more than 1 dashboard is configured, links to available dashboards 
are displayed across the top of the dashboard page. If the dashboard 

you want to view is not listed, click the arrow icon  at the end of 
the links to show additional ones. 

 

3. Click a dashboard link. The selected dashboard loads in the 
Dashboards tab. 

 Use the Manage Dashboards dialog: 

1. In the Dashboards tab, click the button  in the 
top right corner. The Manage Dashboards dialog appears. 

 

2. Click a dashboard link. The selected dashboard loads in the 
Dashboards tab. 
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Sharing a Dashboard 

Choose to share a dashboard when you want to make it public. Sharing 
dashboards gives other Power IQ users access to your dashboards, and 
the widgets it contains. 

Users must have the View and the Create Reports and Dashboards role 
assigned to view your shared dashboards.  

The data that displays in a dashboard is based on each individual user's 
permissions in Power IQ. If another user does not have permission to 
see information about a rack or datacenter, for example, that you have 
shared a dashboard about, the user will not see the data. 

Users that you share a dashboard with cannot edit your dashboard. You 
cannot edit dashboards that you did not create. 

 To share a dashboard: 

1. In the Dashboards tab, select a dashboard.  

 If you only have 1 dashboard, it will be displayed already.  

 If you have multiple dashboards, select it from the list across the 
top of the dashboard, or from the Manage Dashboards dialog 

after clicking . See Viewing the 
Dashboard (on page 90). 

Click a dashboard link. The selected dashboard loads in the 
Dashboards tab. 

2. Click the  button in the upper right corner of the 
Dashboards tab. The Dashboard Configuration dialog appears. 

3. Select the Share This Dashboard checkbox to make this dashboard 
and widgets public. 

 

4. Click Save. 

 To make a dashboard private: 

1. Click the  button in the upper right corner of the 
Dashboards tab. The Dashboard Configuration dialog appears. 
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2. Deselect the Share This Dashboard checkbox to remove the 
dashboard from public view.  

3. Click Save. 

 To check which dashboards are shared: 

1. In the Dashboards tab, click the button  in the 
top right corner. The Manage Dashboards dialog appears. 

 

2. Dashboards that you are sharing are marked as "shared by you." 
Dashboards that have been shared by other users are marked as 
"shared by username." 

 

Adding or Deleting a Dashboard 

You can configure more than one version of the dashboard so that each 
has different widgets, charts or layouts.  

If any dashboard version is not needed anymore, you can remove it, but 
you can only remove the dashboards that you created. 

 To add or delete a dashboard: 

1. In the Dashboards tab, click the button  in the 
top right corner. The Manage Dashboards dialog appears. 

 

2. To add a new dashboard, click Add and then type a name for the 
new dashboard. 

 To configure the new dashboard, such as adding widgets or 
charts, see Setting the Dashboard Layout (on page 94). 

3. To delete any dashboards, select the checkboxes for the dashboards 
you want to remove, and click Delete. 
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 A confirmation message appears. Click Delete Selected 
Dashboards to confirm. 

 

Setting the Dashboard Layout 

You can set the number of rows of widgets on your dashboard, drag and 
drop widgets into the rows, and resize each widget and row.  

You can only edit the dashboards that you created. 

 To set the dashboard layout: 

1. In the Dashboards tab, select a dashboard.  

 If you only have 1 dashboard, it will be displayed already.  

 If you have multiple dashboards, select it from the list across the 
top of the dashboard, or from the Manage Dashboards dialog 

after clicking . See Viewing the 
Dashboard (on page 90). 

2. Click the  button in the upper right corner of the 
Dashboards tab. The Dashboard Configuration dialog appears. 

3. Select the Share This Dashboard checkbox to make this dashboard 
and widgets public. 

4. Click a Layout to view the configuration in the dialog. The layouts are 
1 row, 2 rows, 3 rows, or 4 rows.  

5. Resize the rows by clicking and dragging the edges of a row. You 
can resize the width of a widget in a row, and the height of an entire 
row.  

6. Drag and drop widgets from the bottom of the dialog into the rows. 
Drag and drop widgets from row to row to rearrange them. The row 
you're dropping into highlights green.  

7. Drop a widget back into the bottom of the dialog to remove it from 
the layout. 

8. Click Save. The dashboard layout you selected displays in the tab. 
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Configuring Widgets 

Widgets are the configurable tools and charts you can add to the 
dashboard layout. 

 Active Events Widget (on page 95) 

 Device Chart Widget (on page 96) 

 PDU Health Chart Widget (on page 97) 

 Capacity Forecast Chart Widget (on page 98) 

 Capacity Gauge Widget (on page 99) 

 Image Widget (on page 100) 

 Dashboard Heading Widget (on page 101) 

 HTML Widget (on page 102) 

 Cooling Chart Widget (on page 103) 

 PUE Trend Chart Widget (on page 109) 

 Latest PUE Reading Gauge Widget (on page 110) 

 Facilities Chart Widget (on page 112) 

 Floor Map Widget (on page 113) 
 

Active Events Widget 

The active events widget displays the 10 highest severity, active events 
in a list.  

You must have the Event Manager role assigned to view events. See 
Assign Roles to a User (on page 86). 

The list refreshes automatically every 30 seconds.  

 To configure the active events widget: 

1. Click the  button in the upper right corner of the 
Dashboards tab. The Dashboard Configuration dialog appears. 

2. Drag and drop the Active Events widget icon into a row. See Setting 
the Dashboard Layout (on page 94) for details. 

 

3. Click Save. The widget is added to the dashboard. 
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 To use the active events widget: 

 Click an event link to open the event details page, where you can 
clear the event. See Clear Events (on page 71). 

 See Enable or Disable Event Notifications (on page 72) for details 
on receiving email notifications of events. 

 

Device Chart Widget 

The device chart widget displays a default setting of average active 
power over the past 24 hours. 

You can configure the device chart to display power measurements for 
different parts of the data center. Devices must be mapped to rack PDU 
outlets or circuits in the EDM before the data can be charted. See 
Creating Your EDM (on page 135). 

Note: Use the Facilities Chart widget to display power measurements for 
your facilities objects. See Facilities Chart Widget (on page 112). 

 To configure the device chart widget: 

1. Click the  button in the upper right corner of the 
Dashboards tab. The Dashboard Configuration dialog appears. 

2. Drag and drop the Device Chart widget icon into a row. See Setting 
the Dashboard Layout (on page 94) for details. 

 

3. See Device Chart Settings (on page 229) for details on configuring 
this chart. 

4. Click Save. The widget is added to the dashboard. 

 To use the device chart widget: 

 Click the export icon  to export all data in the chart to a .CSV file. 

 The chart will automatically refresh at each polling interval. Click the 
refresh icon to refresh the chart manually. 
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PDU Health Chart Widget 

The default PDU health chart widget shows overall health of all PDUs in 
the system. 

You can configure the chart to show overall health, which includes 
connectivity and active events, or active events only, or connectivity only. 
You can also set the chart to include all PDUs in the system, or just the 
PDUs in a specific level of a data center. The chart refreshes 
automatically every minute. 

 To configure the PDU health chart widget: 

1. Click the  button in the upper right corner of the 
Dashboards tab. The Dashboard Configuration dialog appears. 

2. Drag and drop the PDU health chart widget icon into a row. See 
Setting the Dashboard Layout (on page 94) for details. 

 

3. Click the Settings icon . 

4. Enter a name for the chart in the Title field in the Basics section. 

5. In the Data From field, select All to include all PDUs in the system in 
the chart. Select Data Center or other section of the data center to 
filter the next field's selections. For example, select Racks to filter the 
Contained In field to include the racks in your system. 

6. In the Contained In field, select the location of the PDUs you want to 
include in the Health chart. 

7. In the Options section, select the health measurement. 

 Select Overall Health to view a health chart that combines 
connectivity and active events to create an overall health status 
of the selected PDUs. 

 Select Event Health Only to exclude connectivity from the health 
status. 

 Select Connectivity Health Only to exclude active events from the 
health status. 

8. Click Save.  

 To use the PDU health chart widget: 

 See Overall PDU Health (on page 235) for details on how health 
status is determined. 
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 Click a color-coded bar in the graphic to view the list of PDUs 
with the selected health status. 

 The chart will automatically refresh to show the new health status 
based on any new and cleared events. Click the refresh icon to 
refresh the chart manually. 

 

Capacity Forecast Chart Widget 

The capacity forecast chart widget tracks maximum active power of a 
data center. Based on the capacity settings, the chart displays how many 
days of supply remain before your data center reaches capacity, or it will 
indicate that you have adequate capacity. 

You must have configured the enterprise data model and have a 
minimum of 2 days of daily rollup of KW data. 30 days of daily rollup data 
is recommended for more accurate forecasts. The capacity field must be 
set for the data center node selected. Power capacity is set in KW with 
granularity of 2 decimal places, such as 5.04 KW. You can configure the 
capacity for different locations in your data center as part of your 
enterprise data model configuration. See Enterprise Relationships (see 
"Enterprise Relationships and the EDM" on page 132). To set 
individual capacities, see Set a Capacity (on page 99). 

 To configure the capacity forecast chart widget: 

1. Click the  button in the upper right corner of the 
Dashboards tab. The Dashboard Configuration dialog appears. 

2. Drag and drop the Capacity Forecast Chart widget icon into a row. 
See Setting the Dashboard Layout (on page 94) for details. 

 

3. Click the Settings icon . 

4. Enter a name in the Title field. 

5. In the Show field, click the browse button, then select the data center 
node whose capacity you want to show in the chart. Expand or 
collapse the nodes by clicking the plus and minus signs. The name 
of the node selected displays in the field at the bottom on the dialog. 
Click Select Node. 

6. In the Period field, select the time period to include in the forecast.  

7. Click Save. The widget is added to the dashboard. 
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 To use the capacity forecast chart widget: 

 The blue line shows the observed data. 

 The purple line is the linear trend line. 

 The red line following the trend line shows the projected data. 

 The chart legend will indicate "Adequate Capacity" when the trend 
does not cross the capacity line for the time period. If the trend line 
crosses the capacity line, the chart legend will indicate the number of 
days of supply remaining until capacity is reached: "Projected X days 
of capacity remaining." 

 

Set a Capacity 

Capacity in kilowatts can be set with up to 2 decimal places. 

Capacity for Racks can only be set in the Data Centers tab. Capacity for 
data center, room, aisle, and row can be set either in the Data Center tab, 
or by importing the enterprise data model .CSV file. See Importing 
Object Mappings (see "Import EDM Object Mappings" on page 140). 

 To set a capacity: 

1. In the Data Centers tab, select a data center level, such as a room. 
The details page opens.  

2. Enter the capacity in the Capacity (kW) field. On the Data Center 
level, first expand the Ratings and Settings section to find the 
Capacity field.  

Note: For the Rack level, choose Actions > Edit Details in the Rack 
smart view to find the Capacity field. See Set Rack Capacity and 

Override Threshold Percentages (on page 69). 

3. Click Save. 
 

Capacity Gauge Widget 

The capacity gauge widget shows how much power a selected node of 
your data center has consumed over a specified time period. The gauge 
shows a tick mark for minimum, maximum and average power consumed 
during the time period. The dial points to the real time active power 
reading. 

 To configure the capacity gauge widget: 

1. Click the  button in the upper right corner of the 
Dashboards tab. The Dashboard Configuration dialog appears. 
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2. Drag and drop the Capacity Gauge widget icon into a row. See 
Setting the Dashboard Layout (on page 94) for details. 

 

3. Click the Settings icon . 

4. Enter a name in the Title field. 

5. In the Show field, click the browse button, then select the data center 
node whose power consumption you want to show in the dial. 
Expand or collapse the nodes by clicking the plus and minus signs. 
The name of the node selected displays in the field at the bottom on 
the dialog. Click Select Node. 

6. In the Period field, select the time period of power consumption to 
include in the dial.  

7. Click Save. The widget is added to the dashboard. 
 

Image Widget 

The image widget displays an image that you upload on the dashboard.  

The maximum images size is 800 pixels high by 800 pixels wide. The 
maximum file size is 2MB for dashboard images. Images uploaded for 
logo usage can be up to 512KB. 

Uploading a new image to an image widget removes the previously 
uploaded image. 

For details on adding a logo to every page in Power IQ, see Display a 
Logo on Every Page (on page 270). 

 To configure the image widget: 

1. Click the  button in the upper right corner of the 
Dashboards tab. The Dashboard Configuration dialog appears. 

2. Drag and drop the Image widget icon into a row. See Setting the 
Dashboard Layout (on page 94) for details. 

 

3. Click the Settings icon . 

4. Click the Browse button, select the image and click Open. 

5. Click Save. The widget is added to the dashboard. 
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Dashboard Heading Widget 

The dashboard heading widget allows you to add and format text on the 
dashboard. Position the report heading widget above or next to other 
widgets to use it as a heading. See Setting the Dashboard Layout (on 
page 94). 

 To configure the dashboard heading widget: 

1. Click the  button in the upper right corner of the 
Dashboards tab. The Dashboard Configuration dialog appears. 

2. Drag and drop the Dashboard Heading widget icon into a row. See 
Setting the Dashboard Layout (on page 94) for details. 

 

3. In the Text field, enter the text you would like to display in the 
dashboard. Maximum title length is 64 characters. 

4. Select the font type in the Font field. 

5. Select the font size in the Size drop-down list. 

6. Select the text color in the Color drop-down list. 

7. In the Align field, select Left, Center or Right to specify how text will 
be oriented in the widget space on the dashboard. 

8. Select the Bold or Italic checkboxes to format the text. 

9. Click Save. The widget is added to the dashboard. 

 To edit text only:  

Once added to the dashboard, you can edit the text only, without 
changing style or layout, directly from the dashboard. 

 In the Dashboards tab, double click heading text and edit in the text 
box that appears. Press Enter to save changes. 
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HTML Widget 

The HTML widget enables you to add your custom HTML portlet to the 
dashboard. Use this widget to add a weather tool, maps, a video camera, 
or anything you can code using HTML. 

HTML portlets may have security implications. You must allow them 
before you can add an HTML widget to the Dashboards tab. See Allow 
HTML Widgets on Dashboard (on page 270). 

In Internet Explorer, you must accept a security warning the first time you 
view a dashboard containing an HTML widget. 

Note: If your HTML widget contains active content, newer versions of 
Firefox and Chrome may block the content. Click the shield icon in the 
address bar to allow the content.  

  

 

 To configure the HTML widget: 

1. Click the  button in the upper right corner of the 
Dashboards tab. The Dashboard Configuration dialog appears. 

2. Drag and drop the HTML widget icon into a row. See Setting the 
Dashboard Layout (on page 94) for details. 

 

If you don't see the HTML widget icon, you must allow HTML portlets. 
See Allow HTML Widgets on Dashboard (on page 270). 

3. Click the Settings icon . 

4. Enter your HTML code in the HTML field. 

5. Click Save. The widget is added to the dashboard. 



 Chapter 7: Dashboard  

 
103

 
 

Note: If you see unexpected changes in your dashboard after adding an 
HTML widget, you can reset it by disabling HTML portlets in the Settings 

tab. See Allow HTML Widgets on Dashboard (on page 270).  
 

Cooling Chart Widget 

Cooling charts enable you to compare your data center's sensor 
readings against industry recommendations. 

American Society of Heating, Refrigerating and Air-Conditioning® 
(ASHRAE) is an industry consortium that provides guidelines for energy 
efficient data center operations.  

ASHRAE recommends certain safe and energy-efficient operating 
temperatures and humidity levels. This data displays on the 
psychrometric chart in Power IQ. ASHRAE offers two different sets of 
recommendations, one from 2004, and one from 2008. The 2008 
recommendations allow for slightly higher temperatures. When viewed 
on the chart, ASHRAE refers to these recommended regions of data as 
"envelopes." 

In Power IQ, you configure the chart to display your data center's 
humidity and temperature readings on the same psychrometric chart as 
ASHRAE's recommendations. You can also specify smaller sections 
within a data center, such as a room or rack. This allows you to 
determine how your readings compare to an ASHRAE recommendation. 
You can also specify your own custom target operating zones. See 
Create a Custom Region. 

 To configure the cooling chart widget: 

1. Click the  button in the upper right corner of the 
Dashboards tab. The Dashboard Configuration dialog appears. 

2. Drag and drop the cooling chart widget icon into a row. See Setting 
the Dashboard Layout (on page 94) for details. 

 

3. Click the Settings icon . 

4. In the Show field, click the browse button to select a node from your 
enterprise data model. You can select any level, up to and including 
the data center. Potential energy savings is calculated only when a 
data center is selected. 
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5. In the Sensor Position field, select Inlet, Outlet, or Outside Air. Inlet 
specifies a "cold aisle" chart, and uses data from inlet located 
sensors. Outlet specifies a "hot aisle" chart, and uses data from 
outlet located sensors. Outside air uses data from outside located 
sensors. See Specify Inlet, Outlet, or Outside Air Location for 
Environmental Sensors (on page 205). 

6. Select the region to display on the chart. See ASHRAE® Envelope 
Descriptions (on page 105) for details of each region. 

 All regions display in blue on the chart. Custom regions have 
default settings you can change. Select Custom, then select 
the Min Temperature and Max Temperature and the Min 
Humidity and Max Humidity. 

7. Select Zoom In or Zoom Out to specify a more or less detailed view 
of the chart to display. 

8. Enter a name for the chart, or check the Auto Name checkbox to 
accept the system name. The system name for a cooling chart 
contains the level of the enterprise data model, such as data center, 
and the sensor location information.  

9. Click Save. The widget is added to the dashboard. 

 To use the cooling chart widget: 

 Hover your mouse over the sensor data points to view details. See 
View Sensor Data Point Details (on page 106). 

 Click the export icon  to export sensor data in the chart to a .CSV 
file. See Export Sensor Data (on page 107). 

 The chart will automatically refresh at each polling interval. Click the 
refresh icon to refresh the chart manually. 

 To calculate savings, see Calculate Potential Cooling Energy 
Savings (on page 108) 

 

Requirements for Cooling Charts 

Cooling charts use data from the humidity and temperature sensors in 
your data center. 

You must have at least 1 temperature sensor and at least 1 humidity 
sensor connected to use Cooling charts. 
 



 Chapter 7: Dashboard  

 
105

 
 

ASHRAE® Envelope Descriptions 

ASHRAE® operating envelopes comprise the following settings. 

 X-Axis: Temperature 

 Y-Axis: Humidity Ratio, with the relative humidity percentage 
calculated along curves on the chart 

The area inside the region created by plotting the thresholds for these 
data points are recommended by ASHRAE to be safe and 
energy-efficient zones of operation for a data center. 

There are two ASHRAE® envelopes available for display in Power IQ, 
based on recommendations issued by ASHRAE in 2004 and in 2008. 

You can also create a custom region to display on the chart, in addition 
to ASHRAE regions. See Create a Custom Region. 

 ASHRAE 2004 Envelope: 

The ASHRAE 2004 recommended operating envelope is a rectangular 
area with the following coordinates. 

 20 Celsius (68 F), 40% RH 

 20 Celsius (68 F), 55% RH 

 25 Celsius (77 F), 40% RH 

 25 Celsius (77 F), 55% RH 

 ASHRAE 2008 Envelope: 

The ASHRAE 2008 recommended operating envelope is a 
pentagon-shaped area with the following coordinates. 

 18 Celsius (64.4 F), 42% RH 

 18 Celsius (64.4 F), 60% RH 

 22.7 Celsius (73 F), 60% RH 

 27 Celsius (80.6 F), 49% RH 

 27 Celsius (80.6 F), 25%RH  
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View Sensor Data Point Details 

On a cooling chart, the data points for your sensors display as green 
points. 

You can verify whether the points are inside the recommended region 
you chose to display. The cooling chart allows you to view the details of 
each data point, and access the associated PDU details page. 

Note: If more than one sensor has the same reading, the points will 
appear stacked, so that 2 points appear to be 1. Hover the mouse over 
the point to view the details of each stacked point. Export the sensor 
data to view the details of each point in a text file. See Export Sensor 

Data (on page 107) 

 To view sensor data point details: 

1. In the Dashboards tab, locate your cooling chart. Hover the mouse 
over a green data point. 

2. The sensor data point details display in a pop-up. 

 Humidity Sensor Reading 

 Humidity Sensor Location - (EDM Hierarchy Rack location) 

 Temperature Sensor Reading 

 Temperature Sensor Location - (EDM Hierarchy Rack location)  

3. Click the green data point. The Sensor List For Data Point dialog 
appears. 

4. Click a row of data to open the PDU details page for the PDU where 
the sensor is located. Pop-up blockers may prevent this page from 
opening. 
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Cooling Chart Details - How Your Sensor Data is Charted 

By default, Power IQ considers all environmental sensors to be inlet 
located. You can specify a sensor as outlet, inlet, or outside air located in 
the PDU details page. See Specify Inlet, Outlet, or Outside Air 
Location for Environmental Sensors (on page 205). 

For each sensor data point, the cooling chart will display the details of 
the associated humidity and temperature sensors. See View Sensor 
Data Point Details (on page 106).  

Each data point requires two coordinates: temperature and humidity. For 
each temperature measurement, Power IQ correlates the corresponding 
humidity value. If the same sensor does not support both humidity and 
temperature readings, then the nearest humidity sensor is used to 
correlate temperature measurement with humidity measurement. The 
determination of the nearest humidity sensor is based on the Power IQ 
Enterprise Data Model hierarchy. For example, Floor -> Room -> Aisle -> 
Row ->Rack.  
 

Export Sensor Data 

To view pairs of sensor readings in a CSV file, export the data. The 
exported file contains a column called In Region, and a list of points. 
Points inside the region are listed as TRUE. Points outside the region are 
listed as FALSE.   
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Calculate Potential Cooling Energy Savings 

Power IQ calculates the estimated cost savings you may experience by 
raising the temperature of your data center to a higher temperature while 
remaining within the guidelines of a selected ASHRAE® or custom region. 

The potential cooling energy savings displays at the bottom of a cooling 
chart automatically when a data center is selected as the EDM node 
included.  

 Potential cooling energy savings can only be calculated at the data 
center level, not at lower levels, such as room, or rack. 

 All temperature sensor data points must be below the upper 
temperature limit for the region selected, or the calculation will show 
as 0%. The calculation works by showing you a potential estimated 
savings based on raising your highest temperature to the maximum 
allowed by the selected region.  

Industry estimates show that you could save 3.9% for each 1 degree 
Fahrenheit that you raise the data center temperature; or 7% for each 1 
degree Celsius that you raise the data center temperature. Your actual 
savings will vary. You can adjust the savings percentage used in the 
calculation.  

 To adjust the savings percentage used: 

1. In the Data Centers tab, select the data center node. 

2. In the Ratings and Settings section, enter the percentage to use in 
the calculation in the Savings % per degrees C field. 

 The Savings % is set to a default: 7% for Celsius readings. 
Readings for Fahrenheit are calculated based on the Celsius 
percentage, and estimated at 3.9%. 

3. Click Save. Go back to the cooling chart in the Dashboard to view 
updated potential cooling energy savings. 
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PUE Trend Chart Widget 

The PUE trend chart allows you to see how your data center's PUE has 
changed over a time period you select. Either daily or monthly 
calculations may be used. The length of the trend depends on how much 
data Power IQ has collected, as well as your selection. 

Monthly data comes from a rollup conducted on the first of each month, 
using the previous month's data. Monthly data charts will update after 
each rollup. Monthly adjustments will affect this chart. See List PUE 
Calculations and Adjustments (on page 239). Note that daily values 
cannot include adjustments. A daily chart may be significantly different 
than a monthly chart when monthly adjustments are used. 

You must configure your system before PUE is calculated. See 
Requirements for PUE (on page 237). 

 To configure the PUE trend chart widget: 

1. Click the  button in the upper right corner of the 
Dashboards tab. The Dashboard Configuration dialog appears. 

2. Drag and drop the PUE trend chart widget icon into a row. See 
Setting the Dashboard Layout (on page 94) for details. 

 

3. Click the Settings icon . 

4. In the Granularity field, select the data you want plotted in the chart, 
either Monthly or Daily . 

5. In the Time Selection section, select Period or Range. 

6. Select Period to show constantly updated measurement.  

7. Select Range to show measurements from a custom Start Date and 
End Date. Select the start and end dates using the calendar dialogs. 

8. Enter a name for the chart, or check the Auto Name checkbox to 
accept the system name.  

9. Select the Include Legend checkbox to display a legend with the 
data center names included on the chart. 

10. To select or deselect any data center, click the Data Centers tab, 
and select or deselect any checkbox of a data center. 

11. Click Save. The widget is added to the dashboard. 
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Latest PUE Reading Gauge Widget 

The latest PUE reading gauge allows you to see where your data 
center's PUE falls in the threshold range you have configured. You can 
set a warning and critical threshold level for each data center. Warning 
and critical threshold levels are displayed as yellow and red in the gauge. 
See Set PUE Thresholds (on page 111). 

The gauge also shows the minimum PUE calculation and the maximum 
PUE calculation for a time period you specify. This data displays as tick 
marks, and may overlap. 

Either daily or monthly calculations may be used. The latest PUE 
calculation is used. For daily gauges, the previous day is used. For 
monthly gauges, the previous full month is used. Monthly data comes 
from a rollup conducted on the first of each month, using the previous 
month's data. Monthly gauges will update after each rollup.  

You must configure your system before PUE is calculated. See 
Requirements for PUE (on page 237). 

 

 To configure the latest PUE reading gauge widget: 

1. Click the  button in the upper right corner of the 
Dashboards tab. The Dashboard Configuration dialog appears. 

2. Drag and drop the latest PUE reading gauge widget icon into a row. 
See Setting the Dashboard Layout (on page 94) for details. 

 

3. Click the Settings icon . 

4. Enter a Title for the gauge. 

5. Select the Data Center whose PUE you want to display. 
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6. In the Granularity field, select the calculation you want to display, 
either Monthly or Daily . 

7. In the Min/Max Period field, select the time period to include in the 
gauge calculation. The gauge displays the minimum and maximum 
of PUE values over the time period selected. The values are 
indicated with tick marks. 

8. Click Save. The widget is added to the dashboard. 
 

Set PUE Thresholds 

An ideal PUE is 1.0. You can set warning and critical thresholds for your 
data center, and Power IQ uses those values to help visualize your PUE 
in the dashboard. See Latest PUE Reading Gauge Widget (on page 
110) for details on the widget that displays this data. 

PUE is calculated only at the data center level.  

 To set PUE thresholds: 

1. In the Data Centers tab, click a data center node. 

2. In the Ratings and Settings section, set the threshold values for PUE 
Warning Threshold and PUE Critical Threshold. 

 

3. Click Save. See Latest PUE Reading Gauge Widget (on page 110) 
for details on configuring the widget that uses these values. 
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Facilities Chart Widget 

The facilities chart widget enables you to display active power or energy 
readings for one or more facilities objects, such as a CRAC, floor PDU, 
floor UPS, power panel, or standalone meter, in your data center.  

Rack PDUs are excluded from this chart. 

Facilities objects must be mapped in the EDM before the data can be 
charted. See Create Your EDM (see "Creating Your EDM" on page 
135). 

 To configure the facilities chart widget: 

1. Click the  button in the upper right corner of the 
Dashboards tab. The Dashboard Configuration dialog appears. 

2. Drag and drop the Facilities Chart widget icon into a row. See 
Setting the Dashboard Layout (on page 94) for details. 

 

3. Configure the settings. 

 Measurement: Active Power or Energy 

 Time Range: Period or Custom 

 Period shows preconfigured time options, such as Past hour, 
Past week, Past month, and so on. Select the time period 
from the drop-down list. See What's the difference 
between "Past" and "Last" time periods? (on page 232)  

 Custom show measurements between the Start Date and 
End Date chosen in the calendar dialogs. 

 Granularity: Monthly, Daily, Hourly, Poll Interval 

 Monthly, Daily, and Hourly show 1 data point per 
month/day/hour for the time period the chart includes. The 
time period must be longer than the granularity.  

 Poll Interval shows 1 data point per poll interval for the time 
period the chart includes. The Poll Interval must be set to 5 
minutes or longer to use Poll Interval granularity.  

 Statistic: Minimum, Maximum, or Average readings for each data 
point.  

 Title: Automatic or Custom. Automatic chart title is Statistic + 
Measurement + Time Range. For example, Average Active 
Power - Past 24 Hours. 
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 Lines: Show one line per data source, or Sum all data sources 
into one line. A data source is one facility object selected in the 
Data Sources table. 

4. In the Data Sources table, click Add, then select the facilities objects 
to include. Use Control-Click to select multiple objects. Click Select 
Nodes. The table displays your selections.  

5. Click Save. The widget is added to the dashboard. 
 

Floor Map Widget 

The floor map widget uses a drawing of your data center, combined with 
information from your EDM and events, to create a color-coded health 
map of your data center. 

The floor map widget supports the display of information regarding racks 
and facilities objects.  

Power IQ supports the following facilities objects: 

 CRAC 

 Floor PDU 

 Floor UPS 

 Power panel 

 Standalone meter 

Objects represented in the drawing must be mapped in the EDM before 
they can display health in the floor map. See Create Your EDM (see 
"Creating Your EDM" on page 135). 

 Make sure your data center drawing is a .DWG file that follows the 
requirements. See Supported Drawing File Software and File 
Format (on page 440), and Floor Map Drawing Files (on page 
439). 

 Object names in the drawing must be unique and match the object 
names in the EDM. 

 To configure the floor map widget: 

1. Click the  button in the upper right corner of the 
Dashboards tab. The Dashboard Configuration dialog appears. 

2. Drag and drop the Floor Map widget icon into a row. See Setting the 
Dashboard Layout (on page 94) for details. 

Tip: Floor Maps may look better as the only widget in a dashboard. 
You can create multiple dashboards.  
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3. Once the layout is saved, the blank floor map displays. Click the  
icon in the upper right corner of the widget to open the Floor Map 
Settings. Choose the location in the EDM for the floor map drawing 
you want to use. Click Select Node. 

You can create one floor map per Data Center, Floor, or Room. If a 
drawing has already been associated with a node, it will appear 

automatically when the location is chosen.  

 

4. In the Title field, select Automatic, or select Custom and add a name 
for the floor map. Click Save.  

5. Click Setup to toggle to the setup options, then click Upload. 

 

6. Click Browse, select the .dwg file, and click Upload. A success 
message displays when the drawing loads. The drawing displays 
with color-coded objects, indicating whether each object name has 
synced to the EDM. See Syncing Floor Map Drawing with EDM 
(see "Syncing the Floor Map Drawing with EDM" on page 115).  

 



 Chapter 7: Dashboard  

 
115

 
 

Syncing the Floor Map Drawing with EDM 

In Setup mode, check the color-coding of each object in your floor map 
drawing to make sure it is synced to the EDM. 

 GREEN: Objects in drawing that uniquely match an object in the 
EDM. 

 YELLOW: Objects in drawing that have duplicate names, or that 
cannot be matched to a unique object in EDM 

 RED: Objects in drawing not found in EDM. 

 

1
 

 

Status legend 

2
 

 

Objects in DB list: This list contains all objects found in the EDM 
for the location selected. The status reports whether the object was 
found in the drawing, and aligns with the colors and statuses in the 
legend. 

Click a drawing object or a list object to highlight the matching 
object, if any. 

3
 

 

The Setup button toggles to show Setup mode, or View mode. 
This is Setup mode. You can upload or download the drawing and 
check sync status. To view Health, Rack Inspector, and click 
through to smart views, toggle to View mode. 
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Using the Floor Map 

In View mode, racks and facilities objects are color coded based on 
event severity. If a facility object, the rack itself, or any PDUs or sensors 
contained in the rack have warning or critical active events, the facility 
object or rack is shown as warning or critical level.  

 GREEN: Normal. No warning or critical events. 

 YELLOW: Warning. Warning level events reported. 

 RED: Critical. Critical level events reported. 

 GRAY: No Data. Object not found in EDM, or you do not have 
permission to view this object. 

 

1
 

 

Status legend 

2
 

 

Rack Inspector: Select an object in the floor map to view readings 
and active events. 

Click the rack, facility object or PDU link in the Rack Inspector to 
go to the smart view. 



 Chapter 7: Dashboard  

 
117

 
 

3
 

 

The selected object has a blue outline. 

4
 

 

The Setup button toggles to show Setup mode, or View mode. 
This is View mode. You can view Health, Rack Inspector, and click 
through to smart views. To upload or download the drawing and 
check sync status, toggle to Setup mode. 

 
 

Floor Map Data Refresh Rates 

Rack threshold events appear and clear at the polling interval. See Rack 
Thresholds (on page 67). 

The drawing and the Rack Inspector refresh at 30-second intervals. 
 

Floor Map User Permissions 

 User permissions required to upload a drawing to a floor map: 

 Administrator, Site Administrator, or Operator 

 User permissions required to view a floor map: 

 View permissions to objects represented in the map. If user does not 
have View permission for a rack, for example, the rack appears gray 
in the drawing, and none of its data is included. 

 Events Manager 
 

View Dashboards as a Slideshow 

When you have more than 1 dashboard configured, you can view them 
as a slideshow. Slideshows play in full screen mode. To enhance the full 
screen effect, set your browser to full screen mode, too. 

 To view dashboards as a slideshow: 

1. In the Dashboards tab, click the button  in the 
top right corner. The Manage Dashboards dialog appears. 
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2. All configured dashboards display in a list. The first dashboard listed 
will display as your default dashboard. Move you mouse pointer to 
the  area, then drag and drop the entries in the list to set a new 
default, and to choose the order the entries will display in the 
slideshow. 

 

3. Select the checkboxes for the dashboards you want to include in the 
slideshow. Select the first checkbox to automatically select all 
configured dashboards. 

4. In the Play Slideshow drop-down list, select the length of time each 
dashboard will display in the slideshow before moving to the next 
dashboard. When you select the time, the slideshow starts. 

 To exit the slideshow: 

 Click the "Exit full-screen mode" link in the top right corner, or click 
the Raritan logo. 

 

Renaming a Dashboard 

You can only rename the dashboard that you created. 

 To rename a dashboard: 

1. In the Dashboards tab, click the button  in the 
top right corner. The Manage Dashboards dialog appears. 

 

2. Select the checkbox for a dashboard. 

3. Click Rename, and then modify the name in the text box that 
appears. 
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 The other alternative is to double click the dashboard's row to 
edit its name. Double-clicking should be performed in the space 
following the name link. 

 

View Dashboard in Full Screen Mode 

You can view the dashboard in full screen mode, which removes all other 
borders and controls. 

 To view dashboard in full screen mode: 

 In the Dashboards tab, click the full screen mode button 

 in the top right corner of the dashboard. 

 To exit full screen mode: 

 Click the "Exit full-screen mode" link in the top right corner, or click 
the Raritan logo. 

 

How Does Power IQ Calculate the Sum of a Data Center Node? 

Power IQ uses a formula for charting a whole data center node, such as 
a Room, that prevents duplication of data. 

The sum of a node is the sum of the inlets of all rack PDUs under the 
node, plus the sum of all non-duplicate Circuits in all Power Panels, Floor 
PDUs, and UPSs contained by the node. See Floor PDUs, Power Panels, 
UPS, Standalone Meters in the Data Center Browser 

If a node contains a rack that contains an IT device mapped to a floor 
PDU outside that node, the IT device is not part of the sum of that node. 

An HVAC system's power is part of the sum of the power for charts 
drawn for the physical location it serves, as position in the Data Center 
browser. See CRACs in the Data Center Browser (on page 183) 
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Installing an HTTPS Certificate 

A PEM file upload is required to replace the current certificate and 
private key. The PEM file needs to contain both an RSA private key and 
an X509 certificate. 

Note: Power IQ® does not provide a Certificate Signing Request (CSR). 
OpenSSL or any other utility can be used to generate CSR. Power IQ 
does not use encrypted private keys. You must remove the password 
from the Private key before it can be used. To remove the encryption 
from the key, issue a command like: "openssl rsa -in server.key -out 
server2.key". Use "server2.key" when using openSSL utility. 

It is not required to provide root certificate of CA signing Power IQ 
certificate signing request (CSR). 

 Step 1: Generate a private key 

This example procedure is for generating a private key using OpenSSL 
on a Linux server. 

1. This command creates an RSA key with Triple DES 1024 byte 
encryption. 

openssl genrsa -des3 -out server.key 1024 

2. Remember the key password from this command. 

3. Generate a Certificate Signing Request. Be prepared to complete the 
following information: 

 private key password 

 two character country code 

 full state or province name 
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 city name 

 company name 

 organizational unit or leave it blank 

 servers common name or fully qualified domain name 

 admin email address 

 other attributes can be left blank 

4. Create the request. 

openssl req -new -key server.key -out server.csr 

5. Display the CSR request.  

cat server.csr 

6. Copy the CSR request and send it to the certificate authority to be 
signed. Make sure to copy everything between the first "-----" and the 
last "-----". 

7. Submit CSR to certificate authority and receive signed X.509 
certificate. 

8. Modify the server key to remove the password 

cp server.key server.key.secure 

openssl rsa -in server.key.secure -out server.key 

Warning: The server.key file must be kept private and secure. If this 
key file is compromised, the certificate should be removed and then 

reissued. 

9. Create PEM file.  

 The PEM file should contain both the RSA private key without 
password and the X.509 certificate.  

 Concatenate the unprotected private key to the signed X.509 
certificate file from the top level certificate authority.  

 Use this file in the upload in Step 2. 

 Step 2: Upload the PEM file to Power IQ: 

You may want to manually load the certificate in your browser first to 
prevent issues while everything loads and refreshes in Power IQ. If you 
see any issues, such as bad labels or a partially loaded UI, refresh your 
browser to resolve. 

1. In the Settings tab, click HTTPS Certificate in the Security and 
Encryption section. 

2. If uploaded, the currently HTTPS certificate displays. To replace it or 
add a new certificate, click Browse and select the PEM file. 

3. Click Upload. 
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Restricting Web and Shell Access Based on IP Address 

To increase security, Power IQ® can be configured to restrict web 
interface and SSH access by IP address.  

When trusted hosts are specified, Power IQ blocks attempts to connect 
from addresses not specified.  

When no hosts are specified, ports 22, 80, 443, 5432 are open to all 
hosts. 

 To restrict web and shell access: 

1. In the Settings tab, click IP based Access Control in the Security and 
Encryption section. 

2. The global options will override any options that allow access to the 
SSH and ODBC service. 

 Allow ICMP ping responses 

 Block all SSH access 

 Block all ODBC access: See ODBC Access (on page 357). 

3. Identify the hosts to allow access to in the Trusted Hosts fields.  

You can enter an IP address, or a subnet using CIDR notation such 
as 192.168.45.0/24.  

4. For each address, select how it is permitted to access Power IQ.  

 Select the Enable SSH to allow SSH access checkbox.  

 Select the Enable HTTP/HTTPS checkbox to enable access 
through the web interface. 

 Select Enable ODBC to allow third party access. 

5. Click Save. 
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Configuring Password Requirements 

To specify password strength for Power IQ users, select from a list of 
password requirements. Users that are locally authenticated will be 
required to use passwords that comply with the settings. For example, 
you may require that all passwords contain a number and are longer 
than 8 characters. 

Password requirements apply to locally authenticated users only. If 
LDAP is enabled, the password requirements selected are not followed. 

Changes to the password requirements apply only to future new and 
changed passwords. Users whose passwords were created before the 
password requirement change will not be forced to change passwords to 
comply with the requirements. 

 To configure password requirements: 

1. In the Settings tab, click Password Requirements in the Security and 
Encryption section. 

2. In the Minimum Password Length field, select the minimum number 
of characters a password must include. 

3. In the Maximum Password Length field, select the maximum number 
of characters a password may include. 

4. Select the checkboxes for each requirement you want included in 
locally-authenticated user passwords. 

 a lowercase character: Password must contain any lowercase 
letter. 

 an uppercase character: Password must contain any capital 
letter. 

 a numeric character: Password must contain a number. 

 a special character: Password must contain any special 
character, including: ~!@#$%^&*()_+{}|:"<>?/.,';][=-\` 

5. Click Save. 
 

Encrypting Data Backup Files 

Power IQ encrypts data backup files using a GnuPG/PGP public key that 
you generate. 

You can generate PGP Encryption Keys using free tools. Go to 
https://www.gnupg.org and look for a binary for your operating system on 
the Downlaods page.  

Important! Make sure to save both the public and private keys that you 

generate. You need the public key for backup file encryption and the 
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private key for backup file decryption. See Decrypt Backup Files Before 

Restoring (on page 130) 

 To encrypt the data backup files: 

1. In the Settings tab, click Data Backup Encryption in the Security and 
Encryption section. 

2. Select the Encrypt Backups checkbox. 

3. Click Browse, then select and upload a GnuPG/PGP Public Key to 
Power IQ.  

4. Click Save. 
 

Enabling Single Sign On for Raritan Products 

You can launch the web interface of a Raritan PX1 or PX2 PDUs or a 
Raritan EMX by clicking the Launch link on the PDU details page. When 
single sign on is not enabled, users must then login manually. 

Enable single sign on to allow users to automatically authenticate with 
their Power IQ credentials. 

Users must have identical credentials on Power IQ and on the target 
Raritan product, and be logged in to Power IQ with those credentials for 
single sign on to succeed. Single sign on must be enabled in Settings > 
Single Sign On. 

See Launch the Web Interface for a Raritan PX PDU (on page 181). 

 To enable or disable single sign on for Raritan Products:  

1. In the Settings tab, click Single Sign on in the Security and 
Encryption section. 

2. Select the "Enable single sign on to Raritan PDUs" checkbox to 
enable, or deselect the checkbox to disable single sign on. 

3. Click Save. 
 

Enabling the WS API 

To get started with the WS API, the API needs to be enabled through the 
Settings Tab. It is disabled by default. 

 To enable the Web API: 

1. In the Settings tab, click Other Security Settings in the Security and 
Encryption section. 

2. In the Web API Settings, select the Enable Web API checkbox, then 
click Save. 
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Enabling the Web API User Account 

The Web API user account is a locally authenticated user that can be 
used for Web API scripts that require user credentials. The username is 
"web_api." The password for the account can be configured.  

The Web API account is configurable only on the Settings > Other 
Security Settings page. The Web API user is always authenticated 
locally, even when LDAP is enabled. 

The Web API account is assigned the administrator role. This role 
assignment cannot be changed. 

 To enable the Web API user account: 

1. In the Settings tab, click Other Security Settings in the Security and 
Encryption section. 

2. In the Web API Settings, select the "Enable web API user web_api" 
checkbox. 

3. In the Web API user password field and the Confirm password field, 
enter a password.  

 The password must follow the requirements selected in 
Settings > Password Requirements. See Configuring 
Password Requirements (on page 123). 

4. Click Save SOAP Web API Settings. 
 

Change Web User Session Timeouts 

You can set Power IQ™ to log out any web users who have been inactive 
for a certain period of time.  

 To change web user session timeouts: 

1. In the Settings tab, click Other Security Settings in the Security and 
Encryption section. 

2. In the User Session Timeout box, select a time from the "Log users 
out" list. The time indicates how long users can remain idle on the 
Power IQ web interface before being logged out. Select Never to 
disable this feature. 

3. Click Save Timeout. 
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Configuring the Authorization Warning Message 

The authorization warning message displays on the Power IQ login page. 
You can change the default message. 

 To configure the authorization warning message: 

Warning: Do not use html scripts in the message. Some scripts could 
cause the system to lock you out.  

1. In the Settings tab, click Other Security Settings in the Security and 
Encryption section. 

2. In the Authorization Warning message section, enter the message 
you want to display on the login page.  

 Header: Text entered in this field displays on the login page in a 
bold font, as the heading to the message 

 Body: Text entered in this field displays in a normal font, as the 
main content of the message. 

3. Click Save. Log out of Power IQ to return to the login page and view 
the message. 

 

Configuring Enterprise Power IQ Settings 

Enterprise Power IQ must use the password configured to communicate 
with a local Power IQ installation.  

 To configure Enterprise Power IQ settings: 

1. In the Settings tab, click Other Security Settings in the Security and 
Encryption section. 

2. Enter the password that will be required in Enterprise Power IQ to 
communication with this local Power IQ. 

3. Enter the password again to confirm. 

4. Click Save Enterprise Power IQ Settings. 
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Configuring Data Rollup Retention 

Power IQ performs periodic roll-ups. During a roll-up, the values over 
that period are averaged and stored along with the minimum and 
maximum values that were measured. As time passes, the stored roll-up 
data itself is rolled up into larger sets of data. Raw data measurements 
are rolled up every hour, and 24 hourly roll-ups are rolled up every day, 
and so on. 

Data does not have to be purged immediately after a roll-up occurs. For 
example, raw data is rolled up every hour but a set of raw data can still 
be made available five hours later. You can configure how long Power IQ 
retains each level of data. 

Ideally, you should adjust the data retention periods before adding PDUs 
to Power IQ management. You should also revisit these settings after 
adding a large number of PDUs. 

Note: Power IQ collects a lot of data. Keeping this data for long periods 
of time consumes large amounts of storage space and may affect 
performance. If you need long term access to the raw poll data, you 
should download daily sensor readings regularly. See Downloading 

Daily Sensor Readings (on page 267). 

Before making any changes to this configuration, enter your settings in 
the data storage calculator to ensure adequate database capacity. 
Improper configuration may result in data loss. Access the data 
storage calculator by clicking the link on the Settings > Data Rollup 
Retention page in Power IQ. 

 To configure data rollup retention: 

1. In the Settings tab, click Data Rollup Retention, in the Data 
Management section. 

2. Start with the "Retain raw data" row. Use the drop-down lists in that 
row to select how long Power IQ should keep this raw data.  
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3. In the Retain hourly averages of data row, configure how long hourly 
roll-ups are stored. 

4. In the Retain daily averages of data row, configure how long daily 
roll-ups should be stored.  

5. In the Retain monthly averages of data row, configure how long 
monthly roll-ups should be stored by Power IQ. 

 

Data Backups 

Power IQ creates a daily system configuration backup file.  

You can download the files to another location. Downloading System 
Configuration Backup Files (on page 128).  

To automatically download daily backup files, setup a remote storage 
location. See Configuring Remote Storage of Archive Files (on page 
131).  

You can also create a new system configuration backup file at any time. 
See Create a System Configuration Backup File (on page 128). 

If needed, you can use a backup file to restore your Power IQ to an 
earlier, backed-up configuration. See Restoring System Configuration 
Backups (on page 129). 
 

Downloading System Configuration Backup Files 

The configuration of your Power IQ is backed up and archived once each 
day. Administrators should periodically copy these backup files to an 
external server for redundancy purposes. 

Note: You can also manually create an archive of the system 
configuration by clicking Create at any time. 

 To download the system configuration backup file: 

1. In the Settings tab, click Data Backups in the Data Management 
section. The Data Backups page opens. 

2. Select a backup entry from the list and click its name to download 
the backup file to your computer. 

 

Create a System Configuration Backup File 

Power IQ creates a daily backup file. You can create a new backup file at 
any time. 

 To create a system configuration backup file: 

1. In the Settings tab, click Data Backups in the Data Management 
section. 
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2. In the Backup Archives section, click Create. The file is created and 
added at the top of the list. An MD5 file is also created along with the 
backup file for verification purposes. 

3.  
 

Restoring System Configuration Backups 

If your system configuration backup file is encrypted, see Decrypt 
Backup Files Before Restoring (on page 130). 

Restoring a system configuration backup file returns Power IQ's 
configuration to the settings captured when the backup was made. 

Note: If you restore a backup containing an SSL security certificate that 
is different from the one currently installed on the system, the progress 
bar for "Restoring the system and restarting..." will not complete. This 
happens because the browser will not accept any messages from Power 
IQ until you establish a secure connection using the restored certificate. 
Start a new browser session and you can log into the system once the 

former certificate has been restored. 

 To restore a system configuration: 

1. In the Settings tab, click Data Backups in the Data Management 
section. The Data Backups page opens. 

2. In the Restore a Backup Archive section, click Browse, then select a 
backup file. 

Click Upload. The Power IQ data and configuration settings are restored 
to the backup's configuration settings, and the server is rebooted. 
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Decrypt Backup Files Before Restoring 

You must decrypt encrypted backup files before they can be used to 
restore a Power IQ system. 

 To decrypt X.509/MIME encrypted backup file: 

Use the openssl Linux command to decrypt a X.509/MIME encrypted 
backup file. 

 Example: 

[root@localhost ~]# openssl smime -decrypt -in 

/root/backup-3.1.0.30-20111118010513.dat -inkey 

user-private-key -inform DER -recip 

user-public-key >unencrypted-backup.dat 

 To decrypt a PGP encrypted backup file: 

Use the gpg Linux commands to decrypt a PGP encrypted backup file. 

 Example: 

[root@dhcp-209 ~]# gpg --import PGP_private_key2.txt 

gpg: directory `/root/.gnupg' created 

gpg: new configuration file `/root/.gnupg/gpg.conf' 

created 

gpg: WARNING: options in ̀ /root/.gnupg/gpg.conf' are not 

yet active during this run 

gpg: keyring `/root/.gnupg/secring.gpg' created 

gpg: keyring `/root/.gnupg/pubring.gpg' created 

gpg: key 41965311: secret key imported 

gpg: /root/.gnupg/trustdb.gpg: trustdb created 

gpg: key 41965311: public key "username@email.com" 

imported 

gpg: Total number processed: 1 

gpg: imported: 1 (RSA: 1) 

gpg: secret keys read: 1 

gpg: secret keys imported: 1 

 

[root@dhcp-209 ~]# gpg --decrypt --output 

/root/unencypted.dat 

/root/backup-4.0.2.8-20130220153455.dat 
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You need a passphrase to unlock the secret key for 

user: "username@email.com" 

1024-bit RSA key, ID 41965311, created 2013-02-19 

 

can't connect to ̀ /root/.gnupg/S.gpg-agent': No such file 

or directory 

gpg-agent[9705]: directory 

`/root/.gnupg/private-keys-v1.d' created 

gpg: encrypted with 1024-bit RSA key, ID 41965311, created 

2013-02-19 

"username@email.com" 

gpg: WARNING: message was not integrity protected 
 

System Configuration Backup File Retention 

Power IQ retains backup for four days. A file older than four days is 
deleted automatically, unless it is the only stored backup file. One 
backup file is always kept, regardless of age. 
 

Configuring Remote Storage of Archive Files 

Configure a remote storage server to automatically store your archive 
files. All files that are not being actively written to are automatically 
stored on the configured server. Sensor reading archives are often being 
actively written to, so their storage may be approximately one day 
delayed. 

Two file types are eligible for automatic remote storage. 

 System configuration archives, that is, system configuration backup 
files, including daily automatic backups and manually created 
backups Note: When using SCP remote storage service, only 
automatic backups are moved, not manually created backups. 

 Sensor reading archive files  

 To configure remote storage of backup files: 

1. In the Settings tab, click Remote Storage in the Data Management 
section. 

2. Select the remote storage service type. 

 None: to stop automatic remote storage 

 Amazon Web Services 
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 SCP 

 SFTP 

 FTP 

3. Select the checkboxes for the file types you want to automatically 
store on a remote server. 

 Store backup archives 

 Store sensor reading archives 

4. Complete the authentication and location information for your 
selected remote server. 

5. Click Save. 
 

Configuring Remote Access to Database 

Power IQ's ODBC interface allows ODBC compliant applications access 
to the power data of managed devices. For example, an ODBC 
compliant reporting application like Crystal Reports can access Power IQ 
data to create customized reports. 

See ODBC Access (on page 357) for details on configuration and 
queries. 
 

Enterprise Relationships and the EDM 

One of Power IQ's advanced features is the ability to model the IT 
equipment infrastructure within your data center. Power IQ can model 
something as simple as a single rack, or as large as a building with 
multiple server rooms.  

In Power IQ, this hierarchical representation of your data center is called 
the enterprise data model, or EDM. The EDM shows the relationships 
between objects in your data center and enables Power IQ to: 

 Display a representation of your equipment in the Data Centers tab. 

 Generate charts in the Analytics tab. 

 Generate charts and gauges on the Dashboard. 

 Calculate PUE. 
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What is an Enterprise Data Model (EDM) Object? 

An object is an item that is a part of your data center. 

The objects are mapped by relationships of parent and child, creating a 
hierarchy. 

Higher-level objects contain and organize lower-level objects. For 
example, a Rack is an object that contains Devices, a Row is an object 
that can contain Racks, and an Aisle is an object that can contain Rows. 
See Object Types and their Hierarchy (on page 134) 

The lowest-level objects are called Devices. Devices are items such as 
servers, KVM drawers, network switches, or other equipment commonly 
installed in server racks. Generally speaking, these are items you 
provide power to. 

There are a couple of special exceptions. You can map circuits and 
outlets as part of your EDM, but these objects don't show in the main 
hierarchy in the Data Centers tab. Since their associations are to your IT 
devices, circuits display in the device details pages, and outlets display 
in both the device details pages, and rack PDU smart pages. 
 

What are Mappings and Relationships? 

All objects, except for the Data Center, must have a larger object as a 
parent. Generally speaking, a parent object is a larger object that 
contains a smaller object. 

The Data Center object is the largest object. It has no parent object. 

This ability to identify an object's parent is a single mapping. Mapping 
each object to its parent describes a model of equipment and how it is 
organized to Power IQ.  

Your model does not have to include every level, as long as it follows the 
rules for parent-child relationships. See Object Types and their 
Hierarchy (on page 134). 
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Object Types and their Hierarchy 

From the top of the hierarchy to the bottom: 

 DATA_CENTER - The data center object type. This object has no 
parent. 

 FLOOR - The floor object type. This object can only have a 
DATA_CENTER as a parent. 

 ROOM - The room object type. This object can have a 
DATA_CENTER or FLOOR as a parent. 

 AISLE - The aisle object type. This object can have a 
DATA_CENTER, FLOOR, or ROOM as a parent. 

 ROW - The row object type. This object can have a DATA_CENTER, 
FLOOR, ROOM, or AISLE as a parent. 

 RACK - The rack object type. This object can have a 
DATA_CENTER, FLOOR, ROOM, AISLE, ROW, or RACK as a 
parent. 

 DEVICE - The IT Device object type. This object can only have a 
RACK as a parent. 

These objects represent outlets, circuits, PDUs, and sensors: 

 PDU - The PDU object type. This object represents all types of PDUs 
in Power IQ, including Rack PDUs, Rack Transfer Switches, CRACs, 
Floor PDUs, Floor UPS, Power Panels, and Standalone Meters. This 
object can have a DATA_CENTER, FLOOR, ROOM, AISLE, ROW, 
or RACK as a parent. 

 SENSOR - The sensor object type. This object can have a 
DATA_CENTER, FLOOR, ROOM, AISLE, ROW, or RACK as a 
parent.  

 OUTLET - The outlet object type. This object can only have a 
DEVICE as a parent. 

 CIRCUIT - The circuit object type. This object can only have a 
DEVICE as a parent. 

 

Requirements for Creating EDM 

 All PDUs included in your EDM must already be added to Power IQ. 
See Adding PDUs to Power IQ Management (on page 20). 

 



 Chapter 9: Data Management  

 
135

 
 

Creating Your EDM 

There are several ways to create your EDM: 

 Import a CSV file containing the EDM object mappings. See Import 
EDM Object Mappings (on page 140). 

 Add objects manually in the Data Centers tab, using drag-and-drop 
to arrange the hierarchy. See Create an EDM Manually (on page 
136). 

 Generate a default EDM. A default EDM gives you a starting point for 
customization using the other methods, and enables you to start 
using dashboard charts immediately. See Generate a Default EDM 
(on page 148). 
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Create an EDM Manually 

The Data Centers tab has menu options to add each EDM object 
manually, and associate PDUs and sensors. Once objects are added, 
drag and drop them to arrange the hierarchy that represents your data 
center. See Object Types and their Hierarchy (on page 134) for details 
on each object and how it can be used in the EDM. 

See Importing EDM Object Mappings (see "Import EDM Object 
Mappings" on page 140) for an alternative to creating the EDM 
manually. 

Prerequisite: PDUs must be added to Power IQ before creating an EDM. 
See Adding PDUs to Power IQ Management (on page 20). 

 To add EDM objects: 

You can add Data Center, Floor, Room, Aisle, Row, Rack, and IT Device 
objects.  

Click Add, then select the object and name it when it appears in the tab.  
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 To associate PDUs and sensors: 

To associate PDUs in the EDM, you must add them to Power IQ first. 
Use the PDU Association menu option to find PDUs that are not yet in 
the EDM, and place them in the hierarchy. Power IQ automatically adds 
your sensors to the EDM when you associate their PDUs. And, Power IQ 
moves your sensors when they have the same parent as the PDU. See 
Automatically Associate Sensors in the EDM (on page 139). 
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Note: Only PDUs and sensors that are unassociated will appear as 
options. PDUs include facilties objects. 

 To associate outlets and circuits with IT devices: 

Outlets and circuits can be associated with IT Device objects only. See 
Associate a Circuit or Outlet with an IT Device (on page 149). 
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Automatically Associate Sensors in the EDM 

Power IQ automatically associates your sensors into the EDM. See 
Enterprise Relationships and the EDM (on page 132). 

Every five minutes, Power IQ checks for sensors that are not part of the 
EDM. If the sensor's PDU is in the EDM, Power IQ adds the sensor to 
the PDU's parent object, usually a rack. Click Refresh in the Data 
Centers tab to view the updated EDM. 

When you associate a PDU in the EDM, Power IQ adds the sensors to 
the PDU's parent object. 

When you remove a PDU from the EDM, Power IQ unassociates 
sensors that are associated with the PDU's parent object. But, any 
sensor that were associated to other EDM objects stay where they are. 

When you move a PDU in the EDM, Power IQ moves the sensors that 
had the same parent to the new parent. But, any sensors that were 
associated to other EDM objects stay where they are. 

Note: Because unassociated sensors attached to an associated PDU will 
be re-associated every five minutes, you cannot remove a sensor from 

the EDM if its PDU is in the EDM.  

You can also associate sensors manually and by import. See Create an 
EDM Manually (on page 136) and Import EDM Object Mappings (on 
page 140). 
 

Icons for EDM Objects 

The following icons are used to represent each object in the EDM.  

Icon Object 

 

Data Center 

 
Floor 

 
Room 

 
Aisle 

 
Row 

 
Rack 

 
IT Device 

 Rack PDU 

 Sensor 
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Icon Object 

 CRAC 

 Floor PDU 

 Floor UPS 

 Power Panel 

 Standalone Meter 

 
Rack Transfer Switch 

 
 

Import EDM Object Mappings 

One method to create or add to an EDM is to import the objects and their 
mappings. These mappings are imported as one or more Comma 
Separated Value (CSV) files. Additional CSV files append to the EDM, 
except when objects are duplicated in the CSV files. In the case of 
duplicates, the last uploaded object updates the previous entries. 

If an EDM already exists, you can export it as a single CSV file. This file 
can then be edited to make additions, or used as a template to create a 
new file. See Exporting an EDM (on page 149). 

For details on creating the CSV file, see Structure of the EDM Import 
File (on page 141). 

Note: All PDUs must be added to Power IQ first, before importing an 
EDM. Importing a CSV file that lists a PDU not added to Power IQ results 

in an error. See Adding PDUs to Power IQ Management (on page 20).  

 To import EDM object mappings: 

1. In the Settings tab, click Enterprise Relationships. 

2. In the CSV Data Mapping Actions area, click Browse, and select the 
CSV file.  

3. Click Import. 

A status window indicates any issues that occurred when the upload 
completes. If any errors have occurred, none of the objects in the file are 
added. Edit the CSV file to correct any issues and try again. 
 



 Chapter 9: Data Management  

 
141

 
 

Structure of the EDM Import File 

The EDM import file must be in .CSV format.  

 General structure: 

 One Object per line. 

 All Objects except for a Data Center list another valid object as a 
parent. 

 All Objects have a unique key for their type. 

 Within a single CSV file, object order is not important. All objects are 
processed at the same time.   

 The CSV file has a maximum length of 2500 lines, meaning a 
maximum of 2500 objects can be imported at one time. See 
Importing More than 2500 Objects (on page 148) for details on 
importing multiple files. Object order and import order are important 
in this case. 

 Object key: 

An object's unique identity is a combination of its object type and its 
object key, which is called an external key. This means you could have 
two objects with the same name, as long as they are different types of 
objects. 

However, if two lines are both type "DEVICE" and both have an external 
key "Sales1", Power IQ sees only one device object with the key 
"Sales1". In this case, it uses the last DEVICE object identified as 
"Sales1" as the description for that device. 

The columns required for each object varies, depending on the object 
type. 

All columns are separated by a comma. 

 Most columns containing text information can be up to 64 characters 
long. These columns can contain any character except for a comma. 

 The custom_field_1, custom_field_2, external_key and 
parent_external_key fields can be up to 255 characters long. These 
columns can contain any character except for a comma. 
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CSV Columns for DATA_CENTER Objects 

A line that describes a Data Center object has the following attribute 
columns in the order listed. 

All columns are separated by a comma. 

Note the attribute columns toward the end. For example: by providing the 
cost of energy for the data center, Power IQ can calculate the cost of 
running the data center in an Analytics report. Report can be filtered to 
include only a smaller object, such as a Rack. See Configuring Charts 
(on page 229). 

 object_type - this value is always "DATA_CENTER" 

 external_key - The unique identifier for this object. It can be a name, 
number, or any other kind of text. This field must be unique. 

 name - The name of the data center. 

 contact_name - The name of the contact for this data center. 

 contact_phone - The phone number for the contact for this data 
center. 

 contact_email - The email address of the contact for this data center. 

 company_name - The name of the company that owns this data 
center 

 city - The city where the data center resides. 

 state - The state/province where the data center resides. 

 country - The country where the data center resides. 

 peak_kwh_rate - The cost per kilowatt hour during peak hours 

 off_peak_kwh_rate - The cost per kilowatt hour during off-peak hours 

 peak_begin - The time the peak hours begin. 

 peak_end - The time the peak hours end. 

 co2_factor - The co2 factor for this site. This indicates thse amount 
of carbon dioxide produced per kWh. 

 cooling_factor - The cooling factor per kw energy used. This is the 
energy used for cooling, or how many kilowatts of energy are used to 
cool 100 kilowatts of power consumption. 

 custom_field_1 - A custom field for the user to specify. 

 custom_field_2 - A second custom field for the user to specify.  

 capacity - The peak capacity in kilowatts, specified with up to two 
decimal places. 
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CSV Columns for FLOOR, ROOM, AISLE, and ROW Objects 

Lines that describe a Floor, Room, Aisle, or Row have the following 
attribute columns in this order: 

 object_type - One of the following values: FLOOR, ROOM, AISLE, 
ROW 

 external_key - The unique identifier for this object. It can be a name, 
number, or any other kind of text. This field must be unique. 

 name - The name of the object. 

 parent_object_type - One of DATA_CENTER, FLOOR, ROOM, or 
AISLE, as described previously. 

 parent_external_key - The unique identifier for the parent object. It 
can be a name, number, or any other kind of text. This field must be 
unique to that parent object (however, many "child" objects may 
have the same parent). 

 capacity - The peak capacity in kilowatts, specified with up to two 
decimal places. 
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CSV Columns for RACK Objects 

A line that describes a Rack has the following attribute columns in this 
order: 

 object_type - RACK 

 external_key - The unique identifier for this object. It can be a name, 
number, or any other kind of text. This field must be unique. 

 name - The name of the object. 

 parent_object_type - One of DATA_CENTER, FLOOR, ROOM, 
AISLE, or ROW, as described previously. 

 parent_external_key - The unique identifier for the parent object. It 
can be a name, number, or any other kind of text. This field must be 
unique to that parent object (however, many "child" objects may 
have the same parent).  

 location - an optional field that can be used to identify where rack sits 
in a row or aisle. 

 capacity - The peak capacity in kilowatts, specified with up to two 
decimal places. 

 override_upper_critical_percent - Value to override the default upper 
critical percent for rack threshold. See Set Rack Capacity and 
Override Threshold Percentages (on page 69). 

 override_upper_warning_percent - Value to override the default 
upper warning percent for rack threshold. See Set Rack Capacity 
and Override Threshold Percentages (on page 69). 

The Rack model object is similar to the Floor, Room, Aisle and Row 
objects. The exception is the location value. This value is intended to 
make the rack easier to identify, and can be given a location value. For 
example: "3rd Rack" to indicate the third rack in a particular row. 

It can also use some other identifying trait. For example: "Yellow" if the 
rack has a yellow color. 
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CSV Columns for DEVICE Objects 

A line that describes a Device object has the following attribute columns 
in this order: 

 object_type - this value is always "DEVICE" 

 external_key - The unique identifier for this object. It can be a name, 
number, or any other kind of text. This field must be unique. 

 name - The name of the data center. 

 parent_object_type - This value is always "RACK". 

 parent_external_key - The external key for the parent rack. 

 customer - The customer using this device. 

 device_type - The type of device. For example: "exchange server" or 
"test unit". 

 power_rating - The power rating of this device in watts or VA. 

 decommissioned - Indicates whether this device has been 
decommissioned or not. This value is either "true" or "false". 

 custom_field_1 - A custom field for the user. 

 custom_field_2 - A second custom field for the user.  

 device_ip - The IP address of the device. Required when also 
importing a graceful shutdown command.  

 shutdown_command_name - The name of the shutdown command 
assigned to this device. See Add Shutdown Commands (on page 
217). 

 shutdown_wait_time - The number of seconds Power IQ should wait 
for the shutdown to complete before powering off the associated 
outlet. See Enable Graceful Shutdown for an IT Device (on page 
218). 

 Sample CSV for a device with a graceful shutdown command: 

DEVICE,Device -- 54,Web Server 7,RACK,Rack -- 12,Marketing,Linux 
Server,,false,Dell PowerEdge R910,Tag# 
336549,192.168.43.142,Marketing Linux Servers Shutdown 
Commands,5 

 Sample CSV for a device without a graceful shutdown 
command: 

DEVICE,Device -- 55,Router,RACK,Rack -- 12,Marketing,Cisco 
Router,,false,Cisco 7600 Router,Tag#044142,,, 
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CSV Columns for OUTLET Objects 

A line that describes an Outlet object has the following attribute columns 
in this order: 

 object_type - this value is always "OUTLET" 

 pdu_ip - The IP address of the PDU that this is attached to. 

 pdu_proxy_address - If the PDU is in a daisy-chained configuration 
or console server configuration, enter the PDU's position number in 
the chain or serial port number. 

 outlet_number - The outlet number on the side of the PDU for this 
outlet. 

 parent_object_type - This value is always "DEVICE" 

 parent_external_key - The unique identifier for the DEVICE that this 
outlet serves.  

Power IQ automatically creates Outlet objects when Raritan PX PDUs 
are placed under its management. If you create an Outlet object with a 
pdu_ip not under Power IQ management, the CSV file generates an 
error. 
 

CSV Columns for PDU Objects 

You must add all PDUs to Power IQ before you can map them in the 
EDM. 

A line that describes a PDU object has the following attribute columns in 
this order: 

 object_type - This value is always PDU. 

 pdu_ip - The IP address of the PDU. 

 pdu_proxy_address - If the PDU is in a daisy-chained configuration 
or console server configuration, enter the PDU's position number in 
the chain or serial port number. 

 parent_object_type - One of DATA_CENTER, FLOOR, ROOM, 
AISLE, ROW, RACK. 

 parent_external_key - The unique identifier for the parent object. It 
can be a name, number, or any other kind of text. This field must be 
unique to that parent object. Many "child" objects may have the 
same parent. 
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CSV Columns for CIRCUIT Objects 

You must add all PDUs to Power IQ before you can map them in the 
EDM. 

A line that describes a CIRCUIT object has the following attribute 
columns in this order: 

 object_type - This value is always CIRCUIT. 

 pdu_ip - The IP address of the PDU. 

 pdu_proxy_address - If the PDU is in a daisy-chained configuration 
or console server configuration, enter the PDU's position number in 
the chain or serial port number. 

 panel_number - If the circuit is located in a panel, enter the panel 
number. 

 circuit_number - The circuit's number 

 parent_object_type - A circuit's parent_object is always DEVICE. 

 parent_external_key - The parent DEVICE's external key. This field 
must be unique to that parent object. Many "child" objects may have 
the same parent. 

 

CSV Columns for SENSOR Objects 

Sensors must have unique labels. 

A line that describes a SENSOR object has the following attribute 
columns in this order: 

 object_type - This value is always SENSOR. 

 pdu_ip - The IP address of the PDU the sensor is attached to. 

 pdu_proxy_address - If the PDU is in a daisy-chained configuration 
or console server configuration, enter the PDU's position number in 
the chain or serial port number. 

 type - One of the following values: AIR_FLOW,, AIR_PRESSURE, 
CONTACT_CLOSURE, HUMIDITY, SMOKE, TEMPERATURE, 

VIBRATION, WATER.  

 ordinal: The number of the sensor's position on the PDU. 

 parent_object_type - A sensor's parent_object is one of the following: 
DATA_CENTER, FLOOR, ROOM, AISLE, ROW, RACK. 

 parent_external_key - The parent DEVICE's external key. This field 
must be unique to that parent object. Many "child" objects may have 
the same parent. 
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Importing More than 2500 Objects 

The EDM import file may contain a maximum of 2500 lines, one line per 
object. If you have an EDM with more than 2500 objects, create multiple 
CSV files. 

In this case, the contents of each CSV file, and the order in which you 
import them is important. 

All objects except for Data Center must have a valid parent when added. 
Importing a child object in file #1, and the parent object in file #2, results 
in an error. 

Make sure each file contains a parent object for each object, or import all 
high-level parent objects first, such as Data Center and Room, then 
import the lower-level child objects in subsequent files. 
 

Generate a Default EDM 

If you've added PDUs to Power IQ, you can generate a default EDM. 
You can customize the default EDM using the menu options in the Data 
Centers tab, or use export, edit the file, and re-import.  

Generating a default EDM deletes all mappings already configured.  

The default EDM contains: 

 1 data center 

 1 room 

 1 aisle 

 1 row per facilities object types of PDU, that is CRAC, floor PDU, 
floor UPS, power panel, standalone meter 

 1 rack per rack PDU 

 To generate a default EDM: 

1. In the Settings tab, click Enterprise Relationships in the Data 
Management section. 

2. Click Generate Default Enterprise Relationships in the CSV Data 
Mapping Actions section. 

3. Click OK to confirm. 
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Associate a Circuit or Outlet with an IT Device 

To allow for power control functions for outlets, you must associate your 
IT devices with their outlet. To allow for charting devices, the IT devices 
must be associated to their circuits or outlets.  

 To associate a circuit or outlet with an IT device: 

1. In the Data Centers tab, select the IT device in its rack. The IT 
device details page opens. 

2. In the Power Connections section, click Associate, then choose 
Outlets or Circuits. 

 

3. The Associate Entity dialog opens. Begin typing the circuit or outlet 
name in the Search field. A list of unassociated circuits or outlets 
appears that match your search.  

Note: If a list does not appear, there are no unassociated outlets or 
circuits in Power IQ.  

4. Select the circuit or outlet in the list, then click Add. 
 

Exporting an EDM 

Power IQ can export the existing EDM, as well as any unmapped PDUs, 
circuits, and sensors, as a CSV file. Use the file to edit and re-import, as 
a backup, or as a template for creating a new file. 

Power IQ exports all object mappings as a single CSV file, regardless of 
how many objects it contains. If you want to re-import a file that contains 
more than 2500 objects, separate them into multiple CSV files. 

Note: To find unmapped PDUs, circuits, and sensors in the exported file, 
look for objects with a blank "parent_external_key".  

 To export an EDM: 

1. In the Settings tab, click Enterprise Relationships.  

2. In the CSV Data Mapping Actions area, click Export Relationships. 
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Clearing Enterprise Relationships 

Clearing the enterprise relationships deletes the EDM. Deleting the EDM 
will disrupt all configured charts that are based on EDM relationships.  

 To clear enterprise relationships: 

1. In the Settings tab, click Enterprise Relationships in the Data 
Management section. 

2. In the CSV Data Mapping Actions box, click Clear Enterprise 
Relationships. 

3. Click "Clear all enterprise relationships" in the warning message to 
confirm. 

 

Viewing Enterprise Relationship Summaries 

The summary of enterprise mappings provides an overview of the EDM 
configured in Power IQ.  

In the Settings tab, click Enterprise Relationships. The summary is in the 
top left corner. 

 
 

Viewing Orphaned Systems Information 

The Orphaned Systems information shows whether there are any PDUs 
in Power IQ that are not mapped to a parent object in the EDM. PDUs 
that are not in the EDM cannot be included in charts. 

 To view orphaned systems information: 

 In the Settings tab, click Enterprise Relationships in the Data 
Management section of the page. 

The Orphaned Systems information is in the top right section of the 
page that opens. 

See the table for explanations and possible action required. 

 Outlets Mapped Outlets Not Mapped 
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 Outlets Mapped Outlets Not Mapped 

PDU 
Mapped 

The number of PDUs that are 
mapped to a parent object such as 
a rack, and have at least one 
outlet mapped to an IT device.  

No action is required. 

The number of PDUs that are 
mapped to a parent object 
such as a rack, but do not 
have any outlets mapped to IT 
devices. 

No action is required. 

PDU Not 
Mapped 

The number of PDUs that are not 
mapped to a parent object such as 
a rack, but have 1 or more outlets 
mapped to IT devices. 

Action required! 

If you have unmapped PDUs, 
you must assign them to a 
parent object for analytics to 
perform correctly. 

See Find and Map Unmapped 
PDUs (see "Finding 
Unmapped PDUs" on page 
151). 

The number of PDUs that are 
not mapped to a parent object 
such as a rack, and have zero 
outlets mapped to a device.  

Action required! 

If you have unmapped 
PDUs, you must assign 
them to a parent object for 
analytics to perform 
correctly. 

See Find and Map 
Unmapped PDUs (see 
"Finding Unmapped 
PDUs" on page 151). 

 
 

Finding Unmapped PDUs 

There are several ways to find unmapped PDUs so that you can map 
them to parent objects in the EDM. 

All PDUs must be mapped to a parent object, such as a rack. PDUs that 
are not in the EDM cannot be included in charts. 

 To view the number of unmapped PDUs: 

See Viewing Orphaned Systems Information (on page 150). 

 To find unmapped PDUs in CSV file export: 

1. In the Settings tab, click Enterprise Relationships. 

2. Click Export Relationships. 

3. In the CSV file, find the section labeled "# The following section 
contains the current list of PDUs and the PDU column 

headers for use during import." 
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4. In that section, find the "parent_object_type" column. Rows 

without data in the "parent_object_type" column are unmapped 

PDUs. 

5. Map the unmapped PDUs to parent objects in a data center. 

 To find unmapped PDUs in a default Enterprise Data Model: 

This method maps unmapped PDUs to an "Unassigned Data Center" 
parent object so that you can view the PDUs in the Data Centers tab. 
Then, you can drag and drop the PDUs to the correct position beneath a 
parent object, such as a rack. 

1. In the Settings tab, click Enterprise Relationships. 

2. Click Generate Default Enterprise Relationships. 

3. When the generation completes successfully, click the Data Centers 
tab and find the Unassigned Data Center.  

4. Expand the Unassigned Data Center. All the previously unmapped 
PDUs are assigned to this data center object. 

5. Drag and drop the PDU objects to assign them to the correct parent 
objects, such as racks, within the correct data center. 

 To manually assign PDUs to a parent object: 

When you attempt to manually associate PDUs to a parent object in the 
Data Centers tab, only unmapped PDUs are available in the search tool. 

1. In the Data Centers tab, select the parent object, such as a rack, that 
you want to associate an unmapped PDU with. 

2. Click Add > PDU Association.  

3. In the Associate a PDU dialog, select an unmapped PDU in the PDU 
IP Address field, and click OK. The PDU is mapped to the data 
center parent object. 
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Configuring Custom Fields 

The Data Center, Device, and PDU objects each contain two custom 
field values.  

Custom fields display in the Data Centers tab's hierarchy on the object 
page, for all 3 types of custom field. PDU custom fields also display in 
the PDUs tab, in the PDU Details. IT Device custom fields also display in 
the Devices tab, in the Device Details. You can use custom field values 
as filters when configuring charts. See Configuring Charts (on page 
229). 

By default, these are named: 

 Data Center Custom Field 1 and Data Center Custom Field 2 

 IT Device Custom Field 1 and IT Device Custom Field 2 

 PDU Custom Field 1 and PDU Custom Field 2 

Rename the field to specify the information it will contain. For example, 
to add data about the department that uses a group of devices, rename 
the IT Device Custom field "Department," and enter department names in 
the field for each device in Power IQ.  

 To configure custom fields: 

1. In the Settings tab, click Enterprise Relationships in the Data 
Management section. 

2. In the Configure Custom Fields box, enter the new field name next to 
each custom field.  

3. To assign data to the field, enter the data in the newly renamed 
custom field in either the Data Centers tab, on the objects page, or in 
the PDUs or Devices tab, in the details page. Data Center custom 
fields can only be accessed in the Data Centers tab. Or, you can use 
CSV import to update the information. See Importing Object 
Mappings (see "Import EDM Object Mappings" on page 140). 
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For simplicity in the GUI, Power IQ uses the term PDU to encompass 
any device that Power IQ polls to gather power or sensor data.  

When you see the term PDU in the product interface, remember that it 
includes every polled object: rack PDUs, CRACs, floor PDUs, floor UPSs, 
power panels, standalone meters, and environmental sensor 
aggregators. 

In this guide, the following terms are also used: 

 Rack PDU 

Facilities Objects: CRAC, floor PDU, floor UPS, power panel, and 
standalone meter. 

In This Chapter 

Viewing a PDU ...................................................................................... 155 
Rack PDU Smart View .......................................................................... 156 
Rack Smart View ................................................................................... 163 
PDU Elements - Rack Smart View and Rack PDU Smart View ............ 167 
Rack Transfer Switches ......................................................................... 169 
PDU Connectivity Health Statuses ........................................................ 173 
Trend Chart Settings in Smart Views .................................................... 176 
Active Power Trends for Devices .......................................................... 177 
Actions Menu in Smart Views ................................................................ 177 
Using the PDUs Tab .............................................................................. 178 
 
 

Chapter 10 PDUs 
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Viewing a PDU 

All PDUs have a smart view page, which you can access from different 
tabs.  

For details on the smart views: 

 Rack PDU Smart View (on page 156) 

 Rack Smart View (on page 163) 

 CRAC Smart View (on page 184) 

 Floor PDUs Smart View (on page 187) 

 Floor UPS Smart View (on page 192) 

 Power Panels Smart View (on page 196) 

 Standalone Meters Smart View (on page 200) 

 View a PDU in the Data Centers tab: 

The Data Centers tab displays your EDM. See Enterprise 
Relationships and the EDM (on page 132). Find your PDU within the 
EDM hierarchy, and click it to access the smart view. 
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 View a PDU in the PDUs tab: 

The PDUs tab lists all PDUs in Power IQ, even if they are not in the EDM. 
To go to the smart view, find your PDU in the list, and click the Label link.  

 

 If the PDU is not in the EDM, the smart view opens in the PDUs tab.  

 If the PDU is in the EDM, the smart view opens in the Data Centers 
tab, and you'll see the EDM hierarchy expand to show you where the 
PDU is organized in the EDM. 

 

Rack PDU Smart View 

A rack PDU smart view may contain the following sections, depending on 
the PDU: 

 Rack PDU Energy Trends (on page 157) 

 PDU Elements - Rack Smart View and Rack PDU Smart View (on 
page 167) 

 Rack PDU Readings (on page 158) 

 Rack PDU Sensors (on page 160) 

 Rack PDU Details (on page 161) 

 Rack PDU Event Listing (on page 162) 

 Rack PDU Asset Strips (on page 162) 
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Rack PDU Energy Trends 

Energy Trends display at the top of the rack PDU smart view. 

 Active Power 

 IT Energy 

 Line Current - one trend-line for each line in the PDU 

 Circuit Breaker Current - one trend-line for each circuit breaker in the 
PDU 
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Rack PDU Readings 

The Readings section of the Smart PDU view contains the power 
readings for the PDU.  

 The Inlet Readings shows the Voltage, Current, Active Power, 
Apparent Power, Power Factor, and Energy for each inlet of the PDU. 
Readings are shown for each inlet on a multiple inlet PDU. 

 The Inlet/Outlet Readings section for an inline meter shows the 
Voltage, Current, Active Power, Apparent Power, Power Factor, and 
Energy for each inlet/outlet. 

 The Line Readings section shows Voltage, Current, and the 
available current for each line.  

 The Circuit Breakers Readings section shows the Current in amps 
and the available current for each circuit breaker. 

 The Sensor Readings section shows the latest reading for each 
attached sensor, and the ordinal number of the sensor on the PDU. 

 The status at the bottom of the Readings section shows the latest 
reading time. 
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Inlet Readings and Line Readings for Three Phase PDUs 

For three phase PDUs, the Inlet Current and Voltage readings are 
maximum current and minimum voltages of the individual line readings of 
the inlet. 

The line readings voltages are "line-to-line." 

 

1 The inlet voltage reading is the Minimum of the 
line voltages.  

Min Line Voltage 

2 The inlet current reading is the maximum of the 
line currents. 

Max Line Current 

3 The line voltage readings are from line to line. L1 = L1-L2 

L2 = L2-L3 

L3 = L3-L1 
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Multi-Inlet PDU Readings 

A multi-inlet PDU displays readings for each inlet, and for each line of 
each inlet, the same as single inlet PDUs.  

The Readings section of the rack PDU smart view contains this 
information. 

 
 

Rack PDU Sensors 

A sensors list displays in the rack PDU smart view when attached 
sensors are detected. 

The sensor label is clickable and opens the sensor smart view. If the 
sensor is not associated in the EDM, the label is not clickable, and there 
is no smart view. See Sensors (on page 204). 
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Rack PDU Details 

The Details section contains all information about the PDU except for the 
IP address, which may or may not display depending on the PDU display 
setting. See Configuring PDU Display Settings - View PDUs by IP or 
Name (on page 40). 

Click the Belongs To link to view the rack, or other parent object in the 
EDM. 
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Rack PDU Event Listing 

The Event Listing section of the rack PDU smart view shows all events 
for the PDU. 

 Click an Event link to open the Event details page.  

 Select the checkbox for one or more events, then click Clear 
Selected Events to clear them. See Clear Events (on page 71). 

 
 

Rack PDU Asset Strips 

Power IQ can detect asset management strips connected to rack PDUs. 

The asset strip information displays in the rack PDU smart view. 

 To change the color of an LED: 

1. In the row of the asset tag whose color you want to change, double 
click the hexadecimal color code.  

2. Select the new color from the chart of colors. 

3. The LED color on the strip changes. 

 To associate an asset tag with an IT device: 

1. Copy the asset tag ID number from the PDU smart view for the PDU 
connected to the asset strip. 

2. In the Devices tab, select the device you want to associate with the 
asset tag. 

3. In the Device details page, paste the code into the Asset Tag Id field 
then click Save. 
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Asset Strip and Tag Events 

Power IQ can receive an event whenever an asset strip or tag is moved.  

See Raritan PX Supported Events (see "Raritan PX/PX2/PX3 
Supported Events" on page 55). 
 

Rack Smart View 

The rack smart view combines data from objects mapped to each rack in 
your EDM to give you perspective on a whole rack, including trends, 
elements like outlets and circuit breakers, and IT devices. 

Racks are part of your EDM, so you cannot see the rack smart view until 
you've added PDUs and created an EDM. See Creating Your EDM (on 
page 135). 

You must have View permissions or a role that includes View 
permissions for the chosen rack. Otherwise the rack smart view is 
unavailable. See Assigning Roles for User Permissions (on page 83). 

 To open the rack smart view: 

 In the Data Centers tab, select a rack. The rack smart view opens if 
you have View permissions for that rack. 

The rack smart view contains three sections: 

 Rack Energy and Environmental Trends (on page 164) 

 Rack IT Devices (on page 165)  

 PDU Elements  - Rack Smart View and Rack PDU Smart 
View (see "PDU Elements - Rack Smart View and Rack PDU 
Smart View" on page 167)  
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 Rack Details (on page 166) 

 

 When you do not have View permissions for the rack: 

 The following message displays. 

 
 

Rack Energy and Environmental Trends 

The rack smart view shows Energy and Environmental Trends at the top 
of the page. 

The first and last data points in the trend are shown at the left end of the 
chart. 

The minimum and maximum values in the trend are shown at the right 
end of the chart. 

 Environmental sensor charts 

 Temperature, one chart per sensor. 

 Humidity, one chart per sensor. 
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 Total Active Power for all devices and PDUs in the rack 

 
 

Rack IT Devices 

The IT Devices section of the Smart Rack view contains a list of all 
devices that are connected to one or more outlets or circuits.. If a device 
does not have any associated outlets or circuits, it will not appear in this 
list. Devices without associated outletsor circuits do still appear in the 
tree view.  

Devices that have associated circuits display the current and active 
power of the circuit. You cannot control power to circuits. 

The outlets associated with each device display beneath the IT device. 
There is a checkbox for each outlet, to select it for power control 
operations. 

 Each outlet shows a Trend chart showing the active power trend. 

Note: In Internet Explorer 7 and 8, click Load Chart to view the trend 
chart. 



Chapter 10: PDUs 
 

166
  

 

 Each device shows an Active Power reading, per device, and per 
outlet. 

 Outlets that are powered on display in black. 

 Outlets that are powered off display in gray. 

 

 To change the active power display: 

1. At the bottom of the IT Devices section, select the readings and time 
period to include in the fields. 

2. Trend: minimum, maximum or average readings. Not available for 
past hour readings. 

3. For the past: hour, day, week, month. 

 To perform power control on devices: 

1. Select the checkboxes for each outlet associated with a device. All 
outlets are grouped beneath the device. 

To select all devices in a rack, select the top checkbox. 

2. Choose Power Control > On, Power Control > Off, or Power 
Control > Cycle. 

Note: Power Off and Power Cycle operations on this page do not use 
graceful shutdown, even if it is enabled for a selected device. 

 

Rack Details 

The Actions button on the Smart Rack view opens options for changing 
the rack name, location, external key, and capacity, editing for user 
permissions on this rack, and tags. 

 To access rack details configuration: 

1. Click the Actions button, then choose an option. 

2. Choose Edit Details: 
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 Enter a new rack name, location, external key, or capacity and 
overrides. See Set Rack Capacity and Override Threshold 
Percentages (on page 69) for details on these fields. Click OK. 

3. Choose Edit Permissions: 

 View and change the roles and permissions assigned for users of 
this rack. See Assign Roles within a Data Center (on page 88) 
for more details. 

 Click Add Role to > Add User Role or Add Role to > Add 
Group Role. Adding a Group Role will give permissions 
selected to all users in the group. Then, select the user or 
group who needs permission to this object. rack. 

 Select the role to allow in the Roles list. Click OK. 

4. Choose Edit Tags: 

 Tags are used in tabular reports. See Reports and Tags (on 
page 240). 

 

PDU Elements - Rack Smart View and Rack PDU Smart View 

The PDU Elements section appears in both the rack and rack PDU smart 
views.  

This section contains a list of all outlets in the rack, or all outlets on the 
PDU, respectively. 

Note: Circuit breaker information is in the rack PDU's Readings section. 
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Key Description 

1 
The trend chart's topics is selected in the blue outlined field: active power or 
current. Data included in the trend chart is filtered by the 
minimum/maximum/average selection, and the time period selection fields 
outlined in red. 

2 
Last column shows the latest poll data for either Active Power or Current, as 
selected in the field outlined in blue.  

The min/max/average and time period selections do not affect this reading. 

Active Power (W): Latest poll reading is shown.  

Current (A): Latest poll reading is shown. 

 Each outlet shows a Trend chart showing the active power trend, or 
the current (amps) trend.  

Note: In Internet Explorer 7 and 8, click Load Chart to view the trend 
chart. 

 Outlets that are powered on display in black. 

 Outlets that are powered off display in gray. 

 Apparent Power, Voltage, and Unutilized Capacity columns also 
display in the Rack PDU Elements section. These columns do not 
display at the rack level. 

 To change the trend chart display: 

The minimum/maximum/average setting and the time period setting 
change what data is included in the small trend charts. The last column 
always displays the latest poll data. 

1. At the bottom of the PDU Elements section, select the readings and 
time period to include in the fields. 

2. Trend: minimum, maximum or average readings. Not available for 
past hour readings. 

3. For the past: hour, day, week, month. 

4. Select either Active Power or Current in amps. 

 To perform power control on outlets: 

1. Select the checkboxes for each outlet.  

To select all outlets in a rack, select the top checkbox. 

2. Choose Power Control > On, Power Control > Off, or Power 
Control > Cycle. 

Note: Power Off and Power Cycle operations on this page do not use 
graceful shutdown, even if it is enabled for a selected device. 
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3 Phase PDU Outlet Readings for Raritan PX1 

Power IQ uses the following algorithm to convert three line readings into 
one outlet reading for current and voltage only. This algorithm applies 
only to 3 phase PX1 inline meters. 

In the algorithm, "LineX_Readings" is a list of all the readings for a given 
time period.   

MAX = MAX(MAX(Line1_Readings), MAX(Line2_Readings), 

MAX(Line3_Readings)) 

AVG = MAX(AVG(Line1_Readings), AVG(Line2_Readings), 

AVG(Line3_Readings)) 

MIN = MAX(MIN(Line1_Readings), MIN(Line2_Readings), 

MIN(Line3_Readings)) 
 

PDUs with Fuses 

Most Raritan PDUs monitor load at the internal PDU circuit breaker. 
Some PDUs have fuses instead of circuit breakers.  

If a PDU has fuses, information about them displays in Power IQ with the 
"Circuit Breaker" label. 

PX models with an F1 suffix have a fuse instead of a circuit breaker. 

 PX2-4656V-F1 

 PX2-4863V-F1 

 PX2-2496-F1 

 PX2-1496-F1 

 PX2-4464I2-F1M2 

 PX2-4496I2V-F1 

 PX2-4656V-F1 

 PX2-4863V-F1 
 

Rack Transfer Switches 

Rack Transfer Switches are high speed switches that provide power from 
one of two sources depending on settings and availablity. Power IQ 
supports several Raritan and APC rack transfer switches. 
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Transfer Switch Smart View 

The header in the transfer switch smart view shows the switch's 
operating status, such as Normal or Standby.  

 
 

Transfer Switch Energy Trends 

Energy Trends display at the top of the rack transfer switch smart view. 

 Active Power 

 Energy 

 Inlet Current - one trend-line for each line in the transfer switch 

 Circuit Breaker - one trend-line for each circuit breaker in the transfer 
switch 

 Some data may not be supported by your transfer switch model. 
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Transfer Switch Readings 

Readings display in the second section of the smart view. 

Configure the columns by clicking the arrow in a heading, then selecting 
options to display, hide, or sort. 

Transfer switch readings come from the inlets, lines, circuit breakers, and 
sensors.   

This sample smart view shows one possible configuration of a transfer 
switch. 

To see details on the transfer switch status, see the Details section of the 
smart view. See Transfer Switch Details (on page 172). 

 

 
 

Transfer Switch Elements 

Elements display in the third position in the smart view. The title "PDU 
Elements" is used for all types of PDUs and facilities objects. 

The default Elements view for transfer switches includes this information: 

 PDU Element: outlets 

 IT Device: IT devices associated with outlets include a link to the IT 
device page. 

 Trend: small trend chart for active power. Change the trend to 
min/max/average active power or current using the fields below it. 

 Active Power (W): latest poll reading for active power. Change the 
latest poll reading to Current using the field below it. 
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Transfer Switch Details 

Details are the fourth section in the smart view. 

See the details section for the ordinal of the Active and Preferred Inlet of 
the transfer switch. 
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Transfer Switch Event Listing 

Event listing is the fifth section in the smart view. 

Events are created from transfer switch traps. For transfer switch 
functions, state change traps are supported. For Raritan PX3TS transfer 
switches, additional traps are supported for other functions. 

See supported traps here: 

APC Transfer Switch Supported Events (on page 45) 

Raritan PX3TS Transfer Switch Supported Events (on page 63) 

 

 To export the events to CSV, click the Save icon at upper right. 

 To clear events, select the checkboxes, then click Clear selected 
events. 

 To view event details, click the Event link. 
 

PDU Connectivity Health Statuses 

These statuses may appear in the mouse-over text when your mouse 
hovers over the Health column for a PDU on the PDU listings page. The 
statuses also appear in the Health section of the PDU smart view. 

Status Explanation 

OK Most recent poll of the target PDU was successful. 

New The system has not yet completed a successful scan 
or poll of the PDU. This is typical for systems that have 
been recently added. 

Unknown The system has not yet completed a successful scan 
or poll of the PDU. This is typical for systems that have 
been recently added. 

Lost Communication This status indicates thatPower IQ can no longer 
collect power data from the PDU. Most PDUs are 
managed via the SNMP protocol, and in this case, 
Power IQ can't communicate with the PDU over 
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Status Explanation 

SNMP. 

See Troubleshooting Connectivity Health (on page 
175). 

Degraded This status indicates certain non-critical aspects of the 
poll failed. The issue is most commonly caused when 
data-buffered data retrieval is enabled in Power IQ but 
is configured with a "read" SNMP community string 
instead of a "write" community string. In this case, 
Power IQ can still perform a poll, but it won't be able to 
enable data buffering and set the appropriate sample 
rate on PDUs that support data buffering, such as 
Raritan PX. Other possible causes of this error are 
incompatibility issues with Raritan PX running older 
firmware revisions, or if Power IQ is unable to persist 
sensor readings data to CSV file. 

Poll incomplete Certain aspects of the scan or poll failed, such as 
retrieving the model name, persisting outlet sensor 
data to CSV file, or retrieving information via SNMP. 
This can be due to an incompatibility with this version 
of the PDU or because the SNMP is misconfigured or 
the agent is disabled on the target PDU. 

 Make sure the PDU's SNMP settings are correct. 
See Editing PDUs under Power IQ Management 
(on page 22). 

Application error If the PDU is associated with a dynamic plugin, an 
index mapping may have failed to resolve. Check the 
dynamic plugin log for mapping resolution errors. 

If the PDU is not associated with a dynamic plugin, this 
indicates an unexpected application error. Contact 
Raritan Technical Support: 
http://www.raritan.com/support/contact-support 

No auth This indicates invalid or missing credentials.  

 Correct the PDU's credentials. See Editing PDUs 
under Power IQ Management (on page 22). 

No contact This indicates that Power IQ was unable to 
communicate with the PDU over any of the supported 
management protocols and so can't discover and 
manage the PDU. The most often used protocol is 
SNMP, but a few PDU models are managed using 
other protocols like HTTP. There are a number of 
possible root causes for this. 

This may indicate that the IP address is incorrect. 

 Correct the PDU's IP address. See Editing PDUs 
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Status Explanation 

under Power IQ Management (on page 22). 

Badadmcred This indicates that the PDU was configured with an 
invalid administrative username or password. SNMP 
communication is still possible and Power IQ can 
manage the PDU, but firmware upgrades will not work. 

Missing credentials This indicates invalid or missing credentials. 

 Correct the PDU's credentials. See Editing PDUs 
under Power IQ Management. (see "Editing 
PDUs under Power IQ Management" on page 22) 

Unmanageable This indicates that Power IQ contains no plug-in 
capable of managing the PDU. The target PDU is not 
supported by this version of Power IQ, or the plug-in 
requires a proxy index and one was not specified. 

 Specify an appropriate proxy index if one is 
required but was not specified. 

 Make sure Power IQ supports the PDU. See the list 
of supported PDUs at 
http://www.raritan.com/resources/power-iq-rack-pdu
-support/ 

 Create a dynamic plugin for the PDU. See 
Dynamic Plugins (on page 272). 

 
 

Troubleshooting Connectivity Health 

A PDU's Lost Communication or No Contact connectivity health status 
may be caused by one of these common problems. Troubleshoot using 
the following checklist. 

 

Cause Solution 

The user has configured Power IQ with the wrong 
community string for the PDU. 

Verify that Power IQ is configured with the correct 
SNMP community string. 

The user has configured Power IQ with the wrong 
IP address for the PDU. 

Verify that Power IQ is configured with the correct 
IP address. 

There is an actual network connectivity issue 
between Power IQ and the target PDU. 

 Make sure the required ports are open 
between Power IQ and the PDU. See Ports 
Open Between Power IQ and PDUs (on page 
5). 

 Verify that there aren't any other network 
issues preventing communication between 
Power IQ and the target PDU. 

The PDU is powered off or not connected to the 
network. 

Confirm that the PDU is powered on and is 
responding to requests over the network. For 
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Cause Solution 

example, responding to ICMP echo or PING 
requests. 

SNMP support is disabled on the PDU. Some PDUs allow the SNMP agent to be started 
and stopped through the PDU's management 
interface. Verify that SNMP is running on the PDU 
and that it is responding to SNMP requests by 
running SNMP diagnostics from Power IQ or 
through 3rd party tools. 

The configured SNMP timeout and retry value are 
insufficient for your use case. For example, 
managing remote PDUs over a WAN and due to 
network latency or bandwidth limitations, the 
default SNMP settings result in a large number of 
SNMP timeouts. 

If you suspect that the default SNMP settings used 
by Power IQ are insufficient it may be possible to 
correct the issue by modifying the default SNMP 
settings used by Power IQ. See Advanced 
Thread Pooling Settings (on page 17). 

The SNMP agent on the target PDU is not 
responding to requests. One possible reason is 
that the PDU's processor is busy handling other 
tasks and is temporarily unable to respond to 
SNMP requests. 

Verify that SNMP is running on the PDU and that it 
is responding to SNMP requests by running SNMP 
diagnostics from Power IQ or through 3rd party 
tools. If the SNMP agent on the PDU is the issue, 
restarting the SNMP agent on the PDU or 
rebooting the PDU may correct the problem. 

 
 

Trend Chart Settings in Smart Views 

The large trend charts at the top of each smart view are configurable. 

 To change the trend chart settings: 

1. At the bottom of the trend charts section, select the readings and 
time period to include in the fields. 

2. Trend: minimum, maximum or average readings. Not available for 
past hour readings. 

3. For the past: hour, day, week, month. 
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Active Power Trends for Devices 

In the Data Centers tab, an IT device displays the Energy and 
Environmental Trends at the top of its page. Only Active Power data is 
available in the trend chart. 

 If the device has zero or only one connection to outlets or circuits, 
the trend chart displays the total active power only. 

 If the device has more than one connection to outlets or circuits, the 
trend chart displays both the total active power and one active power 
chart per connection. 

The first and last data points in the trend are shown at the left end of the 
chart. 

The minimum and maximum values in the trend are shown at the right 
end of the chart. 

 

To change the trend chart settings, see Trend Chart Settings in Smart 
Views (on page 176). 
 

Actions Menu in Smart Views 

Smart views for rack PDUs and facilities objects include an Actions menu 
in the top right corner.  
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 Choose Actions> Edit to open the edit page for PDU credentials. See 
Editing PDUs under Power IQ Management (on page 22) 

 Choose Actions> Remove to delete the PDU from Power IQ. The 
PDU and all data collected from it are deleted when you remove a 
PDU. Click Remove PDU(s) and Data to confirm. 

 Choose Actions> Rescan to poll the PDU. 

 Choose Actions> Edit Permissions to view and change the roles and 
permissions assigned for users of this PDU. See Assign Roles 
within a Data Center (on page 88) for more details. 

 Click Add Role to > Add User Role or Add Role to > Add Group 
Role. Adding a Group Role will give permissions selected to all 
users in the group. Then, select the user or group who needs 
permission to this object.  

 Choose Actions> SNMP Diagnostics to run SNMP walk on the PDU.  

 Choose Actions> Launch to open the web interface for Raritan PX 
PDUs only. See Launch the Web Interface for a Raritan PX PDU 
(on page 181). 

 

Using the PDUs Tab 

The PDUs tab contains a list of all PDUs added to Power IQ, even if they 
have not been mapped in the EDM. See Creating Your EDM (on page 
135).  

The PDUs list can be configured to meet your needs: 

 Filter the PDUs List (on page 178) 

 Configure the Number of PDUs in the List (on page 179) 
 

Filter the PDUs List 

You can customize your view of the PDUs list by using filters, sorting, 
and hiding or displaying columns of data. 

See Customizing Your View of PDUs, Devices, and Events (on page 
41). 

 To filter the PDUs list: 

In the PDUs tab, all PDUs in the system display in a list. 

Most columns of data contain a filter criteria selection. Click the arrow in 
the column header to open the options. Filter is the last option. 

 Most columns can be filtered by entering a search term in the 
column's filter. 

 Label, Name, Location, Manufacturer, Model, Firmware, Belongs 
To are filtered by search terms. 
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 Belongs To refers to the PDUs parent object in the EDM. For 
example, a PDU probably belongs to a Rack object in the EDM. 
To check, look for the level directly above the PDU in the Data 
Centers tab hierarchy. 

 Filter by PDU health: In the Health column filter, select the health 
statuses you want to view, Good, Warning or Critical, then select the 
source for each status, either Connectivity or Active Events. Select 
multiple options for each as needed. 

 Filter by power readings, including Current (Amps), Active Power 
(Watts), or Apparent Power (VA): In the Current, Active Power or 
Apparent Power column filter, enter the number of amps, watts, or 
volt amperes in the Greater Than (>), Less Than (<) or Equal To (=) 
field to view only PDUs with readings in the correct range.  

 If a PDU has multiple line readings in the Current column, all 
values are shown separated by commas. When filtering by 
Greater Than (>), the highest number is used. When filtering by 
Less Than (<), the lowest number is used. 

 Filter by inlet temperature: In the Inlet Temperature (C) column filter, 
enter the number of degrees Celsius in the Greater Than (>), Less 
Than (<) or Equal To (=) field to view only PDUs with inlet 
temperature sensor readings in the correct range. 

 The inlet temperature shown is the maximum reading for all 
inlet-positioned temperature sensors associated with the PDU.  

 Filter by PDU Type: Types of PDU include rack PDUs, and facilities 
objects managed by dynamic plugin, such as CRACs or Floor PDUs. 
Add the Type column by selecting the checkbox. 

 

Configure the Number of PDUs in the List 

You can configure how many PDUs appear at a time in the PDUs list. 
This preference is set per user. 

You can configure the default number of PDUs that appear in the list, 
and you can change the number of PDUs that appear at any time from 
the PDUs list. 

 To configure the default number of PDUs in the list: 

1. Click your user name link in the top right corner of the page, next to 
the Logoff link. 

2. In the User Information page, click the Prefs tab. 

3. Enter the number of PDUs to list in the Grid Rows field. 

4. Click Save. 
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 To change the number of PDUs in the list: 

1. In the PDUs tab, select the number of PDUs to display from the 
number drop-down list at the bottom of the page. The list refreshes. 

 
 

Export the PDUs List to CSV 

Export the PDU list to create a CSV file containing all the data listed in 
the grid on the PDUs tab. 

The exported file contains the same columns as the page in Power IQ. If 
you have applied filters, the same filters will apply to the exported 
information. 

The export PDUs CSV file is not the same as the file used for importing 
PDUs into Power IQ. See Adding PDUs in Bulk with CSV Files (on 
page 25). 

 To export the PDUs list to CSV: 

1. In the PDUs tab, click the Export/Save icon  in the upper right 
corner of the grid. 

2. Save or open the file using the dialog that appears. 
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Launch the Web Interface for a Raritan PX PDU 

You can launch the web interface for a Raritan PX PDU in Power IQ. 

Users must have identical credentials on Power IQ and on the target 
Raritan product, and be logged in to Power IQ with those credentials for 
single sign on to succeed. Single sign on must be enabled in Settings > 
Single Sign On. See Enabling Single Sign On for Raritan PDUs (see 
"Enabling Single Sign On for Raritan Products" on page 124). 

 To launch the web interface for a PX: 

1. In the PDUs tab, select a Raritan PX PDU. 

2. Hover your mouse on the Actions column, then click the center icon 
to go directly to this PDU in a new window. If single sign on is not 
enabled, log in. 

 

Search for PDUs and Devices 

Use the Quick Search tool at the top of the Power IQ interface to search 
for a PDU or device. 

 

Type the name or IP address of a PDU or device into the Quick Search 
field. If a match is found, Power IQ displays the smart view. 

Note: The PDU display setting affects the Quick Search feature. If IP 
address is selected in the display settings, you can search PDUs by 
either name or IP address. If PDU name is selected, only searching by 
PDU name is permitted. Devices can always be searched by either name 
or IP address regardless of the PDU display preference. See 
Configuring PDU Display Settings - View PDUs by IP or Name (on 

page 40). 
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Power IQ can manage your data center's facilities objects, including 
CRACs, UPSs, Floor PDUs, Standalone Meters, and Power Panels.  

You can work with these objects in Power IQ the same way you work 
with rack PDUs. The PDUs tab, which lists all rack PDUs, also contains 
all facilities objects. 

When you flag your facilities objects as part of your data center's total 
power, Power IQ calculates your Power Usage Effectiveness (PUE). See 
PUE - Power Usage Effectiveness (on page 236). 

Note: Screenshots of smart pages are for illustration purposes only, and 
do not contain real, polled data. 

In This Chapter 

Adding Facilities Objects to Power IQ Management ............................. 182 
Organizing Facilities Objects in the Data Center Browser .................... 183 
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Adding Facilities Objects to Power IQ Management 

You can add facilities objects to Power IQ using the dynamic plugins 
function. The process for adding facilities objects is: 

1. Create a dynamic plugin capable of managing your object. See 
Dynamic Plugins (on page 272). 

2. Add the object using the Add a PDU function. See Adding PDUs to 
Power IQ Management (on page 20). If you use a custom mapping 
dynamic plugin, see Adding PDUs with Custom Dynamic Plugins 
(on page 29). 

3. Make sure the object is included in your enterprise data model 
(EDM), which displays in the Data Centers tab. Objects must be in 
the EDM for inclusion in PUE calculations and Dashboard charts. 
See Enterprise Relationships and the EDM (on page 132). See 
also Organizing Facilities Objects in the Data Center Browser 
(on page 183). 

Chapter 11 Facilities Objects 
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Note: Some rack transfer switches are supported, and you do not need 
to create a dynamic plugin.  

See the list at 
http://www.raritan.com/support/product/poweriq/power-iq-rack-monitored

-devices-support 
 

Organizing Facilities Objects in the Data Center Browser 

Some facilities objects you want to manage in Power IQ, such as floor 
PDUs, power panels, and UPSs may provide power to multiple locations. 

Objects may only have one location in the hierarchical Data Centers 
browser, so associate the object in the enterprise data model using it's 
physical location. Standalone meters may be placed where it best helps 
you understand their data. 

 For example: 

 A floor PDU is physically located on Floor A, but provides power 
to several locations, not all on that floor. Organize the floor PDU 
on Floor A.  

 

CRACs in the Data Center Browser 

You can add a Computer Room Air Conditioner (CRAC) as a node in the 
Data Centers browser. Place the CRAC in the EDM in the location where 
it manages air, rather than the physical location of the CRAC controls.  

 For example: 

 A CRAC serves Rooms 1, 2, and 3 of your data center. Organize 
the CRAC in the EDM at the Floor level that contains these 
rooms. 

 

CRACs 

Computer Room Air Conditioners (CRAC) refers to any HVAC system 
that manages the temperature or humidity of a computer room. It does 
not refer to a standalone raised-floor unit that sits on the data center 
floor. 
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CRAC Smart View 

Power IQ gathers power readings from the CRAC's inlet and inlet lines.  

Note: The data Power IQ can gather depends on how you configure the 
dynamic plugin that manages the object. See Dynamic Plugins (on 
page 272). 

Power IQ displays all data gathered in a smart view. Access the smart 
view by clicking on the object either in the PDUs tab, or in the Data 

Centers browser. 

Power IQ displays all information gathered in a smart view. Access the 
smart view by clicking on the object either in the PDUs tab, or in the Data 
Centers browser.  

A fully populated CRAC smart view includes: 

 CRAC Energy Trends (on page 184) 

 CRAC Readings (on page 185) 

 CRAC Details (on page 186) 
 

CRAC Energy Trends 

Energy Trends display in the top section of the smart view. 

Trend charts display data for the whole unit.  

The trend can be configured to show minimum, maximum, or average 
over a selected time period, using the fields below it. 

CRAC energy trends show a trend line for two readings. 

 Active power 

 Energy 

 Current for each inlet pole 
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CRAC Readings 

Readings display in the second section of the smart view. 

Configure the columns by clicking the arrow in a heading, then selecting 
options to display, hide, or sort. 

CRAC readings include the inlet and the inlet lines. 

 CRAC Inlet Readings shows the Voltage, Current, Active Power, 
Apparent Power, Power Factor, and Energy. 

 CRAC Inlet Line Readings for each line shows the Voltage, Current, 
and Unutilized Capacity 

 The status at the bottom of the Readings section shows the latest 
reading time. 
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CRAC Details 

Details are the fourth section in the smart view. 

 
 

Floor PDUs 

Floor PDUs refers to an intelligent floor PDU system with inlets, panels, 
and branch circuits.  
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Floor PDUs Smart View 

Power IQ gathers power readings from the FPDU inlets, panel inlets, 
circuits, and circuit poles. 

The mapping of the inlets to panels to circuits and circuit poles is 
achieved through your dynamic plugin configuration.  

Note: The data Power IQ can gather depends on how you configure the 
dynamic plugin that manages the object. See Dynamic Plugins (on 

page 272). 

Power IQ displays all data gathered in a smart view. Access the smart 
view by clicking on the object either in the PDUs tab, or in the Data 
Centers browser. 

A fully populated FPDU smart view includes: 

 FPDU Energy Trends (see "Floor PDU Energy Trends" on page 
188) 

 FPDU Elements (see "Floor PDU Elements" on page 191) 

 FPDU Readings (see "Floor PDU Readings" on page 189) 

 FPDU Details (see "Floor PDU Details" on page 192) 
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Floor PDU Energy Trends 

Energy Trends display in the top section of the smart view. 

Trend charts display data for the whole unit.  

The trend can be configured to show minimum, maximum, or average 
over a selected time period, using the fields below it. 

Floor PDU energy trends include a trend line for several types of 
readings. 

 Active Power 

 Energy 

 Current for each line of the master inlet, if applicable. If the FPDU 
does not have a master inlet, trend line for current does not display.  
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Floor PDU Readings 

Readings display in the second section of the smart view. 

Configure the columns by clicking the arrow in a heading, then selecting 
options to display, hide, or sort. 

Floor PDU readings come from the inlets, panel inlets, circuits and circuit 
poles. floor PDUs come in many different configurations. Your 
configuration may vary.  

This sample smart view shows one possible configuration of a 
three-phase floor PDU 

 1 master inlet with 3 lines 

 2 panels 

 Each panel has a panel inlet with 3 lines, and 2 circuits 

 Each circuit has 3 circuit poles 
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Readings start from the "highest level" or top of the power chain. The top of the power 
chain is the first section of readings, progressing down the page to lower points in the 
power chain.  

The master inlet of this 
floor PDU has three 
lines. 

 

Below the master inlet, 
the panel inlets display, 
grouped by panel. Panel 
readings are collapsed 
by default, see Panel 1 in 
the image. 

This floor PDU's Panel 2 
has one panel inlet with 
three lines. 

Below the line readings 
for the panel inlet, the 
circuit readings display. 

This floor PDU's Panel 2 
has 2 circuits, each with 
3 circuit poles. 
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Floor PDU Elements 

Elements display in the third position in the smart view. The title "PDU 
Elements" is used for all types of PDUs and facilities objects.  

The floor PDU's circuits are grouped by panel if mapped accordingly. 
The Elements section is blank for floor PDUs that do not have circuits. 

The default Elements view for floor PDU includes this information: 

 PDU Element: circuits grouped by panel 

 IT Device: IT devices associated with circuits include a link to the IT 
device page. 

 Trend: small trend chart for active power. Change the trend to 
min/max/average active power or current using the fields below it. 

 Active Power (W): latest poll reading for active power. The last 
column can be changed from latest poll reading for active power (W) 
to latest poll reading for current (A) by selecting Current from the 
drop-down list below the PDU Elements section. 

 Apparent Power, Voltage, and Unutilized Capacity 
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Floor PDU Details 

 
 

Floor UPS 

Floor UPS refers to an intelligent, standalone Uninterruptible Power 
Supply (UPS) device. Rack UPS is not supported. 
 

Floor UPS Smart View 

Power IQ gathers power readings from the Floor UPS inlets and inlet 
lines, circuits, and circuit poles. 

The mapping of the circuit poles to circuits is achieved through your 
dynamic plugin configuration.  

Note: The data Power IQ can gather depends on how you configure the 
dynamic plugin that manages the object. See Dynamic Plugins (on 

page 272). 

Power IQ displays all data gathered in a smart view. Access the smart 
view by clicking on the object either in the PDUs tab, or in the Data 
Centers browser. 

A fully populated Floor UPS smart view includes: 

 Floor UPS Energy Trends (on page 193) 

 Floor UPS Elements (on page 195) 

 Floor UPS Readings (on page 193) 

 Floor UPS Details (on page 195) 
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Floor UPS Energy Trends 

Energy Trends display in the top section of the smart view. 

Trend charts display data for the whole unit.  

The trend can be configured to show minimum, maximum, or average 
over a selected time period, using the fields below it. 

Floor UPS energy trends includes a trend line for active power. 

 
 

Floor UPS Readings 

Readings display in the second section of the smart view. 

Configure the columns by clicking the arrow in a heading, then selecting 
options to display, hide, or sort. 

This sample smart view shows one possible configuration of a 
three-phase Floor UPS 

 1 inlet with 3 lines 

 2 circuits 

 Each circuit has 3 circuit poles 
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Readings start from the "highest level" or top of the power chain. The top of the power 
chain is the first section of readings, progressing down the page to lower points in the 
power chain.  

The inlet of this Floor 
UPS has three lines. 

Readings come from the 
whole inlet, and from 
each line for three-phase 
inlets. 

Below the inlet and line 
readings, the circuit and 
circuit pole readings 
display. 

This Floor UPS has 2 
circuits. 

Circuit1 has 3 circuit 
poles. 
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Floor UPS Elements 

Elements display in the third position in the smart view. The title "PDU 
Elements" is used for all types of PDUs and facilities objects. 

The default Elements view for Floor UPS includes this information: 

 PDU Element: circuits  

 IT Device: IT devices associated with circuits include a link to the IT 
device page. 

 Trend: small trend chart for active power. Change the trend to 
min/max/average active power or current using the fields below it. 

 Active Power (W): latest poll reading for active power. Change the 
latest poll reading to Current using the field below it. 

 Apparent Power, Voltage, and Unutilized Capacity 

 
 

Floor UPS Details 

Details are the fourth section in the smart view. 
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Power Panel 

Power Panel refers to a single intelligent power panel on a wall that may 
contain inlets, circuits and circuit poles. 

Anything with multiple panels should be added as a floor PDU, not a 
power panel. 
 

Power Panels Smart View 

Power IQ gathers power readings from the Power Panel's inlets, circuits, 
and circuit poles. 

The mapping of the panels to circuits and circuit poles is achieved 
through your dynamic plugin configuration.  

Note: The data Power IQ can gather depends on how you configure the 
dynamic plugin that manages the object. See Dynamic Plugins (on 

page 272). 

Power IQ displays all data gathered in a smart view. Access the smart 
view by clicking on the object either in the PDUs tab, or in the Data 
Centers browser. 

A fully populated Power Panels smart view includes: 

 Power Panels Energy Trends (on page 197) 

 Power Panels Elements (on page 199) 

 Power Panels Readings (on page 197) 

 Power Panels Details (on page 199) 
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Power Panels Energy Trends 

Energy Trends display in the top section of the smart view. 

Trend charts display data for the whole unit.  

The trend can be configured to show minimum, maximum, or average 
over a selected time period, using the fields below it. 

Power panel energy trends include a trend line for several types of 
readings. 

 Active Power 

 Energy 

 Current, when the power panel has inlet poles 

 
 

Power Panels Readings 

Readings display in the second section of the smart view. 

Configure the columns by clicking the arrow in a heading, then selecting 
options to display, hide, or sort. 

Power Panel readings come from the inlets, circuits, and circuit poles. 
Power panels come in many different configurations. Your configuration 
may vary.  

This sample smart view shows one possible configuration of a 
three-phase Power Panel. 

 1 inlet with 3 lines 

 2 circuits 

 Each circuit has 3 circuit poles 
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Readings start from the "highest level" or top of the power chain. The top of the power 
chain is the first section of readings, progressing down the page to lower points in the 
power chain.  

The inlet of this Power 
Panel has three lines. 

Readings come from the 
whole inlet, and from 
each line for three-phase 
inlets. 

Below the inlet and line 
readings, the circuit and 
circuit pole readings 
display. 

This Power Panel has 2 
circuits. 

Circuit1 has 3 circuit 
poles. 
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Power Panels Elements 

Elements display in the third position in the smart view. The title "PDU 
Elements" is used for all types of PDUs and facilities objects. 

The default Elements view for Power Panels includes this information: 

 PDU Element: circuits  

 IT Device: IT devices associated with circuits include a link to the IT 
device page. 

 Trend: small trend chart for active power. Change the trend to 
min/max/average active power or current using the fields below it. 

 Active Power (W): latest poll reading for active power. Change the 
latest poll reading to Current using the field below it. 

 Apparent Power, Voltage, and Unutilized Capacity 

 
 

Power Panels Details 

Details are the fourth section in the smart view. 
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Standalone Meters 

Standalone Meters refers to a standalone power meter that may be used 
throughout the data center.  
 

Standalone Meters Smart View 

Power IQ gathers power readings from the Standalone Meter's circuits 
and circuit poles. 

The mapping of the circuits and circuit poles is achieved through your 
dynamic plugin configuration.  

Note: The data Power IQ can gather depends on how you configure the 
dynamic plugin that manages the object. See Dynamic Plugins (on 

page 272). 

Power IQ displays all data gathered in a smart view. Access the smart 
view by clicking on the object either in the PDUs tab, or in the Data 
Centers browser. 

A fully populated Standalone Meter smart view includes: 

 Standalone Meter Energy Trends (on page 201) 

 Standalone Meter Elements (on page 203) 

 Standalone Meter Readings (on page 202) 

 Standalone Meter Details (on page 203) 
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Standalone Meter Energy Trends 

Energy Trends display in the top section of the smart view. 

Trend charts display data for the whole unit.  

The trend can be configured to show minimum, maximum, or average 
over a selected time period, using the fields below it. 

Standalone Meter energy trends include a trend line for several types of 
readings. 

 Active Power 

 Current: one trend line for single phase circuits and one trend for 
each line of three-phase circuits 

 

 
 



Chapter 11: Facilities Objects 
 

202
  

 

Standalone Meter Readings 

Readings display in the second section of the smart view. 

Configure the columns by clicking the arrow in a heading, then selecting 
options to display, hide, or sort. 

Standalone Meter readings come from the circuits and circuit poles. Your 
configuration may vary.  

This sample smart view shows one possible configuration of a 
three-phase Standalone Meter. 

 1 circuit with 3 circuit poles 
 

Readings start from the "highest level" or top of the power chain. The top of the power 
chain is the first section of readings, progressing down the page to lower points in the 
power chain.  

The circuit of this 
Standalone Meter has 3 
circuit poles. 

Readings come from the 
whole circuit, and from 
each line for three-phase 
circuits. 
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Standalone Meter Elements 

Elements display in the third position in the smart view. The title "PDU 
Elements" is used for all types of PDUs and facilities objects. 

The default Elements view for Standalone Meters includes this 
information: 

 PDU Element: circuits  

 IT Device: IT devices associated with circuits include a link to the IT 
device page. 

 Trend: small trend chart for active power. Change the trend to 
min/max/average active power or current using the fields below it. 

 Active Power (W): latest poll reading for active power. Change the 
latest poll reading to Current using the field below it. 

 
 

Standalone Meter Details 

Details are the fourth section in the smart view. 
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When you add a PDU to Power IQ, the attached sensors are discovered.  

You can view the list of sensors attached to a PDU in the PDU's smart 
view. See Rack PDU Smart View (on page 156). 

Power IQ automatically associates your sensors into the EDM when their 
PDU is in the EDM. See Automatically Associate Sensors in the EDM 
(on page 139).  

You can change this automatic association to place a sensor in the EDM 
at any room, row, aisle, or rack level. View your sensors in the EDM 
hierarchy in the Data Centers tab. See Creating Your EDM (on page 
135). 

Once associated in the EDM, you can access the sensor smart view. In 
the smart view, you can edit sensor label and position. The sensor smart 
view also has a configurable trend line. See Sensor Smart View (on 
page 204).  

In This Chapter 

Sensor Smart View ................................................................................ 204 
Sensors Connected to PX1 and PX2 PDUs .......................................... 206 
 
 

Sensor Smart View 

Once a sensor is associated in the EDM, you can access the smart view. 

All environmental sensor smart views contain: 

 Sensor Environmental Trends (on page 205) 

A sensor smart view may contain the following options, depending on the 
sensor type: 

 Specify Inlet, Outlet, or Outside Air Location for Environmental 
Sensors (on page 205) 

 Naming Environmental Sensors (on page 206) 
 

Chapter 12 Sensors 
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Sensor Environmental Trends 

The top section of the sensors smart view is a trend line. Configure the 
trend time period using the field below the trend. 

 

Note: If you need to release and then re-manage a sensor associated 
with a Raritan PDU, always use the manual assignment option to ensure 
the accuracy of sensor environmental trends. See Sensor Assignment 

Guideline (on page 210). 
 

Specify Inlet, Outlet, or Outside Air Location for Environmental 
Sensors 

You can specify whether a sensor is inlet or outlet located or if the 
sensor is for outside air. By default, Power IQ considers all 
environmental sensors to be inlet located. 

Sensors are editable only when included in the EDM. See Creating 
Your EDM (on page 135). 

All sensor types can be included in Cooling charts on the dashboard. 
See Cooling Chart Widget (on page 103). 

 To specify inlet or outlet location for environmental sensors: 

 In the sensors smart view, select the Sensor Location: Inlet, Outlet, 
or Outside Air. 
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Naming Environmental Sensors 

Environmental sensors have sensor labels that you can change in Power 
IQ.  

The following PDUs support naming environmental sensors, depending 
on model: APC, Eaton, Baytech, Liebert, Raritan, Servertech, Sinetica.  

Sensor names cannot include only white space characters. The 
maximum name length is 256 characters. The maximum name length for 
PX1 sensors is 33 characters. 

Sensor labels must be unique. During polling, if Power IQ finds two 
sensors of the same type with the same name, the sensor readings for 
those sensors are not saved. Power IQ adds an error message to the 
audit log.  

SNMP read and write access to the PDU is required to name sensors. 
See Adding PDUs to Power IQ Management (on page 20). 

 To name environmental sensors: 

 In the sensors smart view, enter a unique name in the label field, 
then click Save. 

 
 

Sensors Connected to PX1 and PX2 PDUs 

Raritan PX1 and PX2 PDUs support environmental and contact closure 
sensors, which you can poll through Power IQ. 

The sensors must be setup and configured correctly via PX1 or PX2 
before they will work correctly with Power IQ. 

See the online help for your PX model PDU here: 

http://www.raritan.com/support/product/px/ 

http://www.raritan.com/support/product/px2/ 
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States of Managed Sensors 

An environmental sensor shows the state after being managed. 

Available sensor states vary depending on the sensor type -- numeric or 
discrete sensors. For example, a contact closure sensor is a discrete 
(on/off) sensor so it switches between three states only -- unavailable, 
alarmed and normal. 

Note: Numeric sensors show both numeric readings and sensor states to 
indicate environmental or internal conditions while discrete (on/off) 
sensors show sensor states only to indicate state changes. 

Sensor state Applicable to 

unavailable All sensors 

alarmed Discrete sensors 

normal Discrete sensors 

ok Numeric sensors 

below lower critical Numeric sensors 

below lower non-critical Numeric sensors 

above upper non-critical Numeric sensors 

above upper critical Numeric sensors 

Note: The state change of a contact closure sensor occurs only if the 

sensor enters the new state for at least 1 consecutive sample. 
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"unavailable" State 

The unavailable state means the connectivity or communications with the 
sensor is lost. 

The Raritan PX pings all managed sensors at regular intervals in 
seconds. If it does not detect a particular sensor for three consecutive 
scans, the unavailable state is displayed for that sensor. 

When the communication with a contact closure sensor's processor is 
lost, all detectors (that is, all switches) connected to the same sensor 
package show the "unavailable" state. 

Note: When the sensor is deemed unavailable, the existing sensor 
configuration remains unchanged. For example, the ID number assigned 
to the sensor remains associated with it. 

The Raritan PX continues to ping unavailable sensors, and moves out of 
the unavailable state after detecting the sensor for two consecutive 

scans. 

Connected sensors always show unavailable if they are NOT under 
management. 

For DPX2 or DX sensor packages, all of the connected sensor packages 
also enter the unavailable states if any of them is upgrading its sensor 

firmware. 
 

"normal" State 

This state indicates the sensor is in the normal state. 

For a contact closure sensor, usually this state is the normal state you 
have set. 

 If the normal state is set to Normally Closed, the normal state means 
the contact closure switch is closed. 

 If the normal state is set to Normally Open, the normal state means 
the contact closure switch is open. 

For a Raritan's floor water sensor, the normal state must be set to 
Normally Closed, which means no water is detected. 

Note: See Environmental Sensors Guide for information on setting the 
normal state or dip switch. This guide can be downloaded from the 
Raritan website's PX2 Support Files page 

(https://www.raritan.com/support/product/px2/px2-support-files). 
 

https://www.raritan.com/support/product/px2/px2-support-files
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"alarmed" State 

This state means a discrete (on/off) sensor is in the "abnormal" state. 

Usually for a contact closure sensor, the meaning of this state varies 
based on the sensor's normal state setting. 

 If the normal state is set to Normally Closed, the alarmed state 
means the contact closure switch is open. 

 If the normal state is set to Normally Open, the alarmed state means 
the contact closure switch is closed. 

For a Raritan's floor water sensor, the normal state must be set to 
Normally Closed, which means no water is detected. The alarmed state 

indicates that the presence of water is detected. 

Note: See Environmental Sensors Guide for information on setting the 
normal state or dip switch. This guide can be downloaded from the 
Raritan website's PX2 Support Files page 

(https://www.raritan.com/support/product/px2/px2-support-files). 
 

Tip: A contact closure sensor's LED is lit after entering the alarmed state. 
Determine which contact closure switch is in the "abnormal" status 

according to the corresponding LED. 
 

"ok" State 

Only a numeric sensor shows this state. This state means the sensor 
reading is within the acceptable range as indicated below: 

Lower Non-Critical threshold  <=  Reading  <  Upper Non-Critical 
threshold 

Note: The symbol <= means smaller than (<) or equal to (=). 
 

"below lower critical" State 

This state means a numeric sensor's reading is below the lower critical 
threshold as indicated below: 

Reading  <  Lower Critical Threshold 
 

"below lower non-critical" State 

Only a numeric sensor shows this state. 

This state means the sensor reading is below the lower non-critical 
threshold as indicated below: 

Lower Critical Threshold <= Reading < Lower Non-Critical Threshold 

https://www.raritan.com/support/product/px2/px2-support-files
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Note: The symbol <= means smaller than (<) or equal to (=). 
 

"above upper non-critical" State 

Only a numeric sensor shows this state. 

This state means the sensor reading is above the upper non-critical 
threshold as indicated below: 

Upper Non-Critical Threshold <= Reading < Upper Critical Threshold 

Note: The symbol <= means smaller than (<) or equal to (=). 
 

"above upper critical" State 

This state means a numeric sensor's reading is above the upper critical 
threshold as indicated below: 

Upper Critical Threshold  <=  Reading 

Note: The symbol <= means smaller than (<) or equal to (=). 
 

Sensor Assignment Guideline 

A Raritan PDU allows users to release managed sensors and then bring 
them back under management, using either automatic or manual 
assignment option. 

 Automatic assignment: This option may change the sensor ID on the 
PDU. Therefore, sensor indexes of the same sensor type are likely to 
swap in Power IQ, causing the sensor readings to swap as well. 
Power IQ users must not use this option. 

 Manual assignment: This option permits users to specify the original 
sensor ID so that no sensor indexes and readings are swapped in 
Power IQ. Always use this option to ensure the sensor data accuracy 
in Power IQ. 
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Power control is only available for PDUs that support this feature. 

Power IQ must have valid SNMP write access to the PDU for power 
control to work. 

In This Chapter 

Enable or Disable Power Control .......................................................... 211 
Configure Power Control Options .......................................................... 211 
Control Power to Outlets in a Data Center ............................................ 212 
Control Power to Devices in a Group .................................................... 213 
Power Cycle a Device ........................................................................... 214 
Scheduling Power Control ..................................................................... 215 
Configuring Graceful Shutdown ............................................................ 216 
Preparing Servers for Graceful Shutdown ............................................. 220 
When Will Graceful Shutdown Abort? ................................................... 222 
Create Device Groups for Power Control .............................................. 222 
Set a Different Power On Delay for a Device ........................................ 224 
 
 

Enable or Disable Power Control 

Only authorized users can control power. See Role Definitions (see 
"Power IQ Role Definitions" on page 83). 

1. In the Settings tab, click Power IQ Settings in the Appliance 
Administration section. 

2. In the Power Control Settings box, select the "Enable power control" 
checkbox to enable power control. 

3. Click Save Power Control Settings. 
 

Configure Power Control Options 

 To configure power control options: 

1. In the Settings tab, click Power IQ Settings in the Appliance 
Administration section. 

2. In the Power Control Settings box: 

a. Select the "Enable power control" checkbox to enable power 
control. 

b. Select the "Require reason message for power control 
operations" checkbox to require users to log a reason for all 
power control operations. 

Chapter 13 Power Control 
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c. Select the "Allow ad hoc power control for rooms, aisles, rows, 
and racks" to allow authorized users to control power at the room, 
aisle, row and rack levels of the data center. 

d. Select the "Allow scheduled power control" checkbox to allow 
authorized users to schedule power control tasks. 

3. Click Save Power Control Settings. 
 

Control Power to Outlets in a Data Center 

You must enable power control. See Enable or Disable Power Control 
(on page 211).  

Power control is available at the outlet and IT device outlet group level, 
unless you also enable higher levels, such as all outlets in a rack, row, 
aisle, or room. See Configure Power Control Options (on page 211).  

You must be assigned a role that permits power control. See Power IQ 
Role Definitions (on page 83). 

For details about controlling power in the Smart Rack and Smart PDU 
views, see IT Devices - Smart Rack View (see "Rack IT Devices" on 
page 165) and PDU Elements  - Smart Views (see "PDU Elements - 
Rack Smart View and Rack PDU Smart View" on page 167). 

Warning: Graceful shutdown is not supported when controlling power 
from the Smart Rack or Smart PDU pages, which are accessed by 
clicking the rack or PDU in the EDM/Data Centers tab. Use the 
right-click option on the rack or PDU in the EDM, or the power control 
options in the Devices tab for graceful shutdown. 

 To control power in the Data Centers tab: 

1. In the Data Centers tab, select the data center level, such as a rack, 
that contains the outlets you want to control. 

2. Select the checkboxes of the outlets you want to control in the IT 
Devices or PDU Elements section. 

3. Click Power Control > On or Power Control > Off. 

4. If required, enter a reason message for the power control operation, 
and click OK to confirm. 

 To control power with right-click in the Data Centers tab: 

1. In the Data Centers tab, right-click an IT device, or higher level, if 
enabled, then select On or Off. 

2. If required, enter a reason message for the power control operation, 
and click OK to confirm. 
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 To control power in the PDUs tab: 

1. In the PDUs tab, select a PDU, then click View. 

2. Select the checkboxes of the outlets you want to control in the 
Readings section. 

3. Click Power Control > On, Power Control > Off, or Power Control > 
Cycle. 

4. If required, enter a reason message for the power control operation, 
and click OK to confirm. 

 To control power in the Devices tab: 

1. In the Devices tab, select a device. 

2. Click Power Control > On or Power Control > Off. 

3. If required, enter a reason message for the power control operation, 
and click OK to confirm. 

 

Control Power to Devices in a Group 

You can manually control power to devices in a group, or schedule a 
task to run a power control operation at a specified time. 

 To control power to devices in a group manually: 

1. In the Devices tab, choose Activities > Device Groups. 

2. Select the checkbox for the device group you want to control power 
to.  

3. Click Power Control > On or Power Control > Off.  

 All devices in the group are powered on or off sequence specified 
in the group settings.  

 Devices are powered off in sequence, and powered on in the 
reverse sequence. 

 See Create Device Groups for Power Control (on page 222).  

 Devices in the group that are configured with graceful shutdown 
will be shutdown when a power off operation is selected here. 
The configured graceful shutdown delay is used. See 
Configuring Graceful Shutdown (on page 216). 

 To control power to devices in a group via a scheduled task: 

See Add a Power Control Task (on page 215). 
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Power Cycle a Device 

The power cycle feature enables you to hard power cycle devices that 
are mapped to one or more outlets. This can be useful in the event of a 
major software failure.  

Graceful shutdown does not apply when using power cycle. There is a 
30 second delay after the last outlet is turned off before turning the first 
outlet back on. 

 To power cycle a device: 

1. In the Devices tab, click the IT device name link in the Devices tab to 
go to the IT device page in the Data Centers tab. The EDM expands 
to show the IT device. 

2. Find the power cycle button in either of these locations.  

 Right-click the IT Device in the EDM, choose Power Control > 
Cycle. 

 

 Click Power Cycle in the center of the IT Device details page.  

 

3. If required, enter a reason message for the power control operation, 
and click OK to confirm. 



 Chapter 13: Power Control  

 
215

 
 

4. A status bar shows progress and success or failure message. 
 

Scheduling Power Control 

You can schedule power control for device groups only. 
 

View Power Control Task Results 

View the results of power control tasks that have been scheduled. 

Note: Make sure that power control and scheduled power control are 
enabled. See Enable or Disable Power Control (on page 211). 

 To view power control task results: 

1. In the Devices tab, choose Activities > View Task Results. The 
Power Scheduling Task Results page opens.  

2. Click a task name link to view the results. 
 

Add a Power Control Task 

Schedule a power control task to control power to a device group at a 
specified time. You can schedule a task that runs only once, or that 
recurs on a regular schedule. 

You must create device groups before you add power control tasks. See 
Create Device Groups for Power Control (on page 222). 

 To add a power control task: 

1. In the Devices tab, choose Activities > Add New Task. The New 
Power Scheduling Task page opens.  

2. Select Power On or Power Off. If Graceful Shutdown is configured 
for a device in the device group, a power-off task will use graceful 
shutdown automatically, unless you select the Skip Graceful 
Shutdown checkbox in the next step. 

3. Select the Skip Graceful Shutdown checkbox to force a hard 
shutdown for all devices in the device group, even if graceful 
shutdown is enabled. 

4. Select the Leave Outlets On checkbox to leave outlets powered on in 
cases where devices have been powered off using graceful 
shutdown. 

5. Select the Device Group for the power control operation. 

6. Specify when the task should run. 

 To schedule a task that runs only once, select the Date from the 
calendar in the Run Once section.  
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 To schedule a task that recurs, select the checkboxes for the 
days of the week the task should run in the Recurring section. 

 For both types, select the time the task should run in the Hour 
and Minute fields. 

7. Select the Active checkbox to allow this task to run. Deselect this 
checkbox to stop the task from running. 

8. Click Save. 
 

Configuring Graceful Shutdown 

You can configure Power IQ to send a graceful shutdown command to a 
server before powering off outlets. Power IQ allows you to define a set of 
system-wide shutdown commands with credentials to use across 
multiple devices. Power IQ supports both SSH and NetRPC commands 
to shutdown either Unix or Windows servers. 

 Process for Configuring Graceful Shutdown in Power IQ:  

1. Enable power control. See Enable or Disable Power Control (on 
page 211). 

2. Prepare your servers for graceful shutdown: check open ports, 
define accounts for authentication, test authentication methods. See 
Open Ports for Graceful Shutdown (on page 220) and Preparing 
Servers for Graceful Shutdown (on page 220). 

3. Add the shutdown commands to Power IQ. See Add Shutdown 
Commands (on page 217).  

4. Enable graceful shutdown for the server, known as an IT Device in 
Power IQ, specify the command and wait time, and test the 
connection. See Enable Graceful Shutdown for an IT Device (on 
page 218). 

5. To shutdown servers, use the power control functions. 

a. Add a power control task to schedule the power off for a device 
group. See Add a Power Control Task (on page 215). 

OR 

b. Power off an individual outlet. See Control Power to Outlets in 
a Data Center (on page 212). 
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Add Shutdown Commands 

Add shutdown commands if you want to enable graceful shutdown to 
occur on servers before Power IQ switches off outlets. Graceful 
shutdown will occur both when you manually power outlets off or when a 
scheduled power control task runs. 

You can test the commands you configure when you enable graceful 
shutdown for a particular device. See Enable Graceful Shutdown for 
an IT Device (on page 218). 

 Add shutdown commands using Windows Remote Shutdown 

Windows Remote Shutdown is the most common choice for shutting 
down Windows systems. 

1. In the Devices tab, choose Activities > Shutdown Commands. The 
Add New Shutdown Command page opens. 

2. Click Add. 

3. Select Using Windows Remote Shutdown and click Next. 

4. In the Name field, enter a name to describe this shutdown command. 
This name appears in the list of shutdown commands to be selected 
when you enable graceful shutdown for a server. See Enable 
Graceful Shutdown for an IT Device (on page 218). 

5. In the Login field, enter the username of the account to be 
authenticated on each server to be shutdown. 

 Login can include letters, digits, underscores, dots, and hyphens. 

6. In the Password and Password Confirmation fields, enter the 
password for the username in the Login field. 

7. In the Comment field, enter the message to display to users of the 
server when it is shutdown. 

8. Click Add. 

 Add shutdown commands using SSH: 

SSH is the most common choice for shutting down Linux, Unix, or other 
systems: 

1. In the Devices tab, choose Activities > Shutdown Commands. The 
Add New Shutdown Command page opens. 

2. Click Add. 

3. Select SSH and click Next. 

4. In the Name field, enter a name to describe this shutdown command. 
This name appears in the list of shutdown commands to be selected 
when you enable graceful shutdown for a server. See Enable 
Graceful Shutdown for an IT Device (on page 218). 
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5. In the Login field, enter the username of the account to be 
authenticated on each server to be shutdown. 

 Login can include letters, digits, underscores, dots, and hyphens. 

6. Enter the appropriate credentials for the account specified in the 
Login field. See Basic Configuration for SSH Shutdown  (on 
page 220)for more details on authentication. The following options 
are valid. 

a. Password and Password Confirmation 

b. Private Key 

c. Private Key and Passcode and Passcode Confirmation 

7. In the Command field, enter the command. See Sample SSH 
Shutdown Commands (on page 221) for examples.  

8. Click Add. 
 

Enable Graceful Shutdown for an IT Device 

Enable graceful shutdown for an IT Device if you want Power IQ to send 
a shutdown command that you configure to a server before powering it 
off.  

You must add the shutdown commands before enabling graceful 
shutdown. See Add Shutdown Commands (on page 217). 

 To enable graceful shutdown for an IT device: 

1. In the Data Centers tab, select a device that requires graceful 
shutdown to be enabled. 

2. Make sure the IP address for the device is completed in the IP 
Address field. 

3. Expand the Graceful Shutdown section of the IT Device details page 
and select the Graceful Shutdown checkbox. 

4. Select the command to send to the server from the Shutdown 
Command list. You must add commands to Power IQ before 
selecting a command here. See Add Shutdown Commands (on 
page 217).  

5. In the Shutdown Wait field, enter the number of seconds Power IQ 
should wait for the shutdown to complete before powering off the 
associated outlet. 

6. Click Test Connection. Power IQ attempts to connect to the device 
using the selected command. If you see a success message, click 
Save. If you see an error message, click View Log in the dialog to 
troubleshoot the failure. 

7. Click Save to save all changes. 
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Disable Graceful Shutdown for an IT Device 

There are two methods for disabling graceful shutdown for an IT Device. 

 Remove the IT device from the shutdown command details 
page: 

1. In the Devices tab, choose Activities > Shutdown Commands. 

2. Select the shutdown command that you want to disable for the IT 
device. 

3. Select the IT device in the Devices Using Shutdown Command list 
and click Remove. 

4. Click Yes to confirm. The command is removed from the IT device 
and graceful shutdown is disabled.  

 Disable graceful shutdown from the Data centers tab: 

1. In the Data Centers tab, select a device that requires graceful 
shutdown to be disabled. 

2. Expand the Graceful Shutdown section of the IT Device details page 
and deselect the Graceful Shutdown checkbox. 

3. Click Save. 
 

View the IT Devices Using a Shutdown Command 

View the shutdown command details to see a list of IT Devices using 
each shutdown command. 

 To view the IT devices using a shutdown command: 

1. In the Devices tab, choose Activities > Shutdown Commands. 

2. Select the shutdown command whose usage you want to view and 
click Edit. 

3. The list of IT devices that are using the shutdown command displays 
below the command details. 

 

Remove a Shutdown Command from Power IQ 

When you remove a shutdown command from Power IQ, you can assign 
a different command to the IT devices that were using the removed 
command. Or, you can disable graceful shutdown for those devices. 

 To remove a shutdown command from Power IQ: 

1. In the Devices tab, choose Activities > Shutdown Commands link. 

2. Select the command you want to remove from Power IQ and click 
Remove. 
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3. If the command is being used by any IT devices, a dialog appears. 
an option and click 

a. Select Remove Command from Devices and Disable Graceful 
Shutdown, and click OK to remove the command from Power IQ 
and not assign a different shutdown command to the IT devices. 

OR 

b. Select Assign Another Shutdown Command to Devices, and 
then select a different shutdown command from the list, and click 
OK, to assign a different shutdown command to the IT devices. 

 

Preparing Servers for Graceful Shutdown 

Servers must be configured to allow the shutdown commands to run 
when you enable graceful shutdown from Power IQ. 
 

Open Ports for Graceful Shutdown 

Servers that will receive graceful shutdown commands from Power IQ 
must have the following open ports. 

 Unix/Linux: 

 TCP 22: For SSH commands only. Custom SSH ports are not 
supported.  

 Windows: 

 TCP 139: NetBIOS Session Service, for Windows systems only.  

 TCP 445 : For NetRPC commands only.  
 

Basic Configuration for SSH Shutdown 

 Open Ports 

 Open port 22. 

 Authentication for SSH:  

 Power IQ can send a shutdown command via SSH to systems that 
share an authentication method, including the following methods. 

 common user directories 

 common username and password 

 common username and password (users managed by a common 
LDAP server) 

 common username and encrypted key: Append the public key file 

as a string to the ~/.ssh/authorized_keys file of the user 

on each machine to be shut down. 
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 The user must have permission to shut down the machines using the 
authentication method. 

 Each authentication method must be tested from the command line. 

 Shutdown Commands: 

There are two types of shutdown commands that you can use in Power 
IQ. 

1. A call to the native shutdown command, which varies by Unix type 

OR 

2. A common shutdown script that carries out a backup 

 Each method must be tested from the command line of each 
machine to be shut down 

 The command has 30 minutes to complete before Power IQ 
stops trying. If the time expires, Power IQ closes the SSH 
connection, logs an error, and does NOT power off the outlet.  

 If the command returns stderr, Power IQ assumes a failure. 
Power IQ logs stdout and stderr. 

 Error details are written to the Power IQ log. 
 

Sample SSH Shutdown Commands 

Resources for information on writing SSH shutdown commands: 

http://www.unix.com/man-page/OpenSolaris/1m/shutdown/ 

 Sample Linux command: 

/sbin/shutdown -h now 

 Sample OpenSolaris command:  

sudo -E /usr/sbin/shutdown -y -i5 -g5 
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Basic Configuration for Windows Remote Shutdown 

NetRPC shutdown commands can be used to shutdown Windows 
machines remotely. 

 Open ports: 

Open port 445. 

 Authentication: 

The Windows Remote Shutdown command requires a user account 
whose security policy allows shutdowns from a remote system. 

Each server that will receive graceful shutdown commands must accept 
the user account's username and password. 

 Windows Server Configuration: 

RPC commands must be enabled on each Windows server that you will 
shutdown via Power IQ. 
 

When Will Graceful Shutdown Abort? 

If there is any error between beginning to connect with the server and the 
server returning from the shutdown script with a non-zero code, that is, 
no errors in the script, then the attempt is marked as failed and the outlet 
task does not proceed. 
 

Create Device Groups for Power Control 

Create a group of devices when you need to perform a power control 
task on the whole group. You can control power to the group manually, 
or by scheduling a power control task to run at a certain time. See 
Control Power to Outlets in a Data Center (on page 212) and 
Scheduling Power Control (on page 215). 
 

Create a Device Group 

 To create device groups for power control: 

1. Make sure power control and scheduled power control is enabled. 
See Enable or Disable Power Control (on page 211) and 
Configure Power Control Options (on page 211). 

2. In the Devices tab, select the devices you want to add to the group. 

3. Click Add to Device Group > Create a new device group. 

4. In the "Create a new device group" dialog, enter a name for the 
group, then click "Create device group".  
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5. The group is created, and the selected devices are added. A 
success message displays. Click "View device group" to open the 
device group details, where you can set the default power control 
delays and sequence of devices for power control operations. See 
Configure the Power Control Settings for a Device Group (on 
page 223). 

 

Add Devices to an Existing Device Group 

Once groups have been created, you can add devices to the group in the 
Devices tab. 

1. In the Devices tab, select the devices you want to add to the group. 

2. Click Add to Device Group, and the list of groups that have been 
created displays beneath the "Create a new group" option. Select the 
group you want to add the devices to.  

 

Add Devices to a Group in the Data Centers Tab 

You can add one device or all devices within a data center, row, rack, 
and so on, to a group in the Data Centers tab.  

 To add devices to a group from the Data Centers tab: 

1. In the Data Centers tab, select a device to add to the group. To add 
all devices from a section of the data center, select the room, or aisle, 
or rack. You can select any level, up to and including the data center. 

2. Right-click the selected level, select "Add devices to a device group", 
then select the group. To add a group, select "Create a new device 
group", enter a device group name then click "Create device group." 

 

Configure the Power Control Settings for a Device Group 

Configure each device group to set the default power control delay and 
the sequence of devices for power control operations. 

 To configure the power control settings for a device group: 

1. In the Devices tab, choose Activities > Device Groups. 

2. Click a device group Name link. The Edit Device Group page opens. 

3. Set the Default Power On Delay (sec), which is the number of 
seconds that Power IQ delays after powering on each device in the 
sequence of devices in a group. These settings are the default 
power-on delay for all new devices you add to the group. 

4. Set the sequence for power control operations. Select a device, then 
click Up, Down, Top, Bottom, and Move To to arrange the device list 
in the sequence that power control operations should occur. 

 Devices will power off in the sequence set. 
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 Devices will power on in the REVERSE sequence set. 
 

Remove a Device from a Group 

 To remove a device from a group: 

1. In the Devices tab, choose Activities > Device groups. 

2. Click the device group Name link. 

3. Select the device you want to remove, then click Remove. The 
device is removed from the group, but not removed from Power IQ. 

 

Set a Different Power On Delay for a Device 

Power IQ will follow the default delay setting for power-on sequences, 
unless you specify a different delay setting for a device. Delays are for 
power-on sequences only. The delay occurs after each power-on 
operation completes. 

1. In the Devices tab, click a device group Name link in the Device 
Groups column. The Edit Device Group page opens. 

2. Select the device in the Devices in This Group list, then double-click 
the Power On Delay value and enter a new value in the field. 
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What are Power IQ Analytics? 

The Analytics tab allow you to create and view custom reports based on 
Power IQ's knowledge of your data center and the power measurements 
it takes. 

Reports are created as a way to organize charts. See Adding Reports 
to the Analytics Page (on page 227). 

Each report can contain one or more charts. There are two chart types: 
Device and Health. See Creating a Chart (on page 229). 

 Device charts show power measurements of your devices. See 
Device Chart Settings (on page 229). 

 Health charts show connectivity and event statuses of your PDUs. 
See PDU Health Chart Settings (on page 234). 

This list contains some examples of the types of information you can 
include in charts: 

 The Active Power consumed by Test Rack #2 over the past hour. 

 How many Kilowatt Hours were used by Rows A, B and C in the 
Data Center last month. 

 If power costs $0.062 per kWh, what did the IT server room cost to 
power last year? 

 What is the health status of all PDUs in the system, based on 
connectivity and events received? 

You must configure an Enterprise Data Model before using Analytics. 
The Enterprise Data Model populates the Data Center tab with a 
hierarchical representation of your data center. See Enterprise 
Relationships (see "Enterprise Relationships and the EDM" on page 
132). 
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Adding Reports to the Analytics Page 

The analytics page can include multiple report pages. A report page is a 
collection of one or more charts. Creating multiple reports is a good way 
to organize the Analytics information by category or specific need. 

 To add a report to the Analytics page: 

1. Click Add in the Reports column and enter a name for the report.  

2. In the Reports toolbar, select the Share This Report checkbox to 
make the report and charts public. 

 To view a report: 

 In the Analytics tab, select a report in the Reports column. The report 
opens in the main section of the page. 

 If the report has been shared by another user, you cannot edit it. 
Shared reports are marked as "Shared by username." 
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Sharing Reports on the Analytics Page 

Choose to share a report when you want to make it public. Sharing 
reports gives other Power IQ users access to the report, and the charts it 
contains. 

Users must have the View and the Create Reports and Dashboards role 
assigned to view your shared reports.  

Reports that are shared are marked in the list as "shared by you." 
Reports that have been shared by other users are marked as "shared by 
username." 

The data that displays in a report is based on each individual user's 
permissions in Power IQ. If another user does not have permission to 
see information about a rack or datacenter, for example, that you have 
shared a report about, the user will not see the data. 

Users that you share a report with cannot edit your report. You cannot 
edit reports that you did not create. 

 

 To share reports on the Analytics page: 

1. In the Analytics tab, select a report on the left side of the page. 

2. In the Reports toolbar, select the Share This Report checkbox to 
make the report and charts public. 

 To make reports private on the Analytics page: 

1. In the Analytics tab, select a report on the left side of the page. 

2. In the Reports toolbar, deselect the Share This Report checkbox to 
remove the report from public view.  
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Creating a Chart 

You must add a report before you can create a chart. See Adding 
Reports to the Analytics Page (on page 227). 

 To create a chart: 

1. In the Analytics tab, select a report on the left side of the page. 

2. Click Add Chart, then select Device Chart or Health Chart. 

 Device charts show power measurements of your devices. See 
Device Chart Settings (on page 229). 

 Health charts show connectivity and event statuses of your PDUs. 
See PDU Health Chart Settings (on page 234). 

You can change the location of any chart by clicking on the title bar 
of the chart and dragging it to its new position. 

 

Configuring Charts 

Configure a chart to select the data you want to analyze. 

Charts created in the Analytics tab can only be viewed in the Analytics 
tab. Charts configured in the Dashboards tab can be viewed in the 
Dashboards tab, or in a Dashboard slide show. See Dashboard (on 
page 90). 

 For device chart details, see Device Chart Settings (on page 229).  

 For PDU health chart details, see PDU Health Chart Settings (on 
page 234). 

 

Device Chart Settings 

A device chart displays power measurements for the devices in your 
data centers. Devices must be mapped to rack PDU outlets or circuits in 
the EDM before the data can be charted. See Creating Your EDM (on 
page 135). 

You can configure a device chart on the Analytics tab or on the 
Dashboards tab.  

To chart facilities objects, see Facilities Chart Widget (on page 112) 

 To configure device chart settings: 

1. In the Analytics tab, select a Report. The charts contained in the 
Report open. On the chart you want to configure, click the Settings 

icon . See Creating a Chart (on page 229) for 
details on adding a new chart. 

OR 
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In the Dashboards tab, add a device chart widget, then click the 

Settings icon  in the widget. See Device Chart 
Widget (on page 96). 

2. The Device Chart Settings dialog appears.  

3. In the Measurement field, select the type of measurement you want 
to analyze from the drop-down list.  

 The measurement is represented on the y-axis of the chart. 

 See Device Chart Measurements (on page 233). 

4. In the Time Selection section, select Period or Range. 

 Select Period to show constantly updated measurement, such as 
power consumption over the Past hour, Past week, Past month, 
and so on. Select the time period from the drop-down list. See 
What's the difference between "Past" and "Last" time 
periods? (on page 232)  

 Select Range to show measurements from a custom Start Date 
and End Date. Select the start and end dates using the calendar 
dialogs. 

 The time selection is represented on the x-axis of the chart. 

5. In the Granularity field, if available, select the level of granularity of 
data to chart. Hourly will show 1 data point per hour for the time 
period the chart includes, when the time period is 24 hours or longer. 
Poll Interval will show 1 data point per poll interval for the time period 
the chart includes.  

 The Poll Interval must be set to 5 minutes or longer to use Poll 
Interval granularity.  

6. In the Line Configuration field, select an option to determine how 
many lines are on a chart, and how the lines are configured. 

 Select "Manually define lines" to choose the data for each line 
individually. You can add data from different sections of the data 
center to the same chart with this option. See Manually Define 
Individual Device Chart Lines (on page 231). Click the 
Individual Lines (Advanced) tab to configure the lines.  

 Select "Automatically define lines" then select a node from your 
enterprise data model in the Show field to show 1 line of data in 
the chart. Select the "One line per child" checkbox to show 1 line 
of data per child of the location selected in the Show field. For 
example, 1 line per child of a data center may show 1 line per 
room. Parent-child relationships are determined by the structure 
of your enterprise data model, as configured in the Data Centers 
tab.  
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Note: Humidity and Temperature measurements cannot be 
represented as one line per child. To chart one line per humidity or 

temperature sensor, use "Manually define lines." 

7. In the External Key field, enter the external key of the PDU to filter 
the chart's data by that value. 

8. In the Custom Fields 1 and 2, which may be renamed in your system, 
enter a PDU custom field value to filter the chart's data by that value.  

9. Select Minimum, Maximum, or Average to specify whether you want 
the lowest values, highest values, or an average of the data for the 
measurement you selected. Min/Max/Average is not available for all 
measurements. 

10. Click View Matching PDUs to view the list of PDUs to be included in 
the chart data. 

11. The text in the Name field displays as the chart title. Select the Auto 
Name checkbox to allow the name to configure automatically, based 
on the criteria of the chart. Deselect the Auto Name checkbox to 
enter a name manually. 

12. The Include Legend checkbox is enabled by default, and a chart 
legend for the data will be included. Deselect the Include Legend 
checkbox to remove the legend.  

 Removing the legend can make a chart more readable, 
depending on how many lines of data are included. 

13. Click OK to save the settings and view the chart. 
 

Manually Define Individual Device Chart Lines 

You can manually define individual device chart lines to choose the data 
for each line individually. 

You can add data from different sections of the data center to the same 
chart with this option. 

 To manually define individual device chart lines: 

See Device Chart Settings (on page 229) to start the chart 
configuration. In the Chart Settings, select "Manually define lines" to 
enable the Individual Lines (Advanced) tab. 

1. In the Individual Lines (Advanced) tab, select a line in the Lines 
column.  

 By default there is one line, called Power IQ, that represents the 
whole system.  
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2. In the "Select what you want to see on this line" field, click the 
browse button, then select the data center node you want to chart on 
this line. Expand or collapse the nodes by clicking the plus and 
minus signs. The name of the node selected displays in the field at 
the bottom on the dialog. Click Select Node to save the line. 

3. To add more lines, click Add, then select the line and repeat step 2 
to configure it. 

4. To filter a line to a more granular level, select the line in the Lines 
column, then enter your criteria in the fields in the Filter by Device 
Properties section.  

 For example, to configure a chart that includes 1 line per rack or 
row for a certain customer, add 1 line for each rack or row, then 
enter the name of the customer in the Customer Name field of 
each line. 

 Note: Filtering for Device Type, Customer, Custom Field 1 and 
Custom Field 2 will include any match that includes your search 
term, not just exact matches. For example, "ABC" will include 
"ABC" and "ABC123". 

5. The text in the Name field displays as the line name in the legend of 
the chart, when legends are enabled. Select the Auto Name 
checkbox to allow the name to configure automatically, based on the 
criteria of the line. Deselect the Auto Name checkbox to enter a 
name manually. 

6. Click the Chart Settings tab to finish the other chart configurations. 
See Device Chart Settings (on page 229). 

7. Click Save. 
 

What's the difference between "Past" and "Last" time periods? 

 A Past measurement indicates the selected period of time up to the 
current moment.  

For example: If you view a device chart on Tuesday, and the period 
is set to Past Week, the chart includes data from last Tuesday 
through this Tuesday. 

 A Last measurement indicates the most recent completed period of 
time.  

For example: If you view a device chart on Tuesday, and the period 
is set to Last Week, the chart includes data from last Sunday through 
last Saturday. The chart shows the last full week. 
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Device Chart Measurements 

Device charts can be configured for many kinds of measurements. 

 Power Reading Charts: 

 Active Power (W) 

 Current (amp) 

 IT Energy (kWh) 

 CO2 Footprint (CO2 Kg) 

 IT Energy Cost ($ or other currency) 

 Total Energy Including Cooling (kWh) 

 Total Energy Cost Including Cooling ($ or other currency) 

 Temperature Charts: 

Measurement taken as degrees Celsius or Fahrenheit, based on system 
setting in Settings > Application Settings > Language and Locale 
Settings. 

 Inlet Temperature 

 Outlet Temperature 

 Outside Air Temperature  

 Humidity Charts: 

Measurement taken as percentage humidity. 

 Inlet Humidity (%) 

 Outlet Humidity (%) 

 Outside Air Humidity (%) 

 Air Flow and Pressure Charts: 

Measurements taken as meters per second for air flow, and pascals for 
air pressure. 

 Air Flow (m/s) 

 Air Pressure (Pa) 
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PDU Health Chart Settings 

A PDU health chart displays connectivity and event statuses of your 
PDUs. 

You can configure a PDU health chart on the Analytics tab or on the 
Dashboards tab.  

 To configure device chart settings: 

1. In the Analytics tab, select a Report. The charts contained in the 
Report open. On the chart you want to configure, click the Settings 

icon . See Creating a Chart (on page 229) for 
details on adding a new chart. 

OR 

In the Dashboards tab, add a PDU health chart widget, then click the 

Settings icon  in the widget. See PDU Health 
Chart Widget (on page 97). 

2. The Health Chart Settings dialog appears.  

3. Click the Settings icon . 

4. Enter a name for the chart in the Title field in the Basics section. 

5. In the Data From field, select All to include all PDUs in the system in 
the chart. Select Data Center or other section of the data center to 
filter the next field's selections. For example, select Racks to filter the 
Contained In field to include the racks in your system. 

6. In the Contained In field, select the location of the PDUs you want to 
include in the Health chart. 

7. In the Options section, select the health measurement. 

 Select Overall Health to view a health chart that combines 
connectivity and active events to create an overall health status 
of the selected PDUs. 

 Select Event Health Only to exclude connectivity from the health 
status. 

 Select Connectivity Health Only to exclude active events from the 
health status. 

8. Click Save.  
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Overall PDU Health 

Overall health in a PDU Health Chart comprises both connectivity health 
and active events health. The overall health is determined based on 
these criteria: 

 Critical: Red - A PDU is in critical overall health if either its 
connectivity health is critical or its active events health is critical. The 
overall health is critical even when only one of these categories is 
critical. 

 Warning: Yellow - A PDU is in warning level overall health if either its 
connectivity health is warning, or its active events health is warning, 
but neither is critical. This could indicate a warning level active event 
and good connectivity. 

 Good: Green - A PDU is in good overall health if both its connectivity 
health is good and its active events health is good. This indicates no 
unsuccessful polls, and no active warning or critical severity events. 

 

Exporting Charts 

Export a chart to save the chart data to a .CSV file. 

 To export a chart: 

1. In the Analytics tab, select a Report. 

2. The charts contained in the Report open. Click the Export icon  in 
the chart.  

3. Use the dialog that appears to save the file. 
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Power Usage Effectiveness (PUE) is the ratio of the total amount of 
power used by a data center to the power delivered to actual IT 
equipment. An ideal PUE is 1.0. 

PUE = 
Total Facility Power 

IT Equipment Power 

Power usage for anything that is not a computing device, such as lighting 
and cooling, is considered facility power usage. 

Power IQ measures total power and IT power based on the flags set for 
each inlet, outlet or circuit. Flags indicate whether the kilowatt hours 
measured count toward total power, IT power, both, or neither. See Set 
PUE Flags (on page 237) and What PUE Flags Does Power IQ Set 
Automatically? (on page 238) 

Power IQ sums up the measured values on a daily and monthly basis, 
then uses the values to calculate PUE. Both daily and monthly PUE 
calculations are offered. Power IQ does a rollup of daily measurements 
on the first day of each month, using the previous month's data, to create 
a monthly PUE calculation for each data center. You can adjust the 
monthly sums for total power and IT power as needed after the rollup. 

All data represents the PUE flags and EDM configuration as set when 
the data was collected. 

Power IQ displays the PUE calculations in several ways. 

 List PUE Calculations and Adjustments (on page 239): a list of 
the monthly PUE calculations for each data center that enables you 
to enter offset values to adjust the monthly total power and IT power 
readings. 

 PUE Trend Chart Widget (on page 109): a dashboard chart that 
shows PUE calculations over time. 

 Latest PUE Reading Gauge Widget (on page 110): a dashboard 
gauge that shows your latest PUE reading and where it falls within 
the thresholds set. 

In This Chapter 

Requirements for PUE .......................................................................... 237 
Set PUE Flags....................................................................................... 237 
List PUE Calculations and Adjustments ............................................... 239 
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Requirements for PUE 

PUE calculations can begin once your system is set up to include: 

 Enterprise data model (EDM) is configured and includes the objects 
you want to flag as part of the PUE calculation. See Enterprise 
Relationships (see "Enterprise Relationships and the EDM" on 
page 132) 

 Objects are flagged as Total Power and IT Power. See Set PUE 
Flags (on page 237) 

 

Set PUE Flags 

You must identify the sources of IT power and total power using flags. 
Power IQ uses the flags to determine which readings to use in the PUE 
calculation. 

IMPORTANT: When setting Total Power, make sure not to flag the same 

power more than once. Set the flag at the highest level source only. 

 Total Power: 

 Set the flag for Total Power if the object supplies power to the data 
center. Avoid double-flagging Total Power in the stream. For 
example, flagging Total Power on a standalone meter AND the inlet 
to a downstream floor PDU would double-flag the same energy. 

 Best practice is to measure Total Power at the main line in to the 
data center. For example, if you have a standalone meter, flag it 
as Total Power. 

 Another method is to search for circuits of your Power IQ 
managed facilities objects, such as floor PDUs, power panels, 
UPS, and so on, and flag the highest level sources as Total 
Power. 

 Power IQ does not automatically flag Total Power. 

 IT Power: 

 Set the flag for IT Power if the object supplies power for computing 
purposes only. 

 Outlets on Rack PDUs  

 Inlets on Rack PDUs without outlet meters 

 Power IQ automatically flags rack PDUs as IT Power. 
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 See What PUE Flags Does Power IQ Set Automatically? (on page 
238) 

 

 To set PUE flags: 

1. In the PUE tab, use the search criteria to list the objects you want to 
flag. 

 Type: Circuits, Outlets, or Inlets.  

 Filter by Node: Select an EDM node. 

 Flagged as Total: Filters objects by their Total Power flag status.  

 Flagged as IT: Filters objects by their IT Power flag status. 

2. Click Search.  

3. In the search results list, select the checkboxes under the Total and 
IT columns for each object to flag it. 

Note: Use the All Total and All IT icons to automatically flag all 
objects in the search results, or to remove a flag from all objects in 

the search results. 
 

What PUE Flags Does Power IQ Set Automatically? 

Power IQ does not automatically flag for Total power.  

Power IQ automatically sets some PUE flags for IT power.  

When you upgrade to 4.1 or later:  

Object Flagged as IT Power 

Rack PDU or inline meter with outlets outlets 

Rack PDU and inline meter without 
outlets 

inlets 
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When you add a new object : 
 

Object Flagged as IT Power 

Rack PDU or inline meter with outlets outlets 

Rack PDU or inline meter without 
outlets 

inlets 

Floor PDU, Power Panel, Standalone 
Meter, UPS, CRAC 

 Note: These facilities objects are 
added as PDUs, and supported 
using Dynamic Plugins. See 
Dynamic Plugins (on page 272). 

none 

 
 

List PUE Calculations and Adjustments 

The PUE tab displays the monthly rollup PUE calculations for each data 
center. Monthly data comes from a rollup conducted on the first of each 
month, using the previous month's data. You can adjust the monthly 
values for Total Power and IT Power for the month. 

Adjustments can be positive or negative Kilowatt hours. 

Daily values are not displayed, and they cannot be adjusted. 

Adjustments made will affect all PUE charts in the dashboard that use 
monthly data. 

 To list PUE calculations and adjustments: 

1. In the PUE tab, choose Activities > List PUE Calculations. The list 
includes a line for each month of data for each data center in your 
EDM.  

2. Enter the number of Kilowatt hours for adjustments to Total Power or 
IT Power in the fields provided. Use a "-" sign to make a negative 
adjustment to the number of hours. 

 Total kWh Adj: Adjustment to Total Power 

 IT kWh Adj: Adjustment to IT Power 
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The Reports tab allows users to create reports and administer tags. 

 The reporting feature supports the following reports: Power\Energy, 
Temperature, and Rack Failover simulation. 

 Through the Activities menu, users can create and administer Tag 
Groups and the available Tags for those groups. 

You choose the rows and columns you want to include, and how rows 
are grouped and filtered.  

Filters can employ the tags assigned to EDM nodes to determine which 
PDUs and IT device readings are included in the reports. 

See Create a Report (on page 241). 

Reports are only available to the user who creates them. The data 
included is limited to the user's permissions to view objects in the EDM. If 
you do not have permission to view Data Center 1, for example, no data 
about Data Center 1, or any room , rack and so on contained by it, will be 
included in your reports. 

Reports you create can be emailed to anyone you like. Set up a 
schedule for the report to be run and emailed, or send an exported report 
by email. See Schedule a Report (on page 250) and Export a Report 
to PDF or CSV (on page 251). 

Once a report has been run, the output is saved in the Report History. 
Report runs are kept in the report history until a report is deleted. See 
View Report History. 

In This Chapter 

Create a Report ..................................................................................... 241 
Run a Report ......................................................................................... 249 
Schedule a Report ................................................................................. 250 
Export a Report to PDF or CSV ............................................................ 251 
Report Examples ................................................................................... 251 
Add Tag Groups and Tags .................................................................... 258 
Migrating Existing Data to Tags ............................................................ 260 
Assign Tags in the Data Centers Tab ................................................... 262 
Export and Import Tags ......................................................................... 263 
User Permissions for Reports and Tags ............................................... 266 
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Create a Report 

Create a report to set the parameters of the data you want included. You 
can choose the rows and columns to include, and specify sorting and 
filtering. 

Power IQ supports three types of reports: 

 Power/Energy (see "Create a Power/Energy Report" on page 241) 

 Temperature (see "Create a Temperature Report" on page 243) 

 Rack Failover (see "Create a Rack Failover Report" on page 245) 
 

Create a Power/Energy Report 

1. In the Reports tab, click New Report, and select Power/Energy 
Report.  

2. Enter a name for the report in the dialog and click OK. You can 
change it later if needed. 

3. The Preview/Edit page appears. In the Report Details section, select 
the data you want in the report rows. 

 

a. Row for each:  
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 Time: each row is a time period. Select Day, Week, Month, or 
Year 

 Tag: each row is a tag from the selected tag group. Select a 
Tag Group. See Add Tag Groups and Tags (on page 258). 

 EDM Node: each row is a node in your data center, as 
configured in your EDM. Select Data Center, Floor, Room, 
Aisle, Row, Rack, PDU, or Device. 

b. Data from: 

 PDUs: readings are taken from the PDU inlets. 

 Devices: readings are taken from the PDU outlets or circuits 
mapped to the IT device. 

 Racks: readings are taken from the rack power data. 

c. Sort direction: 

 Ascending or Descending. Rows will be sorted by the Time, 
Tag, or EDM Node, unless you choose a measurement in 
Sort by measure. The Sort by measure field becomes active 
after you add a measurement. 

d. Sort by measure: Select the measurement as defined for the 
report columns. Select None to sort by the Time, Tag, or EDM 
Node. 

 None, Energy, Average Active Power, Minimum Active Power, 
or Maximum Active Power, depending on the column 
settings. 

e. Time range: 

 Period: Select a time period to limit the data included in the 
report. Select Yesterday, Past Week, Last Week, Month to 
Date, Past Month, Last Month, Year to Date, Past Year, Last 
Year. 

 Custom: Select a custom date range. Use the calendar tool 
to select a beginning and ending date. 

4. Click Save. 

5. In the Report Columns section, select the readings you want to 
include in the report columns. Click Add, then select Energy or Active 
Power in the Measure field and specify one statistic type, if available, 
in the Statistic field. Repeat to add multiple measurements for a 
multi-column report. 

a. Energy: Readings are kilowatt hours. Data comes from daily 
rollups. No statistic options are available for this reading. 

b. Active Power: Readings are active power in kilowatts. Data 
comes from daily rollups.  
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Three statistic types are available: Average, Maximum and 
Minimum. 

6. In the Tag Filters section, select tags to filter what sources of data 
are included in the report. Only data from tagged sources is included. 
Click Add, then select Tag Group and Tag. Repeat to add more tag 
filters. If multiple tag filters are applied to a report, an object must 
have all the tags in order to be included in the report.  

7. Click Run Now to run the report. See Schedule a Report (on page 
250) for adding scheduled email delivery. 

 

Create a Temperature Report 

A temperature report shows inlet/outlet temperatures at a rack level. 
Therefore, the row of the report is always racks and cannot be 
configured. 

Temperature units are either degrees Celsius or Fahrenheit, based on 
system settings in Settings > Application Settings > Language and Local 
Settings. 

Users without View permissions or a role that includes View permissions 
for certain racks cannot retrieve the temperature data from those racks 
when running the temperature report. See Assigning Roles for User 
Permissions (on page 83). 

 To create a temperature report: 

1. In the Reports tab, click New Report, and select Temperature 
Report. 

2. Enter a name for the report in the dialog and click OK. You can 
change it later if needed. 

3. The Preview/Edit page appears. 
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4. In the Report Details section, select how you want the data to be 
presented. 

 

a. Sort direction: 

 Ascending or Descending. The report is sorted by the rack 
names, unless you choose a measurement in Sort by 
measure. The Sort by measure field becomes active after 
you add a measurement. 

b. Sort by measure: Select the measurement as defined for the 
report columns. Select None to sort by rack names. 

 None, Average Inlet Temperature, Minimum Inlet 
Temperature, Maximum Inlet Temperature, Average Outlet 
Temperature, Minimum Outlet Temperature, or Maximum 
Outlet Temperature, depending on the column settings. 

c. Time range: 

 Period: Select a time period to limit the data included in the 
report. Select Yesterday, Past Week, Last Week, Month to 
Date, Past Month, Last Month, Year to Date, Past Year, Last 
Year. 

 Custom: Select a custom date range. Use the calendar tool 
to select a beginning and ending date. 

5. Click Save. 
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6. In the Report Columns section, select the readings you want to 
include in the report columns. Click Add, then select a temperature 
type in the Measure field, and a statistic type in the Statistic field. 
Repeat to add multiple measurements for a multi-column report. 

a. Measure: Inlet Temperature or Outlet Temperature. 

b. Statistic: Average, Maximum or Minimum. 

7. In the Tag Filters section, select tags to filter what sources of data 
are included in the report. Only data from tagged sources is included. 
Click Add, then select Tag Group and Tag. Repeat to add more tag 
filters. If multiple tag filters are applied to a report, an object must 
have all the tags in order to be included in the report.  

 Selected tags filter out not only racks but also temperature 
sensors, based on whether their parent nodes match the 
selected tags. 

8. Click Run Now to run the report. See Schedule a Report (on page 
250) for adding scheduled email delivery. 

 

Create a Rack Failover Report 

A rack failover report shows which racks may completely lose power 
when one of the two redundant power sources fails or is turned off for 
maintenance. The report simulates a failover situation, and indicates a 
prediction for your rack's highest utilization percentage. 

The report does not provide notification when a rack loses power, but is 
rather used to help you preemptively identify racks that are vulnerable in 
a failover simulation. 

Racks that do not meet the rack requirements are excluded from the 
report automatically, even if they exist in the EDM node selected in the 
report. See Rack Requirements (on page 246). For additional 
assumptions, see Report Disclaimer (on page 249). 

 To create a rack failover report: 

1. In the Reports tab, click New Report, and select Rack Failover 
Report. 

2. Enter a name for the report in the dialog and click OK. You can 
change it later if needed. 

3. The Preview/Edit page appears. 

4. In the Report Details section, select the data you want to include. 

5. In Location, click the browse button to select the EDM node 
containing the racks you want to analyze. You can select EDM 
nodes from Data Center to Row. Unsupported racks are 
automatically excluded from the report. See Rack Requirements 
(on page 246). 
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6. In Time Range, select a period of time, or set a custom range of 
dates. See Data Sources for Each Time Range (on page 247). 

7. Select a sorting option in the Sort By and Sort Direction fields. Rack 
Utilization sorts racks by percentage of utilization. Rack Name shows 
racks in alphabetical order by name. 

8. Click Save. 

9. Click Run Now to run the report. See Schedule a Report (on page 
250) for adding scheduled email delivery. 

 

Rack Requirements 

To be included in the rack failover report, a rack must meet all 
requirements.  

 Racks must contain 2 rack PDUs only. 

 Rack PDUs must be identical: 

 same number of inlets and circuit breakers 

 same capacity ratings and number of poles on all these elements 

 Racks must not contain multi-inlet PDUs 

 Racks must not contain Rack Transfer Switch PDUs 
 

Assumptions About Supported Racks 

Supported racks are assumed to follow these guidelines.  

 The load of the servers is split between the two rack PDUs 

 IT Devices in the rack have an even number of cords, and half of the 
cords are connected to one PDU and the other half to the other PDU 

 For 3-phase rack PDUs, IT Devices are connected to the same 
phase legs on both rack PDUs 

 



 Chapter 16: Reports and Tags  

 
247

 
 

Data Sources for Each Time Range 

A different data source is used for each time interval selection in the 
Rack Failover report. See Create a Rack Failover Report (on page 
245). 

Time Interval Data Source 

Last Complete Poll 
 Raw readings from the last 

completed poll cycle: inlet pole 
current and circuit breaker pole 
current 

Yesterday 

Custom range that is 1 or 2 
days long 

 Hourly rollups: Inlet pole average 
current and circuit breaker pole 
average current 

 For each PDU, the average of all 
the hourly readings for the time 
period is displayed in the report. 

Last Week 

Past Week 

Last Month 

Past Month 

Custom range that is greater 
than 2 days and less than or 
equal to 62 days 

 Daily rollups: Inlet pole average 
current and circuit breaker pole 
average current 

 For each PDU, the report shows 
the average of all the daily 
readings for the time period. 

Last Year 

Past Year 

Custom range greater than 62 
days 

 Monthly rollups: Inlet pole average 
current and circuit breaker pole 
average current 

 For each PDU, the report shows 
the average of all the daily 
readings for the time period. 
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Rack Failover Report Examples 

 
 

1
 

 

The Rack PDU Capacity is retrieved from the rack PDU.  

Note: If your PDU does not report this value, Capacity and Utilizations will be blank. 
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2
 

 

The rack PDUs within a supported rack are grouped, and show their amps capacity and 
current side by side. 

3
 

 

In the Failover Simulation column, the report shows the sum of the two load values, and 
compares it to the capacity of either one.  

4
 

 

When capacity is exceeded, the value is highlighted in red. When the load is within 80% 
of the capacity, the value is highlighted in yellow. 

5
 

 

When a rack PDU has three-phase inlets, the report shows a row for each line, and a 
row for each circuit breaker when available. 

 
 

Report Disclaimer 

This report is designed only for Racks with two identical single inlet Rack 
PDUs and devices powered by the same outlet numbers on both Rack 
PDUs. For 3-phase Rack PDUs, a device is assumed to be connected to 
the same phase legs on both PDUs. This report may not be accurate for 
racks with Rack PDUs that lost connectivity, lost power or were 
decommissioned during the time period selected for the report. Reports 
that specify a time range use average amp readings while reports with 
Last Complete Poll use a recent reading. The report does not report 
peak loads such that while the report may indicate that on average your 
rack would pass a failover situation, it cannot indicate that it will always 
pass. In general, this report relies on data collected in the past under a 
set of conditions. If these conditions change, this report will no longer be 
accurate. This report should not be used as the sole basis for the design 
of an effective failover plan. 
 

Run a Report 
 

 

 To run a report: 

1. In the Reports tab, select the report in the Tabular Reports list. The 
last-run version of the report displays.  



Chapter 16: Reports and Tags 
 

250
  

 

2. Click Run Now. A status message displays while the report 
generates.  

3. The new report appears in the Preview/Edit section.  

4. Verify the report version by looking to the Report History column 
listing all versions of the report. Click other report versions to view. 

 

Schedule a Report 

You can schedule a report to run at a selected interval. Scheduled 
reports are run after 1:30am on the day scheduled. The report is emailed 
to the recipient list shortly after the report run completes.  

Scheduled report runs also appear in the Report History section in the 
Reports tab. 

 To schedule a report: 

1. In the Reports tab, select the report you want to schedule. 

2. Click Edit. 

3. In the Schedules section at the bottom of the report parameters, click 
Add. A report may have more than one schedule. 

4. In the Report Schedule dialog, set the schedule parameters: 

a. Email to: Enter the email addresses for all recipients of the 
report. 

b. Frequency: Select Daily, Weekly, or Monthly. For Weekly or 
Monthly, specify the day or date. 

c. Attachment: Select the file type for the report, CSV or PDF. 

5. Click Save. 
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Export a Report to PDF or CSV 

You can export most report data to either a PDF or CSV file. 

Failover reports can only export to PDF. 

 To export a report to PDF or CSV. 

 

1. In the Reports tab, select the report you want to export. 

2. Choose Export > PDF or CSV. 

3. Save or open the file. Choices depend on your browser. 

Note: If opening a temperature report in CSV with Microsoft applications, 
such as Excel, a redundant character appears prior to the degree symbol. 
This character is resulted from the default Microsoft encoding and can be 

ignored. 
 

Report Examples 

 Monthly Energy Report for One Internal Customer with 
Scheduled PDF Delivery (on page 252) 

 Data Center Power Report for Past Week (on page 254) 

 Load for All B-Side PDUs for Last Month (on page 256) 
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Monthly Energy Report for One Internal Customer with Scheduled 
PDF Delivery 

This report shows how to create a monthly energy usage report for a 
customer, and schedule it for email delivery each month. 
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 Required Tagging:  

 Add a Tag Group for Customer, with tags for each customer's name. 
See Add Tag Groups and Tags (on page 258). 

 Assign the customer name tag to each IT device in your EDM. See 
Assign Tags in the Data Centers Tab (on page 262). 
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Data Center Power Report for Past Week 

This report shows how to quickly find the past week power for your data 
centers.  
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 Required Tagging:  

 None. 
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Load for All B-Side PDUs for Last Month 

This report shows how you could find the kW load on all B-side PDUs for 
the last month.  
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 Tagging Required: 

 Add a Tag Group: PDU Type, with tags for A-Side and B-Side. See 
Add Tag Groups and Tags (on page 258). 

 Assign the B-Side tag to each PDU. See Assign Tags in the Data 
Centers Tab (on page 262). 
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Add Tag Groups and Tags 

Adding tag groups and tags is the first step toward using filtering by tag 
in reports.  

Tag groups and tags help you categorize objects in your data center. 
When you filter by tag in a report, the report automatically includes 
readings from only the tagged objects. If multiple tag filters are applied to 
a report, an object must have all the tags in order to be included in the 
report.  

Some examples of tag groups are Customer, Department, PDU Type, or 
Device Type. See Tag Example: Report on Racks by Customer Tag 
(on page 259). 

Tags must be added before you can assign them to EDM nodes. See 
Assign Tags in the Data Centers Tab (on page 262). 

 To add tag groups and tags: 

 

1. In the Reports tab, choose Activities > Tags and Tag Groups. 

2. In the Tag Groups section, click Add, then add the names of a group 
of tags you want to add. Click Add. 

For example, if you plan to tag by customer name, add a Tag Group 
called Customer. 

3. In the Tags section, click Add, then select the Tag Group you want to 
add tags to, and enter the tag name in the Name field. Click Add. 

For example, if you have a Tag Group called Customer, enter your 
customer names as the Tags in that group.  

4. Next step: Assign the tags to EDM nodes. See Assign Tags in the 
Data Centers Tab (on page 262). 
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Tag Example: Report on Racks by Customer Tag 

In a colocation facility, you may want to track racks by customer.  

 Add a tag group called Customer.  

 Add tags for each customer name.  

 Assign the correct customer name tag to the racks in the EDM that 
the customer owns. 

 In tabular reports, there are two ways to use tags. 

1. Create a report with the Row for Each as Tag, then select Tag Group: 
Customer, and Tag: "Customer Name". When the report runs, you 
see one row of data for each customer. 

OR 

2. Create a report with the Row for Each as Time or EDM Node. Add a 
Tag Filter, for example, using Tag Group: Customer, then selecting 
Tag: Customer Name of your choice. When the report runs, you see 
one row of data for each time or node, but the data is filtered to 
include only nodes tagged with the specified customer name. 
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Migrating Existing Data to Tags 

You can migrate some existing data in your EDM to tags.  

 Data Centers, PDUs and IT Devices: Custom Field 1 and Custom 
Field 2 

 IT Devices: Customer and Device Type 

You can find these fields on the Data Center, IT Device, and PDU 
objects in the Data Centers tab. 

Migration creates tag groups from the field names, and creates tags from 
the data in the fields. Migration also applies the newly created tags to the 
EDM nodes where they were originally entered.  

Note: Migration does not remove the data from the original fields. The 
original fields are not linked to the new tags in any way, so if you choose 
to maintain both data locations, you must do so manually. The best 
practice is to maintain this data as tag groups and tags, going forward. 

See Migrate Custom Field Data (on page 261) for instructions to do the 
migration. 

 IT Devices, Data Centers, and PDUs: 

Each IT Device, Data Center and PDU contains two custom fields, 
Custom Field 1 and Custom Field 2. You may have edited the names.  

Upon migration, the name of the custom field becomes the tag group 
name, with the EDM node in parentheses, to identify where the data 
came from.  

EDM Node Field Name: Contents Migration 
Creates -> 

Tag Group: Tag 

Data Center Custom Field 1: Sales 

Custom Field 2: 
Marketing 

 Custom Field 1 (Data 
Center): Sales 

Custom Field 2 (Data 
Center): Marketing 

IT Device Custom Field 1: Colo1 

Custom Field 2: Colo2 

 Custom Field 1 (IT 
Device): Colo1 

Custom Field 2 (IT 
Device): Colo2 

PDU Custom Field 1: 
Facilities 

Custom Field 2: IT 

 Custom Field 1 (PDU): 
Facilities 

Custom Field 2 (PDU): IT 
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 IT Devices:  

In addition to Custom Fields 1 and 2, IT devices also contain fields for 
Customer and Device Type that you can migrate to tags. 

Field Name: Contents Migration Creates -> Tag Group: Tag 

Customer: Bank  Device Customer: Bank 

Device type: Dell 
PowerConnect 2848 

 Device Type: Dell 
PowerConnect 2848 

 
 

Migrate Custom Field Data 

The Migrate Custom Field Data tool creates new tags and tag groups 
based on existing custom and standard field data for PDUs, devices, and 
data centers.  

See Migrating Existing Data to Tags (on page 260) for details. 

If you use the migration tool more than once, duplicate tags and tag 
groups will not be created. If new data is found, new tags will be added 
to the existing tag groups.  

 To migrate custom field data: 

1. In the Reports tab, choose Activities > Tags and Tag Groups. 

2. Click Migrate. 

3. To confirm, click Migrate Custom Field Data in the message that 
appears. 

4. When complete, tag groups and tags appear in the Reports tab. The 
tags have also been applied to the EDM nodes where they 
originated.  
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To view the tags applied, go to the EDM node in the Data Centers 
tab, then scroll down to the Tags section. For racks and PDUs, there 
is no Tags section. Choose Actions> Edit Tags to view tags.  

 
 

Assign Tags in the Data Centers Tab 

You can assign tags to EDM nodes in the Data Centers tab. To assign 
tags to multiple EDM nodes at once, use the CSV import tool. See 
Assigning Tags with CSV Import (on page 264). 

Tags can be assigned to these EDM nodes: 

 Data Center 

 Floor 

 Room  

 Row 

 Aisle  

 Rack 

 PDU: rack PDUs only, no facilities objects 

 IT Device 

 To assign tags in the Data Centers tab: 

1. In the Data Centers tab, go to the EDM node you want to tag. Scroll 
down to the Tags section. 

2. Click Add, then select the Tag Group and Tag. Click Add. The 
assigned tags display in the list.  

 To assign tags to a rack or PDU in the Data Centers tab: 

1. In the Data Centers tab, go to the rack or PDU you want to tag.  

2. Choose Actions > Edit Tags. 

3. Click Add, then select the Tag Group and Tag. Clck Add. The 
assigned tags display in the list. 
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 To remove tags:  

Note: This is the only way to remove a tag. You cannot remove a tag 
using CSV import. 

1. In the Data Centers tab, go to the EDM node you want to remove a 
tag from. 

2. Select the tag and click Remove. 
 

Export and Import Tags 

Tag import is used to assign tags to EDM nodes. You cannot create tag 
groups and tags using import. See Assigning Tags with CSV Import 
(on page 264). 

To export your existing tag assignments, use the export tool. See Export 
Assigned Tags (see "Export Existing Tag Assignments" on page 
263) 

For help with import errors, see Import Errors for Tags (on page 265). 
 

Export Existing Tag Assignments 

The tag export file includes all tagged EDM nodes.  

You can use the export file as a template to add more tags to EDM 
nodes. Duplicate tags are not added. Each import adds new tags, and 
does not change any existing assigned tags. See Assigning Tags with 
CSV Import (on page 264). 

 To export existing tag assignments: 

1. In the Reports tab, choose Activities > Export/Import Tag Entries. 

2. Click Export. Save or open the file. Choices depend on your browser. 
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Assigning Tags with CSV Import 

To assign tags to multiple EDM nodes at once, use the CSV import tool. 
The import uses the tag groups and tags you have already created. 
Import cannot create new tag groups or tags. To create new, see Add 
Tag Groups and Tags (on page 258). 

Duplicate tags are not added. Each import adds new tags, and does not 
change any existing assigned tags.  

The file is validated before import. If any errors are found,  the whole file 
is rejected, and no changes are made. You can view error messages for 
each line of the file upon rejection. See Import Errors for Tags (on page 
265) 

Tip: To export a CSV file to use as a template, assign one tag manually, 
then export.  

See Assign Tags in the Data Centers Tab (on page 262) and Export 
Assigned Tags (see "Export Existing Tag Assignments" on page 

263). 

 To assign tags with CSV import: 

1. Create the CSV file. The CSV file must have 5 columns: 

type external_key name tag_group tag 

 type: The EDM node you're assigning the tag to. Not case 
sensitive. The following entries can be used. 

 DATA_CENTER 

 FLOOR  

 ROOM  

 ROW  

 AISLE  

 RACK 

 PDU 

 DEVICE 

 external_key: The EDM node's external key.  

 name: Include an EDM node name here for convenience when 
creating your import file. The import does not use or change the 
name. 

 tag_group: The name of an existing tag group. The import cannot 
create a new tag group. 



 Chapter 16: Reports and Tags  

 
265

 
 

 tag: The name of an existing tag in the tag group. The import 
cannot create a new tag. 

 

2. Save the file as .CSV. 

3. In the Reports tab, choose Activities > Export/Import Tag Entries. 

4. Click Browse then select the .CSV file and click OK. Click Import. 
The file is validated. 

Success: All tags are assigned as described in the file. 

Error: If the file does not validate, click View Errors. The Import 
Errors display in the page. See Import Errors for Tags (on page 
265). 

 

Import Errors for Tags 

Each error includes the line number from the CSV file, the error message, 
and the details. 

 

 Common errors and resolutions: 
 

Error  Resolution 

Tag group does not exist 

Tag does not exist 

You must add tag groups and tags before you can 
assign them using the import.  

See Add Tag Groups and Tags (on page 258). 

Tag entry already exists The tag is already assigned to the EDM node specified 
in the CSV file. 
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External key does not exist as 
an external key 

The external key is incorrect for the EDM node. Verify 
the external key in the EDM node in the Data Centers 
tab. 

Tag can't be blank You must enter a tag for each line in the CSV file.  

 Example error: 
 

Line number Error EDM Node 
Type 

EDM Node 
External Key 

Tag Group Tag 

Line 160 has 
Error(s): 

Tag entry already exists 
in 

[DEVICE,  

 

IT Device -- 3657, Device Type,  Ethernet 
Switch] 

 
 

User Permissions for Reports and Tags 

You must have the Site Administrator role to create tag groups and tags. 
This is the "admin" user role. 

You must have Site Administrator, Administrator, or Operator role 
permissions to a node to assign a tag to it. 

The reports you create will be limited based on your permissions to view 
the EDM. 
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Downloading Daily Sensor Readings 

Storage of daily raw readings in CSV files can be enabled or disabled. 
When enabled, depending on your configuration, Power IQ can store up 
to 8 days of CSV files. See Configure Raw Sensor Readings Storage 
(on page 10). 

The daily sensor readings CSV file includes the state of the circuit 
breakers for applicable Raritan PX PDUs. The circuit breaker state is 
recorded to this file only once every polling interval, even if you enable 
buffered data retrieval under Polling Options. 

Sensor readings include internal sensors and temperature, humidity, 
airflow, air pressure, and contact closure sensors.  

See Configuring Remote Storage of Archive Files (on page 131) for 
details on automatic remote storage of sensor reading archives. 

 To download daily sensor readings: 

1. In the PDUs tab, choose Activities > Download PDU Sensor 
Readings. The Sensor Readings Archives page opens. 

 The option is hidden when storage for sensor readings files is 
disabled. See Configure Raw Sensor Readings Storage (on 
page 10). 

2. Click a filename link to download an archive of the sensor readings 
taken on that day. Filenames include the date and time when the file 
was created. There may be more than one file per day, because 
Power IQ creates the file when a reasonable maximum file size is 
reached, before the file is too large to be usable in Excel. Or, click 
Download Latest Readings to download the current sensor readings 
CSV file. 

Chapter 17 Maintenance Tasks 
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Tip: Use the time stamp of the file to find the beginning of a time period 
you are looking for, and the time stamp on the next file for the end of this 
period. Note that with data logging or network outages, readings taken 
outside the time stamp range may be in the file. 

Note: To delete an archived file, select the checkbox next to the filename, 
then click Remove. 

 To download daily sensor readings via script: 

You can set up an external program to download the latest sensor 
readings file each day. 

Example using wget: 

wget-1.10.2.exe -t 3 --http-user=[username] 

--http-passwd=[password] --no-check-certificate 

https://[hostname]/sensor_readings_csvs/latest 

Example using curl: 

curl --user [username]:[password] 

https://[hostname]/sensor_readings_csv/latest > 

latest-csv-archive.zip 
 

Upgrading Power IQ Firmware 

When new firmware is released, you can upgrade Power IQ to receive 
the latest in features and functionality. 

See the Release Notes for any special instructions on upgrading.  

 To upgrade Power IQ firmware: 

1. In the Settings tab, click Software Upgrades in the Appliance 
Administration section. The Upgrade page opens. 

2. Click Browse, select the firmware file (usually a *.bin file). 

3. Click Upload. The new firmware uploads to the application.  
 

Shutting Down and Restarting Power IQ 

You can shut down and power off or restart Power IQ. 

 To shut down and power off Power IQ: 

 In the Settings tab, click System Shutdown in the Appliance Services 
section. 

The Power IQ shuts down and powers off. 
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 To restart Power IQ: 

 In the Settings tab, click System Restart in the Appliance Services 
section. 

The Power IQ restarts. 
 

Accessing Audit Logs 

Power IQ Web Client audit logs can be viewed in a browser, or exported 
to a file for viewing or storage. 

Warning: Audit logs are automatically deleted from the system after 3 
calendar months. If you need to maintain a complete audit trail, export 
logs regularly and store the files outside Power IQ. 

 To access audit logs: 

1. In the Settings tab, click Audit Log in the Application Administration 
section. 

2. The Audit Log Entries page opens. 

 To export audit logs to a text file: 

1. In the Settings tab, click Audit Log in the Application Administration 
section. 

2. Click the Download Audit Logs link. All audit log entries are exported 
to a text file.  

3. Save the file. 
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Allow HTML Widgets on Dashboard 

The Dashboards tab can include your custom HTML portlets as a widget. 
HTML portlets may have security implications. You must allow them 
before you can add an HTML widget to the Dashboards tab. 

 To allow HTML widgets on dashboard: 

1. In the Settings tab, click Application Settings in the Appliance 
Settings section. 

2. In the Display Settings section, select the "Allow user-created HTML 
portlets on the dashboard" checkbox. 

3. Click Save. 
 

Display a Logo on Every Page 

Upload your company logo to display it on every page in Power IQ. This 
is useful for branding a dashboard presentation. 

Logos must not exceed 150 pixels wide, 48 pixels high, or 512KB in size. 

For details on adding a logo to the dashboard, see Image Widget (on 
page 100). 

 To display a logo on every page: 

1. In the Settings tab, click Application Settings in the Appliance 
Administration sections. 

2. In the Display Settings box, select the "Show a custom uploaded 
logo" checkbox. 

3. Click Browse to select the logo file, then click Open. 

 If the file does not meet the logo criteria, error messages display. 
Edit the image as needed, then upload again. 

Chapter 18 Appliance Administration 
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4. Click Save Display Settings. The logo appears in the top right corner 
of every page in Power IQ. 

 

Configuring the System Clock 

Power IQ uses the system clock to time-stamp events and data records. 
Set the system clock as soon as possible to keep an accurate record of 
events. 

Using an NTP server is recommended to keep the system clock 
synchronized between Power IQ and the PDUs it manages.  

Important! You must use the same NTP server for Power IQ and all 
Raritan PX PDUs managed to get accurate readings from PX. 
 

Configuring NTP Server Settings 

The Configure Time Servers table lists the NTP servers Power IQ 
contacts to get date and time information. NTP must be enabled first.  

 To enable NTP and configure NTP servers: 

1. In the Settings tab, click Application Settings in the Appliance 
Administration section. 

2. In the Time Settings box, click the arrow to expand the NTP Settings 

3. Select the Enable NTP checkbox. 

4. Click Add. 

5. Type the time server's IP address in the Time Server field then click 
OK. 

6. Click Save Time Settings.  

 To edit NTP server settings: 

1. Select the server in the table and click Edit. 

2. Type the time server's IP address in the Time Server field  

3. Click Save Changes. 
 

 To remove an NTP server: 

1. Select the server in the table. 

2. Click Remove. 

3. Click Yes in the confirmation message. 
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Configuring the System Clock Manually 

 To configure the system clock manually: 

1. In the Settings tab, click Application Settings in the Appliance 
Administration section. 

2. In the Time Settings section, select the Time Zone Power IQ server 
resides in from the Time Zone drop-down list. 

3. Select the date and time using the tools in the "Set time manually" 
fields. Select the date from the pop-up calendar. Select the 24-hour 
time from the drop-down list.  

4. Click Save Time Settings. 
 

Dynamic Plugins 

The dynamic plugins feature enables you to add data collection support 
for external PDUs and facilities objects that Power IQ does not support 
by default.  

For a full list of supported devices, go to 
http://www.raritan.com/support/product/poweriq/power-iq-rack-monitored
-devices-support 

http://www.raritan.com/resources/power-iq-rack-pdu-support/ 

Dynamic plugins work by mapping SNMP OIDs to Power IQ's database, 
so that Power IQ can find and retrieve data from the device.  

There are two types of dynamic plugins, structured and custom. See 
Types of Dynamic Plugins: Structured and Custom (on page 274) 

The following device types are supported in each type of dynamic plugin: 

 CRAC 

 Floor PDU 

 Floor UPS 

 Power Panel 

 Rack PDU 

 Standalone Meter 
 

Limitations of Dynamic Plugins 

Buffered data retrieval is not supported for PDUs added with dynamic 
plugins. 
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Plugins Created Before Power IQ Release 4.1 

All dynamic plugins created before Power IQ release 4.1 were structured 
dynamic plugins. Upon upgrade, the dynamic plugin type for these 
existing plugins will be set to "Rack PDU". You cannot change the type, 
but the rest of the dynamic plugin can be edited. 
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Types of Dynamic Plugins: Structured and Custom 

There are two types of dynamic plugins: structured and custom. 

The structure of the PDU's SNMP MIB typically determines whether a 
structured or a custom dynamic plugin is most appropriate.   

Generally, if the MIB you are working with supports it, you should choose 
the structured dynamic plugin option.  

 Structured dynamic plugin: 

A structured dynamic plugin is derived from hierarchically structured 
MIBs. Typically the values are organized in tables in the MIB. For 
example, a hierarchical MIB for a rack PDU typically has separate tables 
for elements such as inlets, circuit breakers, and outlets.    

In a structured dynamic plugin, you define mappings that represent a 
series of OID values to be collected. You do not have to provide a 
mapping for every single SNMP OID that you want Power IQ to collect. If 
the MIB supports values that can be retrieved that indicate the number of 
inlets, outlets, circuits, and so on, it is possible to create a structured 
dynamic plugin that is capable of managing a variety of PDU models. 
This is not possible with a custom dynamic plugin. 

 Custom dynamic plugin: 

A custom dynamic plugin requires a mapping for every desired reading. 
For example, you would map values for outlet 1 voltage, outlet 1 current, 
outlet 2 voltage, outlet 2 current. You must manually specify each object 
id you want Power IQ to collect, and then map each object id into the 
Power IQ PDU/electrical device data model.   

Custom dynamic plugins are useful when: 

 You want to monitor a PDU that does not use SNMP for remote 
communication. These PDUs may use Modbus or Bacnet protocols 
for remote communication. You can monitor these PDUs with an 
SNMP gateway. The SNMP gateway gives the ability to convert 
Modbus, or other protocols, to SNMP. The custom dynamic plugin 
can use a combination of the SNMP OIDs and hard-coded values 
mapped to the data model of the PDU type to support your specific 
PDU. See SNMP Gateways and Custom Mappings (see "SNMP 
Gateways and Custom Dynamic Plugins" on page 335) 

 The device's MIB does not contain data in tables, also known as a 
"flat" or "unstructured" MIB.  
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Mappings for Each PDU Type 

CRAC Mappings 

A CRAC may contain inlets and inlet poles. 

"Index" mappings are supported in structured dynamic plugins only. 

 Mappings: 

 Inlet Index 

 Inlet Apparent Power 

 Inlet Active Power 

 Inlet Power Factor 

 Inlet Pole Index 

 Inlet Pole Active Power - not displayed in Power IQ, but data is rolled 
up to provide Inlet Active Power. Use this mapping if your PDU does 
not provide Active Power data at the Inlet level. 

 Inlet Pole Voltage 

 Inlet Pole Current 

 Inlet Voltage 

 Inlet Current 

 Inlet Energy 
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Floor PDU Mappings 

A Floor PDU may contain inlets, inlet poles, power panels, panel inlets, 
panel inlet poles, circuits and circuit poles. 

"Index" mappings are supported in structured dynamic plugins only. 

 Floor PDU Mappings: 

 Inlet Index 

 Inlet Apparent Power 

 Inlet Active Power 

 Inlet Power Factor 

 Inlet Pole Index 

 Inlet Pole Active Power - not displayed in Power IQ, but data is rolled 
up to provide Inlet Active Power. Use this mapping if your PDU does 
not provide Active Power data at the Inlet level. 

 Inlet Pole Voltage 

 Inlet Pole Current 

 Inlet Voltage 

 Inlet Current 

 Inlet Energy 

 Panel Index 

 Panel Name 

 Panel Inlet Index 

 Panel Inlet Apparent Power 

 Panel Inlet Active Power 

 Panel Inlet Power Factor 

 Panel Inlet Energy 

 Panel Inlet Voltage 

 Panel Inlet Current 

 Circuit Index 

 Circuit Apparent Power 

 Circuit Active Power 

 Circuit Power Factor 

 Circuit Voltage 

 Circuit Current 

 Circuit Energy 

 Circuit Pole Index 
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 Circuit Pole Name 

 Circuit Pole Phase 

 Circuit Pole Position 

 Circuit Pole Active Power: not displayed in Power IQ, but data is 
rolled up to provide Circuit Active Power. Use this mapping if your 
PDU does not provide Active Power data at the Circuit level. 

 Circuit Pole Voltage 

 Circuit Pole Current 
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Floor UPS Mappings 

A Floor UPS (Uninteruptible Power Supply) may contain inlets, inlet 
poles, circuits, and circuit poles. 

"Index" mappings are supported in structured dynamic plugins only. 

 Floor UPS Mappings: 

 Inlet Index 

 Inlet Apparent Power 

 Inlet Active Power 

 Inlet Power Factor 

 Inlet Pole Index 

 Inlet Pole Active Power - not displayed in Power IQ, but data is rolled 
up to provide Inlet Active Power. Use this mapping if your PDU does 
not provide Active Power data at the Inlet level. 

 Inlet Pole Voltage 

 Inlet Pole Current 

 Inlet Voltage 

 Inlet Current 

 Inlet Energy 

 Circuit Index 

 Circuit Apparent Power 

 Circuit Active Power 

 Circuit Power Factor 

 Circuit Voltage 

 Circuit Current 

 Circuit Energy 

 Circuit Pole Index 

 Circuit Pole Name 

 Circuit Pole Phase 

 Circuit Pole Position 

 Circuit Pole Active Power: not displayed in Power IQ, but data is 
rolled up to provide Circuit Active Power. Use this mapping if your 
PDU does not provide Active Power data at the Circuit level. 

 Circuit Pole Voltage 

 Circuit Pole Current 
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Power Panel Mappings 

A Power Panel may contain inlets, inlet poles, circuits and circuit poles. 

"Index" mappings are supported in structured dynamic plugins only. 

 Power Panel Mappings: 

 Inlet Index 

 Inlet Apparent Power 

 Inlet Active Power 

 Inlet Power Factor 

 Inlet Pole Index 

 Inlet Pole Active Power - not displayed in Power IQ, but data is rolled 
up to provide Inlet Active Power. Use this mapping if your PDU does 
not provide Active Power data at the Inlet level. 

 Inlet Pole Voltage 

 Inlet Pole Current 

 Inlet Voltage 

 Inlet Current 

 Inlet Energy 

 Circuit Index 

 Circuit Apparent Power 

 Circuit Active Power 

 Circuit Power Factor 

 Circuit Voltage 

 Circuit Current 

 Circuit Energy 

 Circuit Pole Index 

 Circuit Pole Name 

 Circuit Pole Phase 

 Circuit Pole Position 

 Circuit Pole Active Power: not displayed in Power IQ, but data is 
rolled up to provide Circuit Active Power. Use this mapping if your 
PDU does not provide Active Power data at the Circuit level. 

 Circuit Pole Voltage 

 Circuit Pole Current 
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Rack PDU Mappings 

A Rack PDU may contain inlets, inlet poles, circuit breakers, outlets, and 
outlet poles. 

"Index" mappings are supported in structured dynamic plugins only. 

 Rack PDU Mappings: 

 PDU Name 

 PDU Firmware  

 Inlet Index 

 Inlet Active Power 

 Inlet Apparent Power 

 Inlet Current 

 Inlet Power Factor 

 Inlet Voltage 

 Inlet Energy 

 Inlet Pole Index 

 Inlet Pole Active Power - not displayed in Power IQ, but data is rolled 
up to provide Inlet Active Power. Use this mapping if your PDU does 
not provide Active Power data at the Inlet level. 

 Inlet Pole Voltage 

 Inlet Pole Current 

 Circuit Breaker Index 

 Circuit Breaker Current 

 Circuit Breaker Name 

 Circuit Breaker State 

 Outlet Index 

 Outlet Active Power  

 Outlet Apparent Power 

 Outlet Name 

 Outlet Power Control 

 Outlet Power Factor 

 Outlet State 

 Outlet Voltage 

 Outlet Energy 

 Outlet Current 

 Outlet Pole Index 
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 Outlet Pole Current: not displayed in Power IQ, but data is rolled up 
to provide Outlet Current. Use this mapping if your PDU does not 
provide Current data at the Outlet level. 

 Outlet Pole Voltage: not displayed in Power IQ, but data is rolled up 
to provide Outlet Voltage. Use this mapping if your PDU does not 
provide Voltage data at the Outlet level. 

 External Temperature and Humidity Sensors: See External 
Temperature and Humidity Sensor Mappings for Rack PDUs (on 
page 282) 

 

Standalone Meter Mappings 

A Standalone Meter may contain circuits and circuit poles. 

"Index" mappings are supported in structured dynamic plugins only. 

 Standalone Meter Mappings: 

 Circuit Index 

 Circuit Apparent Power 

 Circuit Active Power 

 Circuit Power Factor 

 Circuit Voltage 

 Circuit Current 

 Circuit Energy 

 Circuit Pole Index 

 Circuit Pole Name 

 Circuit Pole Phase 

 Circuit Pole Position 

 Circuit Pole Active Power: not displayed in Power IQ, but data is 
rolled up to provide Circuit Active Power. Use this mapping if your 
PDU does not provide Active Power data at the Circuit level. 

 Circuit Pole Voltage 

 Circuit Pole Current 
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External Temperature and Humidity Sensor Mappings for Rack PDUs 

External temperature and humidity sensor mappings are available for 
rack PDUs only. Examine your MIB to determine how the external sensor 
data is arranged and choose the correct mapping. 

 Generic sensor mappings: 

Generic sensor mappings do not include the "temperature" or "humidity" 
term in the mapping. Generic sensor mappings are useful when you 
have an OID to determine the type of sensor, and all sensor data is 
encoded in a single MIB table. 

For extra details when mapping sensors in a custom dynamic plugin, see 
Generic Sensor Mappings for Custom Dynamic Plugins (on page 
284). 

 External Sensor Index: external_sensor_index 

 External Sensor Type: external_sensor_type 

 External Sensor Name: external_sensor_name 

 External Sensor Value: external_sensor_value 

 External Sensor Unit: external_sensor_unit 

 External Sensor Scale Factor: external_sensor_decimal_digits 

 The "decimal digits" mapping works as a multiplier. Use this 
mapping when the MIB table contains multiple sensor types and 
each type has a different scaling. If the scalings are the same, 
using a multiplier as needed will work, and the multiplier is 
applied to all sensors. 
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 Sensor specific mappings for temperature: 

Use a sensor-specific mapping for temperature when all temperature 
readings are isolated in separate MIB tables from other sensor types, or 
the MIB table contains both temperature and humidity readings in each 
row, or a single MIB table contains both temperature and humidity 
readings (one reading per row) but there is no column OID that indicates 
the sensor type.  

Note: Sensor specific mappings for temperature cannot be used in 
custom dynamic plugins. Use the generic sensor mappings instead. 

 Temperature Sensor Index: external_sensor_temperature_index 

 Temperature Sensor Name: external_sensor_temperature_name 

 Temperature Sensor Value: external_sensor_temperature_value 

 Temperature Sensor Unit: external_sensor_temperature_unit 

 Sensor specific mappings for humidity: 

Use a sensor-specific mapping for humidity when all humidity readings 
are isolated in separate MIB tables from other sensor types, or the MIB 
table contains both temperature and humidity readings in each row, or a 
single MIB table contains both temperature and humidity readings (one 
reading per row) but there is no column OID that indicates the sensor 
type.  

Note: Sensor specific mappings for humidity cannot be used in custom 

dynamic plugins. Use the generic sensor mappings instead. 

 Humidity Sensor Index: external_sensor_humidity_index 

 Humidity Sensor Name: external_sensor_humidity_name 

 Humidity Sensor Value: external_sensor_humidity_value 
 

Temperature Unit Configuration Precedence 

For flexibility to support many kinds of MIB structures, there are several 
ways of indicating what unit temperature readings are displayed in. 

They will be applied in the following order of precedence: 

1. If external_sensor_unit (generic) or 
external_sensor_temperature_unit (specific) mappings are 
configured and corresponding Temperature Unit (Celsius) and 
Temperature Unit (Farhrenheit) metadata types are configured then 
the unit information retrieved from the SNMP agent of the target PDU 
will be used to determine temperature unit. 

2. If a Temperature Unit metadata type is configured then it will be used 
to determine the temperature reading units. 
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3. If no other means to determine temperature reading units is available 
then Celsius will be assumed. 

 
 

Generic Sensor Mappings for Custom Dynamic Plugins 

In custom dynamic plugins, only the generic sensor mappings are 
supported.  

The generic sensor mappings can be used to identify both external 
temperature and humidity sensors. Mappings specific to temperature and 
humidity are not required for custom dynamic plugins because you have 
the ability to control each OID that is collected, and you can hard code 
any value that is not available through the MIB. If the MIB does not 
provide a sensor type value, you must hard code it. 

 External Sensor Index: external_sensor_index: Not supported for 
custom dynamic plugins. 

 External Sensor Type: external_sensor_type 

 External Sensor Name: external_sensor_name 

 External Sensor Value: external_sensor_value 

 External Sensor Unit: external_sensor_unit 

 For temperature only, to specify Fahrenheit or Celsius. The unit 
for humidity is always assumed to be a percentage. When all 
readings are given in the same unit, it's easier to set the 
Temperature Unit metadata value. 

 This mapping is needed only in the unlikely case that a MIB gives 
some temperature readings in Fahrenheit and some in Celsius. If 
so, you must define this mapping for all temperature and 
humidity sensors identified, because the plugin requires the 
same total number of mappings for each data model element. 
For example, if a plugin has 5 external sensor name mappings 
defined, then it must have exactly 0 or 5 unit mappings defined. 
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 External Sensor Scale Factor: external_sensor_decimal_digits 

 This mapping must be used when the MIB table contains multiple 
sensor types and each type has a different scaling. If the 
scalings are the same, using a multiplier as needed will work, 
and the multiplier is applied to all sensors. 

 

Wildcard Index Mappings - Structured Dynamic Plugins Only 

Wildcard index mappings are valid for structured dynamic plugins only. 

When a MIB has related OIDs grouped together and in a sequential 
order, but not in perfectly structured tables, wildcard index mappings can 
help you make the information work in a structured dynamic plugin. 

Use a wildcard index mapping when you need an index and the relevant 
stock index mappings have already been used, or do not make sense. 
See Wildcard Index Mapping Example 

 Wildcard index mappings: 

 Wildcard Index 1 

 Wildcard Index 2 

 Wildcard Index 3 

 Wildcard Index 4 
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Wildcard Index Mapping Example 

Wildcard index mappings are useful for creating a structured dynamic 
plugin when the MIB is not logically organized into tables. A wildcard 
index mapping can be used as a substitution value in any structured 
dynamic plugin mapping. 

For example, a structured MIB that supports outlet names and outlet 
current will typically have an outlet table where each row contains one 
outlet's name and its current (amperage) reading. However, imagine a 
scenario where the MIB supports outlet names and outlet current, but 
these values are not accessible through a table. Instead the values are 
organized as consecutive OIDs in the MIB.   

 For example: 

The MIB's outlet name OIDs: 

 1.3.6.1.4.1.999.1.2.1 

 1.3.6.1.4.1.999.1.2.2 

 1.3.6.1.4.1.999.1.2.3 

 1.3.6.1.4.1.999.1.2.4 

The MIB's outlet current OIDs: 

 1.3.6.1.4.1.999.1.2.5 

 1.3.6.1.4.1.999.1.2.6 

 1.3.6.1.4.1.999.1.2.7 

 1.3.6.1.4.1.999.1.2.8 

The last decimal value of the OID is the "index" for that value. The index 
values for the outlet name OIDs are: 1,2,3,4. The index values for the 
outlet current OIDs are: 5,6,7,8. 

With a single 'outlet_index' mapping, you could not collect both outlet 
name and outlet current. To solve this problem, you can use a wildcard 
index to generate a second series of index values needed, so that both 
sets of values can be collected. 
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Trap Support in Dynamic Plugins - Structured or Custom 

Trap support applies to both structured and custom dynamic plugins. 

Power IQ can convert incoming SNMPv1 and SNMPv2 traps from a PDU 
managed with a dynamic plugin into a Power IQ event.To support this 
ability, you must add trap mappings to your dynamic plugin.  

Note: Trap mapping is supported for proxied PDUs only when managed 
through custom dynamic plugins. Each proxied PDU is managed by a 
unique dynamic plugin mapping. You must add an event filter on 
whatever trap parameter uniquely identifies the proxied PDU which is the 

target of the event. 

Trap mapping is not supported for proxied PDUs managed through a 
structured dynamic plugin mapping.  

Traps can be mapped to one of these events: 

 genericInfo 

 genericWarning 

 genericCritical 

The Power IQ events are generic. Because of this, it is necessary to 
define event summary text for each trap mapping to give meaning to the 
event.Most of the information passed in an SNMP trap is encoded in 
what are called variable bindings, or "varbinds" for short. Variable 
bindings are a key value pair, where the key is an object identifier and 
the value is typically an integer or string. In this guide, for simplicity, trap 
variable bindings are referred to as trap parameters.  

When configuring a trap mapping in Power IQ, the event summary text 
supports parameter expansion for any SNMP trap parameter contained 
in the trap. This means any relevant information encoded in a trap's 
parameters may be displayed in the Power IQ event listing or event 
details pages through the event summary text. See Trap Mapping 
Variables and Format (on page 291). 

The best practice is to create a detailed, meaningful event summary text. 
Use filtering to map traps with values matching the filter to a specific 
event severity level and summary text. 

For examples, see: 

Example: Trap Mapping with Filters (on page 292) 

Example: Event Summary Message with Variables (on page 295) 

Traps can also be added to custom dynamic plugins based on 
SNMP-gateway managed devices. There are some setup requirements. 
See Example: Trap Mapping with Filters for SNMP Gateways (see 
"Example: Trap Mapping with Filters for Babel Buster SPX SNMP 
Gateway" on page 297) 
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Identify Trap OIDs and Parameters 

To create a dynamic plugin with trap support, follow this process to 
prepare your trap mappings. 

1. Identify the trap OIDs that you are interested in mapping.  

2. Identify the key parameters in each trap that will be used to create 
event filters and the event summary text in the trap mapping.  

 Trap OIDs: 

Trap OIDs are used to identity the alarm or condition being reported. 
When creating the trap mapping in the dynamic plugin, you will specify 
the trap OID: 

 The trap OID is specified in the Enterprise OID field for an SNMPv2 
trap. 

 The trap OID is specified in the Enterprise OID and Enterprise 
Specific ID field for an SNMPv1 trap. 

 Trap Parameters: 

Trap parameters are typically useful for: 

 uniquely identifying the alarm or condition which is being reported. 
This is necessary if a single trap can actually describe more than one 
alarm or condition. 

 providing sensor reading values and possibly the threshold value 
that was exceeded 

 uniquely identifying the specific PDU that the alarm pertains to in a 
proxied or gateway scenario. Custom mappings only. 

 any other trap details that may be useful to the Power IQ user 

 Tools To Help With Trap Mapping: 

A number of tools can be useful while trying to learn enough about a 
PDU's traps and their parameters to be able to define trap mappings in 
Power IQ.   

1. The vendor's MIB.  

 The MIB defines the traps that the device can generate, as well 
as the variable bindings, that is, trap parameters, that will be sent 
in each trap. The order of the parameters is specified in the MIB 
as well. Parameter order is important because you must know 
the order to define the parameter expansion values in the event 
summary text. The event summary text defines the message that 
will be generated for the Power IQ event that the trap is mapped 
to. 

2. A MIB browser. 
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 A MIB browser, such as the free iReasoning MIB browser, is 
useful for viewing the contents of the MIB, and it has a trap 
receiver that you can use to listen for and decode SNMPv1 and 
SNMPv2 traps. One good method is to first configure your PDU 
to sent traps to the computer running the iReasoning browser, 
and then cause the alarm condition that generates the trap. The 
iReasoning browser receives and decodes the trap. You can see 
exactly what traps your PDU is generating, what parameters are 
being sent, and in what order. 

 See Use a MIB Browser (on page 300). 
 

Trap OID Wildcards 

An OID wildcard is an asterisk (*) used in place of an object-identifer 
decimal value in an event filter OID value. OID wildcards are useful when 
a trap parameter's OID value contains an index value, and the trap 
mapping being defined should apply to all index values.  

For example, assume that a type of PDU can generate an 
'outletSensorChange' trap. This trap can be used to indicate an over 
current or an over voltage condition on an outlet. One of the trap's 
parameters indicates whether the alarm is for an "over current" or an 
"over voltage" condition. The OID associated with this trap parameter 
has a decimal value that indicates the outlet number that the alarm 
pertains to. The OIDs for this scenario would look similar to these sample 
OIDs: 

Outlet 1: 1.3.6.1.4.1.9999.1.9.1 

Outlet 2: 1.3.6.1.4.1.9999.1.9.2 

and so on, up to the final outlet 

Outlet 30: 1.3.6.1.4.1.9999.1.9.30 

Instead of creating a separate trap mapping in PIQ for each and every 
outlet, use the OID wildcard in place of the index parameter and specify 
a filter with the OID: 

1.3.6.1.4.1.9999.1.9.* 

The filter will include all outlets without needing to map a trap for each 
outlet. 

See Example: Trap Mapping with Filters for Babel Buster SPX 
SNMP Gateway (on page 297) 
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Trap Mapping Variables and Format 

When creating trap mappings in Power IQ, the event summary message 
is important to give a detailed description of the event that occurred.  

To create the most useful event summary text, you can write a message 
that uses parameter expansion for any SNMP trap parameter contained 
in the trap. 

Identify the trap parameters you want to include in your message. Use a 
trap receiver to view the list of parameters. Identify the parameters by 
number using the format shown. 

The following format is supported: {trap.1}, {trap.2} and so on. 

For example, the following table shows the first five trap parameters 
(varbinds) for a Raritan PX2 'inletSensorStateChange' trap. Two sets of 
parameters are shown to demonstrate how the SNMPv1 format trap 
works differently from the SNMPv2 format trap. Note that this is for 
illustration purposes only--a PX2 PDU cannot be configured to send 
SNMPv1 traps. 

SNMPv2 traps will always have a timestamp and a trap OID parameter 
as the first two parameters in the trap. SNMPv1 traps do not. If the MIB 
indicates that a particular trap has five parameters, when it is sent as an 
SNMPv2 trap, it will actually have seven parameters. 

Number SNMPv1 Parameters SNMPv2 Parameters Expansion Value 

1 pduName Timestamp {trap.1} 

2 pduNumber Trap OID {trap.2} 

3 pxInetAddressType pduName {trap.3} 

4 pxInetAddress pduNumber {trap.4} 

5 inletLabel pxInetAddressType {trap.5} 

See Example: Event Summary Message with Variables (on page 
295). 
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Example: Trap Mapping with Filters 

This example uses Raritan PX2 details as a reference. Dynamic plugins 
are not needed for PX2 PDUs. 

In this example, assume a dynamic plugin has been created for a Raritan 
PX2 PDU. The dynamic plugin will support trap mapping for one trap, 
with filtering added to create events with two severity levels. 

 Example Goal:  

To add trap mappings that show a Warning level event when the PX2's 
inlet sensor state is above the upper warning level, and to show a Critical 
level event when the inlet sensor state is above the upper critical level.  

 

PX2 MIB - Trap Information 

inletSensorStateChange                NOTIFICATION-TYPE 

                                     OBJECTS {  

                                               pduName, 

                                               pduNumber, 

                                             pxInetAddressType, 

                                               pxInetIPAddress, 

                                               inletLabel, 

                                               typeOfSensor, 

                                           
measurementsInletSensorTimeStamp, 

                                           measurementsInletSensorValue , 

                                           measurementsInletSensorState , 

                                               oldSensorState, 

                                               sysContact, 

                                               sysName, 

                                               sysLocation  } 

                                     STATUS current 

                                     DESCRIPTION 

                                         "Inlet Sensor State Change" 

                                     ::= { traps 61 } 
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 Steps: 

1. Select SNMP v2c. 

 
 

2
 

 

To add the Critical level mapping, click Add Trap, and add the Enterprise OID for the 
"inletSensorStateChange" trap for the PDU. Use the {pdu_system_oid} variable if 
desired. 

3
 

 

Select Generic Critical for the Event Type. 

4
 

 

Write an event summary message that describes the critical event. Use variables for the 
trap parameters to be included. The trap parameters expand when the message displays 
in the event details.  

For example, the first variable specified in the MIB for this trap is 'pduName'. This is the 
user-assigned name of the PDU that generated the trap. This example shows an 
SNMPv2 trap, so the 'pduName' variable is sent as the third variable in the trap. The first 
two varbinds of all SNMPv2 traps are 'timestamp' and 'trap oid'. See Identify Trap OIDs 
and Parameters (on page 289) and Trap Mapping Variables and Format (on page 
291). 

 

5
 

 

To make sure that only critical-level, inlet state events are mapped to this message, add 
a filter that looks for the "above upper critical" value for the inlet sensor state. Click Add 
Filter. Enter a descriptive name for the filter. Enter the OID for Inlet Sensor State, then 
enter the value for a critical event. This filter requires a value of "6", which means 
"AboveUpperCritical". 
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6
 

 

To add the Warning level trapping, repeat the Add Trap and Add Filter process, with 
these changes: 

 Event Type: Generic Warning 

 Event Summary: write text to describe warning condition, rather than critical 

 Filter Value: change from "6" to "5". A value of "5" for  inlet sensor state means 
"AboveUpperWarning". 
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Example: Event Summary Message with Variables 

Example of a trap mapping with trap parameters as variables in the 
Event Summary message, and the resulting Event Details with complete 
summary shown. 
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The event summary text that is displayed in the Events tab list and in the 
event details is generated at the time of the event creation. Any 
configured {trap.N} substitutions defined in the event summary text of the 
matching trap mapping are expanded from the event's SNMP parameter 
values.   

 

If event summary text cannot be generated because the relevant trap 
mapping was deleted or modified such that it is no longer a match, then 
an error message displays, indicating that no matching trap mapping 
could be found. 
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Example: Trap Mapping with Filters for Babel Buster SPX SNMP Gateway 

Power IQ can receive threshold traps from SNMP gateways, such as 
Babel Buster, and convert them into meaningful events. 

You must configure the Babel Buster to send traps before the traps can 
be mapped in the dynamic plugin. 

To configure a Babel Buster device to generate traps that can be 
converted to Power IQ events, you must: 

 Create uniquely named events  

 Configure threshold rules for the event 

 Associate the event with a register you want to monitor the value of 

 See Tips for Babel Buster Configuration (on page 299). 

 Example: 

To configure the dynamic plugin to be capable of mapping these traps to 
Power IQ events, follow these examples. Check the numbers in the 
screenshot with the list that follows for an example of each item. 
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1
 

 

Configure the Enterprise OID with the Babel Buster 'eventStateChange' trap OID:  
1.3.6.1.4.1.3815.1.2.2.2.0.1  

Babel Buster only supports a single trap OID, so the enterprise trap OID will always 
have this value for any threshold trap you configure. 

2
 

 

Select the appropriate Event Type based on the alarm condition being reported by 
the specific trap you are mapping. 

3
 

 

Configure meaningful Event Summary text using desired trap parameter expansion 
elements: {trap.1}, {trap.2}...{trap.N}  

See Trap Mapping Variables and Format (on page 291). 

4
 

 

Add an Event Name filter. Use the unique event name as configured on the Babel 
Buster as the filter's Value. 

5
 

 

Each filter OID must be specified such that it is an exact match for the OID of the 
targeted trap parameter.  

One or more asterisks (*) may be substituted in any position in the OID in place of a 
decimal value. This asterisk acts as a wildcard and will cause the Power IQ trap 
handler to ignore that particular portion of the OID when performing matching. See 
Trap OID Wildcards (on page 290). 

This is helpful in the Babel Buster scenario because the second to last decimal value 
is an 'eventIndex' value which indicates the row in 'eventTable' in the Babel Buster 
MIB. The 'eventIndex' value is dynamic and will change based on the Babel Buster 
configuration. Specifying an asterisk in your filter OID mappings will prevent your 
configuration from having to be modified in the event that the Babel Buster threshold 
configuration changes in the future. 

6
 

 

Add a 'Register Number' filter. Use the number of the register associated with the 
threshold configured on the Babel Buster as the Filter's Value. This step is optional if 
the 'Event Name' filter value is unique. 

7
 

 

Add an 'Event State' filter. The event state trap parameter value indicates whether the 
alarm condition is active (asserted) or not active (de-asserted). An event state value 
of (1) indicates an active event, and a value of (0) indicates that the condition is not 
active. This means that an event state value of (0) indicates that the alarm condition 
has been cleared.  

A common scenario would be to create two trap mappings for each Babel Buster 
Action Rule or Event Name. One trap mapping would be used to map the active trap, 
where EventState value is 1, and one trap mapping would be used to map the 
clearing trap, where EventState value is 0. 
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Tips for Babel Buster Configuration 

For help with configuring Babel Buster to send SNMP traps, go to the 
Control System help: 

http://www.csimn.com/CSI_pages/bbsp_faq1.html 

 BabelBuster Event State Change reference information: 

eventStateChange 

Babel Buster devices allow you to configure a named threshold that will 
generate an eventStateChange trap. 

Trap 

eventStateChange    NOTIFICATION-TYPE 

    OBJECTS { 

        eventRegNum, 

        eventRegName, 

        eventRegData, 

        eventName, 

        eventTestType, 

        eventTestVal, 

        eventState 

    } 

    STATUS         current 

    DESCRIPTION 

        "This trap is sent when an event changes state 

        if notifications are enabled for the object that changed." 

    ::= { bbx2Traps 1 } 

VariablesEdit section 

 

    eventRegNum - (Integer) Register number referenced by this event. 

    eventRegName - (DisplayString) Name of register referenced by this 
event. 

    eventRegData - (DisplayString) Floating point ASCII string 
representation of register data. 
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    eventName - (DisplayString) Name given to this event for 
identification purposes. 

    eventTestType - (Integer - undefined(0), greaterThan(1), 
greaterOrEqual(2), lessThan(3), lessOrEqual(4), equal(5), notEqual(6)) 
Event test type, comparision of register data against test value. 

    eventTestVal - (DisplayString)  Floating point ASCII string 
representation of event test value. 

    eventState - (Integer - false(0), true(1)) State of event, true means 
register meets test defined by threshold rule, true may imply alarm 
condition active 
 

Structured Dynamic Plugins 

Requirements for Structured Dynamic Plugins 

 MIB file for the device you want to manage. See Find the MIB File 
(on page 300). 

 Ability to correctly identify OIDs in a MIB file. 
 

Find the MIB File 

To add a PDU using dynamic plugins, you must have the MIB file for the 
PDU. 

 To find the MIB file: 

MIBs are usually available in one of the following locations. 

 The product interface. For example, Raritan PX PDUs have a menu 
option to save the MIB file. Note: PX PDUs are supported. You do 
not need to add dynamic plugins for Raritan PDUs. 

 The product's website.  

 The product's technical support department. 
 

Use a MIB Browser 

A MIB browser is useful when creating your dynamic plugins. When 
adding traps to dynamic plugins, a trap receiver is also helpful. 

iReasoning MIB Browser free personal edition is suggested. iReasoning 
also includes a trap receiver. 

See Identify Trap OIDs and Parameters (on page 289) for details on 
using a MIB browser to help with trap mapping. 

Go to http://ireasoning.com/download.shtml 
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Identify the OIDs for Mapping 

Power IQ provides the ability to map OIDs for many components, 
attributes, and details of power devices. Power IQ can collect and display 
data from the device based on the mappings you provide. 

OIDs are documented in a product's MIB file. 

In SNMP, the object identifier (OID) that uniquely identifies the make and 
model of an SNMP-managed device is the MIB-II System Object 
Identifier, commonly referred to as "sysObjectID", which is 
1.3.6.1.2.1.1.2.0.  

Within Power IQ, the value for "sysObjectID" is referred to as the "PDU 
System OID". 

For example, the sysObjectID or "PDU System OID" for a Raritan model 
PX PDU is "1.3.6.1.4.1.13742.4". The "PDU System OID" is commonly 
used as the prefix for additional OIDs used to retrieve PDU attribute and 
component information.   

See Mappings for Each PDU Type (on page 275) for lists of values that 
you can map from your PDU to Power IQ. 

For each feature that you want to map, you must find the OID, and enter 
it in the mapping form to create the dynamic plugin. See Create a 
Structured Dynamic Plugin (on page 301). 
 

Create a Structured Dynamic Plugin 

Select the data you want to collect from your PDU and add the OID 
mappings for it to create the structured dynamic plugin. 

When adding OIDs, you can use variables to simplify data entry and 
reduce errors. You must use the correct formatting, which is validated 
when you save the plugin. See OID Variables and Format (on page 305) 
for details. 

For a full list of available data you can map, see Mappings for Each 
PDU Type (on page 275). 

For help with mapping external sensors on rack PDUs, see External 
Temperature and Humidity Sensor Mappings (see "External 
Temperature and Humidity Sensor Mappings for Rack PDUs" on 
page 282). 

For help with mapping traps, see Trap Support in Dynamic Plugins - 
Structured or Custom (on page 288) 

 To add a dynamic plugin: 

1. In the Settings tab, click Dynamic Plugins in the Appliance 
Administration section. 
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2. Click Add, then click the type of device: CRAC, Floor PDU, Floor 
UPS, Power Panel, Rack PDU, Standalone Meter. Do not select 
Custom when using a structured MIB to create the plugin. See 
Create a Custom Mapping Dynamic Plugin (on page 309). 

 For environmental sensor aggregators, use Rack PDU. 

 Type cannot be changed once the dynamic plugin is created.  

3. The new dynamic plugin page displays.  

4. Enter a name to identify this dynamic plugin, in the Name field.  

 Lowercase letters and underscores only. 

5. Enter a description to identify this dynamic plugin in the Description 
field. 

6. Enter the manufacturer of the device you want to add using this 
dynamic plugin in the Manufacturer field. 

7. The Model field can be used as a filter to specify a specific model 
number string, when the "PDU Model OID" returns more than one 
model number. This is useful when the MIB supports multiple 
different models and it is not possible to design a single dynamic 
plugin capable of supporting them all.  

8. Phase: Select Automatic to allow Power IQ to determine the phase 
of the device by counting the number of poles on the inlets. Or, make 
a selection to hard-code the phase as Single Phase or Three Phase.  

9. Check the Always Use SNMPv1 checkbox if the target device only 
supports SNMPv1. Leave the checkbox blank to use the default, 
SNMPv2 communication. 

10. In the Metadata section, enter the value used in the MIB to indicate 
each status or control value. Common MIB value pairs are Yes/No, 
On/Off, 1/2. See Metadata for Circuit Breakers and Outlets (on 
page 306) for details. 

 Circuit Breaker State OK 

 Circuit Breaker State Tripped 

 Outlet State On 

 Outlet State Off 

 Outlet Power On 

 Outlet Power Off 
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11. Enter values for the Sensors Metadata. These values work with 
external sensor mappings. See Metadata for Sensors (on page 
307). 

 

12. Enter the PDU System OID and PDU Model OID for the devices that 
will use this dynamic plugin. See OID Variables and Format (on 
page 305) for details. Required. See step 7 for the Model filtering 
field, if you expect multiple models to be returned. 

13. To add features of the PDU, select an item from the "Add another 
mapping" drop-down list, then click Add. These links contain the list 
of supported mappings for each device type.  

 CRAC Mappings (on page 275) 

 Floor PDU Mappings (on page 276) 

 Floor UPS Mappings (on page 278) 

 Power Panel Mappings (on page 279) 

 Rack PDU Mappings (on page 280) 

 Standalone Meter Mappings (on page 281) 

 Wildcard Index Mappings - Structured Dynamic Plugins Only 
(on page 285) 

14. For each mapping you add, enter the OID. If the MIB does not have 
an OID for an Index item, enter an integer value. See Index 
Mapping Format (on page 308) for details about mapping indices.  

Some mappings require extra information, below the main mapping 
field.  

a. Start and Step for Index mappings: 

 Some MIBs number indices starting at a number other than 1, 
and in increments greater than 1. If your MIB shows this, 
enter the starting number in the Start field, and the increment 
in the Step field. 

b. Multipliers for measurement mappings: 
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 Power IQ expects power readings to be in the following units: 
Amps, Volts, Watts, VoltAmps, Degrees Fahrenheit/Celsius, 
and so on. 

 Many MIBs report power readings in different units than what 
Power IQ requires. The multiplier field is used to scale the 
retrieved readings to the units required. For example, if the 
MIB reports readings in KiloWatts a multiplier value of 1000 
must be specified to scale KiloWatts to Watts. A value of 
5KW reported by the SNMP agent is converted to 5000 
Watts when the multiplier is applied.  

15. To add mappings for traps sent by the PDU, select SNMP Version, 
v1 or v2c, then click Add Trap to display the fields. To add multiple 
traps, click Add Trap to display another set of fields.  

a. For SNMP v1 traps, enter the Enterprise OID and the Enterprise 
Specific ID for the trap. For SNMP v2 traps, only the Enterprise 
OID for the trap is required. 

b. Select the generic event this trap will map to: Generic Info, 
Generic Warning, Generic Critical.  

c. In the Event Summary, write the message that will appear in the 
event details. Use the trap's parameters as variables to create a 
complete, detailed summary of the event. See Trap Mapping 
Variables and Format (on page 291) for syntax. See Example: 
Event Summary Message with Variables (on page 295) for a 
sample summary. 

d. To filter the incoming traps, click Add Filter to display the fields. If 
a trap defined by the PDU's MIB can describe multiple alarm 
conditions, and you would like to map an incoming trap to one of 
several Power IQ events based on a specific alarm condition, 
then you must define event filters. The filters determine which 
Power IQ event an incoming trap should be mapped to. 

 Enter a name for the filter.  

 Enter OID of the trap parameter that this filter applies to. 

 Enter the value that the trap parameter must match. The trap 
parameter value must match exactly to be considered a 
match. 

 See Example: Trap Mapping with Filters (on page 292). 

16. When you've finished with mappings, click Create Plugin. 

17. Add the PDU that uses the dynamic plugin. See Adding PDUs to 
Power IQ Management (on page 20).  

See Check PDUs Added with Dynamic Plugins (on page 330). 
 



 Chapter 18: Appliance Administration  

 
305

 
 

OID Variables and Format 

When creating mappings in Power IQ, you can use a variable to 
represent some OIDs, when the number is part of another OID. For 
example, many OIDs contain the PDU System OID. 

The following variables are supported. 

OID Variable 

PDU System OID {pdu_system_oid} 

PDU Proxy Index {proxy_index} 

Circuit Breaker Index {circuit_breaker_index} 

Inlet Index {inlet_index} 

Inlet Pole Index {inlet_pole_index} 

Outlet Index {outlet_index} 

Outlet Pole Index {outlet_pole_index} 

Panel Index {panel_index} 

Panel Inlet Index {panel_inlet_index} 

Panel Inlet Pole Index {panel_inlet_pole_index} 

Circuit Index {circuit_index} 

Circuit Pole Index {circuit_pole_index} 

Sensor Indexes {external_sensor_index} 

{external_sensor_temperature_index} 

{external_sensor_humidity_index} 

Wildcard Indexes {wildcard_one_index} 

{wildcard_two_index} 

{wildcard_three_index} 

{wildcard_four_index} 

 To use a variable in an OID: 

To use a variable in an OID, substitute the variable text for the numbers. 
You must use the curly brackets before and after, and the period after 
the final bracket. Follow the examples in the table. 

 

OID with variable substitution Fully Expanded OIDs 

 

{pdu_system_oid}.1.1.13.0 

PDU Name for a PX1: 

1.3.6.1.4.1.13743.4.1.1.13.0 



Chapter 18: Appliance Administration 
 

306
  

 

 

{pdu_system_oid}.1.1.1.0 

PDU Firmware for a PX1 

1.3.6.1.4.1.13743.4.1.1.1.0 

 

{pdu_system_oid}.1.2.2.1.7.{outlet_index} 

Outlet Active Power OIDs for an 8-outlet PX1 

1.3.6.1.4.1.13742.4.1.2.2.1.7.1 

1.3.6.1.4.1.13742.4.1.2.2.1.7.2 

1.3.6.1.4.1.13742.4.1.2.2.1.7.3 

1.3.6.1.4.1.13742.4.1.2.2.1.7.4 

1.3.6.1.4.1.13742.4.1.2.2.1.7.5 

1.3.6.1.4.1.13742.4.1.2.2.1.7.6 

1.3.6.1.4.1.13742.4.1.2.2.1.7.7 

1.3.6.1.4.1.13742.4.1.2.2.1.7.8 

 
 

Metadata for Circuit Breakers and Outlets 

 

 Circuit Breaker State and Outlet State metadata: 

The dynamic plugin uses the Circuit Breaker State and Outlet State 
metadata values to interpret values retrieved from a target PDU during 
polling. The values entered must be based on information in the target 
PDU's MIB.  

For example, if the MIB indicates that an integer value of 1 indicates that 
an outlet is ON, and 2 indicates that an outlet is OFF, you must specify 
those values in the metadata section so that Power IQ can interpret the 1 
as ON, and the 2 as OFF when those values are retrieved in polling. 

 Outlet Power metadata: 

The dynamic plugin uses the Outlet Power metadata values when 
performing outlet power control on a target PDU. Some MIBs will use the 
same value to indicate both the outlet state and power control operations.  
Some MIBs use different values. All four Outlet State and Power 
metadata values must be configured properly for outlet power control to 
work. 
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Metadata for Sensors 

 

In the Metadata for sensors, the fields work together with the mappings 
you add to determine your sensor types, and the units used to interpret 
readings. See External Temperature and Humidity Sensor Mappings 
for Rack PDUs (on page 282) for details. See External Temperature 
and Humidity Sensor Mappings Example Screenshots (on page 326) 
for examples. 

 Humidity Sensor Type: When the MIB contains a single sensor 
reading table, and there is a value you can use to determine 
sensor type, use this field to set the value of the humidity sensor 
type. 

 Temperature Sensor Type: When the MIB contains a single 
sensor reading table, and there is a value you can use to 
determine sensor type, use this field to set the value of the 
temperature sensor type. 

 Temperature Unit: set the value to C or F to hard code the units 
used to interpret readings, when the MIB does not have sensor 
reading unit information, or when Temperature Unit 
(Celsius)/Temperature Unit (Fahrenheit) values are not found in 
this metadata section. This field is only used when a units value 
is not specified on a per reading basis using the 
external_sensor_unit (generic) or 
external_sensor_temperature_unit (specific) mappings. 

 Temperature Unit (Celsius) and Temperature Unit (Fahrenheit): 
These fields work with the external_sensor_unit, or 
external_sensor_temperature_unit mappings. Your readings unit 
is determined by a match between the value specified here, and 
the value returned from the MIB for either external_sensor_unit 
or external_sensor_temperature_unit. 
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Index Mapping Format 

Structured dynamic plugins use index mappings to determine the 
number of PDU elements that a particular PDU has. PDU elements are 
inlets, inlet poles, circuit breakers, outlets, and so on. 

There are 2 options for specifying a index mapping values. 

 Specify an SNMP OID whose retrieved value indicates the PDU 
element's count. 

 Specify a hard-coded integer value to indicate the PDU element's 
count 

The advantage of specifying an OID value that the dynamic plugin can 
use to retrieve the PDU element count is that a single dynamic plugin is 
capable of supporting a variety of different PDU models with different 
numbers of inlets, inlet poles, circuit breakers, outlets, and so on. 

If the MIB does not support OIDs that can be used to find the count, you 
must provide a hard-coded integer value. In this case, the dynamic 
plugin will likely only work for a specific model. You may also need to 
specify a Model name filter to ensure the dynamic plugin is only used 
with the appropriate model type. 

 To specify a count object OID for index mappings: 

Find a count object in the MIB that specifies the number of a particular 
component, such as outlets, that the target PDU has. Specify the OID for 
the count as the value of the index.  

When an OID is a scalar object, that is, not part of a table, add a ".0" to 
the end of the OID. 

For example, the Raritan PX MIB supports an "outletCount" object with 
an OID of 1.3.6.1.4.1.13742.4.1.2.1. 

Add a ".0" to the end of the OID to arrive at an OID of 
1.3.6.1.4.1.13742.4.1.2.1.0. 

Power IQ can then use this OID to perform an SNMP get request for the 
number of outlets on a specific PDU. 

To map this value in the dynamic plugin, enter 
"1.3.6.1.4.1.13742.4.1.2.1.0" in the Outlet Index field. 
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Custom Mapping Dynamic Plugins 

Requirements for Custom Mapping Dynamic Plugins 

 For custom mappings based on flat MIBs: 

 MIB file for the device you want to manage. See Find the MIB File 
(on page 300). 

 Ability to correctly identify OIDs in a MIB file. 

 For custom mappings based on SNMP-gateway managed 
devices: 

 A SNMP gateway device that converts Modbus/Bacnet to SNMP 

 A list of the registers for the PDU you want to manage. See Find the 
Modbus Register List (on page 309). 

 Ability to correctly convert the registers to SNMP OIDs, using your 
SNMP-gateway device 

 

Find the Modbus Register List 

To add a Modbus device using a custom mapping dynamic plugin, you 
must have the register list for the device. 

 To find the Modbus register list: 

Modbus register lists are usually available in one of the following 
locations. 

 The product's user guide 

 The product's website.  

 The product's technical support department. 
 

Create a Custom Mapping Dynamic Plugin 

 To create a custom mapping dynamic plugin: 

1. In the Settings tab, click Dynamic Plugins in the Appliance 
Administration section. 

2. Click Add, then click Custom. Do not select the type of device now.  
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3. The new dynamic plugin page displays.  

4. Enter a name to identify this dynamic plugin, in the Name field.  

 Lowercase letters and underscores only. 

 Tip for SNMP gateway use cases: When you have multiple 
devices using the same gateway, include proxy information in 
the name. This will help you identify the correct plugin when 
adding devices. See Proxy ID field. 

5. Enter a description to identify this dynamic plugin in the Description 
field. 

6. Enter the manufacturer of the device you want to add using this 
dynamic plugin in the Manufacturer field. 

7. The Model field can be used as a filter to specify a specific model 
number string, when the "PDU Model OID" returns more than one 
model number. This allows you to create a dynamic plugin for a 
specific model, even when multiple models are contained in the MIB.  

 

8. Check the Always Use SNMPv1 checkbox if the target PDU only 
supports SNMPv1. Leave the checkbox blank to use the default, 
SNMPv2 communication.  

9. In the Metadata section, enter the value used in the MIB to indicate 
each status or control value. Common MIB value pairs are Yes/No, 
On/Off, 1/2. See Metadata for Circuit Breakers and Outlets (on 
page 306) for details. 

 Circuit Breaker State OK 

 Circuit Breaker State Tripped 

 Outlet State On 
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 Outlet State Off 

 Outlet Power On 

 Outlet Power Off 

 

10. Enter values for the Sensors Metadata. These values work with 
external sensor mappings. See Metadata for Sensors (on page 
307). 

 

11. In the Mappings section, select the type of device: CRAC, Floor PDU, 
Floor UPS, Power Panel, Rack PDU, Standalone Meter. 

 Type cannot be changed once the plugin is created. 

 

12. Enter the device's name in the PDU Name field.  

13. Enter the System OID for the PDU. 

 For SNMP gateway use cases, enter the gateway's System OID. 

14. The Proxy ID field is used to identify PDUs in daisy chained 
configurations, or managed by a serial device. In an SNMP gateway 
use case, use this field to assign a proxy id to each PDU managed 
by the gateway. Best practice is to start with 1 for gateways, entering 
a unique proxy id for each PDU managed through the gateway.  
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Note: When you add the PDUs managed by the SNMP gateway to 
Power IQ, you will indicate the proxy index for each one. This is how 
Power IQ differentiates the separate PDUs behind the same IP 
address. 

15. Enter the PDU Model OID for the PDU that will use this dynamic 
plugin. Required. See step 7 for the Model filtering field, if the MIB 
you are working with supports multiple models and you want this 
custom mapping to apply to a specific model. Hard code a value if 
the MIB does not provide a value. 

16. Enter an OID for the firmware version in the PDU Firmware field. 

17. Enter or import Custom Mappings. See Sensor Mappings (on page 
315). 

 

18. Enter Sensor Multipliers. See Sensor Multipliers (on page 321). 

 

19. To add mappings for traps sent by the PDU, select SNMP Version, 
v1 or v2c, then click Add Trap to display the fields. To add multiple 
traps, click Add Trap to display another set of fields.  

a. For SNMP v1 traps, enter the Enterprise OID and the Enterprise 
Specific ID for the trap. For SNMP v2 traps, only the Enterprise 
OID for the trap is required. 

b. Select the generic event this trap will map to: Generic Info, 
Generic Warning, Generic Critical.  

c. In the Event Summary, write the message that will appear in the 
event details. Use the trap's parameters as variables to create a 
complete, detailed summary of the event. See Trap Mapping 
Variables and Format (on page 291) for syntax. See Example: 
Event Summary Message with Variables (on page 295) for a 
sample summary. 
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d. To filter the incoming traps, click Add Filter to display the fields. If 
a trap defined by the PDU's MIB can describe multiple alarm 
conditions, and you would like to map an incoming trap to one of 
several Power IQ events based on a specific alarm condition, 
then you must define event filters. The filters determine which 
Power IQ event an incoming trap should be mapped to. 

 Enter a name for the filter.  

 Enter OID of the trap parameter that this filter applies to. 

 Enter the value that the trap parameter must match. The trap 
parameter value must match exactly to be considered a 
match. 

 See Example: Trap Mapping with Filters (on page 292). 

 See Example: Trap Mapping with Filters for Babel Buster 
SPX SNMP Gateway (on page 297). 

20. When you've finished with mappings, multipliers, and traps, click 
Create Plugin. 

21. Add the PDU that uses the dynamic plugin. See Adding PDUs to 
Power IQ Management (on page 20).  

See Check PDUs Added with Dynamic Plugins (on page 330). 
 

Metadata for Circuit Breakers and Outlets 
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 Circuit Breaker State and Outlet State metadata: 

The dynamic plugin uses the Circuit Breaker State and Outlet State 
metadata values to interpret values retrieved from a target PDU during 
polling. The values entered must be based on information in the target 
PDU's MIB.  

For example, if the MIB indicates that an integer value of 1 indicates that 
an outlet is ON, and 2 indicates that an outlet is OFF, you must specify 
those values in the metadata section so that Power IQ can interpret the 1 
as ON, and the 2 as OFF when those values are retrieved in polling. 

 Outlet Power metadata: 

The dynamic plugin uses the Outlet Power metadata values when 
performing outlet power control on a target PDU. Some MIBs will use the 
same value to indicate both the outlet state and power control operations.  
Some MIBs use different values. All four Outlet State and Power 
metadata values must be configured properly for outlet power control to 
work. 
 

Metadata for Sensors 

 

In the Metadata for sensors, the fields work together with the mappings 
you add to determine your sensor types, and the units used to interpret 
readings. See External Temperature and Humidity Sensor Mappings 
for Rack PDUs (on page 282) for details. See External Temperature 
and Humidity Sensor Mappings Example Screenshots (on page 326) 
for examples. 

 Humidity Sensor Type: When the MIB contains a single sensor 
reading table, and there is a value you can use to determine 
sensor type, use this field to set the value of the humidity sensor 
type. 

 Temperature Sensor Type: When the MIB contains a single 
sensor reading table, and there is a value you can use to 
determine sensor type, use this field to set the value of the 
temperature sensor type. 
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 Temperature Unit: set the value to C or F to hard code the units 
used to interpret readings, when the MIB does not have sensor 
reading unit information, or when Temperature Unit 
(Celsius)/Temperature Unit (Fahrenheit) values are not found in 
this metadata section. This field is only used when a units value 
is not specified on a per reading basis using the 
external_sensor_unit (generic) or 
external_sensor_temperature_unit (specific) mappings. 

 Temperature Unit (Celsius) and Temperature Unit (Fahrenheit): 
These fields work with the external_sensor_unit, or 
external_sensor_temperature_unit mappings. Your readings unit 
is determined by a match between the value specified here, and 
the value returned from the MIB for either external_sensor_unit 
or external_sensor_temperature_unit. 

 

Sensor Mappings 

Sensor mappings are used in the custom dynamic plugin to identify each 
power sensor, or data point, you want Power IQ to support for your PDU. 

Sensor mappings can be entered manually, by entering and selecting 
values. Or, you can create a CSV file with the information formatted 
correctly, and import the file. 

To understand sensor mappings, and view instructions for manual entry, 
see: 

 Object Identifier (on page 316) 

 Data Model Element (on page 316) 

 Sensor Type (on page 318) 

 Custom Dynamic Plugin Example Screenshots (on page 323) 

To see instructions and an example of the CSV file for importing 
mappings, see: 

 Sensor Mapping CSV Import File Structure (on page 320) 

To see rules that apply to mappings, see: 

 Additional Custom Mapping Rules (on page 322) 
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Object Identifier 

The object identifier is the SNMP OID for the sensor, such as an attribute 
or reading, you want to collect.  

In some cases, when an OID is not available in the MIB, you can hard 
code a value. 

Valid values: 

 SNMP OID for the sensor  

OR 

 A hard-coded value for some sensor types. See Sensor Type (on 
page 318). 

Hard code a value when an OID is not available in the MIB. You can 
hard code circuit pole phase, circuit pole position on a panel, names, and 
any sensor type where a positive decimal number value would be 
returned. Hard coding for numeric values makes sense in some cases, 
such as voltage. Some other numeric values, such as active power, may 
be hard coded but will not result in meaningful data. 
 

Data Model Element 

The data model element specifies where this sensor is associated in the 
model of the PDU. 

Each device type support different data model elements. The data model 
elements have hierarchical parent-child relationships. See Data Model 
Elements by PDU Type (on page 317). 

You must identify the precise association of each sensor. 

 To identify the data model element: 

1. In the list of data model elements, find the data model element you 
want to associate a sensor type with. See Data Model Elements by 
PDU Type (on page 317). 

2. Append the number of the element to the end of each element's 
name. Leave one space between elements.  

 Example: 

An amperage sensor for pole 3 on circuit 10 of a Floor PDU's second 
panel. 

panel2 circuit10 circuitpole3 
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Data Model Elements by PDU Type 

Data model elements have hierarchical parent-child relationships.  

 Rules for all PDU types:  

 A panel may directly contain inlets and circuits or circuitpoles 

 An inlet may contain inletpoles 

 An outlet may contain outletpoles 

 A circuit may contain circuitpoles 

 CRAC 

 inlet 

 inlet inletpole 

 FLOOR_PDU 

 inlet 

 inlet inletpole 

 panel 

 panel inlet 

 panel inlet inletpole 

 panel circuit 

 panel circuit circuitpole 

 panel circuitpole 

 circuit 

 circuit circuitpole 

 circuitpole 

 FLOOR_UPS 

 inlet 

 inlet inletpole 

 circuit 

 circuit circuitpole 

 POWER_PANEL 

 inlet 

 inlet inletpole 

 circuit 

 circuit circuitpole 

 circuitpole 

 RACK_PDU 

 inlet 
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 inlet inletpole 

 circuitbreaker 

 outlet 

 outlet outletpole 

 externalsensor 

 STANDALONE_METER 

 circuit 

 circuit circuitpole 
 

Sensor Type 

The sensor type identifies the type of reading expected from the sensor. 
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Valid values Valid for these data model elements Valid hard coded value in Object 
Identifier Field 

 active_power  inlet, inletpole, outlet, circuit, 
circuitpole 

 positive decimal number 

 apparent_power  inlet, outlet, circuit  positive decimal number 

 current  inlet, outlet, circuit, any pole  positive decimal number 

 decimal_digits  external sensor  positive decimal number used to 
scale external sensor readings 

 name  outlet, circuit, circuitpole, 
circuitbreaker 

 name of the data model element 

 phase   circuitpole  L1, L2, L3 

 A, B, C 

 X, Y, Z 

 1,2,3 

 See Set Phase Labels for Circuit 
Pole Phase (on page 336). 

 position   circuitpole  Number greater than 0.  

 Specifies the circuit pole position on 
the panel. 

 power_control  outlet  Hard coding not supported for 
power control. 

 power_factor   inlet, outlet, circuit  positive decimal number between 0 
- 1. 

 Example: Power factor 98% is hard 
coded as .98. 100% is 1.0. 

 state  outlet, circuit breaker  Hard coded value must match the 
configured metadata value. 

 See Metadata for Circuit 
Breakers and Outlets (on page 
306). 

 type   externalsensor  Example: T for Temperature, H for 
Humidity. 

 Hard coded value must match the 
configured metadata value for 
Humidity Sensor Type or 
Temperature Sensor Type.  

 See Metadata for Sensors (on 
page 307). 
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Valid values Valid for these data model elements Valid hard coded value in Object 
Identifier Field 

 unit  externalsensor  Example: C for Celsius.  

 Hard coded value must match the 
configured metadata value for 
Temperature Unit (Celsius) or 
Temperature Unit (Fahrenheit). 

 See Metadata for Sensors (on 
page 307). 

 value  externalsensor  decimal number 

 voltage  inlet, outlet, circuit, any pole  positive decimal number 

 watt_hour  inlet, panelinlet, circuit, outlet  positive decimal number 

 
 

Sensor Mapping CSV Import File Structure 

To include sensor mappings for a custom dynamic plugin, you may 
import a CSV file containing the information, instead of entering and 
selecting the information manually. 

These links include instructions and valid values for each column: 

 Object Identifier (on page 316) 

 Data Model Element (on page 316) 

 Sensor Type (on page 318) 

 To import the sensor mapping CSV file: 

1. In the custom plugin form, click Import in the Sensor Mappings 
section. 

2. Select the file and click Upload. If the file validates, the entries 
appear in the fields.  
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 The structure of the CSV file: 

 One line per sensor mappinig 

 No header row 

 Each line has only the value columns, in the following order 

Column 1:  

Object Identifier 

Column 2:  

Data Model Element 

Column 3:  

Sensor Type 

 Example: 

 
 

Sensor Multipliers 

Power IQ expects power readings to be in the following units: Amps, 
Volts, Watts, VoltAmps, Degrees Fahrenheit/Celsius, and so on. 

Many MIBs report power readings in different units than what Power IQ 
requires. The multiplier field is used to scale the retrieved readings to the 
units required.  

 To enter sensor multiplier mappings: 

1. In the custom dynamic plugin form, click Add to add a row to the 
Sensor Multipliers list.  

 The list has three fields for each entry.  

 Double-click the Data Element and Sensor Type fields to access 
a drop-down list of values.  

 Double-click the Multiplier field to access a text field.  
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Data Element Sensor Type:  Multiplier Value: 

Select the data model element 
this multiplier is used on. 

Select the sensor type this 
multiplier is used on. 

Enter the decimal value the 
dynamic plugin will use to 
normalize the readings into units 
supported by Power IQ. 

 circuit 

 circuit_breaker 

 circuit_breaker_pole 

 inlet 

 inlet_pole 

 outlet 

 outlet_pole 

 external_sensor 

 external_sensor_humidity 

 external_sensor_temperature 

 panel_inlet 

 panel_inlet_pole 

 active_power 

 apparent_power 

 current 

 power_factor 

 voltage 

 watt_hour 

 value 

 For example: If an active 
power sensor OID returns a 
value of 5 kilowatts, enter a 
multiplier of 1000 to 
normalize to 5000 watts. 

 
 

Additional Custom Mapping Rules 

When creating your plugin, remember these additional rules to ensure 
your plugin validates, and that you get the best possible data collection. 

 Make sure you correctly map the phase of your circuit poles to the 
phase of the building. 

 Add inlet poles in order (A, B, C). 

 In a group of like elements, for example, inlet_poles, each element 
must have the same type of sensors mapped, and must indicate the 
same total number of the element.  

 Example: If an inlet_pole has voltage mapped, than all 
inlet_poles for that plugin must have voltage mapped.  

 Example: If there are mappings for 3 voltage sensors for 
'inlet_pole' then there must be exactly 3 current sensors 
configured, or 0 current sensors if current readings are not 
desired or available.  

 For a given sensor type and data model element, all mappings must 
be OIDs or hard-coded. A mix is not permitted.  

 

Showing Accurate Circuit Pole Positions 

To show accurate circuit pole positions, add the OIDs for each pole to 
the custom mapping in the correct order, or hard code the circuit pole 
positions in the custom mapping. 
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Custom Dynamic Plugin Example Screenshots 

This custom dynamic plugin example shows a Babel Buster SNMP 
gateway managing a Schneider PowerLogic PM710 standalone meter. 
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External Temperature and Humidity Sensor Mappings Example 
Screenshots 

 If temperature and humidity sensor information is available in a 
single table AND there is a way to uniquely determine the type 
of the sensor: 

If temperature and humidity information is available is a single table AND 
there is an OID that can be queried to determine the type of the sensor, 
use the generic set of external_sensor_* mappings to collect sensor 
data. 

For example, a PX1 192.168.45.236 has environmental sensor data 
available in a single table called 'externalSensors'. There is an OID 
'externalSensorType' that determines the type of each sensor. In this 
scenario, the generic set of external_sensor_* mappings can collect the 
environmental sensor data.  

MIB for the PX1: 
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Sensor Metadata and Mappings Using the PX1 MIB: 
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 If there is no OID to determine the sensor type, but there are 
separate OIDs for temperature and humidity sensor values: 

When the temperature and humidity sensor information is available in a 
single table AND there is no OID to determine the sensor type, BUT 
there are separate OIDs for temperature and humidity sensor values, 
use the temperature_sensor_* and humidity_sensor_* mappings to 
collect sensor data. 

For example, an APC 192.168.42.216-1 has one environmental probe 
that has both temperature and humidity sensors. The information is 
available in a single table and there are separate OIDs for temperature 
and humidity readings. In this scenario, the temperature_sensor_* and 
humidity_sensor_* mappings can collect the sensor data. 

MIB for the APC: 
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Sensor Metadata and Mappings Using the APC MIB: 
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Adding PDUs with Custom Dynamic Plugins 

When adding a PDU that uses a custom dynamic plugin, use the same 
Add a PDU feature as any other addition. See Adding PDUs to Power 
IQ Management (on page 20). 

When Power IQ detects that there is at least one custom dynamic plugin 
configured, a Plugin drop-down field displays. 

 

 Automatic: Use Automatic to allow Power IQ to determine the correct 
plugin for the PDU you are adding. Automatic attempts to find an 
exact match between the PDU and the plugin for SysObjectID, PDU 
Model name, and Proxy ID. 

 If there is no exact match, but several dynamic plugins are 
eligible to manage the PDU, based on sysObjectID, then Power 
IQ selects from among the eligible plugins. If automatic mode 
does not select the desired dynamic plugin, delete the PDU and 
add it again, selecting the specific custom dynamic plugin from 
the list. 

 Or, select the specific custom dynamic plugin from the list. 
 

Check PDUs Added with Dynamic Plugins 

After you add a PDU using a dynamic plugin, you should check the data 
collected to verify accuracy. 

 To check PDUs added with dynamic plugins: 

1. In the PDUs tab, click the PDU link. The PDU details page opens. 

2. Examine the page to verify that all the data you created mappings for 
is available. If you do not see data you expected, check your 
mappings. 

3. Check power measurement values to make sure that multipliers 
were entered correctly. 

4. If you see issues, check all mappings and the log file to troubleshoot. 
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 To access the dynamic plugins log: 

1. In the Settings tab, click Dynamic Plugins in the Appliance 
Administration section. 

2. Click View Log.  
 

View PDUs Using a Dynamic Plugin 

When a dynamic plugin is in use, you can view the PDUs that are 
associated with it. 

 To view PDUs using a dynamic plugin: 

1. In the Settings tab, click Dynamic Plugins in the Appliance 
Administration section. 

2. All dynamic plugins display in a list. In the PDU Count column, the 
number link shows how many PDUs use this dynamic plugin. Click 
the link to view a list of the PDUs associated with the plugin. 
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Troubleshooting Dynamic Plugins 

For each scenario, check the Dynamic Plugin Log file to help 
troubleshoot errors. 

 Add PDU fails with error "Unmanageable", or PDU connectivity 
is "Unmanageable": 

The wrong PDU System OID, or the wrong PDU Model OID is specified 
in the dynamic plugin.  

 Dynamic Plugin Log file excerpt sample when PDU System OID is 
wrong: 

   2011-05-12 13:44:40,394 INFO  

[DiscoverTask-192.168.100.100] PduDiscovery: 

supportsSystemObjectId: target 

sysObjectId=1.3.6.1.4.1.13742.4 

   2011-05-12 13:44:40,450 INFO  

[DiscoverTask-192.168.100.100] PduDiscovery: 

supportsSystemObjectId: no dynamic plugin capable of 

managing PDU w/ sysObjectID 1.3.6.1.4.1.13742.4 

 Dynamic Plugin Log file excerpt sample when PDU Model OID is 
wrong: 

   2011-05-12 12:23:36,836 INFO  

[DefaultUDPTransportMapping_127.0.0.1/0] SnmpUtils: 

onResponse: got an exception varbind for oid 

1.3.6.1.4.1.13742.4.1.1.120.0,  

   2011-05-12 12:23:36,836 WARN  

[DiscoverTask-192.168.100.100] PduDiscovery: 

getModelName: failed to retrieve model name 

   2011-05-12 12:23:36,837 INFO  

[DiscoverTask-192.168.100.100] PduDiscovery: discover:  

Model Name not Found 

 Information on PDU details page is wrong or missing: 

If adding the PDU is successful, but information on the PDU details page 
is missing or wrong, an incorrect OID for outlet active power may be 
specified in the dynamic plugin, for example. 

 Dynamic Plugin Log file excerpt sample when Outlet Active Power is 
wrong: 

   2011-05-12 14:14:24,647 INFO  

[DefaultUDPTransportMapping_127.0.0.1/0] SnmpUtils: 

onResponse: got an exception varbind for oid 

1.3.6.1.4.1.13742.4.1.2.2.1.56.1,  
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   2011-05-12 14:14:24,647 INFO  

[DefaultUDPTransportMapping_127.0.0.1/0] SnmpUtils: 

onResponse: got an exception varbind for oid 

1.3.6.1.4.1.13742.4.1.2.2.1.56.2,  

   2011-05-12 14:14:24,647 INFO  

[DefaultUDPTransportMapping_127.0.0.1/0] SnmpUtils: 

onResponse: got an exception varbind for oid 

1.3.6.1.4.1.13742.4.1.2.2.1.56.3,  

   2011-05-12 14:14:24,647 INFO  

[DefaultUDPTransportMapping_127.0.0.1/0] SnmpUtils: 

onResponse: got an exception varbind for oid 

1.3.6.1.4.1.13742.4.1.2.2.1.56.4,  

   2011-05-12 14:14:24,647 INFO  

[DefaultUDPTransportMapping_127.0.0.1/0] SnmpUtils: 

onResponse: got an exception varbind for oid 

1.3.6.1.4.1.13742.4.1.2.2.1.56.5,    

   2011-05-12 14:14:24,647 INFO  

[DefaultUDPTransportMapping_127.0.0.1/0] SnmpUtils: 

onResponse: got an exception varbind for oid 

1.3.6.1.4.1.13742.4.1.2.2.1.56.6,  

   2011-05-12 14:14:24,647 INFO  

[DefaultUDPTransportMapping_127.0.0.1/0] SnmpUtils: 

onResponse: got an exception varbind for oid 

1.3.6.1.4.1.13742.4.1.2.2.1.56.7,  

   2011-05-12 14:14:24,648 INFO  

[DefaultUDPTransportMapping_127.0.0.1/0] SnmpUtils: 

onResponse: got an exception varbind for oid 

1.3.6.1.4.1.13742.4.1.2.2.1.56.8,  

   2011-05-12 14:14:24,648 WARN  [PollScheduler 

Scheduler-10 Pool-fiber09] SnmpOutletCollector: collect: 

failed to retrieve data for mapping symbol 

'outlet_active_power' 

 Add PDU fails with error "Application Error" or PDU 
connectivity is "Application Error": 

The dynamic plugin encountered an unexpected error that it cannot 
recover from while attempting to add the PDU to Power IQ. The PDU 
health shows as Critical in this case, if the PDU is added.  

When the PDU state is "Application Error", this may indicate that one or 
more index mappings is failing to resolve. Check the dynamic plugin log 
output formapping resolution errors. 
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When to Delete and Rediscover a PDU Using a Dynamic Plugin 

Certain changes, either to a PDU, or to a plugin, may require you to 
delete and rediscover the PDU. 

 Change mapping and PDU enters "Application Error" state. 

 Change mapping and the new mapping is not reflected in the PDU's 
details or smart page. For example, changes to multiplier, sensor 
unit, number of circuit poles. 

 

Troubleshooting Dynamic Plugin Trap Mapping 

 Problem: An incoming trap is mapped to the wrong event in 
Power IQ: 

When mapping an incoming SNMP trap to a dynamic plugin trap 
mapping, Power IQ always takes the FIRST possible match. The 
dynamic plugin UI will attempt to alert a plugin author of duplicate trap 
mappings but it is possible for the author to configure multiple trap 
mappings that match a particular trap. This may occur when OID 
wildcards (*) are used.  

To resolve, verify that the trap mappings are unique with the plugin. 

 Problem: In a custom dynamic plugin with proxied PDUs, such 
as in a Babel Buster gateway scenario, an incoming trap is 
associated to the wrong PDU: 

The incoming trap will have the IP address of the proxy and Power IQ 
must determine which of the proxied PDUs the trap is actually for. Power 
IQ iterates through each of the custom plugin's trap mappings used to 
manage the proxied PDUs and will take the FIRST possible match.  

To resolve, verify that the configured trap mappings are unique across 
each of the proxy's custom plugins. 

 Problem: The event summary text for a particular event on the 
event listing or event details is not available:  

Check the dynamic plugin to determine if the relevant trap mapping has 
been modified or deleted. Either scenario will prevent Power IQ from 
generating the desired event summary text when requested. 
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SNMP Gateways and Custom Dynamic Plugins 

The custom dynamic plugin works with SNMP-gateway devices to 
convert other protocols, such as Modbus or Bacnet, to SNMP. The 
SNMP gateway allows you to get the information you need to monitor an 
inteligent power device that does not have an SNMP agent. Examples of 
SNMP gateways include Control Solutions Babel Buster SPX and 
FieldServer DCC1075 gateways. 

For example, Modbus can communicate data about your PDU. Each 
piece of data has a 16-bit integer register, and each register has an 
address. A Modbus register address is similar to an SNMP OID. Each 
uniquely identifies a data point.  

A SNMP-gateway works with Modbus devices in a serial master-slave 
setup. The gateway device polls the slave devices, reads the register 
data back, and stores it into the gateway device. The gateway makes the 
register data available as SNMP OIDs. 
 

Configuring the SNMP Gateway 

Configuring your SNMP gateway device to prepare for creating a custom 
dynamic plugin should include: 

 Getting the Modbus register list for the PDU you want to monitor 
from the PDU manufacturer. 

 Configuring the gateway with the necessary registers to allow for 
data collection. This may include mappings for line to line voltages, 
active power, apparent power, power factor, pole current, and other 
types supported by Power IQ. 

 Using your gateway to convert the registers to SNMP OIDs. 

 Understanding the units that each data point is reported in. The 
register list will specify the scaling factor for each value. For example, 
watts or kilowatts, degrees or degrees multiplied by 100.  

 

Import and Export Plugin Files 

Once you have created a dynamic plugin, you can export it to a .JSON 
file. Use the file to share the plugin with another Power IQ installation, by 
imnporting ti there. Or, use the file as a template to edit to create other 
dynamic plugins, and re-import. 

 To export a plugin file: 

1. In the Settings tab, click Dynamic Plugins in the Appliance 
Administration section. 

2. The list of dynamic plugins displays. Click Download on the plugin 
you want to export. 

3. Open or save the file. 
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 To import a plugin file: 

Only .JSON files can be imported. 

1. In the Settings tab, click Dynamic Plugins in the Appliance 
Administration section. 

2. Click Import, then click Browse and select the .JSON file. Click 
Import. 

3. When the file imports, it displays in the list. 
 

Set Phase Labels for Circuit Pole Phase 

Specify how circuit pole phases are labeled in Power IQ. 

 To set phase labels for circuit pole phase: 

1. In the Settings tab, click Application Settings in the Appliance 
Administration section. 

2. In the Language and Locale Settings, select your Phase Label 
preference. 

 A, B, C 

 L1, L2, L3 

 X, Y, Z 

 1, 2, 3 

3. Click Save Locale Settings. 
 

Set Fahrenheit or Celsius Temperature 

Specify your system temperature unit to Fahrenheit or Celsius. This 
setting is used wherever temperatures are shown in Power IQ. 

 To display temperatures in Fahrenheit or Celsius: 

Temperature settings are global in Power IQ. 

1. In the Settings tab, click Application Settings in the Appliance 
Administration section. 

2. In the Language and Locale Settings, set Temperature Unit to 
Celsius or Fahrenheit. 

3. Click Save Locale Settings. 
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Upgrading Raritan PX PDUs or Raritan EMX devices managed by Power 
IQ consists of three steps. 

 Uploading firmware to Power IQ 

 Creating an upgrade plan to distribute the firmware to the units. 

 Executing the plan. 

You can use the plans immediately or save them for later.  

Warning: Never downgrade a PX to a lower version number. 
Downgrading causes damage to the PDU. 

In This Chapter 

Plan a New Upgrade ............................................................................. 338 
View Saved Upgrade Plans ................................................................... 339 
Edit a Saved Upgrade Plan ................................................................... 340 
Execute a Saved Upgrade Plan ............................................................ 340 
View Status of Upgrade Plans in Progress ........................................... 341 
View Completed Upgrade Plans ........................................................... 341 
Manage Firmware Versions .................................................................. 342 
 
 

Chapter 19 Upgrading Raritan PX and EMX 
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Plan a New Upgrade 

Bulk upgrade plans are only applicable to Raritan PX PDUs and Raritan 
EMX units. 

When adding any PDU in a port forwarding configuration, it is NOT 
required to add all PDUs in the chain to the upgrade plan. 

If the plan includes all PDUs in a port forwarding configuration, Power IQ 
automatically orders them so that the slave PDU is upgraded first and 
then the master PDU. This order is to prevent the slave PDU from losing 
communications with Power IQ due to the master PDU's reset during the 
upgrade process. It is recommended to put all PDUs into maintenance 
mode to prevent any PDU from entering communication lost state during 
the upgrade. See Maintenance Mode (on page 343). 

Note: If a slave PDU is polled when the master PDU resets, the slave 
PDU shows the communication lost state. Restart the poller in Settings > 
Appliance Administration > Restart Poller.  

Appropriate firmware versions for supporting the port forwarding 
configuration are available in the USB-Cascading Solution Guide, which 
can be downloaded from the PX2 web page 
(http://www.raritan.com/support/product/px2/) of the Raritan website 

 To plan a new upgrade: 

1. In the PDUs tab, choose Activities > Upgrade firmware. 

2. Choose Activities > Plan a new upgrade. The upgrade planning 
wizard starts. 

3. Enter a name for the plan and click Continue. 

4. A summary of plan options appears at the top of the page. Continue 
adding details of your upgrade plan at the bottom of the page, or 
click the links in the summary list to add details. 

5. In the Choose Firmware Version section, you can add a new 
firmware file or select a previously uploaded firmware file. Firmware 
files are .BIN files. If the file is zipped, unzip and upload the .BIN file. 

 To add a new file, click the Upload a New File tab, then click 
Browse to select the file. Enter comments. Click Upload. The file 
is automatically selected for the plan. 

 To select a previously uploaded file, click the Available Files tab, 
then select a file from the list, and click Continue. 

6. All PX PDUs available for the upgrade appear in a list. Select the 
checkboxes for the PDUs you want to upgrade, then click Selected 
PDUs to add them to the "PDUs selected to this upgrade" list at the 
bottom of the page. Or, click All PDUs to add all available PX PDUs 
to the list. 

http://www.raritan.com/support/product/px2/
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 To remove PDUs from the plan, click Selected PDUs or All PDUs 
in the bottom list. Only PDUs in the bottom list will be upgraded. 

7. Click Continue. Click the Plan Options link in the summary at top. 

8. On the Plan Options page, edit the plan name, if needed, and set 
other preferences. 

a. Select the "Abort on failure" checkbox if you want Power IQ to 
cancel all remaining upgrades in the plan if an upgrade failure 
occurs. This could help prevent an upgrade problem from 
affecting other PDUs in the plan. 

b. Select the "Allow simultaneous rollouts" checkbox if you want 
Power IQ to upgrade the firmware of multiple Raritan PX PDUs 
at once. This makes batch upgrades faster by allowing up to 25 
upgrades to run at the same time. 

9. Click Continue. Review the summary of the plan. Click Add 
Comment if you want add notes to the plan. Click Add or Remove 
PDUs if you want to edit the list of PDUs to upgrade. 

10. Click Save. The completed plan summary page opens. 

11. Click Start Upgrade to execute the plan immediately. The upgrade 
starts, and the status page displays. You can also execute the saved 
plan later. See Execute a Saved Upgrade Plan (on page 340). 

 See View Status of Upgrade Plans in Progress (on page 341) 
for details on checking upgrades in progress. 

 See View Completed Upgrade Plans (on page 341) for details 
on checking completed upgrades. 

 

View Saved Upgrade Plans 

View saved upgrade plans to verify and edit their details before 
executing a plan. 

 To view saved upgrade plans: 

1. In the PDUs tab, choose Activities > Upgrade Firmware. 

2. Click "View saved plans." All plans display in a list. 

3. Click the Plan name link to view the details and edit if needed. 
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Edit a Saved Upgrade Plan 

Saved upgrade plans can be edited to change details, add or remove 
PDUs, or change the firmware version. 

You can only edit upgrade plans that you created. 

 To edit a saved upgrade plan: 

1. In the PDUs tab, choose Activities > Upgrade Firmware. 

2. Click "View saved plans." All plans display in a list. 

3. Click the Plan name's link to view the details. 

4. Click the blue links in the plan summary to edit the plan. Or, scroll 
down to click Edit and use the wizard to edit.  

See Plan a New Upgrade (on page 338) for details of plan settings. 
 

Execute a Saved Upgrade Plan 

Once a plan is saved, execute it to start the upgrade process. 

If the plan includes all PDUs in a port forwarding configuration, Power IQ 
automatically orders them so that the slave PDU is upgraded first and 
then the master PDU. This order is to prevent the slave PDU from losing 
communications with Power IQ due to the master PDU's reset during the 
upgrade process. It is recommended to put all PDUs into maintenance 
mode to prevent any PDU from entering communication lost state during 
the upgrade. See Maintenance Mode (on page 343). 

Note: If a slave PDU is polled when the master PDU resets, the slave 
PDU shows the communication lost state. Restart the poller in Settings > 

Appliance Administration > Restart Poller.  

 To execute an upgrade plan: 

1. In the PDUs tab, choose Activities >Upgrade Firmware. 

2. Click "View saved plans." All plans display in a list. 

3. Click the Plan name link for the plan you want to execute. 

4. Click Start Upgrade to execute the plan.  

 See View Status of Upgrade Plans in Progress (on page 341) 
for details on checking upgrades in progress. 

 See View Completed Upgrade Plans (on page 341) for details 
on checking completed upgrades. 
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Upgrade Timing 

Each PX PDU upgrade takes approximately 5-10 minutes. 

If you select "Allow simultaneous rollouts" in the plan options, 25 
upgrades will begin simultaneously, and each batch of 25 will take 
approximately 10 minutes. 
 

View Status of Upgrade Plans in Progress 

Upgrade plans in progress have 3 possible statuses. 

 Init: Rebooting the PDU 

 Login: Logging in to the PDU 

 Verify: Verifying the new firmware version on the PDU 

 To view status of upgrade plans in progress: 

The status page for plans in progress displays when you execute the 
plan. You can return to the status page at any time, even after the plan 
has finished. 

1. In the PDUs tab, choose Activities > Upgrade Firmware. 

2. Click "View saved plans." All saved plans display in a list.  

3. Click the Status link for the plan you executed to view the status 
page.  

 

View Completed Upgrade Plans 

When a plan has been executed, you can view details of the plan status 
and results of each PDU included in the plan. 

 To view completed upgrades: 

1. In the PDUs tab, choose Activities > Upgrade Firmware. 

2. Click "View previously completed upgrades." All completed plans 
display in a list. 

3. Click the Plan name link to view the details. 

 If the plan completed successfully, a success message displays 
at the top of the plan details.  

 The list of PDUs included in the plan includes a Success or 
Failure message. 

 Click the "View detailed upgrade status messages" link for more 
information about each PDU. 
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Manage Firmware Versions 

You can upload different versions of firmware for use in upgrade plans, 
and view previously uploaded firmware. 

Firmware files are .BIN files. You can download firmware versions from 
the Raritan website, in the Support section. If the file is zipped, unzip and 
use only the .BIN file. 

 To view uploaded firmware versions: 

1. In the PDUs tab, choose Activities > Upgrade Firmware.   

2. Click Manage Firmware Versions. This link is not available if you do 
not have any uploaded firmware files. The Manage Firmware 
Versions page opens. 

3. All firmware versions previously uploaded appear in a list.  

 To delete a firmware version: 

 Select the checkbox for the firmware version you want to delete, then 
click Delete. 

 To upload a new firmware version: 

1. Scroll down to the Upload New Firmware File section.  

2. Click Browse to select the .BIN file.  

3. Enter comments in the Comment box.  

4. Click Upload. The file is added to the list and will be available to 
select when creating a new upgrade plan. See Plan a New Upgrade 
(on page 338). 
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Once an object is physically removed, replaced, or being maintained, 
you can mark it as removed or out of service rather than deleting it from 
Power IQ so that its historic data remains available in Power IQ. 

Power IQ does not poll an object that is marked as removed or out of 
service. 

An object can be a PDU, device or sensor. 

In This Chapter 

Available Setting Options ...................................................................... 343 
Maintenance Mode ................................................................................ 343 
Decommissioning an Object .................................................................. 346 
 
 

Available Setting Options 

Power IQ provides two options for marking a PDU that is not in service: 
Maintenance Mode and Decommissioned. If both options are enabled for 
a PDU, that PDU is considered decommissioned. 

You can set any PDU in the USB-cascading configuration to the 
maintenance mode or decommission it. 

For devices and sensors, only the decommissioning option is available. 
They do not have the maintenance mode option in Power IQ. 
 

Maintenance Mode 

Maintenance mode applies to PDUs only. Use this mode when a PDU is 
out of service due to maintenance. 

A PDU in maintenance mode is not polled and its traps are not 
acknowledged. This mode is helpful for preventing a PDU from 
generating connectivity loss events in Power IQ. 

You still can upgrade the PDU's firmware and change the configuration 
while in maintenance mode. Historic data for PDUs in maintenance 
mode is included in tabular reports. 
 

Chapter 20 Managing Removed or Out of 
Service Objects 
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Enable the Maintenance Mode 

Before performing any maintenance task, such as firmware upgrade, set 
the PDU to the maintenance mode. After the maintenance task is 
completed, disable the maintenance mode. 

 To enable the maintenance mode: 

1. In the PDUs tab, click a PDU link to open the PDU Details.  

2. Choose Actions > Edit. 

3. Select the Maintenance Mode checkbox. 

 

Note: If you also select the Decommissioned checkbox, the PDU is 
considered decommissioned instead of being in the maintenance 

mode. See Decommissioning an Object (on page 346). 

4. Click Save. 

 
 

Identify a Maintenance Mode PDU 

The Details section of the rack PDU smart view indicates the 
maintenance mode. 

 To check a PDU's mode: 

1. In the PDUs tab, click the PDU link. 
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2. Examine the Health field of the Details section. 
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Decommissioning an Object 

You can decommission PDUs, devices and sensors. Decommission an 
object when you physically remove, replace or hot swap it with another 
one. 

 Decommissioned PDUs: 

After a PDU is decommissioned, Power IQ stops polling it, and it does 
not receive this PDU's traps or events.  

A decommissioned PDU's historical data remains to be included in the 
tabular report or PUE search, and its configuration data can be changed. 

All but not limited to the following features are prevented on a 
decommissioned PDU. 

 No Polling 

 No rescanning 

 No reception of traps or events associated with the decommissioned 
PDU 

 No power control through the decommissioned PDU 

Note: Power control on the IT devices mapped to the outlets of the 
decommissioned PDU must be performed through a newly 
commissioned PDU which replaces the decommissioned one and is 

associated with the IT devices. 

 All associated sensors become decommissioned and no longer 
display in the rack PDU smart view 

 No firmware upgrade 

 Decommissioned devices: 

Configuration can be changed but no power control permitted for a 
decommissioned device. 

 Decommissioned sensors: 

Configuration data is visible but cannot be changed. All sensor historical 
data is lost. Besides, decommissioned sensors no longer display in the 
rack PDU smart view. 
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Decommission a PDU 

Yo can decommission a PDU and then add a new one to replace it by 
using the same IP address. The replacement PDU can be a different 
model. See Add a Replacement PDU (on page 348). 

If you are using the dcTrack integration which does not support 
decommissioned PDUs, you have to modify the decommissioned PDU's 
external key, which by default is the IP address. 

After decommissioning a PDU, all sensors associated with it also get 
decommissioned. 

 To decommission a PDU: 

1. In the PDUs tab, click a PDU link to open the PDU Details.  

2. Choose Actions > Edit. 

3. Modify the External Key field to make it different from the IP address. 
This is required if you are using the dcTrack integration which does 
not support decommissioned PDUs. 

4. Select the Decommissioned checkbox. 

 

5. Click Save. 
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Do all of the following when using a newly commissioned PDU to replace 
a decommissioned one: 

 Assign the IP address used by the decommissioned PDU to the new 
PDU. 

 Manually associate the new PDU with the original parent object of 
the decommissioned PDU, such as the rack. 

 Manually associate outlets of the new PDU with all IT devices. Outlet 
associations of the new PDU can be different from the outlet 
associations of the decommissioned PDU, and it is NOT required to 
remove old outlet associations. 

 Manually add mappings for IT devices connected to the new PDU in 
the EDM. 

 

Decommission a Device 

1. In the Devices tab, click the IT device name link in the Devices tab to 
go to the IT device page in the Data Centers tab. The EDM expands 
to show the IT device. 

2. Select the Decommissioned checkbox. 

 

3. Click Save. 
 



 Chapter 20: Managing Removed or Out of Service Objects  

 
349

 
 

Decommission a Sensor 

There are two ways to decommission a sensor: 

 Physically disconnect a sensor from the PDU. 

 Decommission the PDU with which the sensor is associated. 
 

Identify a Decommissioned PDU 

After decommissioning a PDU, it is marked as decommissioned 
everywhere throughout Power IQ. The following are a few illustrations. 

 In the Data Centers tab: 

 

 In the PDUs tab: 
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 In the Rack smart view: 

 
 

Identify a Decommissioned Device 

Unlike decommissioned PDUs, a decommissioned device is not marked 
as decommissioned. There are two ways to identify a decommissioned 
device. 

 In the Data Centers tab: 

1. Select the IT device to open the IT device page. 

2. Examine whether the Decommissioned checkbox has been selected. 
For details, see Decommission a Device (on page 348). 

 In the Devices tab: 

1. Make the Decommissioned column visible in this tab. 
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a. To display the Decommissioned column, move the mouse 
pointer to any column header, and click the arrow which appears 
in the column header. 

 

b. Click the Columns, and select the Decommissioned checkbox. 
The Decommissioned column then displays. 

2. Examine the value shown in the Decommissioned column. 

 true: Decommissioned. 

 false: Commissioned. 
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Identify a Decommissioned Sensor 

A decommissioned sensor is marked as decommissioned in Power IQ, 
and it is no longer associated with its original PDU. 

 In the Data Centers tab: 
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In This Chapter 

Support Connections ............................................................................. 353 
Enable or Disable the Root Accounts for Support ................................. 354 
Licensing................................................................................................ 354 
 
 

Support Connections 

A support connection allows Raritan technical support to access your 
Power IQ to diagnose a problem.  

You should open a support connection only when Raritan technical 
support requests one. 
 

Prerequisites for Support Connections 

1. The Power IQ device must be able to use DNS to resolve 

poweriq-access.raritan.com. The DNS server must be able to 

do name resolution for external host names. 

2. The Power IQ device must be able to make an outbound HTTPS 

request on port 443 to poweriq-access.raritan.com. You may 

have to require your firewall to allow this connection. 

3. The Power IQ device must be able to make an outbound SSH 

request on port 22 to poweriq-access.raritan.com. You may 

have to require your firewall to allow this connection. 
 

Create a Support Connection 

Make sure your Power IQ device meets the prerequisites before creating 
a support connection. See Prerequisites for Support Connections (on 
page 353). 

 To create a support connection: 

1. In the Settings tab, click Get Support in the Appliance Services 
section. 

2. Click Start. A log appears.  

3. Make sure the final line of the log includes this text: support 
connection initialization complete.  
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4. Contact Raritan Technical Support with your Appliance ID number. 
The Appliance ID number is on the Settings tab, in the Appliance 
Information section. For example: 
e3b123f8-669e-4007-97bf-ca9d85c431f8. Raritan Technical Support 
uses his number to identify your support connection. 

 

Stop a Support Connection 

Once Raritan technical support has finished using the support 
connection, you can stop it. Stopping the support connection will close 
the SSH connection from your Power IQ device to 
poweriq-access.raritan.com. 

 Stop a support connection: 

1. In the Settings tab, click Get Support in the Appliance Services 
section. 

2. Click Stop. 
 

Save Support Logs 

If you have trouble creating a support connection, the support logs may 
help Technical Support find the problem. 

 To save support logs: 

1. In the Settings tab, click Get Support in the Appliance Services 
section. 

2. Choose Activities > Download All System Logs.  

3. Click Save, then save the file using the dialog that appears. 
 

Enable or Disable the Root Accounts for Support 

Power IQ has "root" and "sudoroot" user accounts in place for Raritan 
use when supporting the product. You may be asked to access the 
console as the "config" user to enable these accounts during the support 
process. You cannot change the passwords for these accounts. When 
disabled, there is no external access to the system using those accounts. 

New installations of Power IQ have these accounts disabled by default. 
Upgrading will not change the enable/disable status of these accounts.  
 

Licensing 

Power IQ requires a license. Licenses allow you to add a certain number 
of rack PDUs and facilities objects to Power IQ. You may need more 
than one license file to be allowed to add your full number of PDUs. 
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View Licenses 

The licenses that you have uploaded to Power IQ are available to view. 

 To view licenses: 

1. If you have not already done so, get a Power IQ license file by 
contacting Raritan Customer Support.  

2. In the Web Client, click Admin > Appliance Settings. The Settings 
window opens. 

3. Click Product Licensing in the Application Administration panel. 

4. Click Add in the Licenses section.  

 Use the browse function to locate and add the license file. The 
Licenses list contains all license files that you have uploaded to 
Power IQ.  

Feature 
The feature that is allowed by this license. 

Type 
Initial: A required license to activate Power IQ and set the 
initial PDU capacity allowed. 

Incremental: A secondary license type that allows you to 
add to the initial license's PDU capacity. 

Count 
The number of PDUs that you can add to Power IQ under 
this license. 

Licensee 
Your company name. 

 To view licensing summary: 

 Licensing Summary contains information about how many PDUs 
your combined licenses allow you to add to Power IQ. 

Customer 
Name 

Your company name. 

PDU License 
Capacity 

The total number of PDUs allowed by all your licenses. 

PDU 
Licenses 
Available 

The number of PDUs remaining that you are allowed to 
add. 
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Add a License File 

If this is your first time logging in and you need to add a license file, see 
Connecting to Power IQ (on page 6). Once you add a license file and 
log in for the first time, you can follow the instructions in this topic to add 
or remove license files as needed. 

 To add a license file: 

1. If you have not already done so, get a Power IQ license file by 
contacting Raritan Customer Support.  

2. In the Web Client, click Admin > Appliance Settings. The Settings 
window opens. 

3. Click Product Licensing in the Application Administration panel. 

4. Click Add in the Licenses section.  

5. Use the browse function to locate and add the license file. 

Licenses are .LIC files. Repeat this step to add incremental licenses 
if needed. 

Note: Your license file can be retrieved from the Raritan web site 
after you have activated your registration. To activate your 
registration, click the link in the "Thank you for registering" email 
from Raritan and create your user account. Once you create your 
account, look for a "Your Raritan software license key is available" 

email containing a link to your license file download page. 

6. If you see error messages AND you're unable to use Power IQ or to 
add the total licensed number of PDUs, contact Raritan Technical 
Support. There may be a problem with your license file. 

 

License Count Rules for Rack PDUs and Facilities Objects 

Your license count defines how many rack PDUs you can add to Power 
IQ under your purchased license. 

Different types of facility objects count against your license count at 
higher rates. 

CRAC 5  

Floor PDU 5 

Floor UPS 5 

Power Panel 5 

Standalone Meter 1 
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Power IQ's ODBC interface allows ODBC compliant applications access 
to the power data of managed devices. For example, an ODBC 
compliant reporting application like Crystal Reports can access Power IQ 
data to create customized reports. 

 The Power IQ ODBC server listens on TCP Port 5432 

 Roll-up tables summarize data over one hour, twenty four hours, and 
one month. Upon summarization, detailed readings are purged. For 
example, when you create a daily roll-up, the hourly poll data is 
purged from the database. You can configure the data retention 
settings. See Configuring Data Rollup Retention (on page 127). 

 Power IQ ODBC Interface is backed by an PostgreSQL database. 

In This Chapter 

Configuring ODBC Access to Power IQ ............................................... 357 
Configuring ODBC User Credentials .................................................... 358 
ODBC Client Configuration ................................................................... 359 
Timezone Configuration for ODBC Data .............................................. 360 
Advanced Reporting with Database and Reporting Programs ............. 360 
Power IQ ODBC Schema ..................................................................... 362 
Sample ODBC Queries ......................................................................... 422 
ODBC Configuration and Sample Query for Apple Users .................... 427 

 
 

Configuring ODBC Access to Power IQ 

Specify the IP addresses that you authorize to make connections to the 
database.  

 To enable ODBC access to Power IQ: 

1. Click Settings. 

2. Click ODBC Access in the Data Management section. The ODBC 
Access page opens. 

3. Click Add, then double-click the 0.0.0.0/0 addresses to enter edit 
mode and type the ODBC network address with the mask in CIDR 
format. 

 CIDR format example: 192.168.43.0/24 instead of 192.168.43.0 
and 255.255.255.0.  

 Use the network mask value to specify a single address or a 
range of addresses.  

 Use the default value 0.0.0.0/0 to allow access from all IP 
addresses. 

Appendix A ODBC Access 
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4. Repeat to add new addresses as needed. Select an address and 
click Remove to remove authorization from the address. 

5. Click Save when all authorized addresses have been added. The 
Power IQ database restarts. 

After the restart, ODBC compliant applications are allowed to access 
the database from the authorized IP addresses. 

 

Configuring ODBC User Credentials 

Factory default user credentials for ODBC access in Power IQ are: 

 Username: odbcuser 

 Password: raritan 

The ODBC user credentials can be customized as needed. After ODBC 
user credentials are modified, you must also change the user credentials 
entered in the ODBC Client and driver. 

 To change the ODBC user credentials: 

1. Click Settings. 

2. Click ODBC Access in the Data Management section. The ODBC 
Access page opens. 

3. In the Configure ODBC Security section, type the user name and 
password intended for ODBC authentication. 

 

Note: For restrictions that apply to the ODBC user credentials, see 
Restrictions of ODBC User Credentials (on page 359). 

4. Click Save. 
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Restrictions of ODBC User Credentials 

The ODBC user name is NOT subject to the restrictions applied to a 
Power IQ user name. 

Certain restrictions apply to the ODBC user name and password. 

 ODBC user name: 

 Support 1 to 63 characters long 

 Consist of alphanumeric characters and/or underscores only, 
including 0 to 9, a to z, and _ 

 No number used for the first character 

 No uppercase alphabets contained 

 No support for multi-byte characters 

 No use of certain names, such as public, postgres, raritan, odbc 
and floormaps 

 ODBC password: 

 The password must follow the requirements selected in 
Settings > Password Requirements. See Configuring 
Password Requirements (on page 123). 

 

ODBC Client Configuration 

1. ODBC Client must install and configure a suitable PostgreSQL driver. 
PostgreSQL drivers are available at 
http://www.postgresql.org/ftp/odbc/versions/msi/. 

2. ODBC Client must configure Power IQ as a ODBC Data Source with 
the following credentials: 

Database Name raritan 

User ID and 
Password 

Same as the ODBC user 
credentials specified in 
Power IQ* 

Port Number 5432 

Server Power IQ IP Address 

* For information on ODBC user credentials, see Configuring ODBC 
User Credentials (on page 358). 
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Timezone Configuration for ODBC Data 

ODBC tables use the Power IQ® system time setting, which is EST/EDT. 
This setting is converted to your selected timezone when you are using 
the Power IQ web interface, but this conversion is not applied to ODBC 
connections.  

The time data available via the ODBC connection can be changed on a 
per session basis. By using a specific SQL statement to adjust the client 
session, you can run reports and view information in the desired 
timezone. 

This link contains documentation on setting the timezone for the 
database using an SQL statement. Use the "SET SESSION ...." syntax, 
because Power IQ ODBC users do not have super user privileges. 

http://www.postgresql.org/docs/9.2/static/sql-set.html 
 

Advanced Reporting with Database and Reporting Programs 

Create advanced reports and charts with reporting programs such as 
SQL report writer, Crystal Reports®, and Microsoft Access®. Follow these 
instructions to use Microsoft Access. 

ODBC Access must be enabled. See Configuring ODBC Access to 
Power IQ (on page 357). 

You must install a PostgreSQL driver first. See Install and Configure a 
PostgreSQL Driver 
 

Install and Configure a PostgreSQL Driver 

You must install and configure a PostgreSQL driver before you can use 
Microsoft® Access® to create table reports of your Power IQ™ data. 

 To install and configure a PostgreSQL driver: 

1. Configure Power IQ to allow ODBC access from your client IP 
address. See Configuring ODBC Access to Power IQ (on page 
357). 

2. Go to http://www.postgresql.org/ftp/odbc/versions/msi/ and download 
the latest driver .ZIP file. Run the .MSI file contained in the .ZIP to 
install the driver on your client.  

3. Go to Control Panel > Administrative Tools > Data Sources (ODBC). 

4. Click Add then select the driver, PostgreSQL Unicode, and click 
Finish. 

5. In the dialog that appears, enter the Power IQ database information: 

 Database: raritan 



 Appendix A: ODBC Access  

 
361

 
 

 Server: Power IQ IP address 

 Description: Enter a name for this data source 

 SSL Mode: disable 

 Port: 5432 

 User Name and Password: Same as the ODBC user credentials 
specified in Power IQ* 

* For information on ODBC user credentials, see Configuring 
ODBC User Credentials (on page 358). 

6. Click Test. If the test is successful, click Save.  

7. Click OK. 
 

Link Database Tables in Microsoft® Access® 

Use Microsoft Access to create links between the Power IQ database 
tables you want to query. See Correlated Fields in ODBC Tables (on 
page 362) for details on which Power IQ tables can be linked. 

These instructions refer to Access 2003. Other versions may vary. 

 To link database tables in Microsoft Access: 

Note: You only have to link database tables once in Microsoft Access, 
and the links are retained. You do not have to repeat this task each time 

you want to create queries or run reports.  

1. Choose File > New then select Blank Database. 

2. Name the file and click Create. 

3. In the dialog that appears, Tables is selected by default in the Object 
list. Click New. 

4. Select Link Table and click OK. 

5. In the dialog that appears, select ODBC Databases in the "Files of 
type" list.  

6. In the dialog that appears, click the Machine Data Source tab, select 
the ODBC driver you installed, and click OK.  

7. A list of all ODBC tables appears. Select the table you want to link 
and click OK. 

8. Select the unique record identifier for the table and click OK. The 
unique record identifier is typically the first item in the list. See the 
table details in this guide to check. See Power IQ ODBC Schema 
(on page 362). 

9. The linked table appears in the list. Repeat these steps to add other 
tables you want to query. 

10. Identify the relationships between the linked tables.  
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a. Choose Tools > Relationships.  

b. Select all the tables in the list and click Add. The tables appear 
with lists of their fields. Resize the tables to view the field names.  

c. Link the fields that relate by dragging and dropping a field from 
one table to the field it relates to in another table. See the 
Microsoft Access help on "Define relationships between tables" 
for details.  

Note: Fields that have relationships are marked as "foreign key 
relationships" in the ODBC schema. See Power IQ ODBC Schema 
(on page 362) view the lists of fields. See Correlated Fields in 

ODBC Tables (on page 362) for details and an example.  
 

Correlated Fields in ODBC Tables 

To find how tables in Power IQ relate to each other, look for the foreign 
key reference fields in each table. The tables are listed in this help. See 
Power IQ ODBC Schema (on page 362). 

 Example - the relationship between the PDUOutlets table and 
the PDUs table: 

The PDUOutlets table has a relationship to the PDUs table, via the 
PDUID field in the PDUOutlets table.  

PDUID Integer Foreign key reference to 
PDUs table 

See PDUOutlets (on page 364) and PDUs (on page 362).  

Both tables contain a field called PDUID. Link these fields in Microsoft® 
Access® to enable these tables to be queried together. See Link 
Database Tables in Microsoft® Access® (on page 361). 
 

Power IQ ODBC Schema 

Power IQ makes a number of its data views available through the ODBC 
interface. 
 

PDUs 

The PDUs view contains information about the PDU device. 

Field Type Notes 

ID Integer Unique PDU number 

Caption VarChar (64) PDU Name 

Description TEXT MIB II SysDescr 
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Field Type Notes 

IPAddress inet IP Address 

PDUType VarChar (64)  Rack PDU or facilities 
objects 

ProxyIndex Integer Subtending unit ID 
applicable only to 
daisy-chained and 
console server connected 
PDU units 

NameFormat VarChar (64)  

ModelName TEXT PDU Model 

Manufacturer TEXT PDU Manufacturer 

Location TEXT MIB II SysLocation 

Contact VarChar (256) Contact name 

PDUName TEXT PDU Name 

Firmware TEXT PDU Firmware version 

Serial Number TEXT PDU Serial Number 

CurrentStatus TEXT PDU overall health 
status: Good, Warning, or 
Critical 

EventHealth TEXT PDU active events health 
status: Good, Warning, or 
Critical 

ConnectivityHealth TEXT PDU connectivity health 
status: OK, LostComm, 
NoContact, NoPlugin, 
and others. 

PrimaryOwnerName VarChar (64) Owner name 

PrimaryOwnerContact VarChar (256) MIB II SysContact 

InletTemperature Float Temperature at the inlet 
of the PDU. Latest 
reading in Celsius from 
the first temperature 
sensor attached to the 
PDU  

External Key TEXT An external key, such as 
asset tag number, 
associated with the PDU. 
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Field Type Notes 

Custom Field 1 TEXT A custom field for the 
user to specify. 

Custom Field 2 TEXT A custom field for the 
user to specify. 

Current Float Latest line current 
reading for the PDU, or 
the maximum of the line 
currents for three-phase 
PDUs 

RatedVoltage TEXT The PDU's rated voltage. 

RatedAmps TEXT The PDU's rated current. 

RatedVoltAmps TEXT The PDU's rated 
volt-amps. 

DefaultAssetStripConn
ectedLEDColor 

VarChar The color of the LED in 
hex when asset is 
connected. 

DefaultAssetStripDisco
nnectedLEDColor 

VarChar The color of the LED in 
hex when asset is 
disconnected. 

 
 

PDUOutlets 

The PDUOutlets view shows the outlets associated with a PDU. 

Field Type Notes 

PDUOutletsID Integer Unique outlet number 

PDUID Integer Foreign key reference to 
PDUs table 

OutletID Integer PDU outlet number 

OutletName VarChar(64) Outlet name 

OutletState VarChar(64) Outlet state 

ITDeviceID Integer Associated IT Device ID 
foreign key 

PDUOutletNumber Integer PDU outlet number 

OutletRatedAmps Integer The rated amps of the 
outlet 
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PDUCircuitPoles 

Field Type Notes 

PDUCircuitPoleID    Integer Unique circuit pole ID 

PDUCircuitID Integer Foreign key reference to 
PDUCircuits table 

PDUPanelID Integer Foreign key reference to 
PDUPanels table 

PDUID Integer Foreign key reference to 
PDUs table 

CircuitPoleOrdinal  Integer The circuit pole's number 

Phase  VarChar(64) The circuit pole's phase 

 
 

PDUCircuits 

Field Type Notes 

PDUCircuitID Integer Unique circuit ID 

PDUID  Integer Foreign key reference to 
PDUs table 

PDUPanelID Integer Foreign key reference to 
the PDUPanels table 

CircuitOrdinal  Integer Circuit number on the 
PDU 

CircuitName VarChar (64) Name of the circuit 

RatedAmps Integer Rated amps of the circuit 

 
 

PDUCircuitBreakers 

The PDUCircuitBreakers view shows the circuit breakers associated with 
a PDU. 

Field Type Notes 

PDUCircuitBreakersID Integer Unique CB Number 

PDUID Integer Foreign key reference to 
PDUs table 

CircuitBreakerOrdinal Integer Circuit breaker number 
on the PDU 
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Field Type Notes 

CircuitBreakerState Integer 0 (closed) 1 (open) 3 
(unknown) 

CircuitBreakerLabel VarChar(64) Label assigned to a CB 

CircuitBreakerRating Integer The rated amps of the 
circuit breaker in amps 

CircuitBreakerRatedAm
ps 

Integer The rated amps of the 
circuit breaker in amps 

 
 

PDULines 

Field Type Notes 

PDULinesID Integer Primary key for the table. 

PDUInletsID Integer Foreign key reference to 
PDUInlets table 

PDUID Integer Foreign key reference to 
PDUs table 

LineNumber Integer The inlet line number on 
the PDU 

 
 

PDUInlets 

Field Type Notes 

PDUInletsID Integer Primary key for the 
PDUInlets table. 

PDUID Integer Foreign key reference to 
PDUs table 

InletNumber Integer The number of the inlet 
on the PDU. 

InletRatedAmps Integer The rated amps on the 
inlet. 

PDUPanelID Integer Foreign key reference to 
PDUPanels 

Source Boolean Whether main inlet 
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PDUPanels 

Field Type Notes 

PDUPanelID Integer Unique ID for each panel 

PDUID Integer Foreign key reference to 
PDUs table 

PanelOrdinal  Integer The panel's number on 
the floor PDU. 

PanelName VarChar (255) The panel's name, only 
for floor PDU panels, not 
standalone power panels. 

 
 

PDUReadings 

Note: This table will be deprecated soon. It is recommended to stop 
using it, and use the new PDUInletReadings table. See 
PDUInletReadings (on page 368). 

The PDUReadings view shows the raw power data collected from PDUs. 
A data record is added for each PDU polled. This data is summarized 
hourly in a PDUReadingsRollup view, and the readings in this view are 
purged. 

Field Type Notes 

PDUReadingsID Integer Unique ID for each 
reading 

PDUID Integer Foreign key reference to 
PDU 

Time Timestamp with 
Timezone 

Local timestamp 

ActivePower Real Active power drawn by 
PDU 

ApparentPower Real Apparent power drawn by 
PDU 

WattHour Real Cumulative watt-hours 
consumed by the PDU, if 
available for the PDU 

MaxActivePower Real Maximum active power 
drawn by PDU 

MinActivePower Real Minimum active power 
drawn by PDU 
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Field Type Notes 

MaxApparentPower Real Maximum apparent 
power drawn by PDU 

MinApparentPower Real Minimum apparent power 
drawn by PDU 

 
 

PDUInletReadings 

A PDU can have multiple inlets. To get a total reading for the PDU, you 
must to request the values for all inlets on a PDU. 

Field Type Notes 

PDUInletReadingsID bigint Unique ID for each 
reading 

PDUID Integer Foreign key reference to 
PDUs table 

InletID Integer Foreign key reference to 
PDUInlets table 

InletNumber Integer Inlet number on the PDU 

Time timestamp with 
time zone 

Local timestamp 

Voltage Real Voltage at the inlet 

MinVoltage Real Minimum voltage reading 
over the sample period. 
Applies to devices with 
data buffering enabled. 

MaxVoltage Real Maximum voltage reading 
over the sample period. 
Applies to devices with 
data buffering enabled. 

Current Real Current (Amps) drawn by 
the inlet 

MinCurrent Real Minimum current (Amps) 
reading over the sample 
period. Applies to devices 
with data buffering 
enabled. 
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Field Type Notes 

MaxCurrent Real Maximum current (Amps) 
reading over the sample 
period (applies to devices 
with data buffering 
enabled. 

PowerFactor Real Power factor of the inlet 

MinPowerFactor Real Minimum power factor 
reading over the sample 
period. Applies to devices 
with data buffering 
enabled) 

MaxPowerFactor Real Maximum power factor 
reading over the sample 
period. Applies to devices 
with data buffering 
enabled. 

ActivePower Real Active power (Watts) 
drawn by the inlet 

MinActivePower Real Minimum active power 
(Watts) reading over the 
sample period. Applies to 
devices with data 
buffering enabled. 

MaxActivePower Real Maximum active power 
(Watts) reading over the 
sample period. Applies to 
devices with data 
buffering enabled. 

ApparentPower Real Apparent power (VA) 
drawn by the inlet 

MinApparentPower Real Minimum apparent power 
(VA) reading over the 
sample period (applies to 
devices with data 
buffering enabled) 

MaxApparentPower Real Maximum apparent 
power (VA) reading over 
the sample period. 
Applies to devices with 
data buffering enabled. 
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Field Type Notes 

VoltAmpHours Real Cumulative 
volt-amp-hours 
consumed by the inlet, if 
available for the PDU 

WattHours Real Cumulative watt-hours 
consumed by the inlet, if 
available for the PDU 

 
 

PDUInletReadingHourlyRollups 

 

Field Type Notes 

PDUInletReadingsRollu
pID 

Bigint Primary key for the table 

PDUID Integer Foreign key reference to 
PDUs table 

InletID Integer Foreign key reference to 
PDUInlets table  

InletNumber Integer The number of the inlet 
on the PDU. 

Time Timestamp Local timestamp 

Voltage Real Average voltage reading 
during rollup interval 

MinVoltage Real Minimum voltage reading 
during rollup interval 

MaxVoltage Real Maximum voltage reading 
during rollup interval 

Current Real Average current reading 
(Amps) during rollup 
interval 

MinCurrent Real Minimum current reading 
(Amps) during rollup 
interval 

MaxCurrent Real Maximum current reading 
(Amps) during rollup 
interval 
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Field Type Notes 

PowerFactor Real Average Power factor 
reading during rollup 
interval 

MinPowerFactor Real Minimum power factor 
reading during rollup 
interval 

MaxPowerFactor Real Maximum power factor 
reading during rollup 
interval 

ActivePower Real Average active power 
(Watts) reading during 
rollup interval 

MinActivePower Real Minimum active power 
(Watts) reading during 
rollup interval 

MaxActivePower Real Maximum active power 
(Watts) reading during 
rollup interval 

ApparentPower Real Average apparent power 
(VA) reading during rollup 
interval 

MinApparentPower Real Minimum apparent power 
(VA) reading during rollup 
interval 

MaxApparentPower Real Maximum apparent 
power (VA) reading 
during rollup interval 

MaxUnutilizedCapacity Real Maximum unutilized 
capacity (rated amps 
minus current) reading 
during rollup interval 

MinUnutilizedCapacity Real Minimum unutilized 
capacity (rated amps 
minus current) reading 
during rollup interval 

UnutilizedCapacity Real Average unutilized 
capacity (rated amps 
minus current) reading 
during rollup interval 
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Field Type Notes 

VoltAmpHours Real Maximum of the 
cumulative volt-amp-hour 
meter readings over the 
rollup interval 

WattHours Real Maximum of the 
cumulative watt-hour 
meter readings over the 
rollup interval 

 
 

PDUInletReadingDailyRollups 

 

Field Type Notes 

PDUInletReadingsRollu
pID 

Bigint Primary key for the table 

PDUID Integer Foreign key reference to 
PDUs table 

InletID Integer Foreign key reference to 
PDUInlets table   

InletNumber Integer The number of the inlet 
on the PDU. 

Time Timestamp Local timestamp 

Voltage Real Average voltage reading 
during rollup interval 

MinVoltage Real Minimum voltage reading 
during rollup interval 

MaxVoltage Real Maximum voltage reading 
during rollup interval 

Current Real Average current reading 
(Amps) during rollup 
interval 

MinCurrent Real Minimum current reading 
(Amps) during rollup 
interval 

MaxCurrent Real Maximum current reading 
(Amps) during rollup 
interval 
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Field Type Notes 

PowerFactor Real Average Power factor 
reading during rollup 
interval 

MinPowerFactor Real Minimum power factor 
reading during rollup 
interval 

MaxPowerFactor Real Maximum power factor 
reading during rollup 
interval 

ActivePower Real Average active power 
(Watts) reading during 
rollup interval 

MinActivePower Real Minimum active power 
(Watts) reading during 
rollup interval 

MaxActivePower Real Maximum active power 
(Watts) reading during 
rollup interval 

ApparentPower Real Average apparent power 
(VA) reading during rollup 
interval 

MinApparentPower Real Minimum apparent power 
(VA) reading during rollup 
interval 

MaxApparentPower Real Maximum apparent 
power (VA) reading 
during rollup interval 

VoltAmpHours Real Maximum of the 
cumulative volt-amp-hour 
meter readings over the 
rollup interval 

WattHours Real Maximum of the 
cumulative watt-hour 
meter readings over the 
rollup interval 
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PDUInletReadingMonthlyRollups 

 

Field Type Notes 

PDUInletReadingsRollu
pID 

Bigint Unique ID for each 
reading 

PDUID Integer Foreign key reference to 
PDUs table 

InletID Integer Foreign key reference to 
PDUInlets table 

InletNumber Integer Inlet number on the PDU 

Time Timestamp Local timestamp for the 
first day of the month 
over which the rollup was 
calculated. 

Voltage Real Average voltage reading 
during rollup interval 

MinVoltage Real Minimum voltage reading 
during rollup interval 

MaxVoltage Real Maximum voltage reading 
during rollup interval 

Current Real Average current reading 
(Amps) during rollup 
interval 

MinCurrent Real Minimum current reading 
(Amps) during rollup 
interval 

MaxCurrent Real Maximum current reading 
(Amps) during rollup 
interval 

PowerFactor Real Average Power factor 
reading during rollup 
interval 

MinPowerFactor Real Minimum power factor 
reading during rollup 
interval 

MaxPowerFactor Real Maximum power factor 
reading during rollup 
interval 
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Field Type Notes 

ActivePower Real Active power drawn by 
the inlet in Watts 

MinActivePower Real Minimum active power 
(Watts) reading during 
rollup interval 

MaxActivePower Real Maximum active power 
(Watts) reading during 
rollup interval 

ApparentPower Real Apparent power (VA) 
drawn by the inlet 

MinApparentPower Real Minimum apparent power 
(VA) reading during rollup 
interval 

MaxApparentPower Real Maximum apparent 
power (VA) reading 
during rollup interval 

VoltAmpHours Real Cumulative 
volt-amp-hours 
consumed by the inlet, if 
available for the PDU 

WattHours Real Cumulative watt-hours 
consumed by the inlet, if 
available for the PDU 

 
 

PDUOutletReadings 

The PDUOutletReadings view shows the raw power data collected from 
PDU outlets. A data record is added for each outlet polled. This data is 
summarized hourly in a PDUOutletReadingsRollup view, and the outlet 
records in this view are purged. 

Field Type Notes 

PDUOutletReadingsID Integer Unique ID for each 
reading 

PDUID Integer Foreign key reference to 
PDUs table 

OutletID Integer Foreign key reference to 
PDUOutlets table 

OutletNumber Integer PDU outlet number 

Time Timestamp with Local timestamp 
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Field Type Notes 

Timezone 

CurrentAmps Real Amps drawn by the outlet 

ActivePower Real Active power drawn by 
the outlet 

ApparentPower Real Apparent power drawn by 
the outlet 

WattHour Real Cumulative watt-hours 
consumed by the outlet, if 
available for the PDU 

MaxCurrentAmps Real Maximum amps drawn by 
the outlet 

MinCurrentAmps Real Minimum amps drawn by 
the outlet 

MaxActivePower Real Maximum active power 
drawn by the outlet 

MinActivePower Real Minimum amps drawn by 
the outlet 

MaxApparentPower Real Maximum apparent 
power drawn by the outlet 

MinApparentPower Real Minimum apparent power 
drawn by the outlet 

Voltage Real Voltage drawn by the 
outlet 

MinVoltage Real Minimum voltage reading  

MaxVoltage Real Maximum voltage reading 

PowerFactor Real Power factor of the outlet 

MinPowerFactor Real Minimum power factor 

MaxPowerFactor Real Maximum power factor 

VoltAmpHours Real Cumulative 
volt-amp-hours 
consumed by the outlet, if 
available for the PDU 
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PDULineReadings 

The PDULineReadings view shows the power data collected from PDU 
current-carrying lines. A data record is added for each line polled. 
Single-phase PDUs have 1 line. Three-phase PDUs have 3 lines. This 
data is summarized hourly in a PDULineReadingsRollup view, and the 
line readings in this view are purged. 

Field Type Notes 

PDULineReadingsID Integer Unique ID for each 
reading 

PDUID Integer Foreign Key Reference 
To PDUs table 

InletNumber Integer Inlet number on the PDU 

LineNumber Integer Line number on this PDU 

Time Timestamp with 
Timezone 

Local timestamp 

CurrentAmps Real Amps drawn on this line 

UnutilizedCapacity Real Available amps remaining 
on this line 

MaxCurrentAmps Real Maximum amps drawn on 
this line 

MinCurrentAmps Real Minimum amps drawn on 
this line 

Voltage Real Voltage for the line 

MinVoltage Real Minimum voltage reading 
over the sample period. 
Applies to devices with 
data buffering enabled. 

MaxVoltage Real Maximum voltage reading 
over the sample period. 
Applies to devices with 
data buffering enabled. 

 
 

PDUCircuitReadings 

Field Type Notes 

PDUCircuitReadingsID   Big Integer Unique circuit number 

PDUID Integer Foreign key reference to 
PDUs table 
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Field Type Notes 

PDUCircuitID  Integer Circuit number on the 
PDU 

Time  timestamp with 
time zone 

Local timestamp 

Voltage  Real  Voltage drawn by the 
circuit 

MinVoltage Real Minimum voltage reading   

MaxVoltage Real Maximum voltage reading   

Current  Real Amps drawn by the circuit   

MinCurrent  Real Minimum amps drawn by 
the circuit   

MaxCurrent Real Maximum amps drawn by 
the circuit   

UnutilizedCapacity Real Available amps remaining 
on this circuit   

MinUnutilizedCapacity  Real Minimum amps remaining 
on this circuit   

MaxUnutilizedCapacity  Real Maximum amps 
remaining on this circuit   

PowerFactor Real Power factor of the circuit   

MinPowerFactor Real Minimum power factor   

MaxPowerFactor Real Maximum power factor   

ActivePower Real Active power drawn by 
the circuit   

MinActivePower Real Minimum active power 
drawn by the circuit   

MaxActivePower Real Maximum active power 
drawn by the circuit   

ApparentPower  Real Apparent power drawn by 
the circuit   

MinApparentPower Real Minimum apparent power 
drawn by the circuit   

MaxApparentPower Real Maximum apparent 
power drawn by the 
circuit   
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Field Type Notes 

VoltAmpHour Real Cumulative 
volt-amp-hours 
consumed by the circuit   

WattHour Real Cumulative watt-hours 
consumed by the circuit   

 
 

PDUCircuitPoleReadings 

Field Type Notes 

PDUCircuitPoleReadin
gsID  

Big Integer Unique circuit pole 
number 

PDUCircuitPoleID  Integer Circuit pole number on 
the PDU 

PDUID     Integer Foreign key reference to 
PDUs table 

Time  timestamp with 
time zone 

Local timestamp 

Voltage  Real  Voltage drawn by the 
circuit pole 

MinVoltage Real Minimum voltage reading  

MaxVoltage Real Maximum voltage reading 

Current  Real Amps drawn by the circuit 
pole 

MinCurrent  Real Minimum amps drawn by 
the circuit pole 

MaxCurrent Real Maximum amps drawn by 
the circuit pole 

UnutilizedCapacity Real Available amps remaining 
on this circuit pole 

MinUnutilizedCapacity  Real Minimum amps remaining 
on this circuit pole 

MaxUnutilizedCapacity  Real Maximum amps 
remaining on this circuit 
pole 
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PDUCircuitBreakersReadings 

The PDUCircuitBreakerReadings view shows the power data collected 
from circuit breakers on the PDU. This view does not contain any data 
for PDUs that do not have circuit breakers. A data record is added for 
each circuit breaker polled. This data is summarized hourly in a 
PDUCircuitBreakerReadingsRollup view, and the circuit breaker readings 
in this view are purged. 

Field Type Notes 

PDUCircuitBreakerReadin
gsID 

Integer Unique ID for each reading 

PDUID Integer Foreign key reference to 
PDUs table 

CircuitBreakerNumber Integer Circuit breaker number on the 
PDU 

CircuitBreakerID Integer Foreign key reference to 
PDUCircuitBreakers table 

Time Timestamp with 
Timezone 

Local timestamp 

CurrentAmps Real Current value in Amps 

UnutilizedCapacity Real Available amps remaining on 
this circuit breaker 

MaxCurrentAmps Real Maximum amps drawn on the 
circuit breaker 

MinCurrentAmps Real Minimum amps drawn on the 
circuit breaker 

 
 

PDUSensorReadings 

The PDUSensorReadings view shows the data collected from PDU 
sensors. A data record is added for each sensor polled. This data is 
summarized hourly in a PDUSensorReadingsRollup view and the sensor 
readings in this view are purged. 

Field Type Notes 

PDUSensorReadingsID Integer Unique ID for each 
reading 

SensorID Integer Database ID of the 
sensor as seen in 
PDUSensors 



 Appendix A: ODBC Access  

 
381

 
 

Field Type Notes 

Time Timestamp with 
Timezone 

Local timestamp when 
the reading occurred 

Value Real Sensor value 

MinimumValue Real Minimum sensor value 
over the sample period. 
Applies to devices with 
data buffering enabled. 

MaximumValue Real Maximum sensor value 
over the sample period. 
Applies to devices with 
data buffering enabled. 

 
 

PDUOutletReadingsRollup - To Be Deprecated 

Note: This table will be deprecated soon. It is recommended to stop 
using it, and use the new PDUOutletReadingsHourlyRollup, 
PDUOutletReadingsDailyRollup, and PDUOutletReadingsMonthlyRollup 
tables. If you experience any performance issues, move to the new 
tables. 

The PDUOutletReadingsRollup view summarizes the outlet readings 
power data over the roll-up interval. Hourly roll-ups are rolled up once a 
day. Daily roll-ups are rolled up once a month. When data is rolled up, 
shorter interval roll-up entries in the PDUOutletReadingsRollup view are 
purged. 

Field Type Notes 

PDUOutletReadingsRollup
ID 

Integer Non-unique ID for each 
reading 

PDUID Integer Foreign key reference to 
PDUs table 

OutletID Integer Foreign key reference to 
PDUOutlets table 

OutletNumber Integer Outlet number on the 
PDU 

RollupInterval Integer 1: one hour 

2: one day 

3: one month 

Time Timestamp with 
Timezone 

Timestamp when rollup 
was created 

MinimumCurrent Real Lowest current (Amps) 
reading during rollup 
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Field Type Notes 

interval 

MaximumCurrent Real Maximum current (Amps) 
reading during rollup 
interval 

AverageCurrent Real Average current (Amps) 
reading during rollup 
interval 

MinimumActivePower Real Lowest active power 
(Watts) reading during 
rollup interval 

MaximumActivePower Real Maximum active power 
(Watts) reading during 
rollup interval 

AverageActivePower Real Average active power 
(Watts) reading during 
rollup interval 

MinimumApparentPower Real Lowest apparent power 
(VA) reading during rollup 
interval 

MaximumApparentPower Real Maximum apparent 
power (VA) reading 
during rollup interval 

AverageApparentPower Real Average apparent power 
(VA) reading during rollup 
interval 

MinimumPowerFactor Real Minimum power factor 
reading during rollup 
interval 

MaximumPowerFactor Real Maximum power factor 
reading during rollup 
interval 

AverageActivePower Real Average power factor 
reading during rollup 
interval 

MinimumVoltage Real Minimum voltage reading 
during rollup interval 

MaximumVoltage Real Maximum voltage reading 
during rollup interval 

AverageVoltage Real Average voltage reading 
during rollup interval 
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Field Type Notes 

WattHours Real Maximum of the 
cumulative watt-hour 
meter readings over the 
rollup interval 

 
 

PDUOutletReadingHourlyRollups 

 

Field Type Notes 

PDUOutletReadingsRollup
ID 

Integer Unique ID for each 
reading 

PDUID Integer Foreign key reference to 
PDUs table 

OutletID Integer Foreign key reference to 
PDUOutlets table 

OutletNumber Integer Outlet number on the 
PDU 

Time Timestamp with 
Timezone 

Timestamp when rollup 
was created 

MinimumCurrent Real Lowest current (Amps) 
reading during rollup 
interval 

MaximumCurrent Real Maximum current (Amps) 
reading during rollup 
interval 

AverageCurrent Real Average current (Amps) 
reading during rollup 
interval 

MinimumActivePower Real Lowest active power 
(Watts) reading during 
rollup interval 

MaximumActivePower Real Maximum active power 
(Watts) reading during 
rollup interval 

AverageActivePower Real Average active power 
(Watts) reading during 
rollup interval 

MinimumApparentPower Real Lowest apparent power 
(VA) reading during rollup 
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Field Type Notes 

interval 

MaximumApparentPower Real Maximum apparent 
power (VA) reading 
during rollup interval 

AverageApparentPower Real Average apparent power 
(VA) reading during rollup 
interval 

MinimumVoltage Real Minimum voltage reading 
during rollup interval 

MaximumVoltage Real Maximum voltage reading 
during rollup interval 

AverageVoltage Real Average voltage reading 
during rollup interval 

VoltAmpHours Real Maximum of the 
cumulative volt-amp-hour 
meter readings over the 
rollup interval 

WattHours Real Maximum of the 
cumulative watt-hour 
meter readings over the 
rollup interval 

AveragePowerFactor Real Average power factor 
reading during rollup 
interval 

MinimumPowerFactor Real Minimum power factor 
reading during rollup 
interval 

MaximumPowerFactor Real Maximum power factor 
reading during rollup 
interval 

 
 

PDUOutletReadingDailyRollups 

 

Field Type Notes 

PDUOutletReadingsRollup
ID 

Integer Unique ID for each 
reading 

PDUID Integer Foreign key reference to 
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Field Type Notes 

PDUs table 

OutletID Integer Foreign key reference to 
PDUOutlets table 

OutletNumber Integer Outlet number on the 
PDU 

Time Timestamp with 
Timezone 

Timestamp when rollup 
was created 

MinimumCurrent Real Lowest current (Amps) 
reading during rollup 
interval 

MaximumCurrent Real Maximum current (Amps) 
reading during rollup 
interval 

AverageCurrent Real Average current (Amps) 
reading during rollup 
interval 

MinimumActivePower Real Lowest active power 
(Watts) reading during 
rollup interval 

MaximumActivePower Real Maximum active power 
(Watts) reading during 
rollup interval 

AverageActivePower Real Average active power 
(Watts) reading during 
rollup interval 

MinimumApparentPower Real Lowest apparent power 
(VA) reading during rollup 
interval 

MaximumApparentPower Real Maximum apparent 
power (VA) reading 
during rollup interval 

AverageApparentPower Real Average apparent power 
(VA) reading during rollup 
interval 

MinimumVoltage Real Minimum voltage reading 
during rollup interval 

MaximumVoltage Real Maximum voltage reading 
during rollup interval 

AverageVoltage Real Average voltage reading 
during rollup interval 
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Field Type Notes 

VoltAmpHours Real Maximum of the 
cumulative volt-amp-hour 
meter readings over the 
rollup interval 

WattHours Real Maximum of the 
cumulative watt-hour 
meter readings over the 
rollup interval 

AveragePowerFactor Real Average power factor 
reading during rollup 
interval 

MinimumPowerFactor Real Minimum power factor 
reading during rollup 
interval 

MaximumPowerFactor Real Maximum power factor 
reading during rollup 
interval 

 
 

PDUOutletReadingMonthlyRollups 

 

Field Type Notes 

PDUOutletReadingsRollup
ID 

Integer Unique ID for each 
reading 

PDUID Integer Foreign key reference to 
PDUs table 

OutletID Integer Foreign key reference to 
PDUOutlets table 

OutletNumber Integer Outlet number on the 
PDU 

Time Timestamp with 
Timezone 

Local timestamp for the 
first day of the month 
over which the rollup was 
calculated 

MinimumCurrent Real Lowest current (Amps) 
reading during rollup 
interval 

MaximumCurrent Real Maximum current (Amps) 
reading during rollup 
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Field Type Notes 

interval 

AverageCurrent Real Average current (Amps) 
reading during rollup 
interval 

MinimumActivePower Real Lowest active power 
(Watts) reading during 
rollup interval 

MaximumActivePower Real Maximum active power 
(Watts) reading during 
rollup interval 

AverageActivePower Real Average active power 
(Watts) reading during 
rollup interval 

MinimumApparentPower Real Lowest apparent power 
(VA) reading during rollup 
interval 

MaximumApparentPower Real Maximum apparent 
power (VA) reading 
during rollup interval 

AverageApparentPower Real Average apparent power 
(VA) reading during rollup 
interval 

MinimumVoltage Real Minimum voltage reading 
during rollup interval 

MaximumVoltage Real Maximum voltage reading 
during rollup interval 

AverageVoltage Real Average voltage reading 
during rollup interval 

VoltAmpHours Real Maximum of the 
cumulative volt-amp-hour 
meter readings over the 
rollup interval 

WattHours Real Maximum of the 
cumulative watt-hour 
meter readings over the 
rollup interval 

AveragePowerFactor Real Average power factor 
reading during rollup 
interval 
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Field Type Notes 

MinimumPowerFactor Real Minimum power factor 
reading during rollup 
interval 

MaximumPowerFactor Real Maximum power factor 
reading during rollup 
interval 

 
 

PDUReadingsRollup - To Be Deprecated 

Note: This table will be deprecated soon. It is recommended to stop 
using it, and use the new PDUInletReadings tables. 

The PDUReadingsRollup view summarizes the PDU readings power 
data over the roll-up interval. Hourly roll-ups are rolled up once a day. 
Daily roll-ups are rolled up once a month. When data is rolled up, shorter 
interval roll-up entries in the PDUReadingsRollup are purged.   

Field Type Notes 

PDUReadingsRollup Integer Non-unique ID for each 
reading 

PDUID Integer Foreign key reference to 
PDU 

RollupInterval Integer 1: one hour 

2: one day 

3: one month 

Time Timestamp with 
Timezone 

Timestamp when rollup 
was created 

MinimumActivePower Real Lowest active power 
(Watts) reading during 
rollup interval 

MaximumActivePower Real Maximum active power 
(Watts) reading during 
rollup interval 

AverageActivePower Real Average active power 
(Watts) reading during 
rollup interval 

MinimumApparentPower Real Lowest apparent power 
(VA) reading during rollup 
interval 

MaximumApparentPower Real Maximum apparent 
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Field Type Notes 

power (VA) reading 
during rollup interval 

AverageApparentPower Real Average apparent power 
(VA) reading during rollup 
interval 

WattHours Real Maximum of the 
cumulative watt-hour 
meter readings over the 
rollup interval 

 
 

PDULineReadingsRollup - To Be Deprecated 

Note: This table will be deprecated soon. It is recommended to stop 
using it, and use the new PDULineReadingsHourlyRollup, 
PDULineReadingsDailyRollup, PDULineReadingsMonthlyRollup tables.  

The PDULineReadingsRollup view summarizes the line readings power 
data over the roll-up interval. Hourly roll-ups are rolled up once a day. 
Daily roll-ups are rolled up once a month. When data is rolled up, shorter 
interval roll-up entries in the PDULineReadingsRollup is purged. 

Field Type Notes 

PDULineReadingsRollupI
D 

Integer Non-unique ID for each 
reading 

PDUID Integer Foreign key reference to 
PDU 

LineNumber Integer Line number on the PDU 

InletNumber Integer Inlet number on the PDU 

RollupInterval Integer 1: one hour 

2: one day 

3: one month 

Time Timestamp with 
Timezone 

Timestamp when rollup 
was created 

MinimumCurrent Real Lowest current (Amps) 
reading during rollup 
interval 

MaximumCurrent Real Maximum current (Amps) 
reading during rollup 
interval 

AverageCurrent Real Average current (Amps) 
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Field Type Notes 

reading during rollup 
interval 

MinimumUnutilizedCapacit
y 

Real Lowest unutilized 
capacity (Amps) during 
rollup interval 

MaximumUnutilizedCapaci
ty 

Real Maximum unutilized 
capacity (Amps) during 
rollup interval 

AverageUnutilizedCapacit
y 

Real Average unutilized 
capacity (Amps) during 
rollup interval 

 
 

PDULineReadingHourlyRollups 

The PDULineReadingsHourlyRollup view summarizes the line readings 
power data over the hourly roll-up interval.  

Field Type Notes 

PDULineReadingsRollupI
D 

Integer Unique ID for each 
reading 

PDUID Integer Foreign key reference to 
PDU 

LineNumber Integer Line number on the PDU 

InletNumber Integer Inlet number on the PDU 

Time Timestamp with 
Timezone 

Timestamp when rollup 
was created 

MinimumCurrent Real Lowest current (Amps) 
reading during rollup 
interval 

MaximumCurrent Real Maximum current (Amps) 
reading during rollup 
interval 

AverageCurrent Real Average current (Amps) 
reading during rollup 
interval 

MinimumUnutilizedCapacit
y 

Real Lowest unutilized 
capacity (Amps) during 
rollup interval 

MaximumUnutilizedCapaci
ty 

Real Maximum unutilized 
capacity (Amps) during 
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Field Type Notes 

rollup interval 

AverageUnutilizedCapacit
y 

Real Average unutilized 
capacity (Amps) during 
rollup interval 

 
 

PDULineReadingDailyRollups 

The PDULineReadingsDailyRollup view summarizes the line readings 
power data over the daily roll-up interval.  

Field Type Notes 

PDULineReadingsRollupI
D 

Integer Unique ID for each 
reading 

PDUID Integer Foreign key reference to 
PDU 

LineNumber Integer Line number on the PDU 

InletNumber Integer Inlet number on the PDU 

Time Timestamp with 
Timezone 

Timestamp when rollup 
was created 

MinimumCurrent Real Lowest current (Amps) 
reading during rollup 
interval 

MaximumCurrent Real Maximum current (Amps) 
reading during rollup 
interval 

AverageCurrent Real Average current (Amps) 
reading during rollup 
interval 

MinimumUnutilizedCapacit
y 

Real Lowest unutilized 
capacity (Amps) during 
rollup interval 

MaximumUnutilizedCapaci
ty 

Real Maximum unutilized 
capacity (Amps) during 
rollup interval 

AverageUnutilizedCapacit
y 

Real Average unutilized 
capacity (Amps) during 
rollup interval 
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PDULineReadingMonthlyRollups 

The PDULineReadingsMonthlyRollup view summarizes the line readings 
power data over the monthly roll-up interval.  

Field Type Notes 

PDULineReadingsRollupI
D 

Integer Unique ID for each 
reading 

PDUID Integer Foreign key reference to 
PDU 

LineNumber Integer Line number on the PDU 

InletNumber Integer Inlet number on the PDU 

Time Timestamp with 
Timezone 

Local timestamp for the 
first day of the month 
over which the rollup was 
calculated 

MinimumCurrent Real Lowest current (Amps) 
reading during rollup 
interval 

MaximumCurrent Real Maximum current (Amps) 
reading during rollup 
interval 

AverageCurrent Real Average current (Amps) 
reading during rollup 
interval 

MinimumUnutilizedCapacit
y 

Real Lowest unutilized 
capacity (Amps) during 
rollup interval 

MaximumUnutilizedCapaci
ty 

Real Maximum unutilized 
capacity (Amps) during 
rollup interval 

AverageUnutilizedCapacit
y 

Real Average unutilized 
capacity (Amps) during 
rollup interval 

 
 

PDUCircuitReadingHourlyRollups 

Field Type Notes 

PDUCircuitReadingHou
rlyRollupsID  

Big Integer Unique ID for each 
reading 
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Field Type Notes 

PDUID  Integer Foreign key reference to 
PDUs table 

PDUCircuitID Integer Foreign key reference to 
the PDUCircuits table 

Time  timestamp with 
time zone 

Timestamp when rollup 
was created 

Voltage  Real Average voltage reading 
during rollup interval 

MinVoltage  Real Minimum voltage reading 
during rollup interval 

MaxVoltage Real Maximum voltage reading 
during rollup interval 

Current  Real Average current reading 
(Amps) during rollup 
interval 

MinCurrent Real Minimum current reading 
(Amps) during rollup 
interval 

MaxCurrent Real Maximum current reading 
(Amps) during rollup 
interval 

UnutilizedCapacity Real Average unutilized 
capacity (rated amps 
minus current) reading 
during rollup interval 

MinUnutilizedCapacity   Real Minimum unutilized 
capacity (rated amps 
minus current) reading 
during rollup interval 

MaxUnutilizedCapacity Real Maximum unutilized 
capacity (rated amps 
minus current) reading 
during rollup interval 

PowerFactor Real Average Power factor 
reading during rollup 
interval 

MinPowerFactor Real Minimum power factor 
reading during rollup 
interval 
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Field Type Notes 

MaxPowerFactor Real Maximum power factor 
reading during rollup 
interval 

ActivePower Real Average active power 
(Watts) reading during 
rollup interval 

MinActivePower Real Minimum active power 
(Watts) reading during 
rollup interval 

MaxActivePower Real Maximum active power 
(Watts) reading during 
rollup interval 

ApparentPower  Real Average apparent power 
(VA) reading during rollup 
interval 

MinApparentPower Real Minimum apparent power 
(VA) reading during rollup 
interval 

MaxApparentPower Real Maximum apparent 
power (VA) reading 
during rollup interval 

VoltAmpHour Real Maximum of the 
cumulative volt-amp-hour 
meter readings over the 
rollup interval 

WattHour Real Maximum of the 
cumulative watt-hour 
meter readings over the 
rollup interval 

 

 

PDUCircuitReadingDailyRollups 

Field Type Notes 

PDUCircuitReadingDail
yRollupsID  

Big Integer  

PDUID  Integer Foreign key reference to 
PDUs table 

PDUCircuitID Integer Foreign key reference to 
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Field Type Notes 

the PDUCircuits table 

Time  timestamp with 
time zone 

Timestamp when rollup 
was created 

Date date Date when rollup was 
created  

Voltage  Real Average voltage reading 
during rollup interval 

MinVoltage  Real Minimum voltage reading 
during rollup interval 

MaxVoltage Real Maximum voltage reading 
during rollup interval 

Current  Real Average current reading 
(Amps) during rollup 
interval 

MinCurrent Real Minimum current reading 
(Amps) during rollup 
interval 

MaxCurrent Real Maximum current reading 
(Amps) during rollup 
interval 

UnutilizedCapacity Real Average unutilized 
capacity (rated amps 
minus current) reading 
during rollup interval 

MinUnutilizedCapacity   Real Minimum unutilized 
capacity (rated amps 
minus current) reading 
during rollup interval 

MaxUnutilizedCapacity Real Maximum unutilized 
capacity (rated amps 
minus current) reading 
during rollup interval 

PowerFactor Real Average Power factor 
reading during rollup 
interval 

MinPowerFactor Real Minimum power factor 
reading during rollup 
interval 

MaxPowerFactor Real Maximum power factor 
reading during rollup 
interval 
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Field Type Notes 

ActivePower Real Average active power 
(Watts) reading during 
rollup interval 

MinActivePower Real Minimum active power 
(Watts) reading during 
rollup interval 

MaxActivePower Real Maximum active power 
(Watts) reading during 
rollup interval 

ApparentPower  Real Average apparent power 
(VA) reading during rollup 
interval 

MinApparentPower Real Minimum apparent power 
(VA) reading during rollup 
interval 

MaxApparentPower Real Maximum apparent 
power (VA) reading 
during rollup interval 

VoltAmpHour Real Maximum of the 
cumulative volt-amp-hour 
meter readings over the 
rollup interval 

WattHour Real Maximum of the 
cumulative watt-hour 
meter readings over the 
rollup interval 

 
 

PDUCircuitReadingMonthlyRollups 

Field Type Notes 

PDUCircuitReadingMon
thlyRollupsID  

Big Integer Unique ID for each 
reading 

PDUID  Integer Foreign key reference to 
PDUs table 

PDUCircuitID Integer Foreign key reference to 
the PDUCircuits table 

Time  timestamp with 
time zone 

Timestamp when rollup 
was created 
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Field Type Notes 

Year double 
precision   

Year when rollup was 
created  

Month  double 
precision 

Month when rollup was 
created 

Voltage  Real Average voltage reading 
during rollup interval 

MinVoltage  Real Minimum voltage reading 
during rollup interval 

MaxVoltage Real Maximum voltage reading 
during rollup interval 

Current  Real Average current reading 
(Amps) during rollup 
interval 

MinCurrent Real Minimum current reading 
(Amps) during rollup 
interval 

MaxCurrent Real Maximum current reading 
(Amps) during rollup 
interval 

UnutilizedCapacity Real Average unutilized 
capacity (rated amps 
minus current) reading 
during rollup interval 

MinUnutilizedCapacity   Real Minimum unutilized 
capacity (rated amps 
minus current) reading 
during rollup interval 

MaxUnutilizedCapacity Real Maximum unutilized 
capacity (rated amps 
minus current) reading 
during rollup interval 

PowerFactor Real Average Power factor 
reading during rollup 
interval 

MinPowerFactor Real Minimum power factor 
reading during rollup 
interval 

MaxPowerFactor Real Maximum power factor 
reading during rollup 
interval 
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Field Type Notes 

ActivePower Real Average active power 
(Watts) reading during 
rollup interval 

MinActivePower Real Minimum active power 
(Watts) reading during 
rollup interval 

MaxActivePower Real Maximum active power 
(Watts) reading during 
rollup interval 

ApparentPower  Real Average apparent power 
(VA) reading during rollup 
interval 

MinApparentPower Real Minimum apparent power 
(VA) reading during rollup 
interval 

MaxApparentPower Real Maximum apparent 
power (VA) reading 
during rollup interval 

VoltAmpHour Real Maximum of the 
cumulative volt-amp-hour 
meter readings over the 
rollup interval 

WattHour Real Maximum of the 
cumulative watt-hour 
meter readings over the 
rollup interval 

 
 

PDUCircuitPoleReadingHourlyRollups 

Field Type Notes 

PDUCircuitPoleReadin
gHourlyRollupsID  

Big Integer Unique ID for each 
reading 

PDUCircuitPoleID  Integer Circuit pole number on 
the PDU 

PDUID     Integer Foreign key reference to 
PDUs table 

Time  timestamp with 
time zone 

Timestamp when rollup 
was created 
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Field Type Notes 

Voltage  Real  Average voltage reading 
during rollup interval 

MinVoltage Real Minimum voltage reading 
during rollup interval 

MaxVoltage Real Maximum voltage reading 
during rollup interval 

Current  Real Average current reading 
(Amps) during rollup 
interval 

MinCurrent Real Minimum current reading 
(Amps) during rollup 
interval 

MaxCurrent Real Maximum current reading 
(Amps) during rollup 
interval 

UnutilizedCapacity Real Average unutilized 
capacity (rated amps 
minus current) reading 
during rollup interval 

MinUnutilizedCapacity   Real Minimum unutilized 
capacity (rated amps 
minus current) reading 
during rollup interval 

MaxUnutilizedCapacity Real Maximum unutilized 
capacity (rated amps 
minus current) reading 
during rollup interval 

 
 

PDUCircuitPoleReadingDailyRollups 

Field Type Notes 

PDUCircuitPoleReadin
gDailyRollupsID  

Big Integer Unique ID for each 
reading 

PDUCircuitPoleID  Integer Circuit pole number on 
the PDU 

PDUID     Integer Foreign key reference to 
PDUs table 

Time  timestamp with 
time zone 

Timestamp when rollup 
was created 
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Field Type Notes 

Date date Date when rollup was 
created 

Voltage  Real  Average voltage reading 
during rollup interval 

MinVoltage Real Minimum voltage reading 
during rollup interval 

MaxVoltage Real Maximum voltage reading 
during rollup interval 

Current  Real Average current reading 
(Amps) during rollup 
interval 

MinCurrent Real Minimum current reading 
(Amps) during rollup 
interval 

MaxCurrent Real Maximum current reading 
(Amps) during rollup 
interval 

UnutilizedCapacity Real Average unutilized 
capacity (rated amps 
minus current) reading 
during rollup interval 

MinUnutilizedCapacity   Real Minimum unutilized 
capacity (rated amps 
minus current) reading 
during rollup interval 

MaxUnutilizedCapacity Real Maximum unutilized 
capacity (rated amps 
minus current) reading 
during rollup interval 

 
 

PDUCircuitPoleReadingMonthlyRollups 

Field Type Notes 

PDUCircuitPoleReadin
gMonthlyRollupsID  

Big Integer Unique ID for each 
reading 

PDUCircuitPoleID  Integer Circuit pole number on 
the PDU 

PDUID     Integer Foreign key reference to 
PDUs table 
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Field Type Notes 

Time  timestamp with 
time zone 

Timestamp when rollup 
was created 

Year double 
precision 

Year when rollup was 
created 

Month double 
precision 

Month when rollup was 
created 

Voltage  Real  Average voltage reading 
during rollup interval 

MinVoltage Real Minimum voltage reading 
during rollup interval 

MaxVoltage Real Maximum voltage reading 
during rollup interval 

Current  Real Average current reading 
(Amps) during rollup 
interval 

MinCurrent Real Minimum current reading 
(Amps) during rollup 
interval 

MaxCurrent Real Maximum current reading 
(Amps) during rollup 
interval 

UnutilizedCapacity Real Average unutilized 
capacity (rated amps 
minus current) reading 
during rollup interval 

MinUnutilizedCapacity   Real Minimum unutilized 
capacity (rated amps 
minus current) reading 
during rollup interval 

MaxUnutilizedCapacity Real Maximum unutilized 
capacity (rated amps 
minus current) reading 
during rollup interval 
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PDUCircuitBreakerReadingsRollup - To Be Deprecated 

Note: This table will be deprecated soon. It is recommended to stop 
using it, and use the new PDUCircuitBreakerReadingsHourlyRollup, 
PDUCircuitBreakerReadingDailyRollups, and 
PDUCircuitBreakerReadingMonthlyRollups tables. If you experience any 
performance issues, move to the new tables. 

The PDUCircuitBreakerReadingsRollup view summarizes the circuit 
breaker readings power data over the roll-up interval. Hourly roll-ups are 
rolled up once a day. Daily roll-ups are rolled up once a month.  When 
data is rolled up, shorter interval roll-up entries in the 
PDUCircuitBreakerReadingsRollup view are purged. 

Field Type Notes 

PDUCircuitBreakerReadingsRollup
ID 

Integer Non-unique ID for each 
reading 

PDUID Integer Foreign key reference to 
PDU 

CircuitBreakerNumber Integer Circuit breaker number 
on the PDU 

CircuitBreakerID Integer Foreign key reference to 
PDUCircuitBreakers table 

RollupInterval Integer 1: one hour 

2: one day 

3: one month 

Time Timestamp with 
Timezone 

Timestamp when rollup 
was created 

MinimumCurrent Real Lowest current (Amps) 
reading during rollup 
interval 

MaximumCurrent Real Maximum current (Amps) 
reading during rollup 
interval 

AverageCurrent Real Average current (Amps) 
reading during rollup 
interval 

MinimumUnutilizedCapacity Real Lowest unutilized 
capacity (Amps) during 
rollup interval 

MaximumUnutilizedCapacity Real Maximum unutilized 
capacity (Amps) during 
rollup interval 
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Field Type Notes 

AverageUnutilizedCapacity Real Average unutilized 
capacity (Amps) during 
rollup interval 

 
 

PDUCircuitBreakerReadingHourlyRollups 

The PDUCircuitBreakerReadingHourlyRollup view summarizes the 
circuit breaker readings power data over the hourly roll-up interval.  

Field Type Notes 

PDUCircuitBreakerReadingsRollup
ID 

Integer Unique ID for each 
reading 

PDUID Integer Foreign key reference to 
PDU 

CircuitBreakerNumber Integer Circuit breaker number 
on the PDU 

CircuitBreakerID Integer Foreign key reference to 
PDUCircuitBreakers table 

Time Timestamp with 
Timezone 

Timestamp when rollup 
was created 

MinimumCurrent Real Lowest current (Amps) 
reading during rollup 
interval 

MaximumCurrent Real Maximum current (Amps) 
reading during rollup 
interval 

AverageCurrent Real Average current (Amps) 
reading during rollup 
interval 

MinimumUnutilizedCapacity Real Lowest unutilized 
capacity (Amps) during 
rollup interval 

MaximumUnutilizedCapacity Real Maximum unutilized 
capacity (Amps) during 
rollup interval 

AverageUnutilizedCapacity Real Average unutilized 
capacity (Amps) during 
rollup interval 
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PDUCircuitBreakerReadingDailyRollups 

The PDUCircuitBreakerReadingsDailyRollup view summarizes the circuit 
breaker readings power data over the daily roll-up interval.  

Field Type Notes 

PDUCircuitBreakerReadingsRollup
ID 

Integer Unique ID for each 
reading 

PDUID Integer Foreign key reference to 
PDU 

CircuitBreakerNumber Integer Circuit breaker number 
on the PDU 

CircuitBreakerID Integer Foreign key reference to 
PDUCircuitBreakers table 

Time Timestamp with 
Timezone 

Timestamp when rollup 
was created 

MinimumCurrent Real Lowest current (Amps) 
reading during rollup 
interval 

MaximumCurrent Real Maximum current (Amps) 
reading during rollup 
interval 

AverageCurrent Real Average current (Amps) 
reading during rollup 
interval 

MinimumUnutilizedCapacity Real Lowest unutilized 
capacity (Amps) during 
rollup interval 

MaximumUnutilizedCapacity Real Maximum unutilized 
capacity (Amps) during 
rollup interval 

AverageUnutilizedCapacity Real Average unutilized 
capacity (Amps) during 
rollup interval 
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PDUCircuitBreakerReadingMonthlyRollups 

The PDUCircuitBreakerReadingsMonthlyRollup view summarizes the 
circuit breaker readings power data over the monthly roll-up interval.  

Field Type Notes 

PDUCircuitBreakerReadingsRollup
ID 

Integer Unique ID for each 
reading 

PDUID Integer Foreign key reference to 
PDU 

CircuitBreakerNumber Integer Circuit breaker number 
on the PDU 

CircuitBreakerID Integer Foreign key reference to 
PDUCircuitBreakers table 

Time Timestamp with 
Timezone 

Local timestamp for the 
first day of the month 
over which the rollup was 
calculated 

MinimumCurrent Real Lowest current (Amps) 
reading during rollup 
interval 

MaximumCurrent Real Maximum current (Amps) 
reading during rollup 
interval 

AverageCurrent Real Average current (Amps) 
reading during rollup 
interval 

MinimumUnutilizedCapacity Real Lowest unutilized 
capacity (Amps) during 
rollup interval 

MaximumUnutilizedCapacity Real Maximum unutilized 
capacity (Amps) during 
rollup interval 

AverageUnutilizedCapacity Real Average unutilized 
capacity (Amps) during 
rollup interval 
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PDUSensorReadingsRollup - To Be Deprecated 

Note: This table will be deprecated soon. It is recommended to stop 
using it, and use the new PDUSensorReadingsHourlyRollups, 
PDUSensorReadingsDailyRollups, and 
PDUSensorReadingsMonthlyRollups tables. If you experience any 
performance issues, move to the new tables. 

The PDUSensorReadingsRollup view summarizes the sensor readings 
power data over the roll-up interval. Hourly roll-ups are rolled up once a 
day. Daily roll-ups are rolled up once a month. When data is rolled up, 
shorter interval roll-up entries in the PDUSensorReadingsRollup view are 
purged. 

Field Type Notes 

PDUSensorReadingsRollu
pID 

Integer Non-unique ID for each 
reading 

SensorID Integer Database ID of the 
sensor as seen in 
PDUSensors 

RollupInterval Integer 1: one hour 

2: one day 

3: one month 

Time Timestamp with 
Timezone 

Timestamp when rollup 
was created 

MinimumValue Real Lowest sensor reading 
during rollup interval 

MaximumValue Real Maximum sensor reading 
during rollup interval 

AverageValue Real Average sensor reading 
during rollup interval 

 
 

PDUSensorReadingHourlyRollup 

The PDUSensorReadingsHourlyRollup view summarizes the sensor 
readings power data over the roll-up interval. Hourly roll-ups are rolled up 
once a day. Daily roll-ups are rolled up once a month. When data is 
rolled up, shorter interval roll-up entries in the 
PDUSensorReadingsRollup view are purged. 

Field Type Notes 

PDUSensorReadingsRollu
pID 

Integer Unique ID for each 
reading 
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Field Type Notes 

SensorID Integer Database ID of the 
sensor as seen in 
PDUSensors 

Time Timestamp with 
Timezone 

Timestamp when rollup 
was created 

MinimumValue Real Lowest sensor reading 
during rollup interval 

MaximumValue Real Maximum sensor reading 
during rollup interval 

AverageValue Real Average sensor reading 
during rollup interval 

 
 

PDUSensorReadingDailyRollup 

The PDUSensorReadingsDailyRollup view summarizes the sensor 
readings power data over the roll-up interval. Hourly roll-ups are rolled up 
once a day. Daily roll-ups are rolled up once a month. When data is 
rolled up, shorter interval roll-up entries in the 
PDUSensorReadingsRollup view are purged. 

Field Type Notes 

PDUSensorReadingsRollu
pID 

Integer Unique ID for each 
reading 

SensorID Integer Database ID of the 
sensor as seen in 
PDUSensors 

Time Timestamp with 
Timezone 

Timestamp when rollup 
was created 

MinimumValue Real Lowest sensor reading 
during rollup interval 

MaximumValue Real Maximum sensor reading 
during rollup interval 

AverageValue Real Average sensor reading 
during rollup interval 
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PDUSensorReadingMonthlyRollup 

The PDUSensorReadingsMonthlyRollup view summarizes the sensor 
readings power data over the roll-up interval. Hourly roll-ups are rolled up 
once a day. Daily roll-ups are rolled up once a month. When data is 
rolled up, shorter interval roll-up entries in the 
PDUSensorReadingsRollup view are purged. 

Field Type Notes 

PDUSensorReadingsRollu
pID 

Integer Unique ID for each 
reading 

SensorID Integer Database ID of the 
sensor as seen in 
PDUSensors 

Time Timestamp with 
Timezone 

Local timestamp for the 
first day of the month 
over which the rollup was 
calculated 

MinimumValue Real Lowest sensor reading 
during rollup interval 

MaximumValue Real Maximum sensor reading 
during rollup interval 

AverageValue Real Average sensor reading 
during rollup interval 

 
 

PDUSensors 

The PDUSensors view contains information about sensors attached to 
PDUs that Power IQ manages. 

Field Type Notes 

SensorID  Integer Auto-generated ID 

PDUID Integer Foreign key reference to 
PDUs table 

PDUSensorID Integer ID of the sensor on the 
PDU, as gathered from 
the pdu 

SensorNumber Integer Sensor number on the 
PDU 

AttributeName VarChar(64) Type of sensor 

Label VarChar(255) Sensor's label as 
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Field Type Notes 

gathered from the PDU 

Removed VarChar(64) When the sensor was 
removed from the 
system, or null for current 
sensors 

Position VarChar(10) Sensor position on the 
PDU: inlet, outlet or 
outside air 

 
 

PDUTransferSwitchStates 

This view represents the state of a Transfer Switch at a particular 
moment in time, normally recorded when the state of the switch has 
changed. 

Field Type Notes 

PDUTransferSwitchStatesI
D 

BigInt The primary key for 
this view 

PDUTransferSwitchesID Integer Foreign key reference 
to the 
PDUTransferSwitches 
view. 

ActivePDUInletNumber VarChar(32) The ordinal of the 
active inlet. 

OperatingStatus VarChar(32) A string representing 
the operating status 
reported by the PDU's 
MIB. 

Time Timestamp with 
Timezone 

Local timestamp 

 
 

PDUTransferSwitches 

This view represents the physical transfer switch inside of a PDU of type 
‘Rack Transfer Switch’. 

Field Type Notes 

PDUTransferSwitchesI
D 

Integer The primary key for this view 

PDUID Integer Foreign key reference to the 
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PDUs view. 

CreatedAt Timestamp with 
Timezone 

The date and time that the 
Transfer Switch was added 
to the system. 

UpdatedAt Timestamp with 
Timezone 

The date and time this 
Transfer Switch was last 
updated. 

 
 

TagEntries 

This view shows all of the tags that have been applied to an entity. 

Field Type Notes 

TagEntriesID Integer The primary key for this view 

TagsID Integer Foreign key reference to the Tags 
view. 

TaggableType VarChar(255) The type of EDM entity that was 
tagged (Room, Rack, PDU, etc.) 

TaggableID Integer Foreign key reference to the 
appropriate entity view. 

CreatedAt Timestamp with 
Timezone 

The date and time this Tag Entry 
was created. 

UpdatedAt Timestamp with 
Timezone 

The date and time this Tag Entry 
was last updated. 

 
 

TagGroups 

This view lists all of the tag groups in Power IQ. 

Field Type Notes 

TagGroupsID Integer The primary key for this view 

Name VarChar(255) Name of the Tag Group 

CreatedAt Timestamp with 
Timezone 

The date and time this Tag 
Group was created. 

UpdatedAt Timestamp with 
Timezone 

The date and time this Tag 
Group was last updated. 
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Tags 

This view lists all of the tags in Power IQ and the shows which tag group 
they belong to. 

Field Type Notes 

TagsID Integer The primary key for this view 

TagGroupsID Integer Foreign key reference to the 
TagGroups view. 

Name VarChar(255) Name of the Tag 

CreatedAt Timestamp with 

Timezone 

The date and time this Tag was 
created. 

UpdatedAt Timestamp with 

Timezone 

The date and time this Tag was 
last updated. 

 
 

DataCenters 

The DataCenters view contains information about data center objects as 
part of the Enterprise Relationship Model. The fields in this view 
correspond to the item attributes in the model. 

Field Type Notes 

DataCenterID Integer Auto-generated ID 

Name VarChar(255) Human-assigned name 
for this data center object 

CompanyName VarChar(255) Name of the company 
that owns this data center 

ContactName VarChar(255) Name of the person to 
contact regarding data 
center 

ContactPhone VarChar(255) Phone number for contact 

ContactEmail VarChar(255) Email for contact 

City VarChar(255) City location of data 
center 

State VarChar(255) State location of data 
center 

Country VarChar(255) Country location of data 
center 

PeakKWHRate Double Energy cost per Kilowatt 
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Field Type Notes 

Hour during peak hours 

OffPeakKWHRate Double Energy cost per Kilowatt 
Hour during off-peak 
hours 

PeakBegin Double Time of day peak hours 
begin  

For example 19.5 = 19:30 
hours 

PeakEnd Double Time of day peak hours 
end 

CO2Factor Double CO2 computational factor 

CoolingFactor Double Cooling factor for data 
center 

CustomField1 VarChar(255) A user-defined field 

CustomField2 VarChar(255) A user-defined field 

ExternalKey VarChar(255) The unique code used by 
the Enterprise Model to 
identify this data center 

 
 

Floors 

The Floors view contains information about Floor objects as part of the 
Enterprise Relationship Model. The fields in this view correspond to the 
item attributes in the model. 

Field Type Notes 

FloorID Integer Auto-generated ID 

Name VarChar(255) Human-assigned name 
for this Floor object. 

ExternalKey VarChar(255) The unique code used by 
the Enterprise Model to 
identify this Floor. 
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Rooms 

The Rooms view contains information about Room objects as part of the 
Enterprise Relationship Model. The fields in this view correspond to the 
item attributes in the model. 

Field Type Notes 

RoomID Integer Auto-generated ID 

Name VarChar(255) Human-assigned name 
for this Room object. 

ExternalKey VarChar(255) The unique code used by 
the Enterprise Model to 
identify this Room. 

 
 

Aisles 

The Aisles view contains information about Aisle objects as part of the 
Enterprise Relationship Model. The fields in this view correspond to the 
item attributes in the model. 

Field Type Notes 

AisleID Integer Auto-generated ID 

Name VarChar(255) Human-assigned name 
for this Aisle object. 

ExternalKey VarChar(255) The unique code used by 
the Enterprise Model to 
identify this Aisle. 

 
 

Rows 

The Rows view contains information about Row objects as part of the 
Enterprise Relationship Model. The fields in this view correspond to the 
item attributes in the model. 

Field Type Notes 

RowID Integer Auto-generated ID 

Name VarChar(64) Human-assigned name 
for this Row object. 

ExternalKey VarChar(256) The unique code used by 
the Enterprise Model to 
identify this Row. 
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Racks 

The Racks view contains information about Rack objects as part of the 
Enterprise Relationship Model. The fields in this view correspond to the 
item attributes in the model. 

Field Type Notes 

RackID Integer Auto-generated ID 

Name VarChar (255) Human-assigned name 
for this Rack object. 

SpaceIdentifier VarChar(255) Optional human-assigned 
value to identify this rack. 

ExternalKey VarChar(255) The unique code used by 
the Enterprise Model to 
identify this Rack. 

 
 

Rack Readings Rollups 

The rack readings rollups views contain rollups of raw readings. 
 

RackReadingHourlyRollups 

Field Type Notes 

RackReadingHourlyRoll
upsID  

Bigint  Unique ID for each 
reading 

RackID Integer ID of the rack 

Time Timestamp with 
time zone 

Timestamp when rollup 
was created 

ActivePower Real Average active power 
(Watts) reading during 
rollup interval 

MinActivePower Real Minimum active power 
(Watts) reading during 
rollup interval 

MaxActivePower Real Maximum active power 
(Watts) reading during 
rollup interval 
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RackReadingDailyRollups 

Field Type Notes 

RackReadingDailyRollu
psID  

bigint  Unique ID for each 
reading 

RackID integer ID of the rack 

Date date Date when rollup was 
created  

ActivePower Real Average active power 
(Watts) reading during 
rollup interval 

MinActivePower Real Minimum active power 
(Watts) reading during 
rollup interval 

MaxActivePower Real Maximum active power 
(Watts) reading during 
rollup interval 

 
 

RackReadingMonthlyRollups 

Field Type Notes 

RackReadingMonthlyR
ollupsID  

bigint  Unique ID for each 
reading 

RackID integer ID of the rack 

Year double precision Year when rollup was 
created  

Month double precision Month when rollup was 
created 

ActivePower Real Average active power 
(Watts) reading during 
rollup interval 

MinActivePower Real Minimum active power 
(Watts) reading during 
rollup interval 

MaxActivePower Real Maximum active power 
(Watts) reading during 
rollup interval 
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ITDevices 

The ITDevices view contains information about IT Device objects as part 
of the Enterprise Relationship Model. The fields in this view correspond 
to the item attributes in the model. 

Field Type Notes 

ITDeviceID Integer Auto-generated ID 

Name VarChar(255) Human-assigned name 
for this IT Device object 

Customer VarChar(255) Name of the customer 
that owns this object 

DeviceType VarChar(255) Type of device 

PowerRating Integer Power in watts that this 
device is rated for 

Decommissioned Boolean Whether this device 
should be considered 
decommissioned 

CustomField1 VarChar(255) A user-defined field 

CustomField2 VarChar(255) A user-defined field 

ExternalKey VarChar(255) The unique code used by 
the Enterprise Model to 
identify this IT Device 

 
 

IT Device Readings Rollups 

The IT device readings rollups views contain rollups of raw readings.  

The following limitations apply: 

 IT devices associated with Raritan PX1 and PX2 outlets only. 

 Data buffering must be enabled on the PDU. 

 Outlets from other PDUs are excluded from the rollups. 
 

ITDeviceReadingHourlyRollups 

See IT Device Readings Rollups (on page 416) for details on this view. 

Field Type Notes 

ITDeviceReadingHourly
RollupsID  

Bigint  Unique ID for each 
reading 

ITDeviceID Integer ID of the IT Device 
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Field Type Notes 

Time Timestamp with 
time zone 

Timestamp when rollup 
was created 

Current  Real Average current reading 
(Amps) during rollup 
interval 

MinCurrent Real Minimum current reading 
(Amps) during rollup 
interval 

MaxCurrent Real Maximum current reading 
(Amps) during rollup 
interval 

ActivePower Real Average active power 
(Watts) reading during 
rollup interval 

MinActivePower Real Minimum active power 
(Watts) reading during 
rollup interval 

MaxActivePower Real Maximum active power 
(Watts) reading during 
rollup interval 

ApparentPower  Real Average apparent power 
(VA) reading during rollup 
interval 

MinApparentPower Real Minimum apparent power 
(VA) reading during rollup 
interval 

MaxApparentPower Real Maximum apparent 
power (VA) reading 
during rollup interval 

 
 

ITDeviceReadingDailyRollups 

See IT Device Readings Rollups (on page 416) for details on this view. 

Field Type Notes 

ITDeviceReadingDailyR
ollupsID  

bigint  Unique ID for each 
reading 

ITDeviceID integer ID of the IT Device 

Date date Date when rollup was 
created  
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Field Type Notes 

Current  Real Average current reading 
(Amps) during rollup 
interval 

MinCurrent Real Minimum current reading 
(Amps) during rollup 
interval 

MaxCurrent Real Maximum current reading 
(Amps) during rollup 
interval 

ActivePower Real Average active power 
(Watts) reading during 
rollup interval 

MinActivePower Real Minimum active power 
(Watts) reading during 
rollup interval 

MaxActivePower Real Maximum active power 
(Watts) reading during 
rollup interval 

ApparentPower  Real Average apparent power 
(VA) reading during rollup 
interval 

MinApparentPower Real Minimum apparent power 
(VA) reading during rollup 
interval 

MaxApparentPower Real Maximum apparent 
power (VA) reading 
during rollup interval 

 
 

ITDeviceReadingMonthlyRollups 

See IT Device Readings Rollups (on page 416) for details on this view. 

Field Type Notes 

ITDeviceReadingMonthl
yRollupsID  

bigint  Unique ID for each 
reading 

ITDeviceID integer ID of the IT Device 

Year double precision Year when rollup was 
created  
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Field Type Notes 

Current  Real Average current reading 
(Amps) during rollup 
interval 

MinCurrent Real Minimum current reading 
(Amps) during rollup 
interval 

MaxCurrent Real Maximum current reading 
(Amps) during rollup 
interval 

ActivePower Real Average active power 
(Watts) reading during 
rollup interval 

MinActivePower Real Minimum active power 
(Watts) reading during 
rollup interval 

MaxActivePower Real Maximum active power 
(Watts) reading during 
rollup interval 

ApparentPower  Real Average apparent power 
(VA) reading during rollup 
interval 

MinApparentPower Real Minimum apparent power 
(VA) reading during rollup 
interval 

MaxApparentPower Real Maximum apparent 
power (VA) reading 
during rollup interval 

 
 

EDMNodes 

The EDMNodes view contains the relationship between EDM entities 
arranged as nested sets. EDM entities are part of a data hierarchy. 
Hierarchical data can be efficiently searched when arranged as a Nested 
set tree structure.  

Field Type Notes 

ID Integer Auto-generated 
EDMNodes ID 

Lft Integer Auto-generated 
EDMNode Left ID 

Rgt Integer Auto-generated 
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Field Type Notes 

EDMNode Right ID 

edm_entity_type VarChar(40) Entity Type. For example, 
DataCenter, Floor, Rack, 
Device, 
ComputerSystem, 
Sensors. Entity Type 
ComputerSystem 
represents a PDU 
system. 

edm_entity_id Integer Entity ID of the entity. 

create_at Timestamp Create time stamp. 

Updated_at Timestamp Update time stamp. 

ParentID Integer Entity ID of the parent 
entity 

 
 

AssetStrips 

The AssetStrips view contains information about asset management 
strips attached to PDUs that Power IQ manages. 

Field Type Notes 

AssetStripID Integer Database id of the asset 
strip 

PDUID Integer Database id of the 
attached PDU 

Name VarChar (255) Name of the asset strip 

State VarChar (64) ok, upgrading, 
unavailable, unsupported 

AssetStripCreationTime Timestamp with 
time zone  

Time asset strip was 
created in the database 

AssetStripLastUpdateTi
me 

Timestamp with 
time zone  

Time the asset strip last 
changed in the database 

AssetStripOrdinal Integer The id of the asset strip 
on the PDU: 1 to n 
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RackUnits 

The RackUnits view contains information about the rack units on asset 
strips connected to PDUs that Power IQ manages. 

Field Type Notes 

RackUnitID Integer Database id of rack unit 

AssetStripID Integer Database id of asset 
strip. 

See AssetStrips (on 
page 420). 

AssetTagIDString VarChar (255) Asset tag id string of any 
attached asset tag that 
plugs into the asset strip. 

Unique from the factory. 

RackUnitOrdinal Smallint 1-n the number of the 
rack unit within the asset 
strip 

RackUnitLEDState VarChar (64) LED state: on, off, 
blinking 

RackUnitLEDMode VarChar (64) LED mode: automatic or 
manual 

RackUnitLEDColor VarChar (6) LED color: hexadecimal 
code for the color 

RackUnitCreationTime Timestamp with 
time zone  

When the rack unit was 
created in the database 

RackUnitLastUpdateTim
e 

Timestamp with 
time zone 

When the rack unit was 
last changed in the 
database 

 
 

PUECalculations 

Field Type Notes 

PUECalculationsID  bigint   Unique ID for each 
reading 

DataCenterID integer  Foreign key reference to 
DataCenters table  

TotalEnergy integer  PUE facility energy 

TotalAdjustment integer  Facility Energy manual 
adjustment value 
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Field Type Notes 

ITEnergy  integer  PUE IT energy 

ITAdjustment integer  IT Energy manual 
adjustment value 

MeasuredOn date The date when rollup was 
created 

Granularity text whether daily or monthly 
rollup 

 
 

Sample ODBC Queries 

This section contains sample ODBC queries that can be used to 
generate custom reports. 
 

Obtain Active Power and Apparent Power Data for a PDU With IP 
Address 66.214.208.92 

Select "PDUs"."IPAddress", "PDUs"."PDUName", 
"PDUReadings"."ActivePower", "PDUReadings"."ApparentPower" , 
“PDUReadings”.”Time” from "PDUs", "PDUReadings" where 
"PDUs"."IPAddress"=’66.214.208.91' AND 
"PDUs"."ID"="PDUReadings"."PDUID"; 

The table shows a sample custom report. 
 

IP Address PDU Name Active Power Apparent Power Time 

66.214.208.91 Sentry3_511c
15 

8 8 2009-12-08 
12:46:21.753-05 

66.214.208.91 Sentry3_511c
15 

8 8 2009-12-08 
12:58:23.871-05 

66.214.208.91 Sentry3_511c
15 

8 8 2009-12-08 
16:29:26.032-05 

66.214.208.91 Sentry3_511c
15 

8 8 2009-12-08 
16:32:36.868-05 
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Obtain Active Power and Apparent Power for an IT Device With 
Name “DBServer’’ 

raritan 

Select "ITDevices"."Name", "PDUOutletReadings"."Time", 
"PDUOutletReadings"."ActivePower", 
"PDUOutletReadings"."ApparentPower", 
"PDUOutletReadings"."CurrentAmps" from "ITDevices", "PDUOutlets", 
"PDUOutletReadings" where "ITDevices"."Name"='DBServer' AND 
"PDUOutletReadings"."OutletID" = "PDUOutlets"."PDUOutletsID" AND 
"PDUOutlets"."ITDeviceID" = "ITDevices"."ITDeviceID"; 

The table shows a sample custom report. 
 

Name Time Active Power Apparent Power Current Amps 

DBServer 2009-12-08 
14:16:31.759-05 

0 0 0 

DBServer 2009-12-08 
16:11:27.017-05 

0 0 0 

 
 

Report Maximum Power Reading for Each IT Device Since Added to 
Power IQ 

To obtain the maximum power reading for an IT device since it was 
added to Power IQ, three queries are needed. These sample queries 
group data by device name. This assumes that device names are unique. 
If your device names are not unique, use IT Device ID for grouping. 

1. Query for all devices with all readings for all outlets.  

2. Group, per device, per hour, all outlets of a device and sum up the 
outlet usage 

3. Find the maximum power per device of the total power consumption. 
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 List all outlet readings for all devices: 

SELECT odbc_ITDevices.Name, 

odbc_PDUOutletReadingsRollup.Time, 

odbc_PDUOutlets.PDUOutletsID, 

odbc_PDUOutletReadingsRollup.MaximumActivePower 

FROM odbc_ITDevices, odbc_PDUOutlets, 

odbc_PDUOutletReadingsRollup 

WHERE 

(((odbc_PDUOutletReadingsRollup.RollupInterval)=1) AND 

((odbc_PDUOutletReadingsRollup.OutletID)=[odbc_PDUOut

lets].[PDUOutletsID]) AND 

((odbc_PDUOutlets.ITDeviceID)=[odbc_ITDevices].[ITDev

iceID])) 

ORDER BY odbc_ITDevices.Name, 

odbc_PDUOutletReadingsRollup.Time, 

odbc_PDUOutlets.PDUOutletsID; 
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 Group hourly outlet readings per IT device: 

SELECT [List of all Devices with all readings for all 

outlets].Name, [List of all Devices with all readings for 

all outlets].Time, Sum([List of all Devices with all 

readings for all outlets].MaximumActivePower) AS 

SumOfMaximumActivePower 

FROM [List of all Devices with all readings for all outlets] 

GROUP BY [List of all Devices with all readings for all 

outlets].Name, [List of all Devices with all readings for 

all outlets].Time 

ORDER BY [List of all Devices with all readings for all 

outlets].Name; 

 



Appendix A: ODBC Access 
 

426
  

 

 Find the maximum power reading per IT device: 

SELECT [Summation per Device of hourly readings].Name, 

Max([Summation per Device of hourly 

readings].SumOfMaximumActivePower) AS 

MaxOfSumOfMaximumActivePower 

FROM [Summation per Device of hourly readings] 

GROUP BY [Summation per Device of hourly readings].Name; 

 
 

Finding All Entities in a Rack 

The following query shows all the entities, such as IT Devices and PDUs,  
contained in a specific rack. The example uses "Rack 4." 

1. Retrieve the EDMNodes id for a rack with RackId=4. 

 oculan=> select id from "EDMNodes" where 
edm_entity_type='Rack' and edm_entity_id=4; 

 id 

---- 

 14 

(1 row) 

2. Use the EDMNodes id =14 to retrieve entities contained under this 
rack. 

 oculan=> select "EDMNodes".* FROM "EDMNodes", 
"EDMNodes" AS parent where (("EDMNodes".id != parent.id) 
AND ("EDMNodes".lft >parent.lft AND "EDMNodes".rgt 
<=parent.rgt AND parent.id=14)) ORDER BY "EDMNodes".lft; 

The table shows a sample custom report. 
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ID Lft Rgt EDM_Entity_Type EDM_Entity_ID Created_at Updated_at 

1 4 5 Device 3 2009-06-19 
11:16:48.257348-
0 

2009-06-19 
11:16:48.257348-04 

2  6 7 Device 4  2009-06-19 
11:16:48.274988-
0 

2009-06-19 
11:16:48.274988-04 

3  8  9  Device 5  2009-06-19 
11:16:48.276324-
0 

2009-06-19 
11:16:48.276324-04 

 

  
 

ODBC Configuration and Sample Query for Apple Users 

This section contains instructions for configuring ODBC and creating 
custom reports for Apple users. 

These instructions apply to the following Apple products: 

1. Mac OS 10.7.x or higher. These instructions were tested in Lion. 

2. Microsoft Excel 2011 

The sample report provides the Max/Min/Avg power consumption of 
every rack in the data center.  
 

Download and Install ODBC Client Driver for Mac 

1. Go to 
http://www.actualtech.com/product_opensourcedatabases.php 
(see http://www.actualtech.com/product_opensourcedatabases.php - 
http://www.actualtech.com/product_opensourcedatabases.php) , 
to download the ODBC Pack for Mac OSX. 

Note: The driver is free to try. You can confirm that it works for you 
first, by following the steps in this guide.  

2. Follow the usual Mac steps to install the "Actual ODBC Pack.pkg" 
 

Download and Install Microsoft Query for Mac (included in Office 
2011 v14.1.2) 

1. Make sure you have the latest updates for your version of Microsoft 
Excel. 

2. If you are using Mac OS X Lion or higher, you must use Microsoft 
Office 2011 v14.1.2 or higher.  

 

http://www.actualtech.com/product_opensourcedatabases.php


Appendix A: ODBC Access 
 

428
  

 

Allow Your Mac to Access Power IQ via ODBC 

1. Login to Power IQ. 

2. In the Settings tab, click ODBC Access in the Data Management 
section. The Configure ODBC Database Access page opens. 

3. Click Add. Double-click the 0.0.0.0/0 Network Address, then enter 
the IP Address information of your Mac. Or, leave the default 
0.0.0.0/0 to allow access from all IP addresses. 

4. Click Save. 

 
 

Add Power IQ as an ODBC Information Source to your Mac 

1. On your Mac, launch /Applications/Utilities/ODBC Manager.app.  

Note: ODBC Manager may need to be installed. It is not included 
with the operating system. You can downloaded it from 

www.odbcmanager.net. 

2. Select the tab "User DSN", and click Add. 

3. Select Actual Open Source Databases and click OK. The Actual 
Open Source Databases DSN Configuration wizard opens. 

4. Click Continue. 
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5. Name the Power IQ that you are connecting to, and select 
PostgreSQL as the database type. Click Continue. 

 

6. Enter the IP address of your Power IQ server, and copy the rest of 
the settings exactly as pictured here. Click Continue. 

 Server: IP address of Power IQ 

 Port: 5432 
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 Do NOT select "Connect to server to obtain default settings for 
the additional configuration options"  

 

7. Enter "raritan" as the database name. Make sure to select the 
checkbox labeled "Always include views in table lists". Click 
Continue. 
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8. Click Test. 

 

9. At the next prompt, enter the username and password based on the 
ODBC user credentials specified in Power IQ, and click OK. See 
Configuring ODBC User Credentials (on page 358). 
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10. The test results should be successful. Click OK. 

 

11. Click Done. 

Note: If the test was successful, the ODBC driver works, and you can 
purchase it.  

12. Launch /Applications/Utilities/ODBC Manager.app again. Select User 
DSN and highlight the Power IQ entry you just created. 

13. Click Configure. 
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14. Click Licenses and follow instructions to buy and enter a license key. 

 

Remember, the license you want to buy is the "Actual ODBC Driver 
for Open Source Databases." 

 

Your Mac now can access all the data on the Power IQ server, and 
you can create reports using Microsoft Excel, FileMaker Pro, or any 
ODBC-compliant reporting tool. 

See Create Database Connection in Excel (on page 433) for 
instructions on using Microsoft Excel. 

 

Create Database Connection in Excel 

1. On your Mac, launch Excel.  

2. Choose Excel > About Excel. If you are running Mac Lion or higher, 
make sure you have Excel version 14.1.2 or higher. 

3. Create a new Workbook and save it. For example, "Power 
Consumption by Rack.xlsx" 
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4. In the Excel toolbar, choose Data > Get External Data > New 
Database Query. 

 

5. The "iODBC Data Source Chooser" dialog appears. In the User DSN 
tab, select the Power IQ data source that you created previously. 
Click OK. 

 

6. If this is the first time you are using the data source in Excel, enter 
the username and password according to the ODBC user credentials 
specified in Power IQ, and click Store password in Keychain then 
click OK. 

For information on Power IQ's ODBC user credentials, see 
Configuring ODBC User Credentials (on page 358). 
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Formulate a Database Query 

After creating the database connection, Microsoft Excel ("Microsoft 
Query") shows a list of all data tables that Power IQ makes available. 
See Power IQ ODBC Schema (on page 362) 

 

 To formulate a database query: 

These instructions will create a report providing the max/min/average 
power utilization of every PDU in Power IQ. 

1. Click SQL View. 

2. Copy and paste this EXACT string, including every quotation mark, 
every capitalization, and so on. The string must be used Exactly as 
shown.  

SELECT "PDUReadingsRollup"."PDUID", "PDUs"."ID", 

"PDUs"."PDUName", 

"PDUReadingsRollup"."AverageActivePower", 

"PDUReadingsRollup"."AverageApparentPower", 

"PDUReadingsRollup"."MaximumActivePower", 

"PDUReadingsRollup"."MaximumApparentPower", 

"PDUReadingsRollup"."MinimumActivePower", 

"PDUReadingsRollup"."MinimumApparentPower", 

"PDUReadingsRollup"."Time" 

FROM "PDUReadingsRollup", "PDUs" 

WHERE "PDUReadingsRollup"."PDUID" = "PDUs"."ID" 
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    AND "PDUReadingsRollup"."Time" = '2012-09-10 

00:00:00' 

 

3. Click Return Data. A new window opens. Select "New Sheet", then 
click Properties. 
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4. Deselect the checkboxes for "Enable background refresh" and Use 
Table. 

 

5. Click OK, then click OK again on the previous "New Sheet" dialog. 

6. The report is generated. The query shows rollups from September 
10, 2012. Change the query date in the string you copied and pasted 
for data from other days. 
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To create floor map drawing files for Power IQ, you may find the dcTrack 
drawing file templates useful. This appendix contains information about 
downloading and using those templates.  

Because a dcTrack floor map may require more information in the 
drawing file than a Power IQ floor map, you'll notice extra details in the 
template. 

 Power IQ Floor Map Drawing Files Must: 

 Be a supported file type.Supported Drawing File Software and File 
Format (on page 440)   

 Represent a data center, floor or room in your EDM. 

 Contain all racks that you want to display in the floor map. 

 Include unique rack names that are exactly the same as the rack 
names in the EDM in Power IQ. Duplicate rack names will not work. 

 Follow all drawing file requirements in either Visio or AutoCAD. See 
Microsoft Visio Drawing File Requirements (on page 443) and 
AutoCAD Drawing File Requirements (on page 450). 

In This Chapter 

Terminology - Objects vs. Shapes ........................................................ 439 
Supported Drawing File Software and File Format ............................... 440 
Create Drawing Files or Download Raritan Templates......................... 440 
Microsoft Visio Drawing File Requirements .......................................... 443 
AutoCAD Drawing File Requirements .................................................. 450 
AutoCAD Drawing Object File Recommendations ............................... 451 

 
 

Terminology - Objects vs. Shapes 

When discussing drawing files, 'objects' refers to graphical 
representations of cabinets, floor PDUs, UPS units and CRAC units in an 
AutoCAD® drawing file. 

'Shapes' is used when referring to these same items in a Microsoft Visio® 
drawing file.  
 

Appendix B Floor Map Drawing Files 
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Supported Drawing File Software and File Format 

Power IQ® supports either AutoCAD® 2012 (and earlier) or Microsoft 
Visio®.  

Note: Drawings created in AutoCAD® 2013 and 2014 are not supported 
by dcTrack. 

Both AutoCAD and Microsoft Visio drawing files must be saved as .DWG 
files in order to upload them to dcTrack. 
 

Create Drawing Files or Download Raritan Templates 

For the floor map widget, you can: 

 Use Your Existing Drawing Files (on page 440) 

OR 

 Download Raritan Drawing File Templates (see "Raritan Drawing 
File Templates" on page 440) 

A Visio stencil with Raritan designed shapes and connectors is available 
as a download from the Raritan support website. The visio stencil is 
designed for both Power IQ and dcTrack use. Use the stencil with the 
Raritan Visio templates, or with your own Visio files. See Microsoft Visio 
Floor Map Stencil. 

Whether you use your own file or a Raritan template, review the 
information in this section to help ensure your file is formatted correctly. 
 

Use Your Existing Drawing Files 

Use your existing .DWG drawing files as long as they are created using a 
supported version of Microsoft Visio® or AutoCAD®. See Supported 
Drawing File Software and File Format (on page 440). 
 

Raritan Drawing File Templates 

Raritan provides generic Microsoft Visio® and AutoCAD® drawing files to 
use as templates, or as examples to follow when creating your own Visio 
or AutoCAD drawing files. 

The Raritan designed Visio stencil can be used with the Visio template. 
See Microsoft Visio Floor Map Stencil (on page 442). 

Templates and stencils are downloaded from the Raritan Support 
website.  
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Microsoft Visio Drawing File Default Layers - Usage in Power IQ 

Raritan's Microsoft Visio® drawing file template provides predefined 
layers with various drawing shapes and elements. 

You can download the template from the Raritan Support website.  

Go to: https://www.raritan.com/support/product/poweriq 

The Microsoft Visio floor map stencil is in a zip file. 

Note: The stencil can be used for dcTrack or Power IQ drawings. 

This includes: 

 Individual layers for buildings, row labels, cabinet (rack) shapes, floor 
PDU shapes, UPS shapes and CRAC shapes. 

Layers are provided, but you are not required to create them for each 
of these elements and shapes in a drawing a file. 
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Microsoft Visio Floor Map Stencil 

Raritan provides a Microsoft Visio® stencil containing the shapes and 
connectors used to create shapes in a data center drawing file.  

If needed, download the stencil from the  Raritan Support website.  

Go to: https://www.raritan.com/support/product/poweriq 

The Microsoft Visio floor map stencil is in a zip file. 

Note: The stencil can be used for dcTrack or Power IQ drawings. 

Use the stencil in the Raritan template, or your own Visio drawing file.  

Add the stencil to your Visio My Shapes folder so it is available as 
needed. See Add the dcTrack Stencil to Microsoft Visio 
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Microsoft Visio Drawing File Requirements 

The following Microsoft Visio® drawing file requirements must be met to 
successfully save the file in AutoCAD® file format (.DWG), and visualize 
the floor map properly in the Power IQ® Web Client and Classic View 
once the drawing file is uploaded. 

The file must be converted to a .DWG file to upload it to Power IQ. 

Shapes in Visio represent objects on a floor map in Power IQ. 
 

Shape Outline Requirements - Visio Files 

 A shape's border must be closed  

 Unless a shape is on a layer, the border outline can be black or any 
other color of your choosing.  

For more information on border color when working with layers, see 
Shape Border Layer Requirements - Visio Files (on page 446) 

 

Shape Fill Requirements - Visio Files 

 Each shape created in a Microsoft Visio® file must use a solid fill 
color, but the fill color cannot be 01:White.  

 Aside from the colors used by the objects on the floor map generated 
from the drawing file, the shape's fill color does not impact Power 
IQ®.  

 
 

Add a Fill Color to a Visio Shape 

 To add a fill color to a shape in Visio: 

1. In the Microsoft Visio® file, right-click the shape and select Format > 
Fill.  

Tip: Select multiple shapes at once and apply a fill at the same time. 
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2. Select a color from the Color drop-down, or apply a custom color. 
See Create a Custom Color for Visio Shapes 

3. Select 01:Solid from the Pattern drop-down. Even if it is selected by 
default, you must click on it to apply it.    

4. Click OK to apply the fill and close the dialog. 

 
 

Shape Name Requirements for Power IQ - Visio Files 

The rack shapes in your drawing file must include unique rack names 
that are exactly the same as the rack names in the EDM in Power IQ. 
Duplicate rack names will not work. 

Facilities object shapes in your drawing file must also include unique 
names that are the same as the facilities objects in the EDM. Power IQ 
supports the following facilities objects: 

 CRAC 

 Floor PDU 

 Floor UPS 

 Power panel 

 Standalone meter 

All racks and facilities objects in the drawing file will be synced to the 
EDM. 

 Give each shape a unique name that matches the name in the EDM 
using the Text tool, or entering it directly into the shape. 

 Shape names cannot contain the characters ' \ ? & 
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Add Text to a Visio Shape 

 To add a text ID to a Visio object: 

1. Double-click on the object to put it in edit mode. 

2. Type the text ID, or use the Text Tool to add a text box and type the 
ID.  

Make sure the text box is inside the floor plan shape. 

 
 

Shape Border Layer Naming Requirements - Visio Files 

 Do not begin Microsoft Visio® layer names with the word "dcTrack" 
unless you are directed to do so. 

 Microsoft Visio® layer names cannot contain spaces. Use 
underscores or dashes to separate words if needed. For example, 
Layer1, Layer-1, or Layer_1 
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Shape Border Layer Requirements - Visio Files 

When using layers in a Microsoft Visio® drawing file, a shape on a layer 
cannot have a black border.  

If it does, when the file is converted from a .VSD file to a .DWG 
AutoCAD® file and then uploaded to Power IQ®, the shape's fill is 
changed to black even if another fill color is applied to it. 

For example, you create a rectangle with a black border and blue fill on a 
layer in a Visio file to represent a CRAC unit object on the floor map.  

 

When the file is converted to a .DWG and then uploaded to Power IQ, 
when the CRAC unit object appears on the floor map in Power IQ its fill 
is black, not blue. 

 

Avoid this by setting the shape's fill, border and layer to the same color - 
see Set a Shape's Border, Fill and Visio Layer to the Same Color (on 
page 446) 
 

Set a Shape's Border, Fill and Visio Layer to the Same Color 

 To set a shape's border, fill and layer to the same color:  

1. In Microsoft Visio®, select View > Layer Properties.  

The Layer Properties dialog appears. 

2. Create a new layer for the objects by selecting the New... button, 
naming the layer in the New Layer dialog and clicking OK. 

Visio layer names cannot contain spaces. Use underscores or 
dashes if spaces are required. 
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Important: Do not begin Visio layer names with the word "dcTrack" 
unless you are directed to do so. 

 

3. In the Layer Properties dialog, locate the row containing the layer 
you just created, then click on the layer's field under the Color 
column. A checkmark appears in the field. 

4. Select a color for the layer from the "Layer color:" drop-down, then 
click Apply.  

The color is applied to the layer, and the Color field changes to the 
selected color.   

 

Alternatively, create a custom color. See Create a Custom Color for 
Visio Shapes   

5. Click OK. 

6. Next, assign the shape to the layer. 
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a. Right-click on the shape, then click Format > Layer to open the 
Layers dialog. 

 

b. Select the layer, then click OK.  

 

The shape is assigned to the layer, and its border and fill are the 
same color as the layer.  

Since the shape and layer colors are the same, in order to see 
the shape, a negative (or inverse) image may be displayed.  
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If this is the case, the shape may appear as if it has no fill even 
though it does. 

 

7. Finally, verify only the shape(s) you want are assigned to the layer.  

a. Click View > Toolbars then check the Format Shape option to 
enable that Format Shape toolbar. 

Click on an object that is on the layer you just created. The layer 
is displayed in the Layer drop-down on the Format Shape 
toolbar.  

 

Note: If you want shapes to have a black border even though their border 
and fill color are the same as their layer, there is a workaround. See 
Create a Border for Visio Shapes on a Layer (Workaround) (on page 

449)  
 

Create a Border for Visio Shapes on a Layer (Workaround) 

Once a shape's border and fill are changed to the same color as the 
layer, the shapes do not have a black border to define them from each 
other in the Microsoft Visio® file.  
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If you want the Visio shapes to use a border that is a different color than 
the fill, do the following as a workaround. 

 To create a border for the objects: 

1. Draw an additional rectangle that has no fill (Pattern = None) around 
each object that is not assigned to a layer (Layer = {No Layer}).  

Note: This is similar to the way it would be done in AutoCAD®, where 
the rectangle and the hatch are two separate objects. 

2. To easily distinguish classes of objects, create separate layers and 
colors for each type of floor-standing object in the data center such 
as a cabinet, floor PDU, CRAC or UPS. 

3. Text labels should be modified if the text wraps to multiple lines. Text 
wrapping causes AutoCAD® to insert a dash at the end of each line.  

The workaround to this issue is to size the text box of the label to be 
wide enough so that the text does not wrap. Reducing the font size 
also helps prevent wrapping. 

 

AutoCAD Drawing File Requirements 

Following are Power IQ's® minimum, AutoCAD® drawing file 
requirements. 
 

Object Outlines - AutoCAD Files 

 An object's outline must be closed 
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Object Name Requirements for Power IQ - AutoCAD Files 

The rack shapes in your drawing file must include unique rack names 
that are exactly the same as the rack names in the EDM in Power IQ. 
Duplicate rack names will not work. 

Facilities object shapes in your drawing file must also include unique 
names that are the same as the facilities objects in the EDM. Power IQ 
supports the following facilities objects: 

 CRAC 

 Floor PDU 

 Floor UPS 

 Power panel 

 Standalone meter 

All racks and facilities objects in the drawing file will be synced to the 
EDM. 

 Give each object a unique name that matches the name in the EDM 

 Object names cannot contain the characters ' \ ? & 
 

Drawing File Layer Requirements - AutoCAD Files 

 Do not begin AutoCAD® layer names with the word "dcTrack" unless 
you are directed to do so. 

 

AutoCAD Drawing Object File Recommendations 

When using AutoCAD® to create your floor map drawings, follow these 
recommendations.  
 

Rack Object Recommendations - AutoCAD Drawing Files 

Rack Object - Commands 

 Use the Pline command or the Rectangle command to draw a rack 
outline 

 Make the Pline width of a rack outline equal to 0.75” or 1” 

 When creating a rack with a curved front, use a single Pline and 
draw the rack starting at the center rear.  

Then, to create the curved front, draw several shorter straight lines 
while varying the angle each time to achieve the curved look. 

 

Rack Object - Layers 

 Draw rack outlines on separate layers in the drawing file to make 
future modifications and global changes easier. 
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Object Outline Recommendations - AutoCAD Drawing Files 

Object Outline - Command 

 Create objects using a polyline 
 

Object Outline - Layers 

 Create the object outline on a different layer than the hatch  
 

Object Outline - Color 

 Set the color of the object outline by layer  
 

Object Hatch Recommendations - AutoCAD Drawing Files 

Object Hatch - Layers 

 Draw solid hatches on separate layers in the drawing file so it is 
easier to make future modifications and global changes. 

 Create the hatch on a different layer than the object outline  
 

Object Hatch - Pattern 

 Use a solid pattern for the hatch within an outline  
 

Object Hatch - Color 

 Set the color of the hatch by layer  

 Raritan recommends using the following colors for hatch layers:  

 Color 81 for a cabinet Solid Hatch 

 Color 254 for PDU and CRAC Solid Hatches 

 Color 151 for PT Solid Hatches 
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Object Label and Text Recommendations - AutoCAD Drawing Files 

Object Labels - Text Formatting 

 Object labels should use Arial Bold set to 9 inch height. The text 
height assumes the AutoCAD® drawing is drawn on a 1:1 scale 

 Use Multiline Text for object labels, and make sure they are 
contained within the object outline  

 Create either a Standard Text label or Multiline Text label to identify 
each data center row represented in the drawing file 

 See Object Name Requirements for Power IQ - AutoCAD Files 
(on page 451) 
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Security Questions 

Question Answer 

Are failed login 
attempts recorded? 

The audit log records all login attempts. You can also 
configure Power IQ to send syslog notifications for 
entries in the audit log. 

Does Power IQ 
support LDAP lock-out 
settings? 

Power IQ respects the lock-out settings of an LDAP 
server. If a user attempts multiple invalid logins, and the 
LDAP server set the account to be blocked, Power IQ 
no longer allows access. 

Do session timeouts 
work in an LDAP 
setting? 

Session timeouts are applicable to LDAP users and 
local users. 

 
 

PDU Questions 

Question Answer 

The status of my PDU 
says "Degraded."  

 Check to see if the SNMP agent is enabled on the 
PDU. 

 If enabled, check to see if the matching SNMP read 
strings are configured for the PDU and Power IQ. 

 Check to see if you are running the latest PX 
firmware. For Raritan PX PDUs. 

 If you have enabled Buffered Data Collection, make 
sure the PX has been configured with an SNMP 
write string. For Raritan PX PDUs. 

 Reduce the poll rate or increase the number of 
CPUs (VMware). 

How do I configure my 
MRV PDU so that it 
will work with Power 
IQ's power control 
feature?  

 Make sure that the SNMP community string you use 
to configure the MRV PDU in Power IQ supports 
both SNMP v1 and v2c Gets and Sets. The 
community string must be configured for v1 and v2c 
access in both the Get Clients section and the Set 

Appendix C Frequently Asked Questions 
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Question Answer 

Clients section on the MRV PDU. 
 

 

Unable to Collect IPv4 Routing Table 

The error "Unable to collect IPv4 routing table" may display when you 
attempt to launch a Power IQ virtual machine with multiple NIC cards, 
using ESXi 5.1. 

Renaming two files may be a workaround to this VMware Tools issue. 

mv 

/usr/lib/vmware-tools/plugins32/vmsvc/libtimeSync.so  

/usr/lib/vmware-tools/plugins32/vmsvc/libtimeSync.so.

renamed 

mv 

/usr/lib/vmware-tools/plugins64/vmsvc/libtimeSync.so  

/usr/lib/vmware-tools/plugins64/vmsvc/libtimeSync.so.

renamed 
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